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Welcome! Home 1

Thank you for selecting PDXpert as your product lifecycle management software. PDXpert provides your company with a simple,
flexible and secure tool for managing your product data.

Product lifecycle management (or simply "PLM") is a methodology, as well as a tool, that should be tailored to meet your particular
situation. Specifying PLM procedures depends as much on your company's culture and customer or regulatory requirements as on the
technical contents of design documentation and product content management.

Since PDXpert offers you a great deal of flexibility, this help guide gives general PLM ideas and specific ways that you can change
PDXpert to fit your company's needs.

This help file documents all important features of PDXpert. Some software features may not be available depending upon
how your administrator has configured your particular installation of PDXpert.
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Help styles Home 2

On the Contents  list of this help guide, you'll see icons that represent:

  A group of related topics (a "chapter"). Click on the  to expand the group and show the topics.

  A help topic. Click on the title to show the topic in the right panel.

In describing this application, a help topic may show these styles:

Key  is a key that you press on your computer's keyboard.

System data  is shown by the application or operating system. For example, it's used in the main window's status bar.

Item  contains a complete item, collection member or tool. It's shown in the workspace.

Page  selects one page of information, typically on a form as a page selector ("tab"). A Topic  page that contains a Related
page may be shown in this guide as Topic: Related

Explorer  selects the Collection Explorer or Item Explorer. It's shown in the Explorer selectors.

Group Node ◢  Node  shows a "navigation tree" group node to expand, and a node to select.

Default collection member  in the Collection Explorer.

Inactive collection member  in the Collection Explorer.

Data label  shows the name of a data entry field or selection, or is instruction text.

Data entry  is the data that you type or otherwise provide.

Menu ➔ Command  shows the menu to click, and the command to select.

Selected value ⌵  shows a selection from a list of choices in a dropdown list.

☑ This is a checkbox  It may be marked (true or yes) or not (false or no).

◉ This is a radio button  It shows one selection from a limited set of options.

Button  causes an action when it's clicked with your computer mouse. The action may also be caused by a keyboard key,
such as Enter  or Esc .

Notes provide special information:

A warning identifies areas that require extra caution to prevent damaging your data.
Understand the effects of your action. If you need to explore possible results, use a separate test environment.
Some actions cannot be reversed or undone, so back up your data before you begin.

A note directs your attention to important issues and PDXpert business rules.

A tip may make your PDXpert use more productive, but it's not essential to successful operation.

Item iteration release state

 Pending
 Released
 Canceled

Document class with release state

 Document
 Pending
 Released
 Canceled

Part class with release state



 Part
 Pending
 Released
 Canceled

Change form class with lifecycle status

 Change form
Summary status:

 In-work status
 Released or completed status
 Canceled or rejected status

In work:
 Originated
 Submitted to analyst
 Routed for approval
 Held awaiting more information
 Stopped after disapproval, wait for an analyst to select the next step
 Accepted, and waiting for analyst final review

Success:
 Released. All reviewers approved the change. The analyst completes the change.
 Completed. The affected items are dispositioned.

Failure:
 Canceled, after a reviewer disapproved. The analyst deletes the change.
 Rejected, after a reviewer disapproved. The change form is kept permanently.

Change form reviewer response

 Approve
 Disapprove
 Hold

Change affected items and dispositioning

 Change releases iteration
 Change cancels iteration
 Iteration disposition row
 Show/hide home items
 Show/hide partner items
 Show/hide parts
 Show/hide documents
 Collapse list to hide details
 Expand list to show details
 Add disposition button.
 Delete disposition button

⟣  Releasing affected item
⟡  Releasing and canceling affected item
⟢  Canceling affected item

Advisory and executing changes

 Executing
 Advisory

Change and task priorities



 High
 Normal
 Low

Email queue status

 Email ready
 Email blocked
 Email failed

Other icons show actions and status

 ≡  Page has data
 Error, such as missing or duplicate record
 Warning, such as duplicate collection abbreviation

Related topics
Arrange the Explorer windows
Item menu
Edit menu
Tools menu
Process menu
Window menu
Help menu
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PDXpert Application Server overview Home 3

The PDXpert® Application Server shows an administrator interface window (the "console") for configuring the system and for
managing your product database and library. It works with the PDXpert Server service that communicates with PDXpert client
applications and the Microsoft® SQL Server™ database engine.

In the PDXpert Application Server help topics, pay special attention to warnings like this to avoid data damage or loss.

The PDXpert Application Server requires complete and exclusive control of its database. Do not add your own table, view,
stored procedure, or other resource in the PDXpertDB database. Do not alter PDXpert tables, views or other objects. During
an upgrade, PDXpert may add, alter or drop tables, and make other changes. An upgrade drops all stored procedures,
functions, triggers, and views (with the Views collection), and then rebuilds. Make a separate database to hold your own
objects.

Do not rename the database logical name, PDXpertDB , or physical file names, PDXpertDB.mdf  / PDXpertDB_Log.ldf . Do
not move the physical files out of the \Data\Database  folder.

Do not add files to the server's \Data\  folder or its subfolders. Unrecognized files may interfere with proper operation or may
be deleted without warning.

The PDXpert Server console:
Supports database backup, restore, relocation, reset and instance assignment functions.
Saves the set of server console and service log files.
Resets the super administrator's log-in account password.
Provides a web browser link that points to the PDXpert client installer, and a button to save the client installer.
Resets the PDXpert super administrator account password.
Shows information about PDXpert, Windows and SQL Server, and copies technical details to the Windows clipboard.

The PDXpert Server service:
Confirms that the user logging into the PDXpert client application is authorized to access your system.
Verifies that the PDXpert client application is compatible with the PDXpert service and database schema.
Manages data transfer between the PDXpert client application and the database.
Manages the file library for the PDXpert client application.
Manages the PDXpert Filter service (a child process), which submits file attachment indexing requests to the Windows Search
service.
Validates the software license that your organization has been given.
Downloads new installation software to out-of-date clients.

Before using the PDXpert Server console, or making changes to the service settings, review the appropriate sections of this help file.
The How to... topics provide detailed instructions.
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Back up the database and library Home 4

You should back up your database and library (file attachments) frequently to insure against data loss.

Do not attach copied database MDF/LDF files to another PDXpert Server. Each database has a unique database
identifier to ensure client cache coherence. The PDXpert Server service automatically assigns the new identifier is when it
restores the database backup ( .PDXZ  or .BAK ) file. Attaching the database by other means – such as SQL Server
Management Studio, PowerShell or Windows command line – will damage your data unless the database identifier
dbo.PDXpertInfo.DatabaseId  is also updated and the PDXpert Server service is restarted.

Microsoft recommends backing up a SQL Server database to an internal fixed drive. The operation may fail – possibly
without any warning – if you select a compressed, network-mapped, or external volume. Confirm that a backup that's saved
to the selected device can be restored.

The selected backup location must have sufficient free disk space for the backup file. The server disk also must have free
disk space to build the temporary backup file.

Do not add files to the server's \Data  folder or its subfolders. Unrecognized files may interfere with proper operation or may
be deleted without warning. If the folder has been moved, the actual name may not be \Data  but perhaps \PLM-Data ,
\PDXpert , or something else.

PDXpert releases are not backward compatible. A backup made by a specific PDXpert Server release can only be restored
into the same, or higher, PDXpert Server. If it's restored into a higher release, the backup file is automatically upgraded to the
PDXpert Server's release.

Microsoft SQL Server databases are not backward compatible.
A database backup can only be restored into the same, or higher, SQL Server instance. For example, SQL Server
2017 (version 14.0) can accept a 14.0 database, as well as an older SQL Server 2016 (13.0) database.
SQL Server can't "downgrade" a higher-level database backup. For example, restoring a backup file from SQL Server
2019 (version 15.0) into an earlier SQL Server 2017 (14.0) will fail.

The backup file name includes information about the server machine name, backup date, PDXpert release, and SQL Server
version: {machine}-{date}-{release}-{version}.pdxz   When restoring the backup database, the file name's SQL Server
version is compared to the installed instance to warn of incompatibility.

When restoring a database into a more recent SQL Server version, the restored database stays at the older SQL Server
compatibility level. For example, if the backup file was created using SQL 2014 (level 120 ) and restored to SQL 2019 (level
150 ), the restored database stays at 120  until upgraded using the ALTER DATABASE  command. Upgrading the compatibility
level gives improved T-SQL language features. Always check the Microsoft and PDXpert release notes, and test your
Transforms collection members. For details, search the web: view or alter database compatibility level

Using the manual backup tool
On the PDXpert Application Server window:

1. Select the Manage  page.
2. In the Maintenance  area, click the Backup...  button to open the Save Backup As  dialog.
3. There are two backup formats available:

The default backup format is Database with Library (*.pdxz) ⌵ . This is a simple way to save your database and all library
files into a single compressed ("zip") file. The file contains the SQL Server backup ( .BAK ) file, an XML manifest file, and
the library file attachments.

Files that are downloaded from the internet or compressed in other operating systems (like Linux or MacOS)
may not work well in Windows. Before saving a compressed file attachment in PDXpert, always expand and
then re-compress these files using Windows File Explorer or another Windows compression tool. See the File
tab  help topic. Or, use only the Database without Library (*.bak) ⌵  backup format.



The PDXZ format is convenient as you're starting out, but it's intended only to support smaller systems. Use a
commercial backup solution before the \Database  and \Library  subfolders reach 1GB. See Automating your
backup , below.

The alternative backup format is Database without Library (*.bak) ⌵ . This saves the "raw" SQL Server database without
including the library files. This is a much faster backup, and is useful for maintenance, but is incomplete without the file
attachments.

To have a complete backup, you must use Windows or a backup tool to copy all of your library files that are
stored in the \Library  subfolder.
Copy the \Library  folder contents after the database backup is done.

If more than 2GB of files are in the \Database  and \Library  subfolders, you can only save the SQL Server
database without the library files. This will be shown by the DATABASE ONLY - NO LIBRARY (*.bak) ⌵  format
type.

4. Choose the location where you want your backup file to be saved, and click the Save  button.

Secure your backups to prevent unauthorized access to archival data. The backup database file does not carry any
access restrictions, and includes your software license key. It may be loaded into a different PDXpert instance, and
the database element can be extracted and loaded into any SQL Server database engine.

The PDXZ file is constructed in the \Temp  folder. Temporary files are normally deleted after the PDXZ file is
transferred to the selected location. If a backup error (such as disk full) prevents automatic deletion, all temporary files
can be manually deleted after all users exit the PDXpert client application.

To restore the backup, see the Restore data from a backup  help topic.

Automating your backup
Your server backup software must be compatible with SQL Server. Consumer-grade backup utilities may not be
capable of correctly backing up a SQL Server database, and can even damage or delete your original database.
Search the web for sql server backup software . Some less-capable tools may back up the SQL Server database only,
and you may need a separate utility for backing up the files contained in the library folder.

It's very important to have a scheduled backup procedure that automatically saves the database and the library to a safe archive. As
your database and file library grow, the compressed .PDXZ  backup file will take longer to finish, consume more system resources, and
be increasingly vulnerable to file system errors.

Data that must be backed up
There are two essential PDXpert data elements that you must protect:

1. The SQL Server database in which all of the product data is maintained (for example, files like PDXpertDB.mdf  and
PDXpertDB_log.ldf ), and

2. A Windows folder, called the \Library  folder, that contains all files that have been attached to PDXpert's items.

Both of these data elements work together. Therefore, they must be backed up as a set.

Finding the data to be backed up
The options are:

Back up the entire server computer.
Back up the entire disk drive that contains the PDXpert \Data  folder.
Within the disk drive, back up the entire content of the \Data  folder.
Within the \Data  folder, back up only the content of these two folders:

SQL Server database files: \Database
PDXpert library files: \Library

The disk drive and the location of the data folder are shown on Manage .



Automation practices
Regularly assess your backup & recovery risks, procedures and technologies. Develop and maintain a robust data backup
and disaster recovery plan in consultation with your IT specialist. Always validate the results of a new or revised backup
procedure.

Your Windows operating system may have the necessary software utilities to make a reliable backup procedure. There are also many
commercial tools available to perform this important task.

When developing your data backup and disaster recovery plan, consider these practices:
Schedule backups during quiet periods: backup jobs consume a lot of I/O resources.
Ensure that the backup interval reflects how quickly your data ages, and balance this interval with users' time to reproduce lost
data after the most recent backup's been restored.
Avoid propagating viruses by scanning file attachments before saving them into the library.
Some antivirus software can interfere with the PDXpert Application Server, and should be tested for problems while users
perform normal database and library file tasks.
Do not use your production database/library disk as the primary backup device. Use a separate physical disk and not simply a
partition on the same disk.
After a backup is complete, copy the backup file(s) from the primary backup drive to a secondary device. This secondary device
should be secured, and logically and physically separate from the production network. Use disk-to-disk or disk-to-cloud
technology for secondary backups. Avoid tape.
If you don't control your off-site storage location, consider encrypting your saved data.
To minimize downtime, ensure that off-site backups can be retrieved quickly.
Don't be too aggressive in purging old backups. In a very large historical file library, a monthly snapshot going back a few years
may provide that one crucial file that was corrupted long ago but only recently discovered.
Periodically make sure that your hardware, particularly disk subsystem, is functioning properly.
Test the data integrity of your backup procedure by restoring the backup file(s) into a fresh configuration. Regularly validate that
the backup procedure is making correct backup files.

Restoring a VSS backup
When restoring an automated backup that uses the Volume Shadow Copy Service (VSS), stop the PDXpert Server service before
copying the data into the data folders.

In this example, the VSS backup consists of all folders and files within a \Data\  folder.

1. Ensure all users are logged out of the PDXpert client application.
2. Restore the VSS backup data to a local temporary folder ("source location"). For example: E:\Temp\Data\
3. On the server computer, open the PDXpert Application Server window. (See image above.)

A. The VSS backup data will be copied to the data directory (the "target location"). Note the target location shown next to
the Change Data Directory  button. For example: D:\PDXpert\Data\

B. Find the SQL Server instance name, as shown next to the Change Database Server  button. This instance is typically
named PDXPERT, and usually shown like .\PDXPERT .
If your system uses a SQL Server Express LocalDB database instance, it'll be shown as (localdb)\MSSQLLOCALDB .
This can be confirmed on the PDXpert Application Server's Information  page, where the SQL Server  information box will



include LocalDB  in the name.
C. Close the PDXpert Application Server window.

4. In the Windows Administrator Tools  > Services  window:
A. Find and Stop  the PDXpert Server  service. If asked by the system, allow the PDXpert Filter Service  to stop.
B. Find and Stop  the SQL Server (instance)  service, where instance is the name of the PDXpert instance that you found in

Step 2; for example, SQL Server (PDXPERT) . Skip this step if your system is using SQL Server Express LocalDB.

5. Copy the content of the VSS backup \Data\  folders from the source location to the target location.
6. In the Administrator Tools  > Services  window: Start  the PDXpert Server  service.

Do not start the PDXpert Filter service; it is started by the PDXpert Server service only when needed.
7. Use the PDXpert client to show that the system is working as expected.

If the VSS backup doesn't contain all …\Data\  folders (for example, it contains only the essential …\Data\Database\  and
…\Data\Library\  content), then use the Tools menu ➔ Index Status...  command to re-index the restored data.
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Restore data from a backup Home 5

You can restore a database and related library files from a previous backup. You may need to do this if you're moving PDXpert to a
new server or recovering from a computer failure. You may also want to restore a previous database if you're experimenting with
configuration options or using the Batch Importer tool , and want to return to a previous configuration.

The restored backup data completely and permanently overwrites the current database in the \Database  folder.
Restoring a .PDXZ  backup file completely and permanently deletes all library files before copying its contents into
the \Library  folder.
Restoring a .BAK  backup file doesn't delete, change or replace any files contained in the \Library  folder.

Consider whether you should back up the current database and library before restoring your backup file.

Do not use SQL Server commands to attach database MDF/LDF files copied from another PDXpert system. This can
damage your data. To ensure client cache coherence, each database must have a unique database identifier
( dbo.PDXpertInfo.DatabaseId ). The PDXpert Server assigns a new identifier when it the restores the database, and the
SQL Server ATTACH command does not.

Microsoft recommends restoring a SQL Server database from an internal fixed drive. The operation may fail – possibly
without any warning – if you select a compressed, network-mapped, or external volume.

Microsoft SQL Server databases are not backward compatible.
A database backup can only be restored into the same, or higher, SQL Server instance. For example, SQL Server
2017 (version 14.0) can accept a 14.0 database, as well as an older SQL Server 2016 (13.0) database.
SQL Server can't "downgrade" a higher-level database backup. For example, a backup file from SQL Server 2019
(version 15.0) cannot be restored into an earlier SQL Server 2017 (14.0) instance.

Do not restore a higher backup file into an older PDXpert Server release. A backup can be restored only into the same, or
higher, PDXpert release.
For example, a PDXpert server 14.0.2700.5 can restore a 14.0.2700.5 backup file, and can upgrade an older 12.2.1000.4
backup file. A PDXpert server 14.0.2700.5 doesn't accept backups from higher releases, say, 15.0.3000.5. Refer to
PDXpert's release notes for further compatibility details.

Do not add files to the server's \Data  folder or its subfolders. Unrecognized files may interfere with proper operation or may
be deleted without warning. If the folder has been moved, the actual name may not be \Data  but perhaps \PLM-Data ,
\PDXpert , or something else.

When first opening a PDXpert client, you may need to import your current software license key file. The software license key
must allow the current PDXpert release.

A software license purchased as a subscription must be current.
A perpetual license must show an expiration date after the PDXpert software release date.

All PDXpert client connections are closed when the backup file is restored. Users must restart their client application.

The backup file name normally includes information about the server machine name, backup date, PDXpert release, and
SQL Server version: {machine}-{date}-{release}-{version}.pdxz   When restoring the backup database, the file name's
SQL Server version is compared to the installed instance to warn of incompatibility. If the file has been renamed, file
compatibility may be uncertain.

On the PDXpert Application Server window:

1. Select the Manage  page.
2. If the database and file attachments were saved using the default backup format Database with Library (*.pdxz) ⌵ , then skip this

step and go to the next step.
If the database and file attachments were saved separately using the alternative backup format

Database without Library (*.bak) ⌵ , then:



A. On the PDXpert Server, click the Reset System  button to clear the previous database and all files contained in the
\Library  subfolder. See the Reset the database and library  help topic.

B. Copy your saved library files into the empty data directory path's \Library  subfolder.

Ensure that these files are related to (and were copied immediately after) the database backup .BAK  file that
you'll restore in the next step.

3. In the System changes  area, click the Restore From Backup...  button to open the Restore From Backup  dialog. Navigate to the
location where your backup file is saved, select the correct backup file, and click the Open  button to immediately load the
backup file into the server. The system makes a new database index. A large database may take a while to re-index.

If the database was saved by an older release of PDXpert, then the database is automatically upgraded to the current
schema. After upgrading, the database cannot be used with the older release.

4. Make sure that the restored system is accurate, consistent, and correct.
Accurate: The restored system – parts, documents, change forms, collections, etc. – contains exactly what you expect
and is not, for example, an older backup.
Consistent: The database items refer to the matching set of library file attachments.
Correct: The right software license key is loaded, users can log into the client, and items can be searched, found and
opened.

A. Log into the PDXpert client application.

Your PDXpert client may request a valid software license key that lets the installed PDXpert release use the
restored data.

B. Wait until all items are indexed ( Tools ➔ Index Status... ).
C. Search for an item with a file attachment that was saved just before the backup. View or copy the attachment to confirm

its content.
If you can open the item record, but can't confirm its file attachment, then the library files have not been restored to the
correct location or are inconsistent with the database.
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Reset the administrator password Home 6

Reset the super administrator account password when all other administrator accounts or passwords have been lost. The super
administrator can then log into the PDXpert client and update user accounts in the PDXpert client's User Management  tool.

Anyone with access to the PDXpert Application Server console can reset the super administrator account. A reset provides
full administrative access to your system configuration and product data via the PDXpert client application. Ensure that
access to your server computer is limited to authorized users.

The super administrator account is set within the Collection Explorer's Persons collection. See the Setting a user as the
super administrator  help topic.

On the PDXpert Application Server window:

1. Select the Manage  page.
2. In the Maintenance  area, click the Reset Admin  button. The status text shows the super administrator account name and

confirms that the password has been cleared.

By default, the new super administrator account name is set to Admin . If the super administrator's account is
authenticated to an Active Directory domain, then the user name is reset to exclude the domain; for example,
engineering\lee  is reset to Admin . If a different user has the default name Admin, then the system will append

and, if necessary, increment the super administrator's user name as Admin1 , Admin2 , etc.

You can now log into the PDXpert client application. At the client log-in window, type the super administrator's user name into the Enter
your account name  textbox, leave the Enter your account password  blank, and click the OK  button.
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The Reset System  button overwrites the current database with fresh starting values, and deletes all file attachments in the library. This
is useful when you're first evaluating PDXpert and, after finishing with your test data, you want to return to an "empty" database.

Your data and library files are completely and permanently deleted, and the system is restored to its default
settings. If you need the existing data, back up the database and library files before you reset the system.

All users must close their PDXpert client application before the system is reset.

The PDXpert Application Server requires full control over its database. Do not add your own table, view, stored procedure, or
other resource in the PDXpertDB database. Do not alter PDXpert tables, views or other objects. During an upgrade, PDXpert
may drop or update tables, change stored procedures, or make other changes; it then clears and rebuilds all views and
members of the Views collection. Make a separate database to hold your own objects.

Do not add files to the server's \Data\  folder or its subfolders. Unrecognized files may interfere with proper operation or may
be deleted without warning.

If your system has been issued a software license key, confirm you have a copy before you reset the system.

On the PDXpert Application Server window:

1. Select the Manage  page.
2. In the System changes  area, click the Reset System  button. When the warning is shown, clicking the Yes  button will confirm

that you want to overwrite the current database with new starting values, and clear the file library folder.
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The PDXpert Application Server manages different types of data in several subfolders under a single "data directory" Windows folder.
Together, these subfolders contain your complete PLM data: database, file library, search index and related settings. When the
PDXpert Application Server is first installed, the data subfolders are made within the default data directory. Changing the base path
copies the data subfolders and their contents into the new data directory.

Before changing the data directory:
All users must be logged out of the PDXpert client application.
Back up your database and library.

The selected data directory must be on a local uncompressed internal drive. The operation may fail – possibly without any
error message – if you select a compressed, network-mapped, or external (e.g., USB) volume.

The selected destination folder must be empty, or must be a previously-used PDXpert data directory.
If the selected folder is empty, then the source data is copied into the empty folder.
If the selected folder is a valid PDXpert data directory that contains the pdxpertdata  signature file, then data in the
destination folder is not deleted. The PDXpert Server begins using the data in the destination folder.
If the selected folder contains data that PDXpert does not recognize, a warning is shown. If you click the Yes  button,
data in the destination folder is deleted and the source data is copied into the empty folder.

Do not add files to the server's data folder (usually \Data\ ) or its subfolders. Unrecognized files may interfere with proper
operation or may be deleted without warning.

Application performance relies on good data disk performance. Consider using a solid-state drive (SSD) or other fast
technology.

On the PDXpert Application Server window:

1. Select the Manage  page.
2. Within the System changes  area:

The Change Data Directory...  button opens the Browse for Folder  dialog. Choose or make the folder on the local
computer where you want your product data and library files to be saved, and click the OK  button. For example, if you
want the \Database , \Library  and other folders within D:\PDXpert\Data , then select or create the PDXpert  and Data
folders for this path.

Moving the data may take a while: the PDXpert Application Server must copy the database, index, and each
library file.

The data contained in the source directory is not deleted.

The Copy  button copies the current folder path to the Windows clipboard.
The Open…  button opens the data directory in Windows File Explorer.
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By default, the PDXpert Application Server installs its own Microsoft SQL Server database instance. If you wish, you can specify a
different SQL Server instance.

Back up your database before changing the SQL Server instance.

The SQL Server instance you select must be compatible with your existing SQL Server database files. For example, if your
database is using a SQL Server 2019 instance, then you must select SQL Server 2019 or newer for the replacement
instance. You may not select an older instance, such as SQL Server 2017.

The selected SQL Server instance must exist on the current computer. Do not select a SQL Server instance on a different
computer.

The PDXpert service expects it has full control of the instance, which may include restarting it. This can affect other
applications that share the same instance.

Do not make new objects within the PDXpertDB database, since unrecognized objects may interfere with proper operation or
be deleted.

All users must be logged out of the PDXpert client application.

On the PDXpert Application Server window:

1. Select the Manage  page.
2. In the System changes  area, click on the Change Database Server...  button to open the SQL Server Selector  dialog.
3. Select or enter a Database engine (instance) name , and click the OK  button to save your selection. The connection uses the

form .\instancename , like .\PDXPERT .

This change simply specifies which SQL Server instance manages your database. The database and library files are
not moved; they remain in the original data directory. You can move the database and library files using the

Change Data Directory...  button.

When you need technical support for your system, include details about your database instance as shown on
Information .

4. Reset service connections by doing one of these:
Restart the Windows server computer; or
In the Administrator Tools  > Services  window: Restart  the PDXpert Server  service. If you are asked, allow the PDXpert
Filter  service to restart.

Downgrading the database server
This procedure deletes your database and library files. Before using this procedure, back up the database and the
library files.

Downgrading does not convert a higher-level SQL Server database to the lower-level SQL Server version. The database that
you restore in the last step must be compatible with the lower-level SQL Server engine.

If you must change to a lower-version SQL Server (for example, because an incorrect SQL Server instance was selected above):

1. Back up both database and library. See the Reset the database and library  help topic.
2. In the System changes  area, click on the Change Database Server...  button to open the SQL Server Selector  dialog.
3. Select or enter the original SQL Server instance, and click the OK  button to save your selection.

The system normally shows an error message that the current database is incompatible. You can ignore errors like
The database 'PDXpertDB' cannot be opened...  and A downgrade path is not supported.  These will

be fixed in the next step.



4. Click the Reset System  button. This loads a new starting database that is compatible with the selected SQL Server version,
and verifies the database connection.

5. Restore the database and the library files. See the Restore data from a backup  help topic.
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PDXpert backs up your system's SQL Server database and library files into a single compressed file with a .PDXZ  file extension
("PDXpert Data eXport, Zipped").

The .PDXZ  backup file is different from an IPC-2570 file with a .PDX  file type (a PDX package ).

This topic tells how to extract data from the .PDXZ  backup file.

Opening the PDXZ file
The database and library files are compressed by the PDXpert Application Server into a PDXZ file using the Zip64 compression
format. Older versions of Windows can open a Zip64 file only with the assistance of a third-party utility, while Windows File Explorer in
current versions of Microsoft Windows can open a Zip64 file directly.

1. In Windows File Explorer, change the file extension on your PDXpert backup file from .PDXZ  to .ZIP  (e.g., MyBackup.pdxz  to
MyBackup.zip )

2. Open your renamed PDXpert backup file (e.g., MyBackup.zip ) by right-clicking the file within Windows File Explorer, and
selecting Open  from the context menu.

You can extract the database backup file ( PDXpertDB.bak ), or the library folder and its contents, by dragging it to a location on your
computer.

3018



Manage Home 11

On the PDXpert Application Server, the Manage  page contains controls for maintaining and modifying your PLM database.

To avoid damaging or losing your data: Refer to each PDXpert Application Server help topic for important operating
procedures.

Do not rename the database logical name, PDXpertDB , or physical file names, PDXpertDB.mdf  / PDXpertDB_Log.ldf . Do
not move the physical files out of the \Data\Database  folder.

Do not add files to the server's \Data\  folder or its subfolders. Unrecognized files may interfere with proper operation or may
be deleted without warning.

Maintenance
While clients are using the system, you can back up your database and library, reset the super administrator's password, and save log
files for technical support.

Backup...
The Backup  button makes a database backup, which may include ( .pdxz ) or exclude ( .bak ) the file library. See the Back
up the database and library  help topic.

Reset Admin
The Reset Admin  button resets the current super administrator account to use a blank password. Clicking the button shows
the super administrator's log-in account name which you can use, with a blank password, to log into the PDXpert client. See
the Reset the administrator password  help topic.

Save Log Files...
The Save Log Files...  button saves the set of PDXpert Application Server's diagnostic files into a single compressed ( .zip )
file.

The log files are managed in %ProgramFiles%\PDXpert\PDXpert PLM\Logs  Open this folder by pressing the Alt
key while clicking the button.

System changes
When you perform a function within this group of controls, the PDXpert client communication service is stopped. Users are
forced out of the database without warning.

Restore From Backup...
The Restore From Backup  button lets you browse for a backup file to restore, which can have either a .PDXZ  or .BAK  file
extension. See the Restore data from a backup  help topic.

Reset System
The Reset System  button overwrites the current database with the starting values of an empty database, and deletes all files
in the library. See the Reset the database and library  help topic.

Change Data Directory...
This defines the folder base location for storing library files, the product database, and other data. Separate subfolders are
added automatically within the selected location. See the Change the data directory  help topic.
The Copy  button copies the folder path to the Windows Clipboard. The Open...  button opens the folder in File Explorer.

Change Database Server...
Select the SQL Server database instance from the dropdown list; for example, .\PDXPERT ⌵ . See the Change the database
server  help topic.

Client installation



The PDXpert Application Server has an http:  service that can deliver the PDXpert client installer to other computers on local or
public networks.

To download the client installer, open a web browser to the link shown. The link is of the format
http://servername:port/client/setup  where servername is the server computer's machine name (or IP address), and the port
value is usually 48084 .

Copy Installer Link
Click this button to copy the browser link to the Windows clipboard, which can then be pasted into (for example) an email.

Save Client Installer...
Click this button to save a copy the PDXpert client installer ( .EXE  file) to a convenient location.
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The Information  page shows the software release and server operating environment.

Copy
Copies information about the PDXpert application and its environment to the Windows clipboard.

View Services...
Opens the Windows Services  application to show information about the PDXpert Server  service.

Be careful when using the Services  window. For example, stopping or restarting the PDXpert Server service
immediately disconnects all users currently logged into the system. Consider closing the PDXpert Application Server
and all PDXpert clients before making changes.
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The About  page provides quick access to the software licenses. See:

PDXpert License Agreement
PDXpert End User License Terms
Other software licenses
Legal notices
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Your security account determines your permissions to system functions and database records within the context of a PDXpert
database (server). Your account has two elements: a user account name and a password.

1. From the Windows Start  menu, select the PDXpert  program folder, and then the PDXpert PLM  program. (Or, double-click the
PDXpert PLM  desktop icon.)

2. When the Welcome to PDXpert PLM  dialog shows, enter your account name.

If no user accounts have been set up, use the default account name Admin .

If your user account is configured to use domain authentication, then include the domain (and perhaps port number)
with your user name domain:port\username , such as engineering\lee . See the Add a new user account  help
topic for details.

3. Enter your account password.

The password is case-sensitive, so enter the password exactly.

If no user accounts have been set up, use the default account password         (blank).

4. Enter the computer name or IP address of your PDXpert application server into the Server computer's machine name  control. If
the PDXpert Application Server is installed on your local workstation, use the default value localhost .

5. You may select Options :
Mark ☑ Encrypt my connection to this server  when using an untrusted connection, such as the public internet or a Wi-Fi
network. Encryption affects data transfers only; the server's database remains unencrypted. If your PC is connected to
the server using a VPN or wired LAN, encryption may not be needed.

PDXpert implements a Transport Layer Security (TLS) application-specific VPN using forward secrecy. The
PDXpert server and each client generate a unique public key security certificate. These are used to negotiate a
shared symmetric security key that has a relatively short lifespan, and is then replaced. Transfer rate is similar
to, and data security is often better than, using a normal VPN.

Mark ☑ Reset my account settings  to clear the client local cache. This resets your window locations, search terms,
previously-opened items list and the client cache. It does not affect the User Settings...  tool settings.

The client local cache contains summary data from each system you use. A reset forces the client to delete and
rebuild the cache. This may take a few extra seconds to several minutes, depending on the cache size and
your network speed. If you use more than one system, each cache is rebuilt when you next connect to that
system.

Click the Save Log Files  button to save the PDXpert client's diagnostic file to a convenient location.

6. Click the OK  button.

If this dialog opens again after clicking the OK  button, refer to the help topic Solve client log-in problems .

There's a normal start-up delay the first time you log into PDXpert, and whenever you connect to a different or
upgraded server. The client must build its local cache, and may need to download new code compatible with the
server.

PDXpert Server and the PDXpert client

Server computer (localhost) clients
The PDXpert Server installer automatically installs its own PDXpert client into the All Users (machine) profile on the server computer.
This client is called the localhost client because you log into PDXpert using the localhost  value in the Server computer's machine
name  control (step 4, above).

The client is updated by the PDXpertSystemSetup  installer, not by the PDXpert Server.



Do not connect one server's localhost client to another other server unless both servers have the exact same PDXpert
release.

Network-attached (remote) clients
Any other PDXpert client on the network is called a network client (or "remote client"), because it must connect to a PDXpert Server
using the server's machine name or IP address.

Network clients can connect to any server on the network. A PDXpert Server with a different software release sends its own client code
to the network computer. The network client keeps each server's code for future use.

Do not install the PDXpert network client software on the server computer.

1017



Enter the software license key Home 15

Administrators open this window using Tools menu ➔ Software License Key...  The menu command is shown when the user's role has ☑
Collections/Rules administrator  marked.

The software license identifies your copy of PDXpert and determines its capabilities, such as the number of users allowed and the
period for which the software can be used or updated.

Carefully read the Software licenses & legal notices reference topics, with special attention to the Program license &
warranty agreement . By using the software license key, you agree to be bound by this agreement.

About 30 days before a subscription period expires, administrators are shown a reminder in the client application's status bar.
For a perpetual license, this MSU subscription reminder is also shown for 30 days after the subscription ends. To avoid a
gap in the service, purchase a new subscription before the expiration date.

If there are more user accounts than the license allows, then only the super administrator account  can log into PDXpert and
remove extra log-in accounts. Other users are blocked until the extra user accounts are deleted.

If you receive a new license that reduces the number of licensed users, and if the old license is still valid, set the extra user
accounts as inactive  before importing the new license.

See the Managing user accounts  help topic for more information.

If you have a license file
A PDXpert license file (file type .pdxl ) contains your company registration information and license key.

Save a backup of the most recent license file in a secure place. It may be needed if the software is re-installed.

The license file authorizes all user accounts, and needs to be imported only once for all users.

The PDXpert license key file is cryptographically signed to verify the license and to support security actions on PDX
packages. These actions confirm a signed PDX package's data integrity, authenticate the sender, and allow AES-256
password encryption. License key file validation requires frequent access to the Certification Authority's certificates, which
are hosted on the web. A computer without an internet connection must have the Certification Authority's root and
intermediate security certificates (the "CA certificate chain") installed.

Do not edit the license file; signature validation requires an exact match.
The PDXpert Server must have an internet connection, or the CA certificate chain must be installed on the server
machine.
The PDXpert client that imports the license file must access the CA certificate chain: (1) use the server machine's
localhost  PDXpert client to import the software license key; or (2) install the certificate chain on the PDXpert client

computer.
Without access to the CA certificate chain, the Software License Key  dialog's OK  button may be disabled or, if enabled,
cryptographic features may not be available to users.
Where an internet connection is not allowed, the PDXpert website's Install Guide has simple instructions to add local CA
certificates – search the web for PDXpert install CA certificate chain

1. Open the PDXpert client application to import the license file.
If the license is expired, the Software License Key  window is shown immediately.
If the license is not expired, select the Tools ➔ Software License Key...  menu command to open the Software License Key
tool.

2. Click the Import License File (.pdxl)  button to show the Open License  dialog.
3. Navigate to the license file and click the Open  button to import the file.



The file name includes the year, month and day xxxxx-xx-YYYYMMDD-L-00-00-xxx-xxx.pdxl  when the subscription
ends. If you have more than one license key file that expires in the future, select the license file that expires first. If
both keys expire on the same date, import the subscription license (with -S-  setting, shown immediately after the
date: xxxxx-xx-YYYYMMDD-S-00-00-xxx-xxx.pdxl ). Just before the first key's ends  date, remove extra user accounts
and then import the next key.

4. Click the OK  button to accept your changes. The license data is copied to the server for all other users.

If the OK  button is not enabled after the license is imported, then confirm that you're using the correct new license
file. The button is not enabled if imported license file contains the same values as the displayed license.
If the end date ( Subscription ends  or Support/upgrades end ) has passed, or your current release was published after
the end date, your PDXpert release may require a more current license.
The license must begin today, or earlier. A license that begins in the future cannot be used.

If you don't have a license file
You can create a temporary license for testing PDXpert software.

After you import a license file, these data fields are locked.

1. Open the PDXpert client application to enter the temporary license data.
If the test license is expired, the Software License Key  window is shown immediately. You must get a license key file, or
reset the system using the PDXpert Server window.
If the license is not expired, select the Tools ➔ Software License Key...  menu item to open the Software License Key  tool.

2. Enter the
Organization name  is required to identify the system owner of the PDXpert system: rules, users, and items (like
documents, parts and change forms). The organization name is copied into the default member of the Organizations
collection, which is the home organization.
Postal code  where the organization is located.
Country  where the organization is located.
Full-function users  that can perform any task, limited only by the user's assigned role (from 1 to 999 users).
Read-only users  that can view data, but can't create, approve or change data (from 0 to 999 users).

3. Click on the OK  button to proceed with a limited-time test.

If the temporary license is expired, or any element has been modified or entered incorrectly, then the OK  button is
disabled.

Reference
The software license is defined using this information:

Evaluation license | Registered license
The ☑ Evaluation license  option is used to test the software. During the evaluation period, the software is fully functional and
supports all features up to a few thousand parts and documents. You can create as many full-function and read-only user
accounts as you need.
Obtain a trial license key after the period has expired, or if you want to test with more than a few thousand parts.
The ☑ Registered license  option is automatically selected when you import a software license key file. You cannot operate
PDXpert if the imported key is invalid, has not yet started or has expired, or is issued to a different organization.

Organization name
This is the exact name of the licensed organization. It's automatically shown as the default member of the Organizations
collection .

Postal code
The postal code reflects the licensed organization's region within the country.

Country



This is the country where the licensed organization is located. The Countries collection  member should be set as active.

User accounts: Full-function
The number of full-function users authorized by license. Each full-function account lets a user manage items, approve change
forms, or edit system settings according to their assigned role. The system requires at least one full-function account to act as
the super administrator.
During the evaluation period, this can be set from 1 to 999.

User accounts: Read-only
Number of read-only users authorized by license. Each read-only account lets a user view, report and export data, but not to
add, edit or approve data.
During the evaluation period, this can be set from 0 to 999.

Registration key
Unique identification code for the license issued to the organization.

Options
This value is used for license management and feature configuration.

License type
A Subscription ⌵  license allows software to be used for the limited period starting at the License begins  date and ending on
the Subscription ends  date. It permits the software to be installed on one server, for use by the licensed number of full-function
and read-only named user accounts.
A Perpetual ⌵  license allows software to be used for as long as the license organization complies with the software license
agreement. It permits the software to be installed on one server, for use by the licensed full-function and read-only named
user accounts. A perpetual license supports any software release published before the Support/upgrades end  date. You can
also request technical help and other support benefits until the Support/upgrades end  date.

License begins
This is the date that the current subscription or perpetual license started. The date is highlighted when the license start date is
earlier than the current date, and the license can't be used.

Subscription ends | Support/upgrades end
For a subscription license, this is when the subscription ends. The software cannot be used after this date, and technical
support and software upgrades are not available. A new subscription license must be purchased to continue using the
software after the date shown.
For a perpetual license, this is when the perpetual license's maintenance, support and upgrades ("MSU") subscription ends.
The end date is highlighted on and after the subscription's expiration. You may continue using the software after this date, but
MSU subscription benefits are not available.

Do not upgrade your PDXpert software to a release that was published after the end date. You will be locked
out of the system until you purchase and import a current license.

Some product features, such as PDX package verification, rely on a current cryptographically-signed license key,
and are not available after the subscription expires. For a description of MSU subscription benefits, search the web
for PDXpert MSU scope
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Log-in problems

Using the account name and password
The PDXpert client must provide the PDXpert Application Server with a valid user account name and password.

If the PDXpert client's Welcome to PDXpert PLM  window is shown repeatedly, this may be caused by an incorrect user account
name or password.

1. Enter the correct user name, as given to you by your application administrator.

If no user accounts have been set up, use the default account name Admin .

If you've been given a domain user account, include the domain with your user name, such as domain\username .

2. Enter your correct account password.

The password is case-sensitive. Ensure that your keyboard's Caps Lock  is correctly set.

If no user accounts have been set up, use the default account password         (blank).

3. Enter the server's machine name or IP address.

If the PDXpert client is on the same computer as the PDXpert Server (that is, it was installed as part of the PDXpert
system setup), use localhost .

Client connection diagnostics
The PDXpert website includes the latest client log-in solutions. Search the web for PDXpert client diagnostics .

The PDXpert client application communicates with the PDXpert server. The PDXpert server responds to requests from each PDXpert
client, and exchanges product data with the SQL Server database.

If the main PDXpert PLM  window or the Software License Key  dialog is shown, then the PDXpert client can communicate with the
PDXpert Application Server.

If the Welcome to PDXpert PLM  log-in dialog is shown more than once, then the PDXpert client connection to the PDXpert
Application Server has an error.

Log-in errors
User-provided log-in data includes the log-in account name, account password, server machine name or IP address, and an
encryption option.

A refusal to connect may be the result of one of these problems:
The user log-in account name or account password is invalid: Try logging into the client with a known good user account. If the
log-in succeeds, the user account has an error (usually a misspelled account name or incorrect password). Ask your
administrator to make sure that your account name is correct or to clear your password (PDXpert client ➔ Tools  menu ➔ User
Management...  command: X  button).

If none of the user accounts are known, then clear the super administrator account password using the Reset Admin
button on the PDXpert Application Server console. The super administrator can then log in to clear all account
passwords using the Tools  menu User Management...  command.

The server machine name is incorrect, or the server's DNS machine name is not recognized, or the server's original IP address
has changed: Your server's machine name (like MYSERVER ) must exist, and be mapped into a useful IP address (like
192.168.1.47 ). If you're having trouble connecting to a named server computer, try entering the server machine's IP address
into the Server computer's machine name  text box. If this is successful, then your DNS server isn't reliably resolving the machine
name to IP address.



The server machine is not on the network: The PDXpert client must communicate with a reachable server. Ping the server to
ensure it's visible to the client.
The PDXpert Application Server software has not yet been installed: Run the PDXpert system setup program on a computer on
your network.
A network router is misconfigured: Router settings must allow communication between the PDXpert Application Server
computer and the PDXpert client workstation.

System security setting errors
When the PDXpert client connection is blocked by firewall or anti-virus software, you may see The server could not be
contacted .

Both client and server computers' firewall and anti-virus (FW/AV) must allow communications on HTTP port 48084, and TCP port
48085 ( ☑ Encrypt my connection  option disabled) and/or the preferred TCP port 48086 ( ☑ Encrypt my connection  option enabled).
Ensure that your AV doesn't override your FW settings (for example, it doesn't change the firewall's Inbound connections:  Allow
setting). Search the web for more information about firewall port settings: PDXpert firewall

To test the firewall and antivirus, temporarily disable both FW/AV on the server and client computers.

If the client can now connect to the server, then:
1. Exit the PDXpert client and re-enable the antivirus software. Log into the PDXpert client. If the client log-in fails, then set each

computer's antivirus to allow communications between the PDXpert server and client applications.
2. Exit the PDXpert client and re-enable the firewall. Log into the PDXpert client. If the client log-in fails, then set each computer's

firewall to allow communications between the PDXpert server and client applications.

Client stops working at log-in
If too many item records are opened, the PDXpert client application may run out of Windows resources and stop working. On restarting
the client, PDXpert uses the previous workspace settings and, in re-opening the item records, again stops working.

1. On the PDXpert client log-in screen, open the Options  and mark the ☑ Reset my account settings  checkbox.
2. Enter your user account information as usual.

The next section contains technical background and recommendations.

Windows resources
Microsoft Windows uses one or more code pointers to manage each image and control (called, respectively, GDI Object handles  and
User Object handles ).

Windows limits the handle resources that any one application can use, as well as the total handles available for all applications. These
limits are not increased by adding system memory (RAM).

PDXpert must display many user controls in every window: one part with BOM and file attachments may need hundreds of handles. If
only a few unused handles remain in the pool, PDXpert is more likely to reach its limit than applications with fewer controls per window.

PDXpert shows a Low Resources  warning in the status bar (lower left corner) if the allowed GDI or user handles are more than 90%
consumed. The warning is removed after resources have been reduced below 85%.

PDXpert can only warn about its own handle pool, it cannot warn that the shared handle pool is low.

To avoid Windows closing PDXpert without notice, release resources that can be used for new windows.

Keep open only the windows you need. Close unused items, datagrids and reports, collection members and other windows.
Other applications compete for the limited number of handles. Close what you don't need when using large, complex
applications. Look at applications with many graphic elements (CAD), windows (email clients), and tabs (browsers).



After you've been working a while, restart the PDXpert client so Windows can reset the handle pool, possibly assigning handles
freed by other applications.
Resources are consumed faster than they return to the pool. There is often a delay between an application releasing resources
and Windows collecting them for re-use.
Some applications may never fully release unused handles until you restart the application or Windows.

If you're comfortable evaluating technical issues in Windows, you may consider changing the handle limits through Windows
Registry settings. Search the web for increasing user and GDI handle limits
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When your system administrator adds your account, you'll receive a temporary password that you can use to enter the program.
However, the system administrator doesn't control your password—you do. You can modify your password at any time by providing a
new password in the Set Password  dialog. When you change your password, only you know what it is. The system administrator
can never view a password that you've made. However, if you forget your password, the system administrator can provide a different
temporary password.

The administrator may let you have a blank password. That is, when you sign into the program you only need to provide your user
name. This may be OK if the program is installed on your local computer, and if your company does not require user security. As a
general rule, though, you should make a user password to ensure that unauthorized people do not get into your system, and so that
other authorized users do not accidentally use your logon account for their own activities.

At the top of the window, the checkmarks show required password properties.

1. Open the Tools  menu and select Passwords...
2. In the Set Password  dialog, enter your old password in the Previous account (log-in) password  textbox. (If your old password is

blank, do not type anything into this textbox).
3. In the New account password  section, type your new password into the New account (log-in) password  textbox.

Passwords are case-sensitive, so "SecretWord", "secretword" and "SECRETWORD" are all different.

If your administrator allows a blank password, and you want to clear your current password, then enter a space
character to confirm your intent. This enables the OK  button.

4. Confirm your new password by again typing it into the Confirm new account (log-in) password  textbox. Remember to type it
exactly the same as you typed it in the previous step, including the same upper- and lower-case letters.

5. If your system administrator requires a different password for change form approvals, enter that password in the New approval
password  textboxes. You cannot use the same password as you entered for the log-in password. If your administrator lets you
use your log-in password for approvals, then these textboxes are unavailable.

6. Click on the OK  button.

The OK  button is disabled until you have entered the minimum number and type of characters specified by your
system administrator.
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PDXpert product lifecycle management  identifies, documents and controls the functional and physical characteristics of an item.
PDXpert PLM saves a history of the decisions that affected the product design.

PDXpert PLM manages:

Products and parts, including those which are used for tooling, inspection, calibration, training, operation and maintenance.
Documents (usually as computer files) that define an item's (1) functional and physical attributes; and (2) procedures for
training, operating and maintaining the item.

PLM procedures are contained in rules, procedures, and resources so that:

The product can be reliably and consistently produced.
Changes are useful and can be done without harmful results.
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Organizations that manufacture products must also create information that show how to produce, inspect, use and service the
products.

Each product is modeled using part records, and the parts and produces are described using documents. The organization organizes
part and document records by giving each one its own number.

Class
Items  are system records that contain information about your products. PDXpert has three classes of items:

A document  record describes a part or procedure, or gives information to assist with procurement, manufacture, test,
inspection, or maintenance and repair.
A part  record represents a physical object that is fabricated, purchased, assembled or consumed to produce other parts and,
ultimately, final products. The record gives physical properties (such as unit of measure, mass, components) as well as non-
physical attributes (regulatory requirements, test procedures or other references).
A change form  identifies a group of part and document records and

changes their release status; or
identifies future document or part changes, or identifies a temporary change to a part or product.

Regardless of its purpose, an item always has an owning organization, an item type, an identifier number and a description.

Item owner
Organizations design and manage items; their intellectual and financial investment establishes their ownership in the item.

The home organization  is the organization that licenses and operates PDXpert. This organization owns all proprietary information that
is develops: requirements, procedures, and specifications; part fabrication, assembly and sourcing data; and design files and records.
The home organization decides when parts and documents are released, revised and canceled in PDXpert, and thus owns all change
forms.

Each partner organization  – such as supplier, regulatory agency, or customer – develops and manages its proprietary documents and
parts, and gives these to the home organization. PDXpert doesn't allow partners to be change form owners.

Item number
The item number  is a string of characters that the owning organization gives to an item to uniquely identify it.

An item type may subscribe to an identifier sequence, which represents the set of rules for how an item number format is constructed.
A sequence can be used by one or more item types.

Item type
An item's type  defines its properties and behavior—in other words, the rules that the item follows. Once you've selected the type, the
specified rules are permanently applied to the item.

Name (parts) / Title (documents) / Description (change forms)
The item description  field gives the item's purpose and characteristics, and typically uses an agreed-upon descriptive format.

The description doesn't uniquely identify the item; other items can have the same description. However, the description
contains the item's key search text and is exported to downstream manufacturing and support systems. It's good practice to
keep the original description after the item's first release.
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An item is identified by its owner and the number that the owner gives to it. As the organization makes changes to the item, each
change is given a new iteration.

An iteration  is technical content (the revision ) that's approved for a specified business purpose (the lifecycle ). Each part or
document record has one or more iterations.

An item iteration has its own release status, with three distinct release states : pending, released and canceled.

A pending  iteration shows that the technical content is being prepared for release. You can edit this as needed to prepare it for
use. If it's not referenced by another item, you can delete it.
A released  iteration approves the technical content for its selected business purpose. You can never delete a released iteration
or its iteration-level relationships; you can only create, then edit, a new pending iteration.
A canceled  iteration has been replaced or is obsolete, and cannot be used for any purpose. You cannot delete a canceled
iteration or its current iteration-level relationships; you can only create, then edit, a new pending iteration.

A change form has a lifecycle that shows where it is in its approval process, but does not have revisions.

Revision (technical content)
A revision represents a single design iteration or technical data record of a part or document.

Revision values
Somewhat like item numbers, revision sequences define the format and rules by which new revisions are given. Unlike item numbers,
a revision value isn't unique to one item; many items can have the same revision value.

Because multiple revisions of a part number can freely mix in the same inventory bin, best practice dictates that physical
parts aren't identified by revision. When we discuss "part revisions", we're really identifying a part data record, not a physical
part.

PDXpert can give the next revision value in a sequence.

The business rules used to give revisions come from (1) the item's lifecycle phase, which defines the item's relative maturity, and (2)
the part type's or document type's revision sequences. Revision sequence formats are specified in the Sequences: Revisions
collection.

Revision sequences
You can specify one or two revision formats in an item type, and items based on the type will follow the specification. The initial
revision sequence is first used when a new item is made. The subsequent revision sequence may also be specified, which is applied
to items after they've reached a production lifecycle phase.

If no subsequent revision sequence is specified, the initial revision sequence continues to be used. (This is preferred practice.)

Although no longer considered good practice, PDXpert can also switch revision sequences—say, from numeric to alphabetic—
depending on the item's pre-production phase or a production lifecycle phase.

Lifecycle (business use)
For each technical revision, an item is given a level of confidence. In early design phases, you may not have a lot of confidence simply
because the item hasn't been tested and verified as useful. As the item is developed, the confidence increases. When an item is ready
for full production, the manufacturing department is allowed to purchase in any quantity necessary to meet sales demands.

Lifecycle phase (or lifecycle state)
A lifecycle phase  represents one step as an item evolves from initial concept, through qualification, and on to production. The point of
identifying and managing various lifecycle phases is to control organizational behavior. If your organization's needs are simple, the



business rules may not even need to distinguish between preproduction and production.

A purchased screw or resistor will have a very simple lifecycle: since some other organization fully defines its characteristics, it's either
qualified (released) or disqualified (canceled) for Production. A more complex item, such as an automobile, will have a very
sophisticated lifecycle.

A lifecycle state is most useful when it defines a unique set of business rules. For instance, you may decide that when an item is at the
Prototype phase, Manufacturing can only build 10 units and Sales cannot put any into the field; if the item's phase is Field Test,
Manufacturing can build up to 250 units and Sales can place half of the items at selected customers' sites.

Item lifecycle phase's relative maturity
The item lifecycle phase's relative maturity  is a numeric value that can specify the lifecycle relative to a production or qualified value of
zero. Negative values for relative maturity show pre-production states (such as design, prototype or unqualified), and values greater
than zero show a post-production maturity (e.g., service only), if needed.

Normally, a production-level product shouldn't be built from pre-production parts. A parent item  at production level should use child
items  that are also at production. You can define detailed lifecycles to ensure that, say, preliminary-level parts aren't used on beta-
level assemblies.

PDXpert identifies a lifecycle mismatch between a parent and its child item on the markup list, and not on its released current
list.

First pending iteration of an item
As you make the first pending iteration of a part record or document, you specify the iteration's lifecycle phase:

If the lifecycle phase has a negative relative maturity (RM < 0), then the item type's initial revision sequence determines the
correct revision sequence. That sequence's starting revision value is given to the item's revision.
If the lifecycle phase has a non-negative relative maturity (RM ≥ 0), then the type's subsequent revision sequence determines
the correct revision sequence, and that sequence's starting revision value is given to the revision. If no subsequent revision
sequence has been specified, the item uses the initial revision sequence's starting value.

Later pending iterations of an item
After the first iteration of a part record or document is released, the revision is suggested based on the lifecycle selected for the next
iteration:

If the next pending iteration's lifecycle phase has a negative RM, then the last released revision value is incremented.
If the next pending iteration's lifecycle phase

has a non-negative relative maturity (RM ≥ 0), and
there's never been a released revision with RM ≥ 0, and
the Part Type or Document Type shows a Subsequent revision sequence  selection.

then the starting revision value of the revision sequence shown in the subsequent revision sequence is used.
If the later pending iteration's lifecycle phase has a non-negative relative maturity (RM ≥ 0), then the immediately-preceding
released revision value is incremented.

PDXpert expects that an item's technical content changes more frequently than its lifecycle; therefore, a new iteration automatically
increments the revision identifier (from, say, revision B  to C ) while retaining the previous lifecycle value (say, Production ⌵ ). This is
simply a matter of convenience, and you can easily edit the revision and lifecycle values to suit your needs.

Ideally, an item's revision value and lifecycle phase selection are independent of each other. An initial revision and
subsequent revision can only distinguish between two lifecycle phases, while most businesses have many; some common
phases are design, prototype, production, NFND (not for new design). It's better to show a data change using the revision,
and to show how that data is used with the lifecycle phase. For this reason (and because it's a lot easier to train for and to
manage), specify only an initial revision sequence and leave the subsequent revision sequence empty.

Each new revision value should be the same or greater than any previous revision.



The revision value always moves to the next value when the technical content changes.
The revision value may use the same revision value only when the lifecycle changes and the technical content does
not.

Versions
An item version  is an optional label for data created in a different configuration management tool. This data can be copied into
PDXpert, and attached to an iteration.

Versions are commonly used for computer program files to identify (a) a known set of features, (b) a set of bug fixes, and/or (c) a
particular build number. For example, a version "3.2.1203" may identify the marketing feature set "3.2" plus the compiler build "1203".
While you have a very good feel for how many releases are represented in going from revision "A" to "D", you'd have little idea whether
there were a few releases, or several hundred, between versions "2.0.103" and "3.2.1203".

Versions are typically enabled for a small number of document or part types, such as a Software document or Programmed part.

Related topics
Sequences: Revision collection
Item Lifecycle Phases collection
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Product documents show the physical attributes and structure of a product, and give the standards for examining whether the product
is correctly made. The purpose of product documentation is to break complex assemblies into individual parts, each of which can be
specified, examined and managed separately.

ISO 9004 takes a broad view of product documentation, and requires that "sufficient documentation be available to follow the
achievement of the required product quality and the effective operation of the quality management system."

Document elements are

Document and iteration data, including administrator-specified custom properties
Document classifications, such as type, lifecycle phase, legal limitations, etc.
Controlling organizations, access right declarations, and media type or physical storage location

A document record is often used for managing one or more electronic file attachments. Such a document record can then be
referenced by several part records. Separating the design file from the part allows simple design re-use and may reduce the number of
items that must be changed when the design file is updated.

Related topics
Document record
How to work with documents
Document Types collection
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A part record contains information for modeling a physical part's structure. Part records include common item elements for
identification and iteration control, custom attributes, references, file attachments, tasks and other common elements.

The part class also has:

Attributes such as unit of measure, unit cost, mass, lead time, etc. that are useful when exporting your product data to computer
systems like MRP/ERP.
Materials content and end-of-life recycling data.
A single-level parts list that, when used with other parts, can show a multi-level bill of materials.
A list of approved manufacturers for purchased parts.

Materials
The Materials  list shows the chemical substances that are used to make the part. Each line item consists of

a substance name or identification,
the quantity and its unit of measure,
a calculated proportion (based on the part mass), and
the location or application of hazardous or controlled material.

The constituents of a part, as well as a complete product, can be summed and reported.

Bill of materials (BOM)
A bill of materials  ("BOM") is a list of the physical parts required to build a manufactured assembly. (It may also be a list of chemicals
in a formula or ingredients in a recipe.) Each row on the BOM is uniquely identified by its find number; the row identifies a physical part
with quantity, unit of measure and possibly application notes, procedure instructions or reference designators.

An indented BOM report shows all of the direct parts, and those parts' lower-level components, that are required to construct an
assembly. All items that directly report to the assembly are considered as one level deep; items that directly report to first-level items
are two levels deep; and so on. (The top assembly has a depth of zero.) Complex products can have as many as 10 levels, although
simpler BOMs are much easier and less expensive to manage, particularly in modern continuous-flow production environments.

To protect the product, child items should be added and removed only after careful review and approval. An item must be released on
an executing change, and a child item must also be added on or taken off an item BOM. The BOM: Markup  list tracks these changes.
Once you've added or deleted the appropriate child items, releasing the item iteration also implements those markup items. The final
BOM is shown on the BOM: Current  list.

Find-item numbers
A find-item number is a child item's location on the BOM and provides:

A point of reference between iterations (and specifically technical revisions), or between similar parent items.
A way to identify items depicted on a drawing without including the actual item number on the drawing, thereby abstracting the
item's purpose from its identification.

To show the differences between two consecutive revisions of a parent item, BOM markups refer to a particular find number, and
reference that find number in removing one item and adding a different item. To ensure traceability between revisions, find numbers
cannot be modified after the parent item's initial revision has been released.

Sources
Rather than designing every part that your products use, your organization may purchase parts from one or more approved vendor
source. The source list is sometimes called an Approved Manufacturer List ("AML") or Approved Vendor List ("AVL").

Only a part record can be the source for a part. You can't drop a document record onto the Sources: Markup  list.



The rank number shows the designer's preference of one supplier over a different supplier.

Your own organization can be the source for an item. This is useful if you are switching to a different numbering system, or
have discovered multiple inventory numbers for the identical item, or are merging two different companies' identification
schemes.

Related topics
Part record
How to work with parts
Part Types collection
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A change form identifies a set of part and document records and changes their current release status; proposes a future change; or
approves a temporary change to business rules.

You can specify related information such as:

Whether a change affects the actual release or cancellation of an item
Affected items
Reviewing groups and observer lists with configurable workflow
Cross-references to related changes

Change results are permanent
Change forms that have been rejected, released, or completed can't be removed or reversed. A canceled change form can (and
should) be removed.

Items listed on a Released  or Completed  change can't be returned to their pre-release state. Parts and documents listed on a
Rejected , Released , or Completed  change cannot be deleted from the change form's Affected  list or removed from the system.

These actions are allowed only when a change form is at Originated  or Submitted  states.

Iteration-related data and relationships — such as BOM parts, Source parts, References and Revision Files — cannot be deleted from
a released or canceled parent item. Selected item-level data (mostly on the Attributes  and Custom  pages) can be changed after an
item has been released; see the list of attributes described in the Product Families collection's Product Team  topic.

Changes don't have revisions
A change is a unit of information that can't be revised. Any released change that has an error is corrected by issuing another change.

Some change attributes can be modified by the analyst after release but prior to completion. A completed or rejected change cannot be
modified, except when the administrator uses the Tools menu: Administrator Override command .

Executing and advisory changes
Under legacy paper-based PLM systems, change forms were documents that described the change, listed the items that were affected
by the change, and provided for authorized people to approve the change. In an automated PLM system, a change form does these
same functions. The PLM system also releases or cancels items as directed by the change's contents.

An executing change form  releases and/or cancels a list of one or more affected items.

An advisory change form  simply announces a particular fact about the affected items. A "fact" may be, for instance, that a product
needs upgrading ("change request"), or product shipments must be stopped until a defect is corrected ("stop ship"), or a different part
can be used as a temporary substitution ("deviation").

An executing change form acts upon the items shown on its Affected  list: pending items are released, and released items are
canceled. In contrast, an advisory change form doesn't release or cancel anything.

To release and cancel items, your PLM design must include at least one executing change in its collection of change forms. All other
change forms are optional.

Common change forms

Executing change forms
The change notice  (or change order ) is an executing change form that defines a set of items being released and/or canceled. That is,
a signed-off CN documents that the items listed on it have been updated and may be used in accordance with the effectivity dates
listed. The CN may also show the cost of the change: for example, the expenses related to scrapping or reworking old parts, and
retooling and supporting new ones.



An engineering change notice, or ECN, typically affects design documentation and part release. A manufacturing change notice (MCN)
may be used to control process documentation and approved vendor parts. Other change notices can manage quality, service,
training, or marketing documents.

Advisory change forms
A change request  proposes a future action to a part or document, without changing its current release status. The CR identifies the
deficiency in enough detail so that the responsible designer can understand the problem. While a proposed solution is usually
required, this solution may not be what is ultimately modified. Change requests do not identify specific iterations, since these could
change by the time the CR is transformed into a change notice.

A deviation or waiver specifies a temporary change to an approved physical configuration, usually because a part is unavailable or not
correctly manufactured. A deviation  proposes to accept parts before they've been produced, while a waiver  proposes to accept
produced parts that do not conform to the design documentation, but are serviceable (or will be serviceable after approved rework is
performed). In most engineering groups, deviations and waivers are treated the same, and are combined into a single advisory change
form. Deviations and waivers are typically limited in quantity or time. Deviations and waivers are used for parts; a document needed for
a temporary part change is issued its own document number, and released on an executing change.

You'd use a stop ship  to temporarily halt shipments of products that may not conform to design requirements. A stop ship will typically
provide a fixed time, after which it expires or is replaced with a new stop ship or other change (e.g., deviation or CN). A stop ship is an
advisory change form, and is limited to parts.

A problem report  identifies a product problem that requires study and possible changes. Since the PR may be initiated by a customer,
regulator, or employee who does not know the product in detail, it may not always identify an affected item. Since all iterations of a part
are interchangeable, the PR identifies a part number, not a specific iteration. Document problems are reported on a change request.

Related topics
Change form
Processing a change
Change Forms collection
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To manage how others view a file, see the User roles & permissions  help topic.

A file (called an attachment ) is a CAD drawing, text specification, cost spreadsheet or other electronic file that's related to a document,
part or change.

PDXpert's file management enables

File identification and type management
File check out and check in
Application/viewer launch

Library and external files
Files are either managed within the data library or are links to files outside the data library.

When you want to capture the file at a point in time, you copy it into the data library by attaching to an item or an unreleased iteration.

When you want to always refer to the latest version of a file, regardless of its current content, then use an external link. Since external
files are, by definition, not under the direct control of PDXpert, there's no guarantee that the file will always contain what you expect or
even that the file will be available when you need it. You'll typically refer to external files whose contents are managed and updated by
other organizations, such as a web page that contains vendor prices or purchasing lead times.

Item and revision files
A revision file typically contains technical design information, and is always related to one iteration of an item. A revision file is stored in
the library; you cannot have an external revision file. A revision file is added to a pending document or part iteration. It can be checked-
out for editing; while it's checked-out, other users can view or copy the current copy, but not edit it. When the item is released, the
revision file is permanently locked, and cannot be modified or deleted.

An item file contains background information like quotes, emails, sketches or other information that's not used for actual production.
These files are related to the item, not one iteration. Any user with correct permissions can add, change, or remove an item file,
regardless of the item's release state. You can designate whether the item file is in the library or is an external resource. Item files can
be attached to parts, documents, change forms and Organizations collection members. Item files are identified, but not included, in
a PDX package.

File-specific attributes
A file's properties include the file's original name, extension, size, an optional note, and view/copy/modify/delete permissions.

File viewing
If you have a related file viewing application installed and have correct permissions, you can view the file. PDXpert launches the
installed application that's related to the file extension (such as .dwg , .xlsx , .sch ).

It's often useful to attach the original design file (a CAD or word-processing file) to maintain control over the design data, and include
one or more equivalent files ( .pdf , .jpg , .txt ) that can be viewed by people who do not have access to the original authoring
application.

File formats
PDXpert manages files made by any Windows application. When you attach the file, the system saves selected file system metadata,
such as creation date, and whatever text is indexed by Windows Search Service.

Microsoft Windows provides good cross-platform file support. However, archive files – .zip , .7z , .rar , and similar general
purpose lossless compression formats – should be made only on a Windows machine. See the File tab  help topic.



Related topics
Files
Item Explorer: Files
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Each PDXpert license has one or more user accounts.

Each user account is given to one person for their exclusive use. User accounts are personal, and cannot be shared.

Full-function and read-only user accounts
A full-function user account  lets a user make and edit item records, review and approve change forms, and manage collections based
on the role given to the user.

A read-only user account  does not let the user make or edit items, add file attachments, or approve change forms. A read-only user
can search for and view items, run reports, view and copy file attachments, and export data. Viewing permissions are regulated in
accordance with the user's role.

User account management
A person record (that is, a member of the Persons collection with a Name  and Email address ) lets that person receive task and
workflow emails. When the person is given a user account, they can view and manage items, and perhaps manage the software
settings as an administrator.

A person can interact with the PDXpert client application only after an administrator adds a named user account that combines:
An available full-function or read-only user account; and
A Persons collection record (say, Pat Lee); and
A named set of permissions as specified by a Roles collection member (like Analyst); and
An account or "log-in" name ( patlee ); and
An optional account password ( mypa$$w0rd ).

The named user account  has two elements: an account (or "log-in") name and a password:
Account names can be any string of characters, such as a mix of the user's first and/or last names or employee number. An
account user name is not case-sensitive.
Passwords are case-sensitive, and are managed by the account user. A temporary password is usually given when a log-in
account is first added, and users are expected to change their passwords immediately. After the account is added, system
administrators can never view a user's password; if a password is forgotten, a system administrator can only clear it or give a
new one.

A named user account is given to one person for their exclusive use. When you delete a person's user account, the user's personal
settings and search history are deleted. The Persons collection member for that user is normally made inactive (not deleted), so that
the person's history as trustee, task worker, analyst, or change reviewer is always available. After the user account is deleted, you can
give the available user account to a different person.

Roles
PDXpert is installed with a standard set of security roles that allow users to view information related to their job. Access can be
changed on existing roles, and new roles can be specified with their own set of permissions.

Administrator
Administrators can add and delete user accounts, authorize group reviewers, manage collections, set system options and workflows,
and make other changes to the system environment.

A role has administrator permissions when ☑ Collections/Rules: Manage  is marked in the related member of the Roles collection.

An administrator can also modify selected item attributes if the role allows access to those items and when the Tools menu:
Administrator Override command  is marked.

Analyst



Analysts have overall responsibility for managing changes while they're being processed. An analyst shown on a change can –
depending on the current workflow state and system rules – edit fields, add and remove file attachments, modify any of the trustees'
work, and process the change to another workflow lifecycle. Analysts who are not shown on the change form can move it to another
lifecycle.

Analysts also can edit documents and parts with the item trustee's permissions, and are automatically members of all product teams.

Document analyst: This role allows managing any document as its trustee.
Part analyst: This role allows managing any part as its trustee.

A system analyst  has been assigned a role where the ☑ Is an analyst  permission is marked for both documents and parts.

Normal user
Normal users have free access to make new items, as well as make and edit change forms that can then be submitted for approval.

If a normal user is an item trustee or an authorized reviewer, more permissions may be available.

Trustee: The user who makes the item is given this role automatically. Trustees have certain rights to modify, release or delete
items that they have made. A user who can create new items can also create a new iteration, and replaces the previous item
trustee.
Reviewer: A group's member examines and approves change forms and their related items.

Guest
Guests can view any item for which they have appropriate permission, but cannot make any database additions, changes, or deletions.
Guests do not have permissions to view collection members.

A guest role is specified by clearing all ☑ Create new  and ☑ Manage  checkboxes on the Roles collection member window.

Group reviewers
A group  identifies a specific responsibility in your change review procedure, and the users who are assigned that responsibility. One
reviewer from each required group must approve a change form before it can be released; any reviewer who disapproves the change
prevents it from being released.

Each reviewer in a group must have a full-function user account. To fully represent a group, a reviewer must have full access to the
items affected by the change form. Therefore, reviewers typically will have broad permissions to view pending, released and canceled
items, and must not be denied access by product family. Even so, a person in a change form's reviewing group has permission to view
the change and its affected items, even if the person's role doesn't have viewing permissions (see the Groups collection: Group
reviewer permission  help topic).

Product Families
While roles define broad categories of access, the Product Families collection denies, or allows more, access to selected users.

Product Team
Users identified on a Product Families collection member's Product Team  list can have:

trustee permissions to modify selected groups of item attributes; and
originator permissions to modify selected groups of change form attributes.

When several product families are assigned to an item, a user assigned to multiple product teams has the teams' combined
permissions. A change form acquires the combined product families of its Affected  items.

Denied Access
You can exclude a person, group, or organization from viewing items belonging to a particular product family, even if a role generally
allows the user to view or manage items. You can override this exclusion by explicitly adding the user to the Product Team. For



instance, you can exclude the entire marketing team from viewing a new product design by listing that group on the Denied Access
list, but then let the project's marketing manager work on the project by adding that user to the Product Team  list.

File access permissions

Access summary
To summarize user file access rights:

An item trustee, and product team members with ☑ Revision Files  permission, may attach a revision file before the item is
released.
An item attachment or external link is managed by the trustee and, with the ☑ Item Files  permission, by members of the product
team.

As noted above, system, document and part analysts have trustee permissions for specified items.

File users
In the descriptions following, different users have various access permissions:

An analyst  has been given a role with ☑ Is an analyst  permission.
The product team  are shown on Product Family's Product Team  list, as given above.
All other users  are those who are not excluded by the Product Family's Denied  list.

Related topics
User management
Roles collection
Groups collection
Product families collection
Unlock change form Files system rule
Unlock change form Tasks system rule
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Starting out
Setting up PDXpert is straightforward:

Install the PDXpert Server, which installs your first PDXpert client
Install PDXpert clients on other workstations as needed
Review and, if necessary, configure PDXpert's settings

The installation details are given in the PDXpert PLM Software Installation Guide section of the PDXpert website.

Configuration
After you install PDXpert, it's immediately ready to run. A standard configuration—such as countries, user roles, units of measure, part
types, materials, change forms and other information—has been loaded into the database for you.

However, you'll probably want to review and change these default settings to accurately reflect your organization's own product data
management preferences.

1. Review the system rules , which control a handful of global application settings.
2. Review and modify the collections, which define what attributes are available for your documents, parts and change forms.

Places/Organizations/Persons: identify regional information, your own and other organizations, people and their roles
and responsibilities.
General: item numbering and revision formats, units of measure and data import/export formats
Documents: classify document types and their attributes
Parts: define properties of physical items such as make/buy categories, materials used, and recovery methods
Changes: review change form attributes like priorities, reasons, workflow and change form templates

3. Set the outbound email account to send workflow notices to your users. See the Email management  help topic.

Some steps build on the tasks that you've previously completed, and the sequence we provide will minimize jumping around.

Initializing your database using the Batch Importer
Many companies have legacy data from a variety of engineering and manufacturing sources. These can be consolidated and imported
into the PDXpert system.

Use the Batch Importer  (on the Tools  menu) to import part and document records, bills of materials, and approved supplier sources.
You can also automatically attach design drawing files and specifications to their items, and import the files into the system library.
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The system rules start with the most useful values.

However, examine each rule to understand its impact on your organization's PLM procedures. One of the most important is the
General: Item uniqueness specified by...  system rule.

1. From the Tools  menu, select System Rules...
2. On the System Rules  tool, select the appropriate page to view the rule setting.
3. Save any changes that you make: Item ➔ Save  or Ctrl + S

Related topics
System Rules tool
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Collections define how your company works: its people, partner organizations, part number formats, change workflows, and other
information.

PDXpert includes pre-populated collections that should simplify your configuration tasks. Most collection members have default values
that provide a good starting point for your own procedures. However, given the enormous range of possible PLM options, you will need
to ensure that each collection has members appropriate for your own organization, and that each collection member accurately reflects
your requirements.

Read the set-up information here and on the following topic pages. When you're done, you'll be prepared to discuss your plans with
your colleagues and then review, modify or make new collection members.

New company, simple configuration
If you are starting a new system at a start-up company, and don't have to worry about legacy data or conform to a particular procedure,
you can simply start using PDXpert exactly as it is installed. All of the design decisions have been made, and the system will let your
company grow for many years with little additional thought.

However, there are a few areas that you'll need to review and update:

If your company regularly works with foreign Currencies and Languages, you'll want to make sure the appropriate members
of these collections are active. After setting the default currency, update the exchange rates from the Tools  menu.
You must add all PDXpert users into the Persons collection, and add their log-in account credentials.
The default configuration has been set with a minimal set of Groups and their reviewers, and these are used in the predefined
Change Forms members. If your change approval procedure requires participation by more people, you'll add new groups,
their authorized reviewers, and the change forms they review.
The Organizations collection should include your suppliers, regulatory agencies and other partners.
By default, the most common metric and U.S. Units of Measure are active. If you don't use these units, you may wish to
make them inactive.

Of course, even if you are starting a new system, you can extensively modify the existing collection members (as well as add new
members) as given in the accompanying help topics.

Tailoring PDXpert to an existing procedure
If, like most companies, you have existing documents and parts, and have to conform to an existing data management procedure,
PDXpert's collections will require editing or new members.

1. Review the PDXpert collections, read about their functions, and get a "big picture" feel for how the collections are used by
documents, parts and changes.

2. Understand and, where necessary, clarify just how your change procedure works.
3. Map the functions you require to the available collections.
4. Test your complete procedure end to end with a small number of documents, parts and changes. Tweak as necessary.

Match values between software systems
Whether it's employee names, supplier organizations or units of measure, data exchanged between systems must be recognized
across those systems. Successful import/export often fails for small differences: the unit each  in one system, while another system
expects to see EA . Be sure you know what data will be exchanged, and then ensure that the transferred values are the same.
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The Places/Organizations/Persons collections define the human environment and how it's organized.

The Collections reference help topics give more details about the following collections. Read these configuration guidelines, and then
decide how you'll configure the collection properties and its members.

Languages: Unless you need to adjust the languages that you use for product labeling, you can probably leave the list alone.
Currencies: You'll need to review the members to ensure that the currencies you'll use in your supply chain are represented,
and the exchange rates are up to date. Refresh the active currencies by selecting Tools ➔ Update Currencies...
Countries: Over 200 countries are included in the starting database, but the most won't be needed to support your supply
chain. You can choose to delete unused countries or simply make them inactive, which retains them for future reactivation.
Partner Classifications: This collection classifies the different types of organizations in your supply chain.
Roles: Each role usually represents a unique set of permissions. You can choose the simple approach of keeping the number
of roles small (read-only, guest, normal, analyst, administrator). Although it's possible to make a unique role for each user (e.g.,
John's role), this becomes difficult to manage when the number of users is large and you decide to change the permissions for
a group of users.
Persons: You can add each person who has interest in your PLM data. A person doesn't need a PDXpert log-in account and, if
you're entering contact information for partner organizations, often won't be given one. However, you must first add a person to
this collection if you're giving them a user account.

Rename the default Persons member, Admin, with the application administrator's actual name. This does not change
the default user account log-in name (admin), it only affects the person's name that's shown in data windows and reports.
If you have licensed more than one full-function user account, you can replace the default admin user account with a
different log-in name.

To create and change user accounts, see the Manage user accounts  help topic.

The Batch Importer tool can import new Persons collection members and create user accounts .

Groups: Groups identify one or more persons who have a special responsibility or authority in your organization. To learn about
designing groups for your change workflow, see the How to use groups  help topic.
The default person is assigned to the default group.

If the group's name doesn't show the correct reviewing responsibility, change the group's name.
Review and, if needed, update the group's Persons  list.

The Batch Importer tool can import new Groups collection members and persons .

Organizations: There are two basic types of organization within PDXpert: the home organization and partner organizations.
Home organization
The home organization:

owns the PDXpert software license
controls the final product designs that are managed within PDXpert
issues proprietary identifiers to identify purchased parts and documents in PDXpert
always issues the change forms used to manage items within PDXpert
manages the users who have access to PDXpert

Since the home organization information is used extensively within PDXpert, and may be exported to other computer systems
and supply-chain partners, ensure that this information is complete.

The Name  is determined by your software license key ( Tools ➔ Software License Key… ).
The Display name  is used throughout the application. The default, Home, should be updated to what your company
prefers to use as a short name, acronym, or abbreviation.
Add the URL/website  and the Address  page, as these are included in PDX packages that you share with supply chain
partners.

Partner organizations
Partner organizations are the home organization's suppliers, contract manufacturers, customers, regulatory agencies and other
entities that affect your product data and procedures. A partner record can be as brief as a company name and display name.
The level of detail you provide is usually related to the user interaction with that organization.



The Batch Importer tool can import new Organizations collection members .

User access setup
Simple is best.

There are a lot of interesting capabilities relating to user access:

Roles let you limit whether users can view pending and/or released and/or canceled documents, parts and changes. They also
let you decide whether users can make documents, parts and changes, and whether they can add or work with changes.
Product Families can be used to determine who can view items relating to a design feature, and who is excluded. They can
separately have team members who have special rights to change certain item attributes (such as part cost) regardless of the
item's release state.
The system gives the author of a new item iteration the trustee role for that iteration, and has special permissions for managing
that record.
Pending, released and canceled items may have different behaviors and visibility.
Viewing, copying and modifying file attachments can be limited by guest role, product family exclusion, or product team
membership.
Administrators have rights to modify items, even previously-released items, using the Tools menu: Administrator override
command .

These access permissions and limits are all a standard part of PDXpert, and automatically take care of many security issues.

So, start out simple. As you discover the need for tighter control over certain items or procedures, you can probably apply that control
using PDXpert's built-in security.
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The General collections define properties that are typically applicable to multiple items.

Item Lifecycle Phases: PDXpert defines all document and part lifecycle phases into this collection. Lifecycle phases should
reflect a set of well-specified business rules and practices based on an item's maturity. For instance, a lifecycle phase may
represent the number of units that can be built based on the risk of design changes: few units during prototyping, unlimited
numbers during full production. Small organizations require only a few lifecycle phases because the business rules can be
simply specified; larger organizations may have more phases (e.g., preliminary, prototype, field test, production, service-only,
obsolete) to meet sophisticated needs.
Product Families: Since this collection controls user access to items, avoid making any changes unless you must address
important security issues. If you must limit users from even generic parts or general-purpose documents, then make a General
member that can be given to any item, and define that member's Denied Access  list to reflect your desired limits.
Sequences: Identifier: These collection members will define the numbering system for your parts, documents, and changes.
Each specified sequence is a counter from which users can pull the next number in a sequence. While most companies should
strive for simplicity, your company may require very detailed numbering formats based on part category, document type, and
change form. If your numbering system is driven by many complex rules, your users may need to manually give each number,
and you won't need to define any members of this collection.
Sequences: Revision: These collection members will define your part record and document revision formats. Typically, there
are only one or two document revision formats, and perhaps a distinct part record revision format. However, it's simplest to have
a single revision format for all items.
Units of Measure: The default collection members include categories covering time, mass, count, length, area, volume, etc.
The default Units of Measure (UoM) lists are pretty extensive, but you may need to match some names to existing CAD or
MRP values.
You won't need to change the contents of the Transforms or Views collections immediately.
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The Documents collections define attribute lists that reflect your documents.

Media/Locations: If all of your documents are electronic, and stored within the PDXpert library, then you won't need to identify
either the media or the location, since these are handled automatically. Organizations with a lot of legacy paper may need this
collection to keep track of their physical data.
Document Types: The number of document types is practically unlimited, and your actual list will depend on your industry and
the types of data you manage. Many lists are available, but the majority (like MIL-STD-100, which is freely available on the web)
may be overkill for most commercial organizations. Keep in mind that a document type is a basic attribute of your document,
and cannot be changed over its lifetime. Therefore, your users should immediately understand the difference between various
types you define, and shouldn't puzzle over whether they want to make a "fabrication" or "construction" document. You can
define custom attributes for document types.
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The Parts collections define the physical items that your organization designs, produces and services.

BOM Type Codes: This collection classifies production usage, and typically isn't modified.
Handling/Storage Categories: You can classify the safety or environmental hazards of parts, or identify special handling
requirements.
Make/Buy Categories: This collection specifies how to get the item, and typically isn't modified.
Material Categories: Broadly classifies the materials that go into the parts that you buy and build.
Material Constraints: You can define the handling, storage, recovery, or legally-imposed constraints on the chemicals and
substances that are used in your parts.
Materials: This collection is primarily intended for WEEE/RoHS and other environmental materials reporting. However, you
can add whatever materials you need.

The Batch Importer tool can import new Materials collection members .

Recovery Methods: Defines part end-of-life dispositioning goals. Although the default members of this collection are
reasonably comprehensive, any industry-specific recovery and disposal methods can be added. You may also choose to make
some members inactive if, for example, you produce items that aren't capable of disassembly.
Part Types: Classifies parts according to their application, and defines their rules and custom properties.
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The Changes collections define the attributes and workflow for changes that affect your parts and documents.

Change Classifications: You can use this collection to specify the impact of a change and which business rules are affected.
A typical choice might show a "non-interchangeable" versus "interchangeable" (backward compatible) change. In a contract-
driven or custom-products company, you may prefer to specify whether a change that affects performance, cost and/or schedule
requires customer approval.
Change Priorities: A change can have important cost impact. Change costs are often determined by how fast the change
must be executed. By setting a change priority, users can control the urgency of implementation, and propose that the change
be synchronized to a date or serial number.
Change Reasons: You can classify the reasons why you decided to make a change. For instance, if you're frequently making
changes because your production team has trouble finding specified parts or is constantly discovering lower-cost suppliers,
perhaps this shows a problem in how your designers are choosing vendors.
Disposition Actions: Item dispositioning activities, which identify what needs to be done to support the release or cancellation
of an item, can be classified beyond what is provided in the default collection.
Disposition Locations: You can classify item disposition locations or expenses incurred during the release or cancellation of
an item.
Problem Sources: A problem source classifies who or what brought an issue to your attention. This can help identify the point
at which repeated design, production, and customer issues are occurring.
Change Forms: Smaller companies typically need very few change types: perhaps just a change notice. Larger organizations,
or those who work within a regulatory environment, may require adding pre-production releases, purchased part releases,
change requests, stop ships, corrective and preventative actions, etc. You may also make change forms based on group
responsibilities (production engineering change order, purchased part release, supplier request and others).
The ideal is to use as few change forms as possible, each having as few reviewers as possible, coupled to the simplest
satisfactory workflow.
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The Item Explorer is the principal tool for working with documents, parts and change forms in your PLM system.

The Item Explorer lets you:

Make new items: New
See items that you've recently worked with: Recent
Find items in the database: Search
See the revision files that you've checked out, and open the items to check them back in: Files
See your open tasks, and open the items they're on: Tasks

You can arrange the Item Explorer  by docking it, making it a floating window, or grouping it with the Collection Explorer.
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If the Item Explorer is not displayed, select the Item Explorer  menu item from the Window  menu.

1. Click on the Item Explorer's New  tab.
2. Scroll through the Documents  list, Parts  list or Changes  list. Click on the appropriate item type to open a new window based on

your selection.

You can adjust the height of the grids by dragging the splitter bar that appears between the lists.

3. Enter as much information as required to complete the item. At a minimum, a valid item includes the owner, number, description,
revision and lifecycle.

The owner for a change form is always the home organization. Change forms do not have revisions.

See also:

Create a new document
Create a new part
Originate a new change form
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The Item Explorer's search works very similar to your favorite web search engine: enter what you want, and PDXpert will show records
ranked with most likely results higher in the list. When you provide more information in your query, the top results are more accurate.

Searching for items
If the Item Explorer is not shown, select the Item Explorer  menu item from the Window  menu.

1. Click on Search .
2. Enter the search terms most likely to uniquely identify an item, just like a web search. For instance, you can use an item

number, words in the item's description, the item's type, the owning organization, release status, or custom attribute values.
You can improve results by including special commands, filters and operators. See the Use search commands  help topic.

3. Click on the search  button to start the search.

If your results do not include the items that you want, try using different terms.

4. An item in the results can be opened, or used for drag-and-drop. You can select more than one item.

Results are ranked according to their relevance to the search terms. Matching item numbers, descriptions and other data shown on an
item's General  list usually rank higher in the results. Some returned items that match fewer search terms are listed lower on the
results list. Items with the same rank are shown in the order they're found.

To optimize workstation and network performance, search results are limited to about two thousand records. If your search is
very general — say, part  or 1*  — then the results may not contain your item. When a search finds only items with low
rank, the system can't choose the most useful, and shows nothing. By using better search terms, you'll get more useful
results, and faster.

The column abbreviations are managed in these collections:
Owner: Organizations collection
Type: Document Types, Part Types, Change Forms collections
Release: Item Lifecycle Phases collection

Hiding results
Use the buttons above the search textbox to reduce the number of rows returned in the search results. An unselected button  hides
the matching items, and a selected button  shows the matching items.

For example, these settings hide canceled parts and canceled documents in the search results.

Hide results buttons:

 Pending parts
 Released parts
 Canceled parts
 Pending documents
 Released documents
 Canceled documents
 In-work change forms
 Released and completed change forms
 Canceled and rejected change forms
 Items owned by the home organization
 Items owned by partner organizations



Permissions
The results show items that meet your search criteria, but you can open an item only when you have the correct security permissions.
These permissions are determined by the system administrator, who specifies:

your Role, which grants access to specified item classes and release status; and
whether you've been denied access in the Product Family, which is added to some items.

Indexing time
It takes a few moments for a saved item to be indexed and included in search results. Items with custom attributes need more time to
index.

File contents are indexed using Windows Search file system plug-ins that have been installed on the server computer. Based on
system load and file size, there may be a noticeable delay before a file's content is included in search results. If a file attachment
doesn't have a matching filter, then its content isn't included in your search results.

See the Tools menu ➔ Index Status  help topic.
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If you want your search results to be more precise, then you can modify your query with tagged terms, wildcards and Boolean
operators.

In this help topic, search examples are shown as search text .

Search terms
A search term can include both alphanumeric and non-alphanumeric symbol characters.
Except as noted below (like Boolean operators  and filter categories ), searches do not distinguish between upper- and lower-
case letters. Your terms are converted to maximize the search results, regardless of capitalization: gear  and GEAR  will return
the same results.
Multiple search terms are separated by a space: specifying film resistor  searches all items with the terms film or resistor or
both.
If you want to search for a particular sequence of words, enclose it in quotes. For example, "plated machine screw"  only returns
items with that exact sequence of terms in a single data field.
Spaces and punctuation within quotes are ignored: "screw, pan head"  will return the same results as "screw pan head" .
An embedded symbol character is equivalent to a space character, and the search term is converted to a quoted phrase. For
example, 123-456  is equivalent to "123 456" . Exceptions are made for:

Abbreviation: A series of single alphanumeric characters followed by .  (this is simply removed). For example, I.S.O.  is
equivalent to iso .
Date: When the search term is in the form YYYY-M-D  (or local short date) then the search is limited to date fields:

2012-10-30 . A quoted date, however, is a string like any other, and "2012-10-30"  is searched as "2012 10 30"  within
text (not date) fields.

A blank search (that is, there are no search terms specified) doesn't return any results.

An empty list shows that there are no matching records, or that the search term is so general that the search engine cannot
select useful results. In both cases, refine your search by adding new or different terms.

Operators
You can specify a single-character wildcard with the ? operator. For example, t?re  would return items with words like tire and
tyre but not there.
You can specify a multi-character wildcard with the * operator. For example, document*  would return items with words like
document and documentation.
To search for terms nearby, enclose the terms in quotes and specify the maximum distance using the ~ operator. The criteria

"10pF ceramic"~3  will return all items with up to 3 other tokens between 10uF and ceramic.
To ensure a term is included in your results, use the + operator. The criteria flat +washer  will return items with washer and
may or may not include flat.
To reduce the number of items returned, you can put a - operator immediately in front of a term that you want to exclude:

hardware -rivet  returns all hardware items that don't include the term rivet. You can also use uppercase NOT:
hardware NOT rivet

It's not necessary to include a space following the - operator, as hardware - rivet  and hardware -rivet  show similar
results. However, you must use a space to separate the NOT operator from a search term: hardware NOT rivet

The - operator is most effective when used with tokens that, by themselves, create a ranked set. Using only a negative
token – for example -change  – assigns the same rank to all "not a change" items. In a database with many items,
the search will show nothing unless the negative token by itself defines a small result set.

You can enter logical expressions using AND (or &&) and OR (or ||) between terms. The && operator will return items when all
terms are present, while the || operator will return items that have one or more of the terms.



Use a space to separate AND and OR operators from search terms: flat AND washer  or flat && washer  and not
flatANDwasher

By default, the OR (or ||) operator is applied between all terms of your search, and need not be explicitly used except
when including other operators (see next example).

Logical expressions contained within parentheses are evaluated before those outside. The expression wire && (copper || steel)
will return items with either copper wire or steel wire or both; (wire && copper) || steel  will return copper wire or anything steel
or both.
Use the [  TO  ] operator to search for a range of up to 100 item numbers. The criteria [10011 TO 10034]  will show up to 24
items, including the two end terms.

To ensure you get items with these numbers, and not unrelated items that simply include the numbers (like in change
descriptions), use the filter category  like: number:[10011 TO 10034]

System tags
System-level tags are automatically added as items are indexed. Tags follow the same search and operator rules as other item text,
such as part washer  and file && *.pdf .

Tag Added to

home Items where the home organization is the owner

partner Items where a partner organization is the owner

document Document records

part Part records

change Change forms

pending Pending documents and parts

released Released documents and parts

canceled Canceled documents and parts

originated
submitted
routed
held

accepted
released
completed
stopped
rejected
canceled

Change forms at the specified lifecycle state.

file File attachments and external links

Tags are less accurate than filters because the item may include conflicting tags. For example, a home document record always
includes the home tag, but its title may contain the word partner.

Filter categories
The system adds categories to an item. You can search a category by using category:parameter .

You can use any combination of full or short categories and full or short parameters. Category text is always lowercase; a parameter is
any combination of uppercase and lowercase text.



Search for... Category Parameter Example

Class
class:

c:

change, chg
document, doc
part, prt

class:part
c:chg

Owner1 owner:
o:

Organizations Name  or Display name
owner:3M
o:Allied

Type1 type:
t:

Document Types, Part Types,
Change Forms Name  or Abbreviation

type:ECN
t:assembly

Number1 number:
n:

Item Number  or isempty2 number:12345
n:56789-*

Description1 description
d:

Document Title , part Name , change Description , or isempty2 description:Bolt
d:IsEmpty

Release state
state:

s:

Document or part release state:
 pending, pnd
 released, rel
 canceled, can
Change workflow state:
 originated, org
 submitted, sub
 routed, rtd
 held, hld
 accepted, acc
 released, rel
 completed, cmp
 stopped, stp
 rejected, rej
 canceled, can

state:rel
s:Routed

Lifecycle
lifecycle:

l:
Item Lifecycles Name  or Display name  as document or part Lifecycle  value3 lifecycle:Service

l:srvc

Trustee trustee:
Persons Name  as document or part Trustee

or as change form Originator
Use double-quotes if you want to include a space

trustee:"pat lee"

Version
version:

v:
A document or part iteration's Version  value3 version:6a5f91e3

v:"10.2.543.6"

Checkbox true is: Parts marked as serialized, certified, compliant4 is:serialized

Checkbox false isnot: Parts not marked as serialized, certified, compliant4 isnot:certified

1. On the Item Explorer's search results list, a bold column header hints that the name (or first letter) can be used as a filter.
2. The isempty parameter enables searching for empty (missing) text.
3. These values are shown on a part or document iteration. A single item may have more than one iteration, and more than one value. A Released

iteration's lifecycle ranks higher, and a Canceled lifecycle is lower, than a Pending iteration's lifecycle.
4. If the part type compliance label is Complies , then is:Complies  returns parts that have the checkbox marked. Use double quotes if the label

contains any spaces. Labels are not case-sensitive: isnot:"Meets RoHS"  is the same as isnot:"meets rohs"

Filter categories can exclude items; for example, -class:part  excludes all parts from the search results. You can mix parameters; for
example, state:(ORG || SUB)  returns change forms that are at the Originated  or Submitted  lifecycle state.

Custom attributes
Where the custom attribute scheme is:



Boolean: The is:  and isnot:  filters are supported.
Integer: Searches return the exact match only, without any digits after the decimal. For instance, 10  will return only 10, and
not 10.01 or -10.
Float, UOM, Money: All numbers with fractional values are converted to text strings. The indexed values always include the
integer and at least one fractional digit. Other fractional values are rounded and saved with up to 7 decimal digits, unless the
trailing digits are 0. For example, the custom attribute value 23.00018  is returned in a search for 23 , 23.0 , 23.0002  or

23.00018 , but not 23.000  or 23.000180 .
UOM, Money: Item values are searched using the numeric value followed (without a space) with a unit of measure or ISO
currency; for example, 12kg  or 17.25USD .
Date: A date is saved in the form YYYY-MM-DD  (numeric year-month-day). For example, search for March 21, 2017 as:

2017-03-21 . You can use wildcards, for example: 2017-03-?? .

Invalid queries
Using operators like  ( ) { } [ ] * - " ? : \  in organization names, item numbers, and descriptions make search
tokens more difficult to enter and correctly parse. For example, the result 2 inches will be found when both the description
and search token use 2in  rather than 2" .

You cannot search for stop words  such as a , an , and the .
You cannot directly include operators  + - && || ! ( ) { } [ ] ^ " ~ * ? : \   as search terms, unless you use the backslash character,
such as \+  and \:   For example, search for the text 2" using 2\"

Parsing rules

Any symbol that is not an operator is treated as whitespace, except as noted.
Period (full stop) .  is treated as an alphanumeric: 3.1415  and ABC.XYZ  are parsed as single tokens, and not like 3 1415

or ABC XYZ
Implied operators ( OR ) are added and stop words may be removed.

Underscores and hyphens
An underscore _  and hyphen -  symbol may be treated as a space character, so that the string is split into separate search tokens.
This is intended to split connected words, but not affect numbers with embedded delimiters (like part and document numbers, or
dates).

The search token is split when the text segment on each side of the symbol does not contain any number character, and the token is
not an email or web address.

Thus, the token serial_number  is treated as serial number  (unless it's in an email or web address), and 90816-01  remains a
single token.

In the search token ABC_xyz_Q123-456 , the value is split into two tokens: ABC  and xyz_Q123-456 . The value xyz_Q123-
456  is not split as xyz  Q123  456  because Q123  contains number characters. Thus, these criteria are possible:

ABC

xyz_Q123-456
xyz*456

abc && *q123-*
"abc xyz_q123-456"

File & link searches
PDXpert uses a private search engine for database text and the server computer's Windows Search service for file attachments.
These engines look at different data, and follow different rules.

File paths and URIs are parsed as identifiers with a mix of symbols and alphanumerics. An search for a web link may have different
item record results, shown in the upper part of the Item Explorer's Search  list, than Windows Search results shown in the lower



section.

For example, a database record with http://example.com/W275Q as a custom attribute finds the record using W275Q . Item parsing
treats the /  as a space, the :  as a reserved operator, and the other characters as separate tokens: http  example.com  W275Q .
However, Windows Search needs *W275Q  to find the external link; it appears to drop the http://  and treats the remaining
characters example.com/W275Q as an unbroken text string.

Definitions
alphanumeric

Letters A-Z, a-z and their Unicode equivalents, and the numbers 0-9.

criteria
The set of all terms and operators used to define the search.

date
Number characters and delimiters as YYYY-MM-DD [ISO8601] or MM/DD/YYYY [US].

letter character
Any valid character in ranges A to Z, a to z or its local language Unicode equivalent.

number
One or more characters in the range 0 to 9.

operator
A symbol that signals special treatment for the immediately-following term.

search term
Valid characters in quotes, or a token, but not including any operator that acts on the term.

search token
A sequence of one or more valid characters.

stop word
A common word that won't add value to searches, and is not indexed.

symbol
A character that is not an alphanumeric (A-Z,0-9) character.

valid character
Any user-entered alphanumeric or symbol character, except non-display control characters.

Operators acting on a single term

* operator
Search wildcard that can be replaced by zero or more characters.

? operator
Search wildcard that can be replaced by exactly one character.

+ operator
Term is required as part of search results.

- operator
Term is excluded from search results.

Operators between two terms

&& operator
Logical AND search operator that requires both terms in the results.

|| operator
Logical OR search operator that requires at least one of the terms in the results.



[   TO   ]
A range from one item numbers to another, including the range end points.

~ operator
Requires two terms to be within a specified distance: ~3 allows gap of up to 3 words.

Grouping operators
(  ) group

Makes a logical group of terms for Boolean (AND / && or OR / ||) functions.

"  " group
Groups one or more valid characters and spaces to make a search term.

Stop words
Very common words are always excluded from indexing, and are ignored in search criteria. These include:

a
an
and
are
as
at
be
but
by
for
if
in
into
is
it
no
not
of
on
or
s
such
t
that
the
their
then
there
these
they
this
to
was
will
with
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Recent items Home 38

The Item Explorer's Recent  list shows items that you've recently opened.

The number of items that can be shown is changed by selecting Tools ➔ User Settings...  and then adjusting the Item Explorer: Recent
items tracking limit  value.

Using the Recent list
If the Item Explorer is not shown, select the Item Explorer  menu item from the Window  menu.

1. Click on Recent .
2. Do one of the following:

Right-click on the item to open the context menu, and select the Open Item(s)  command. You can select more than one
row, and open them.
Double-click the item to open it.
Drag the item from the grid and drop it onto any list that can accept it, such as dragging a part from the grid and dropping
it onto an assembly's BOM: Markup  list.

The column abbreviations are managed in members of these collections:
Owner shows the Organizations collection's Display name
Type shows the Document Types, Part Types, Change Forms collections' Abbreviation
Release shows the Item Lifecycle Phases collection's Abbreviation

Sorting
The list has three types of sorting:

The normal sort order shows favorite ("pinned") items, followed by other recently-opened ("unpinned") items.
A column is sorted from low to high: for example, from A to Z.
A column is sorted from high to low: for example, from Z to A.

When you click on a column header, the normal sort order is changed to ascending, then to descending, and then returns to normal
order. Favorite items are included in the ascending and descending sort order.

Setting and clearing favorites
You can keep a list of favorite items at the top of the Recent  list. Up to half of the total items tracked in your Item Explorer: Recent items
tracking limit  user setting can be set as favorite items.

To set a recent item as a favorite:

Select the item, open the context menu, and select the Set/Clear As Favorite  command to pin or unpin the item.

Setting the item as a favorite moves it to the last row in the pinned list, and sets the text style as italic. Clearing the item as a favorite
moves the item to the first row of the unpinned items, and sets the text style to normal. If more than one item is selected, the primary
selected item is moved.

To the rearrange the favorite list:

1. Clear (unpin) any items that you want to arrange.
2. Set (pin) each item as a favorite in the order that you want the item displayed.

If you reduce the number of tracked items in your User Settings , extra favorites are moved to the unpinned list when you close the
PDXpert client.
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When you check out a revision file for editing, the related item is shown on the Item Explorer's Files  list.

Open the item to check the file into the library, or to release the file lock so others can check out the file.

If the Item Explorer is not shown, select the Item Explorer  menu item from the Window  menu.

1. Click on Files .
2. To open an item shown, do one of the following:

Double-click on the row; or
Open the context menu, and select the Open Item(s)  command.

3. After the item opens, select the item's pending iteration, select the Files  page, and then then Revision Files  list.
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When you're given a task on an item's Tasks  list, the related item is shown on the Item Explorer's Tasks  list.

If the Item Explorer is not shown, select the Item Explorer  menu item from the Window  menu.

Task priorities
Priorities are shown as:

 High
 Normal
 Low

The task list is shown by highest priority, then by soonest due, and finally by most-recently modified.

Tasks added by the system are always given Normal priority.

Opening a task
To open the item that's related to the shown task, use one of these steps:

Right-click the list row, and select Open Item  from the context menu.
Double-click the item on the list.

The normal view shows only tasks that are given to you. To view tasks that you've given to other users, select Tasks assigned by me ⌵
from the dropdown list.

Related topics
Start and update tasks
Tasks (item)
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Open an item related to another item Home 41

There may be times when you're not sure how to locate an item, but know about a related item.

For instance, you may need to locate a part that's used on a known assembly. Or, you may want to view all parent assemblies that use
a specific part.

If the Item Explorer is not displayed, select the Item Explorer  menu item from the Window  menu.

1. Using the Item Explorer, locate and open the item that you know about.
2. Click on the item's appropriate BOM , Sources , References , Appears On , or Affected  tab, and select the item you want

from the list.
3. Select the Open Item  command from the item's context menu. In many cases, you can also double-click the item to open it, or

drag it onto an empty area of the workspace.
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If the Collection Explorer is not shown, select the Collection Explorer  menu item from the Window  menu.

1. If necessary, click on Collection Explorer  to bring the Collection Explorer to the front.

2. Navigate to the collection of interest. If necessary, expand a collection section (for example, the Documents  section) by
clicking on the group's ▷  expansion arrow.

3. Select a collection within the section by clicking on it (for example, the Document Types  collection).
You can show members of the collection by clicking on the collection's expansion icon.
The default member is shown as bold , and is often used as the starting member on new items.
An inactive member is shown as dimmed .
If the collection allows member abbreviations, they're shown in parentheses: Member name (Abbrev) .
Use the context menu to add new members and refresh the list from the database.

4. Select an individual collection member, and right-click to open the context menu. With appropriate permissions, you may:
Set the member as the default member.
Delete the member, if it's not in use by a different collection member or an item record.

To quickly find a collection member, enter its name into the Filter…  box. Matching members are shown in the tree. A
collection member can also be filtered by its abbreviation, display name or material CAS, which is shown in
parentheses, like Assembly (Assy) .
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Some collections have special instructions to protect your system. Read the collection help topic before you begin.

Other users should — and in some cases, must — exit the system while you're working. Close all item records in your
workspace before you begin. Close the PDXpert client and start it again when you've finished.

1. Add a new member using one of these options:

Using the Create Member  form:
On the Item  menu, select the Create Member  command; or
Click on the  toolbar button; or
On your keyboard, press the F8  key.

When the Create Member  form opens:
A. Select the collection.
B. Enter the new member's Name .
C. Click the OK  button.

Within the Collection Explorer:
A. In the Collection Explorer, find and select the collection.
B. Open (right-click) the collection's context menu and select Add Member .

Create a new collection member by copying the default (bold) collection member. You can set the collection's default
member before copying, and restore it after you're done copying. This option is only available for selected collections.

A. In the Collection Explorer, select the collection node (for example, the Parts Types  node).
B. Open (right-click) the collection's context menu and select Copy Default To Add New Member .

2. When the saved member opens, enter appropriate information for the new member.

The member's Name  is required. It must be unique within the collection.

3. Save any changes by saving or closing the member form.
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Other users should not be using the system while you're working. Close all item records in your workspace before you begin.
Close the PDXpert client and start it again when you've finished.

Edit a selected member

1. Open the collection and locate the existing member.
2. Open the member by double-clicking, or select Open Member  from the context menu.
3. You may be permitted to change certain properties of a collection member. To modify a member's properties, press your

keyboard's F2  key, or select the Unlock  icon in the status bar at the lower left corner of the window, or select the Edit ➔ Unlock
Object  main menu.

4. Edit the member attributes.
5. Do one of these to save your changes:

Menu: Item ➔ Save
Keyboard: Ctrl + S
Selecting the Lock  icon in the status bar (or the F2  key)
Menu: Item ➔ Close

Set one member as the collection's default
Every collection requires one default member. The default member must be active.

If you want to make the current default member inactive, first set another active member as the collection's default.

To set a member of the collection as the default member:

1. Close all members of the collection.
2. In the Collection Explorer, select a collection member that you want to set as the default.
3. Right-click to open the context menu, and select Set as Default . The member name becomes bold.

Setting the default member of the Persons collection is the same as setting the Super Administrator .

The default member of the Organizations collection cannot be set here. It is set by importing the software license key .
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You cannot undo your deletion. The collection member is deleted immediately, without further confirmation.

Other users should not be using the system while you're working. Close all item records in your workspace before you begin.

If the collection member is included in any Transforms or Views collection members, update the SQL query to remove the
reference.

Persons collection: If a person has reviewed change forms or been given tasks, it's a good idea to keep a permanent record
of the person's work. Instead of deleting or renaming the Persons collection member, set the person's record inactive .

Collection members in use cannot be deleted. Before removing a member from a custom collection, delete the collection member from
every document, part, and change form where it's used. If the member is the default value on a type's custom attribute definition,
select a different collection member as the default value.

1. Open the collection and select (click on) the existing member. The member becomes highlighted.

Before deleting the collection's default member (shown in bold), select a different collection member as the default.
You cannot change the default member of the Organizations collection.

2. Right-click to open the member's context menu and select the Delete Member  command.

You can also delete a collection member by opening it and selecting Remove Object  from the Item  menu.

Deleting a custom collection
Deleting a custom collection automatically deletes its label and selected member from each item (document, part, change
form) that refers to it.

A custom collection may be deleted only if the collection and its members are not used anywhere in the application.

1. Delete the custom collection from each Document Types, Part Types and Change Forms collection member's Custom
list.
To delete the Custom: {collection name}  row, see the Custom attributes: Deleting a custom attribute  help topic.

2. If the custom collection is used by any members of the Transforms or Views collections, modify these to remove the custom
collection references.

3. Delete each member of the custom collection.
If the member is the collection's default, then do this:

A. Open the Tools  menu and select the Administrator Override  command.
B. Open the collection's default member, clear the ☑ Default member of collection  checkbox, and save.

If you decide not to delete the custom collection, ensure that one of the collection members is selected as the
default member.

C. Delete the collection member.
D. On the Tools  menu, select the ✔ Administrator Override  command to clear the checkmark.

4. When all members of the custom collection are deleted, delete the collection name. Select the collection in the Collection
Explorer list, open the context menu, and select the Delete Collection  command.

2061



How to work with documents Home 46

Documents show the design, construction, service and support information of a product or procedure.

When you add a new document to PDXpert, you're making a document record that is an "index card" or container for one or more
related electronic files. These are added to the document record's Files  lists and stored in the PDXpert file library.

A document record can also identify a real physical object, such as a paper drawing or photographic film.

A document always has at least one iteration and, as your design changes, many more may be added:
Zero or one pending iteration.
Zero or one released iteration.
Zero or more canceled iterations.

Making a new document

Starting the new document
Make the new document by

Creating the document , or
Copying another document

In both of these, you'll permanently identify the document by its type, owning organization, and number.

Finishing the new document record
The document record opens with its first pending iteration. Each record iteration can reflect the document's name, revision, and
lifecycle phase, such as Preliminary ⌵  or Production ⌵ .

Item-level attributes
Some attributes are associated with the item, and shared across all revisions of the item.

General information includes the document name  and data on the Attributes , Custom , and Notes  pages.
Fill in the new document

The Files: Item Files  list has background files and external links for history, manufacturing records, websites and other
information that's not managed by revision.

Attach an item file
Attach an external link

Revision-level attributes
Revision-level data is related to a specific iteration, and changes are tracked using an executing change form.

You may add relationships between the document and other items. You establish these relationships by dragging items from the Item
Explorer's Search  or Recent  lists, and dropping them onto the correct markup list

Add documents to the References: Markup  list, such as customer source drawings, industry specifications and regulatory
requirements. You can also identify physical parts such as tools and equipment used in a test or calibration procedure.

Manage document references
Add one or more design files to the Revision Files  list. These files can be original technical drawings (like CAD or Word files),
information derived from drawings (like CNC code or PDFs), or both.

Attach a revision file
Add an informal reminder to the Tasks  list to prepare the iteration for release.

Start and update a task

After you add new information, save your document .



Releasing the document for the first time
When you've completed adding information, the pending document record is released by (1) adding it to an executing change form

Affected  list and (2) routing, approving, and releasing the change form.

Until you submit the change form for approval, the document record remains pending and can be changed in whatever way that you
want.

After the change form is approved and released, the document record is released, and the final child relationships are shown on the
Current  list.

Many of the released document record's attributes are locked and can never be modified;
Some attributes can be modified by the item trustee and members of the product team; and
Some document attributes (such as revision files) can be modified only by making a new pending iteration of the document
record.

See the Release your document  help topic.

Revising a released document
Revise a released document record by making a new iteration.

On the new iteration, you can markup the BOM, Sources and References lists. You can also add, edit and remove revision files.

The new iteration remains pending until you release it on an executing change form. At that time, you'll also cancel the preceding
iteration by adding it to the same change.

See the Revise a released document  help topic.

Canceling a released document
When a released document is obsolete and no new iterations are needed, it's canceled without a new iteration.

Cancel a released iteration by adding it to a new executing change form's Affected  list, and releasing that change form.

Do not create a new iteration. All references and files stay on a canceled document, so no changes are needed.

To show that a document is no longer useful, you can choose to cancel the released iteration, or to release a new iteration
with lifecycle of (say) Obsolete. A lifecycle change can show the document is obsolete, but doesn't block its use. Canceling
is better. Canceling the document makes sure that:

All pending and released parent items are revised to remove the document before it's canceled.
After the document is canceled, it can't be accidentally added to a markup list.
Users can't open the canceled document unless they have the correct role permissions.

The document can be used again by releasing a new iteration, even with the same revision and lifecycle.

See the Cancel a released document  help topic.

Deleting a document
You can remove (delete) a pending document iteration from the database if it's not used by another document, part or change form.

See the Remove your document  help topic.

Printing and exporting document data
View and share document information using:

Context menu printed reports
PDX package export file
Custom views in the DataGrid



Report/Export Wizard custom export files and reports
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Any user who is assigned a role with appropriate permissions can create a new document record and its first iteration.

There are two methods for creating a new document record.

On the Item Explorer's New  tab, scroll through the list of available document types. Click on the appropriate row to create a
new document of the specified type.
From the Item  menu, select the Create Document  line. (Or, press your keyboard's F9  key.) A wizard will open, and walk you
through the steps necessary to create the basic attributes for your new document.

Select the new document's Type . This determines the attributes of the new document, such as document numbering,
revision format, and starting lifecycle.
Select the document's Owner  value. Although the home organization is the default, you can choose a
partner organization.

The content of a home document is controlled by your organization: you specify the document number and title,
technical revision, business lifecycle, information it contains, when it's released, when it gets revised and when
it becomes obsolete. A partner organization document is where these elements are designed and controlled by
a different organization, and your organization simply references that document for your own purposes.

If you begin typing an organization's name into the control, the list is filtered.

If you select the home organization as the Owner , then the system may give the new document number for you, or you
may enter a document number. When you select a partner organization, you must enter the number that the partner gave
to the document.

Complete your new document:

Fill in the new document
Add a reference item
Attach a revision file , attach an item file , or attach an external link
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Sometimes there's already a document similar to one that you need to create. It's simple to "take a snapshot" of the source document
and then edit the snapshot to reflect your new requirements.

1. Take a snapshot

Snapshot Duplicate
This copies the active document's data into a new record using the same Document Type collection member.

1. Locate the document that you want to copy using the Item Explorer.
2. Select the document and open it so that it is the active (front-most) document window in your item workspace.

If you don't want to copy the current iteration, select the preferred iteration.

3. Select the Snapshot Duplicate  command from the Edit  menu or press Ctrl + D  on your keyboard.

When the new document window opens, fill out the necessary information as outlined in Filling in the new document.

Snapshot Convert
This copies the active document's data into a new record, converting data as needed into the selected Document Type or Part Type
collection member.

1. Search for the document that you want to copy using the Item Explorer.
2. Select the document and open it so that it is the active (front-most) document window in your item workspace.

If you don't want to copy the current iteration, select the preferred iteration.

3. Select the Snapshot Convert  command from the Edit  menu.
4. Select the desired Document Type or Part Type collection member, and then click the OK  button.

The source and target may have very different attributes, and only data that's supported in both source and target
types is copied. For example, a part has a default unit of measure that cannot be copied to a document record.
Custom attributes will only be copied if they share the same name and scheme.

2. Edit the record
Fully describe your new document iteration .
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1. On the General  page, specify
The document's Revision  and Lifecycle phase . You can modify the proposed revision or lifecycle values. For example, if
you're making a new iteration simply to move the document to a new lifecycle (say, from Preliminary ⌵  to

Production ⌵ ), then you can change the lifecycle and use the previous revision to show that the technical content hasn't
changed.
The Document name (title) . The starting value is copied from the document type's Text template  value. See the
Document types: Document title template  help topic.

The Name{a}  button inserts the values on the Custom  page into the part type's Text template . The button is visible
only when custom attributes have been specified on the part type. To make a new document name, first enter the custom
attribute values, and then click the Name{a}  button to make the name. The new name completely replaces the previous
name. You can edit the new name after the custom attributes have been inserted.

Keep in mind any naming constraints of downstream computer systems. For example, some MRP/ERP
systems can accept only 30 characters, or are limited to ANSI Basic alphanumeric characters. Export queries
can, for example, convert the name to uppercase, but converting Unicode to ANSI or correctly shortening a
long description is more difficult. Some data fields show a character counter in the upper right of the box that
show the current text length.

2. Provide more information or keywords in the Release description  and Revision area  that can be used to help users search for this
document.

The Revision area  may be used to identify where the change occurs (say, drawing Zone A2  or
Requirements 2.1 & 4.3 ).

The Release description  briefly summarizes how the technical content has been changed (for example,
Increased hole diameter ). This is shown on the change form Affected  list as a note to reviewers.

3. If you need to apply security access settings related to a Product Families collection member, drag the member from the
Collection Explorer and drop it on the Product families  list box.

4. Use the data on Attributes  to identify people and organizations that affect the document's contents, and identify and access
rights that control document distribution or usage.
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The References  list shows items that are useful for making or validating the document. For instance, an assembly procedure can refer
to other documents that specify calibration or inspection procedures.

If both part and document records are blocked as references, then the References  lists aren't shown. Your administrator
must enable the References Tabs system rule .

To change the references list on a document, it must have a pending iteration. While the document iteration remains pending, all of
your work is managed on the References: Markup  list. After the document record is released using an executing change form (such as
a Change Notice), your reference items show on the iteration's References: Current  list.

To minimize possible database conflicts, save or close all edited items that you'll be adding to the References: Markup  list.

To add a reference item onto the pending iteration of the document's References: Markup  list:

Click on the References: Markup  list. Scroll, if necessary, to expose an empty area.
Using the Item Explorer, locate the reference document or part that you want to add to this record.
Drag the item from the Item Explorer and drop it onto an empty area of the References: Markup  list. The icon in the
Add/Remove  column is .

If you change your mind, you can remove the added row: select the row, and press your keyboard's Delete
key or select the context menu Remove Item from List  command.

Add notes or adjust the row number on the References: Markup  row if desired.

To remove an existing reference item (one that was added and released on a previous iteration of the parent document) from
the pending iteration's References: Markup  list: Select the row, and press the Delete  key, or select the context menu Remove
Item from List  command. The reference item isn't immediately deleted; instead, the "keep" icon  in the Add/Remove  column
becomes a red "take off" icon , signaling that the reference will be removed from the list when the parent document is
released on a change form.

If you change your mind, you can restore a row that's to be removed from the list: select Keep Item on List  from the
context menu.
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The Tasks  list lets you give yourself or others an informal reminder about preparing the item for release. Whether you want to confirm
a design parameter or call your supplier, you can enter the task and update it.

Tasks are requests or reminders, not requirements. Incomplete tasks do not prevent an item from being released. After
release, the task is no longer relevant and is locked at its current status.

Starting a task
To start a new task, the item window must be unlocked:

1. Open the Collection Explorer.
2. Open the Persons collection or enter the person's name into the Filter…  box.
3. Select the person, and drag the record onto an empty area of the Tasks list.
4. Enter the Assigned to , Due date , Status , Priority  and Task description  values.
5. Save the item. An email notice is sent to the person who assigned the task.

The task is shown in the assigned person's Item Explorer Tasks  list.

Changing and ending a task
You can edit a task while the item is not released.

To end a task, the item window must be unlocked:

1. Enter the final Status  as Completed, Deferred, or Canceled.
2. Save the item. An email notice is sent to the person who assigned the task.

The task is removed from the Item Explorer Tasks  list when:

The status is Completed, Deferred to a later time, or Canceled; or,
The item is released.

 

Related topics
Tasks (item)
Item Explorer: Tasks
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Saving a document clears all of the undo history; you can't undo any steps before the save operation.

Select Save  (or Save All ) from the Item  menu; or,
Select Lock Object  from the Edit  menu (or press your keyboard's F2  key); or,
Lock the document form using the Lock  selection in the form's status bar; or,

Close the document window, which saves all changes automatically.

PDXpert may show Cannot save  or similar message when there is a conflict between the current database record and an
earlier version. This conflict is often the result of assigning duplicate item identifiers or editing related records in parallel. For
example, if you add a reference document to an item, the system must update both item records; the update is blocked when
both records are unlocked.
When you see Cannot save , close all item forms and then open the item that you want to edit.
To avoid this problem, edit only one item at a time. When you're done editing the record, save or close the item before
working on a different item. This avoids database conflicts, and lets PDXpert understand how to save your changes.
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You can remove (delete) a pending document iteration from the database if it's not used by another document, part or change form.
You can never remove a released or canceled iteration.

If there's only one iteration of the document, then removing the iteration deletes the entire document record from the database.
If there's more than one iteration of the document, then only the pending iteration is removed. Any released or canceled iteration
remains in the database.

If you are the document iteration's trustee or a document analyst , then you can remove the document iteration only while it's at the
Pending  release state.

If a document has no released iteration, and it's on a pending item's References: Markup  list, then it's blocked from deletion. You can
remove the document from the system only after you edit the list to remove the document. Pending iterations on a change form's

Affected  list must always be deleted from the change form before they can be removed from the system.

To remove a pending document record:

1. Open the document. If it's open, select it to that you can view it.
2. On the Item  menu, select the Remove Object  command.

The Remove Object  command is applied to the document. Do not select any other window. You cannot undo this
command.

1075



Release your document Home 54

All change forms provide control information about documents, but only an executing change form (for example, a Change Notice or
CN) has a permanent effect on the document record. This executing change form, when it is approved, updates all pending items
according to the rules of the change form.

In other words, you released or cancel document iterations by specifying the affected items on the executing change form. Then, after
all groups have approved the change, PDXpert updates the items on the Affected  list.

An advisory change form, like a Change Request (CR), does not update a document iteration's release state. It tells why the document
should change in a later executing change.

To release an unreleased document iteration, use the following general procedure.

1. Start a new executing change form, such as a Change Notice. Or, use an existing change form that's at Originated  state.
2. Drag the document that you want to release from the Item Explorer Search  or Recent  list to the change form's Affected  list.

The pending iteration is shown with  (change releases iteration). If the item has a released iteration, then it's usually
canceled on the same change form, and is shown with  (change cancels iteration).
Pending child items on the document's References: Markup  list – if not on another change form – are automatically added to
the change form's Affected  list.

If the document record has been edited, save or close it before adding it to the Affected  list.

3. Submit or route the change form for review, approval, and release. See the Processing a change  help topic.
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Once the document iteration has been released, you'll notice that much of the data that you could previously modify is now locked. In
particular, the information that gives the document its unique identity (the owner, document type, number, revision and lifecycle) is now
permanently established.

A document iteration is released only once, and can be a used until canceled. A released document can be listed on any number of
advisory change forms (such as a change proposal) as necessary.

If any product families are shown on the item, then members of the product team can edit some attributes even after the item
has been released. Your administrator decides who is a product team member in the Product Families collection .
If the released the document has major changes that affect its application or purpose, then copy the document to make a
replacement. Select the Snapshot to Document  command from the Edit  menu, and edit the new copy.
If the changes are minor, such as editing document attributes or references, or attaching an updated file to the

Files: Revision Files  list, then you typically make a new iteration of that document.

For details, see the Revise a released document  topic.

Finally, if you discover a clerical error that requires a small "off the books" correction, your administrator can edit certain fields
specified by the Tools menu: Administrator Override command .
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The document record's iteration must be released or canceled before you can make a new pending iteration.

Any user who has permission to view a document (and whose role has appropriate permissions) can make a new iteration for that
document, regardless of the previous iteration's trustee.

Click on the iteration dropdown list on the document window's status bar, and select the <..New..> ⌵  line.

You don't need to unlock the existing record iteration to create a new iteration. The record is unlocked automatically.

Complete your new document iteration:

Some data — such as Type, Owner and Number — is locked on the first iteration, and cannot be revised.

Fill in the new document iteration
Add a reference item
Attach a revision file , attach an item file , or attach an external link

When you've completed the new iteration, release your document  on a change form.
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You cancel an obsolete document when it's no longer relevant to your product or procedure, and you want to ensure no one uses it in
the future.

Cancel a released document by adding it to an executing change form's Affected  list, and then approve and release the change form.

If the document iteration is pending, then you can't cancel it; instead, remove the pending document iteration .

A canceled document cannot be used on any pending or released parent item. Before canceling the document, examine its
Appears On: References  list. If it's a child item on any pending or released parent item, then remove it from the parent. If the

parent item is released, then the parent must be revised to remove the document, and the parent revision must be released
with (or before) the child document's canceling change form.

Canceling, instead of revising, a document ends its internal history timeline at the canceled iteration. If you later create a new
iteration, a new history timeline begins. Markups show all previous rows as added (blue "add on" icon ) because they're
copied from the canceled iteration onto the new history.

You don't need to change the iteration's lifecycle when you cancel it. Keeping the current lifecycle indicates its technical
status when it was canceled, and simplifies re-releasing later if it's needed for servicing or a new application.

No reference child items are affected by canceling the parent document.

Canceling a released document iteration is very similar to releasing it.

1. Start a new executing change form, such as a Change Notice. Or, use an existing change form that's at Originated  state.
2. Drag the released document that you want to cancel from the Item Explorer's Search  or Recent  lists to the change form's

Affected  list. The released iteration is shown with  (change cancels iteration).
3. Process the change form for review, approval, and release. See the Processing a change  help topic.

Un-cancel a document
After a document is canceled, you can return it to a released state by creating and releasing a new iteration.

If the document does not have any new technical content, edit the pending Revision  and Lifecycle  values to match the canceled
iteration values.
If the technical content has changed, edit the new pending iteration as described in the Revise a released document  help
topic.

When you've finished editing the new iteration, release your document  on a change form. When it's added to the change Affected
list, the pending iteration is shown with  (change releases iteration); the canceled iteration is not shown.
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Part records identify a physical item installed or consumed in the construction of a product.

A part always has at least one iteration and, as your design changes, many more may be added:
Zero or one pending iteration.
Zero or one released iteration.
Zero or more canceled iterations.

Making a new part

Starting the new part
Make the new part by

Creating the part , or
Copying another part

In both of these, you'll permanently identify the part by its type, owning organization, and number.

Finishing the new part record
The part record opens with its first pending iteration. Each record iteration can reflect the part's name, revision, and lifecycle phase,
such as Preliminary ⌵  or Production ⌵ .

Item-level attributes
Some attributes are associated with the item, and shared across all revisions of the item.

General information includes the Part name  and data on the Attributes , Custom , and Notes  pages.
Fill in the new part

The Item Files  list has background files and external links for history, manufacturing records, websites and other information
that's not managed by revision.

Attach an item file
Attach an external link

If you track the chemical substances that affect environmental compliance, add data to the Materials  list.
Add or remove materials

Revision-level attributes
Revision-level data is related to a specific iteration, and changes are tracked using an executing change form.

You may add relationships between the part and other items. You establish these relationships by dragging items from the Item
Explorer's Search  or Recent  lists, and dropping them onto the correct markup list

Add to the BOM  page Markup  list parts that are used or consumed to produce the parent part.
Add parts from the Item Explorer, or drag parts from other parts
Import a BOM file from CAD

Add to the Sources  page Markup  list parts from supply chain partners.
Manage approved sources

Add to the References  page Markup  list specifications, assembly and test instructions, drawings and other documents. You
can also add parts, such as tooling or fixtures, that are related to the part's construction.

Manage part references
Design files describe how to fabricate, assemble or prepare the part. Add these to the Revision Files  list.

Attach a revision file
Add an informal reminder to the Tasks  list to prepare the iteration for release.

Start and update a task

After you add new information, save your part .



Releasing the part for the first time
When you've completed adding information, the pending part record is released by (1) adding it to an executing change form

Affected  list and (2) routing, approving, and releasing the change form.

Until you submit the change form for approval, the part record remains pending and can be changed in whatever way that you want.

After the change form is approved and released, the part record is released, and the final child relationships are shown on the BOM,
Sources and References Current  lists.

Many of the released part record's attributes are locked and can never be modified;
Some attributes can be modified by the item trustee and members of the product team; and
Some part attributes (such as the BOM) can be modified only by making a new pending iteration of the part record.

See the Release your part  help topic.

Revising a released part
Revise a released part record by making a new iteration.

On the new iteration, you can markup the BOM, Sources and References lists. You can also add, edit and remove revision files.

The new iteration remains pending until you release it on an executing change form. At that time, you'll also cancel the preceding
iteration by adding it to the same change.

See the Revise a released part  help topic.

Canceling a released part
When a released part is obsolete and no new iterations are needed, it's canceled without a new iteration.

Cancel a released iteration by adding it to a new executing change form's Affected  list, and releasing that change form.

Do not create a new iteration. BOM parts, source parts, references and files stay on a canceled part, so no changes are
needed.

To show that a part is no longer useful, you can choose to cancel the released iteration, or to release a new iteration with
lifecycle of (say) Obsolete. A lifecycle change can show the part is obsolete, but doesn't block its use. Canceling is better.
Canceling the part makes sure that:

All pending and released parent items are revised to remove the part before it's canceled.
After the part is canceled, it can't be accidentally added to a markup list.
Users can't open the canceled part unless they have the correct role permissions.

The part can be used again by releasing a new iteration, even with the same revision and lifecycle.

See the Cancel a released part  help topic.

Deleting a part
You can remove (delete) a pending part iteration from the database if it's not used by another document, part or change form.

See the Remove your part  help topic.

Printing and exporting part data
View and share part information using:

Context menu printed reports
PDX package export file
Custom views in the DataGrid
Report/Export Wizard custom export files and reports
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Any user who is given a role with appropriate permissions can make a new part record and its first iteration.

There are two options for creating a new part record.

On the Item Explorer's New  tab, scroll through the list of available part types. Click on the appropriate row to create a new
part record of the specified type.
From the Item  menu, select the Create Part  line. (Or, press your keyboard's F10  key.) A wizard will open, and walk you through
the steps necessary to create the basic attributes for your new part record. Although the home organization is the default, you
can choose a partner organization.

The content of a home part is controlled by your organization: you specify the part number, the item description, the
technical specifications, when it's released and when it's revised. A partner part is where these elements are designed
and controlled by a different organization, and your organization simply references that part for your own purposes.

If you begin typing an organization's name into the control, the list is filtered.

Complete your new part:

Fill in the new part
Add, modify or remove BOM items  or import a CAD BOM
Add approved source parts
Add a reference item
Attach a revision file , attach an item file , or attach an external link
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If an existing part record is similar to one that you need, copy ("snapshot") that part into a new item iteration. Edit the new part to
reflect your requirements.

1. Take a snapshot

Snapshot Duplicate
This copies the active part's data into a new record using the same Part Type collection member.

1. Search for the part that you want to copy using the Item Explorer.
2. Select the part and open it so that it is the active (front-most) part window in your item workspace.

If you don't want to copy the current iteration, select the preferred iteration.

3. Select the Snapshot Duplicate  command from the Edit  menu or press Ctrl + D  on your keyboard.

Snapshot Convert
This copies the active part's data into a new record, converting data as needed into the selected Document Type or Part Type
collection member.

1. Search for the part that you want to copy using the Item Explorer.
2. Select the part and open it so that it is the active (front-most) part window in your item workspace.

If you don't want to copy the current iteration, select the preferred iteration.

3. Select the Snapshot Convert  command from the Edit  menu.
4. Select the desired Document Type or Part Type collection member, and then click the OK  button.

The source and target may have very different attributes, and only data that's supported in both source and target
types is copied. For example, a part has a default unit of measure that cannot be copied to a document record.
Custom attributes will only be copied if they share the same scheme.

2. Edit the record
Fully describe your new part iteration .
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1. On the General  page, specify
The part record's Data revision  and Lifecycle phase . You can modify the proposed revision or lifecycle values. For
example, if you're making a new iteration simply to promote a record to a new lifecycle (say, from Preliminary ⌵  to

Production ⌵ ), then you can change the lifecycle and use the previous revision to show that the technical content hasn't
changed.
The Part name . The starting value is copied from the part type's Text template  value. See the Part types: Part name
template  help topic.
The Name{a}  button inserts the values on the Custom  page into the part type's Text template . The button is visible
only when custom attributes have been specified on the part type. To make a new part name, first enter the custom
attribute values, and then click the Name{a}  button to make the name. The new name completely replaces the previous
name. You can edit the new name after the custom attributes have been inserted.

Keep in mind any naming constraints of downstream computer systems. For example, some MRP/ERP
systems can accept only 30 characters, or are limited to ANSI Basic alphanumeric characters. Export queries
can, for example, convert the name to uppercase, but converting Unicode to ANSI or correctly shortening a
long description is more difficult. Some data fields show a character counter in the upper right of the box that
show the current text length.

2. Enter information or keywords in the Revision area  and Release description  to help users search for this revision.
The Revision area  may be used to identify where the change occurs (say, Mounting flange ).
The Release description  summarizes how the technical content has been changed (for example,
Removed interfering material ). This is shown on the change form Affected  list as a brief note to reviewers.

3. If you need to apply security access settings related to a Product Families collection member, drag the member from the
Collection Explorer and drop it on the Product families  list box.

4. Use the data on the Attributes  list to identify information required by your engineering procedure and manufacturing system,
such as Default unit of measure  and Make/buy code .

If a BOM part can have a unit of measure different than its default  and the part's default is later changed, then make
sure that the unit of measure originally used on the BOM is correct.
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A parent assembly is constructed from subassemblies and physical components. These are often known as parent-child (also
indented, hierarchical, or structured) relationships.

The BOM identifies the child parts that are added or consumed when making the parent assembly. Documents, as well as supporting
parts (such as tooling), are added to the assembly's References list.

Relationships must be a strict hierarchy; lower-level items must never use higher-level items. A higher item that's on the BOM
of a lower item causes a recursion error — an infinite loop — in multi-level reports/exports.

The BOM  lists are visible only if the Part Types collection member has ☑ Markup will accept parts  marked.

You must be working with a pending iteration to modify the BOM  list. While the parent part iteration remains pending, all of your work
is managed on the BOM: Markup  list. After the parent part record is released using an executing change form (such as a Change
Notice), your child parts are shown on the iteration's BOM: Current  list.

To minimize possible database conflicts, save or close all items that you'll be adding to the BOM: Markup  list.

Add a component row
To add a child part onto a pending iteration of the parent part's BOM: Markup  list:

1. Click on the BOM: Markup  list. Scroll the list, if necessary, to expose an empty area.
2. Using the Item Explorer, locate the part or document that you want to add to the parent part.
3. Drag the item from the Item Explorer and drop it onto an empty area of the BOM: Markup  list. The icon in the Add/Remove

column is  and the child item is given a new BOM Find  number.
4. If needed, edit the attributes on the added row.

If you change your mind, you can remove the added row: select the row, and press your keyboard's Delete  key or select the
context menu Remove Item from List  command.

Modify a released row
You can replace the child part on a row and keep the quantity and other data; or keep the part but edit the other data; or both replace
the part and edit the data.

You don't edit the old row, but work on a new copy. The values in the old row and new row can be compared during the change review.

To modify a previously-released child row from the pending iteration of a parent part's BOM: Markup  list:

1. Drag an item from the Item Explorer and drop it onto a released row (as shown by a "keep" icon ). The released row is
marked as removed (red "take off" icon ) and a new row is added (blue "add on" icon ). The Find  number, quantity and
units, reference designators, and notes are copied to the added item.

If you're keeping the same part and only modifying the quantity, notes or RefDes, then you can select the row, open
the context menu, and select Change Row with Same Item .

2. Edit the added  row's quantity, RefDes, notes or other editable fields. Don't change the Find  value.

If you change your mind, you can undo your row replacement: select the added row, and press your keyboard's Delete  key
or select the context menu Remove Item from List  command.

Remove a released row
To remove a BOM row that is on the previous released iteration of the parent part:

On the pending iteration's BOM: Markup  list, select the row.



Press the keyboard Delete  key, or select the context menu Remove Item from List  command.

The child item isn't immediately deleted; instead, the "keep" icon  in the Add/Remove  column becomes a red "remove" icon .
This shows that the item will be removed from the BOM when the parent part is released on a change form.

If you change your mind, you can undo a child row that's marked to take off : Select Keep Item on List  from the context
menu.

Import CAD BOM file
To import a parts list from a CAD file, see the Import a CAD BOM  help topic.

Adjust Find numbers
Each row on the BOM has a Find  number that's used to track how the BOM changes from one revision to the next. To adjust the Find
numbers:

When working with the first iteration of an assembly, the Find can be edited to adjust the rows as needed. Right-click a row to
Insert a Find Number Gap  or to Renumber From Selection . Edit the Find number to a new value (which cannot be the same as any
other Find number of the list).
After the assembly is released, new BOM revisions allow editing the Find number on new rows, but you can't adjust the Find of
released rows.

BOM changes are easier to understand when the Find matches a removed row with its functional replacement. A gap
between existing rows should be filled only by a part that's functionally related to the row that was previously removed.
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Most CAD applications export a bill of materials (BOM) in a convenient plain text format called "comma-separated values" (CSV).
PDXpert defines a standard set of column headers for importing the BOM into a PDXpert assembly record.

Use CSV when your CAD tool gives you the choice between exporting CSV and other formats like Excel. Editing the file in
Excel may damage the CSV file if it contains text that Excel considers numbers and dates. For example, Excel may convert
part number 00123  to 123, or 2021-01  to January 2021. Some versions of Excel can also have problems reading and
saving ANSI Extended and Unicode characters.

If you want to import many BOMs from a data source like an ERP/MRP, use the Batch Importer tool .

The import file doesn't make any new parts; it makes relationships between an assembly and its immediate child parts (a single-level
BOM).

All items must exist in the database, and are matched using the same Item uniqueness system rule  that detects duplicate
parts.

To import a BOM Markup from a file
A BOM import can be performed only within the Markup  list, and only before the assembly's pending iteration is released. The
imported BOM can include pending or released parts, but not canceled parts.

1. When you have your BOM file ready to be imported, make a new part record or open an existing pending iteration. Select the
part's BOM  page.
Within the Markup  workspace, open the context menu, select the Import Markup from File  command.
The Import Markup from File  dialog opens.

2. Browse to your import file, and then click the Open  button. Your file is imported into the Markup  list.

Your import file must conform to PDXpert's standard import format as specified below .

Always manually edit the BOM after importing a new file. Whenever a new file is imported, the BOM list is first reset to
its starting contents.

If you discover an error after you accept the import, you can manually edit the records that you've imported, or import
a new file to replace all edited rows on the markup.

Import file format
Configure your CAD software to export its BOM using the following import format. The format can accept BOM files with very little
information. Most columns are optional; if the column is omitted or the row's value is empty, the system uses default values as shown.

A column name — which your exporting software may call the column header or label — is recognized only if it exactly
matches the column name shown. All non-matching column names are ignored.

Import files must have data in every row. Empty rows may cause an import to fail.

Column definitions for importing BOM markup files

Column
name

Data type Value if empty Description

ChildClass
string Part  or

Document
Part

If not specified, then the child item's Class  is a part.

Only parts can be added to the BOM list; a document row is ignored.
Unless your BOM data source includes documents in the file, this
column can be omitted.



ChildOwner
Organizations
member name

default member (always the
Home organization)

Identifies the organization that is primarily responsible for the child
item's specification and which issues the item Number . Unless the
Allow partner parts on BOM system rule  is marked, this should be

omitted.

ChildType
Part Types member

name
default member

If not specified, then the appropriate type collection is determined by
the child item's Class , and the default member of the resulting type
collection is used to match the record's Type  selection.

Only parts can be added to the BOM list; a row with ChildClass  of
Document  is ignored.

ChildNumber string row is skipped

REQUIRED: If the value is empty, the row is not imported.

If the Find  column is not included in the markup file, the ChildNumber
value is used to identify differences between the previous BOM and
the new import rows.

Find integer ≥ 1
last find-item + 1 when
importing first iteration

This value is given to the Find  row identifier. A parent assembly
cannot have two rows with the same Find  number.

The import file's Find  value provides an anchor for comparing the
imported BOM revision to the previous BOM.

If you include a Find  column, do not leave any row's Find
value empty.

Quantity double ≥ 0 1.0
This value is given to the row's Quantity  value, and represents the
number of child parts required to produce a parent.

Unit Unit of Measure default member
Include this column only when the Lock part default unit of
measure on BOM system rule  is cleared (not enabled). In this case,
if the value is empty, then the part's Default unit of measure  is applied.

RefDes
string: length ≤ 32000

characters
no value

This value is the child part's RefDes  ("reference designator") area, and
should follow the rules for reference designators .

Notes
string: length ≤ 32000

characters
no value This value is the child part's Notes  area.

Per string Per Assembly
Must be assigned as Per Assembly, Per Setup, As Needed or
remain empty.

A minimal CSV import file can be quite simple if your system's Item uniqueness specified by: system rule  has only the ☑ Number
and ☑ Organization  checkboxes marked. For example:

ChildNumber,Quantity
101012,1
100315,6
100917,1
110019,4

When an assembly is first released, its rows are established as anchors for tracking row changes in later revisions of the assembly. As
a BOM file is imported into a pending iteration, each imported row to be compared to the previous iteration's content. Any changes in
the row are marked as Add or Remove, as appropriate.

As noted in the table above, differences between from the released BOM iteration to its new iteration can be identified by ChildNumber
or by Find  values.



If the import file includes the Find  column, the system compares the previous row and the imported row at that Find  value.
Mechanical BOMs often use the Find number to identify the part's location in the assembly, regardless of its part number.

To minimize the number of irrelevant changes on a new assembly revision, do not arbitrarily change the Find value on
revisions to an imported BOM file. For example, new BOM components should not be inserted into the middle of the
import list (which may change Find values in later rows), but added at the end.

If the import file does not include the Find  column, the system uses the ChildNumber  value to match the previous row and the
imported row. Changes to a part number's quantity or other attributes are identified, and the Find value is ignored. This is used
primarily in electronic assemblies, where the reference designators provide location information.
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The Sources  lists show each partner organization part that is approved as a source. The list of sources is sometimes called an
Approved Manufacturer List (AML) or Approved Vendor List (AVL).

Only a part record can be the source for a different part. You can't drop a document record onto the Markup  list.

The source rank shows the designer's technical preference of some source parts over others.

You must first make a partner part record before you can add it to the Markup  list. A partner part record is just like your
home organization's part record, but shows the partner organization as the record Owner , and uses the partner-issued
ordering number in the record's Number  field.

To modify the Sources: Markup  list, the part must have a pending iteration. While the part iteration remains pending, all of your work is
managed on the Sources: Markup  list. After the part record is released using an executing change form (such as a Change Notice),
your source items show on the iteration's Sources: Current  list.

To minimize possible database conflicts, save or close all items that you'll be adding to the Markup  list.

Add a source part
To add a source part onto a pending iteration of the part's Markup  list:

1. Click on the Markup  list and, if necessary, scroll it to expose an empty area.
2. Using the Item Explorer, locate the source part that you want to add to the part record.

Although a partner usually supplies the source part, it's sometimes useful to use a home organization part as a
source.

3. Drag the part from the Item Explorer and drop it onto an empty area of the Markup  list. The icon in the Add/Remove  column is
 and the child part is given a rank number.

If you change your mind, you can remove the added row: select the row, and press your keyboard's Delete  key or
select the context menu Remove Item from List  command.

4. Modify the attributes on the Markup  row as appropriate.

Remove a released source part
Each approved source part is independent of all others. When a source part is no longer approved, it's simply removed and
any newly-qualified sources are added.

To remove an existing child part (one that was added and released on a previous iteration of the parent part) from the pending
iteration's Markup  list:

Select the part, and press the keyboard Delete  key, or select the context menu Remove Item from List  command. The child part
isn't actually deleted; instead, the "keep" icon  in the Add/Remove  column becomes a red "take off" icon , signaling that
the part will be removed from the list when the parent part is released on a change form.

If you change your mind, you can restore a row that's to be removed from the list: select Keep Item on List  from the
context menu.
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The References  list shows documents and parts that are useful for making or validating the part. For instance, the list can refer to
documents that specify fabrication and inspection procedures, or a fixture needed for assembly.

If both part and document records are blocked as references, then the References  lists aren't shown. Your administrator
must enable the References Tabs system rule.

To change the references list on a part, it must have a pending iteration. While the part iteration remains pending, all of your work is
managed on the References: Markup  list. After the part record is released using an executing change form (such as a Change Notice),
your reference items are on the iteration's References: Current  list.

To minimize possible database conflicts, save or close all edited items that you'll be adding to the Markup  list.

To add a reference item onto the pending iteration of the part's Markup  list:

Click on the Markup  list. Scroll, if necessary, to expose an empty area.
Using the Item Explorer, locate the reference document or part that you want to add to this record.
Drag the item from the Item Explorer and drop it onto an empty area of the Markup  list. The icon in the Add/Remove
column is .

If you change your mind, you can remove the added row: select the row, and press your keyboard's Delete
key or select the context menu Remove Item from List  command.

Add notes or adjust the row number on the Markup  row if desired.

To remove an existing reference item (one that was added and released on a previous iteration of the parent part) from the
pending iteration's Markup  list: Select the row, and press the keyboard Delete  key, or select the context menu Remove Item
from List  command. The reference item isn't immediately deleted; instead, the "keep" icon  in the Add/Remove  column
becomes a red "take off" icon , signaling that the reference will be removed from the list when the parent part is released on
a change form.

If you change your mind, you can restore a row that's to be removed from the list: select Keep Item on List  from the
context menu.
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The Materials  list shows materials (chemical substances) that are used to produce the part. The list typically contains the substances
that are regulated for safety or environmental compliance.

Materials values can be changed by the part trustee (and analysts) until the part is released. After release:
A change to the released materials data is treated as non-interchangeable. This requires a new part number, not a
revision to the released part.
The materials list is updated by using the Tools menu: Administrator Override command  or the Batch Importer tool .

To add a material to the list:

1. Unlock the part ( F2  key).
2. Open the Collection Explorer.
3. Open the Materials collection or enter the material name into the Filter…  box.
4. Select the material, and drag the record onto an empty area of the Materials list.
5. Enter the Quantity , Units , and Location  values.
6. Save the part.

To remove a material row:

1. Click on the row selector (on the left) so that the selector shows ► and the complete row is highlighted.
2. Press the keyboard Delete  key.

Related topics
View a collection
Materials collection
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The Tasks  list lets you give yourself or others an informal reminder about preparing the item for release. Whether you want to confirm
a design parameter or call your supplier, you can enter the task and update it.

Tasks are requests or reminders, not requirements. Incomplete tasks do not prevent an item from being released. After
release, the task is no longer relevant and is locked at its current status.

Starting a task
To start a new task, the item window must be unlocked:

1. Open the Collection Explorer.
2. Open the Persons collection or enter the person's name into the Filter…  box.
3. Select the person, and drag the record onto an empty area of the Tasks list.
4. Enter the Assigned to , Due date , Status , Priority  and Task description  values.
5. Save the item. An email notice is sent to the person who assigned the task.

The task is shown in the assigned person's Item Explorer Tasks  list.

Changing and ending a task
You can edit a task while the item is not released.

To end a task, the item window must be unlocked:

1. Enter the final Status  as Completed, Deferred, or Canceled.
2. Save the item. An email notice is sent to the person who assigned the task.

The task is removed from the Item Explorer Tasks  list when:

The status is Completed, Deferred to a later time, or Canceled; or,
The item is released.

 

Related topics
Tasks (item)
Item Explorer: Tasks
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Saving a part record clears all of the undo history; you can't undo any steps before the save operation.

Select Save  (or Save All ) from the Item  menu; or,
Select Lock Object  from the Edit  menu (or press your keyboard's F2  key); or,
Lock the part form using the Lock  selection in the form's status bar; or,

Close the part window, which saves all changes automatically.

PDXpert may show Cannot save  or similar message when there is a conflict between the current database record and an
earlier version. This conflict is often the result of assigning duplicate item identifiers or editing related records in parallel. For
example, if you add a reference document to an item, the system must update both item records; the update is blocked when
both records are unlocked.
When you see Cannot save , close all item forms and then open the item that you want to edit.
To avoid this problem, edit only one item at a time. When you're done editing the record, save or close the item before
working on a different item. This avoids database conflicts, and lets PDXpert understand how to save your changes.
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You can remove (delete) a pending part iteration from the database if it's not used by another document, part or change form. You can
never remove a released or canceled iteration.

If there's only one iteration of the part, then removing the iteration deletes the entire part record from the database.
If there's more than one iteration of the part, then only the pending iteration is removed. Any released or canceled iteration
remains in the database.

If you are the part iteration's trustee or a part analyst , then you can remove the part iteration only while it's at the Pending  release
state.

If a part has no released iteration, and it shows on a pending item's References , BOM  or Sources  list, then it's blocked from
deletion. You can remove the part from the system only after you edit these lists to remove the part. Pending iterations on a change
form's Affected  list must always be deleted from the change form before they can be removed from the system.

To remove a pending part record:

1. Open the part. If it's open, select it to that you can view it.
2. On the Item  menu, select the Remove Object  command.

The Remove Object  command is applied to the active window. Do not select any other window. You cannot undo this
command.
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All change forms provide information about part records, but only an executing change form (for example, a Change Notice or CN) has
a permanent effect on the part record. This executing change form, when it is approved, updates all pending items according to the
rules of the change form.

In other words, you released or cancel part record iterations by specifying the affected items on the executing change form. Then, after
all groups have approved the change, PDXpert updates the items on the Affected  list.

An advisory change form, like a Change Request (CR), does not update a part iteration's release state. It tells why the part record
should change in a later executing change, or accepts a temporary change (such as a part deviation or stop ship).

To release a pending part record iteration, use the following general procedure.

1. Start a new executing change form, such as a Change Notice. Or, use an existing change form that's at Originated  state.
2. Drag the part record that you want to release from the Item Explorer Search  or Recent  list to the change form's Affected

list. The pending iteration is shown with  (change releases iteration). If the item has a released iteration, then it's usually
canceled on the same change form, and is shown with  (change cancels iteration).
Pending child items on the part record's BOM: Markup , Sources: Markup  and References: Markup  lists – if not on another
change form – are automatically added to the change form's Affected  list. For details on which lower-level BOM items are
included, see the Affected page: How items are added  help topic.

If the part record has been edited, save or close it before adding it to the Affected  list.

3. Submit or route the change form for review, approval, and release. See the Processing a change  help topic.
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The part record's iteration must be released or canceled before you can make a new pending record iteration.

Any user who has permission to view a part record (and whose role has appropriate permissions) can make a new iteration for that
part record, regardless of the previous record iteration's trustee.

Best practice says that a physical part that's interchangeable with previous iterations shares the same part number and is
stored at the same inventory location. If a changed part is not interchangeable with previous iterations, then the new part
requires a different part number and a new inventory bin.
PDXpert always shows the released part iteration on a released assembly's BOM, purchased part's sources list, and as a
reference. A part record may be at, say, revision 1  and lifecycle Prototype when it's first assigned to a parent assembly. If
that part record is later released as revision 2  and lifecycle Production, the released assembly automatically shows the
new 2 (Production)  iteration. The inventory location contains the physical part made as either revision 1  or revision
2 . It's good practice to not mark the revision on the part.

Click on the iteration dropdown list on the part window's status bar, and select the <..New..> ⌵  line.

You don't need to unlock the existing record iteration to create a new iteration. The record is unlocked automatically.

Fully describe your new part iteration:

Some data — such as Type, Owner, Number and Part name (description) — is locked on the first iteration, and cannot be
revised.

Fill in the new part iteration
Add, modify or remove BOM items  or import a CAD BOM
Add approved source parts
Add a reference item
Attach a revision file , attach an item file , or attach an external link

When you've finished editing the new iteration, release your part  on a change form.
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Once the part record iteration has been released, you'll notice that much of the data that you could previously modify is now locked. In
particular, the information that gives the part record its unique identity (the owner, part type, number, revision and lifecycle) is now
permanently established.

A part record iteration is released only once, and can be a used until canceled. A released part record can be listed on any number of
advisory change forms (such as a change proposal or stop ship) as necessary.

If any product families are shown on the item, then members of the product team can edit some attributes even after the item
has been released. Your administrator decides who is a product team member in the Product Families collection .
If the released part's interchangeability is affected by new information or you want to make a similar part, then copy the part.
Open the part record. If it's open, select it to that you can view it. Select the Snapshot to Part  command from the Edit  menu, and
edit the copy.
If interchangeable changes are made to the part attributes, BOM, sources or references; or an updated file is attached to the

Files: Revision Files  list, then you should make a new iteration of that part record.

For details, see the Revise a released part  topic.

Finally, if you discover a clerical error that requires a minor "off the books" correction, your administrator can edit certain fields
specified by the Tools menu: Administrator Override command .

1139



Cancel a released part Home 73

You cancel an obsolete part record when it's no longer relevant to your product, and you want to ensure no one uses it in the future.

Cancel a released part record by adding it to an executing change form's Affected  list, and then approve and release the change
form.

If the part iteration is pending, then you can't cancel it; instead, remove the pending part iteration .

A canceled part cannot be used on any pending or released parent item. Before canceling the part, examine its Appears On
lists (BOM, References, Sources). If it's a child part on any pending or released parent item, then remove it from the parent.
If the parent item is released, then the parent must be revised to remove the part, and the parent revision must be released
with (or before) the child part's canceling change form.

Canceling, instead of revising, a part ends its internal history timeline at the canceled iteration. If you later create a new
iteration, a new history timeline begins. Markups show all previous rows as added (blue "add on" icon ) because they're
copied from the canceled iteration onto the new history.

You don't need to change the iteration's lifecycle when you cancel it. Keeping the current lifecycle indicates its technical
status when it was canceled, and simplifies re-releasing later if it's needed for servicing or a new application.

BOM, source or reference child items are not affected by canceling the parent part record. They remain released and can be
used on other parents until you cancel them.

Canceling a released part record iteration is very similar to releasing it.

1. Start a new executing change form, such as a Change Notice. Or, use an existing change form that's at Originated  state.
2. Drag the released part that you want to cancel from the Item Explorer's Search  or Recent  lists to the change form's

Affected  list. The released iteration is shown with  (change cancels iteration).
3. Process the change form for review, approval, and release. See the Processing a change  help topic.

Un-cancel a part
After a part is canceled, you can return it to a released state by creating and releasing a new iteration.

If the part does not have any new technical content, edit the pending Revision  and Lifecycle  values to match the canceled
iteration values.
If the technical content has changed, edit the new pending iteration as described in the Revise a released part  help topic.

When you've finished editing the new iteration, release your part  on a change form. When it's added to the change Affected  list, the
pending iteration is shown with  (change releases iteration); the canceled iteration is not shown.
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Open the window by selecting Tools ➔ Markup Wizard...

The Markup Wizard provides powerful capabilities for revising one or more BOM  or References  lists in a single operation.

Add one or more child items  shows a list of child items that you want to add to one or more parent item.
Replace one child item  replaces one child item with a different item across multiple parent items. This is useful for substituting

a new part on many assemblies where an old part is used.
Remove one or more child items  shows a list of child items that must be removed from a list of parent items.

After you've specified your new iterations, you can specify an executing change form that releases them.

To use the Markup Wizard, you must have a Roles collection  member that includes both ☑ Documents: Is an analyst  and ☑
Parts: Is an analyst  marked as True.
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The Markup Wizard lets you identify a list of one or more child items that are added to a list of parent items.

If the parent item doesn't have a pending iteration available for markup, then a new pending iteration is made automatically. All child
items are marked as Add  to the end of each parent item's markup list, with the correct find-item number.

The parent item must accept (in its Document Types or Part Types collection member) the child items that you want to
add. For example, if you're adding a part to a parent Assembly part type, that Assembly part type must have its ☑ Show
BOM tab  marked as True. Similarly, if you're adding a document to the parent's References list, then the appropriate
References Tabs system rule must be enabled.

Use the Markup Wizard only with items that have been saved to the database. First make whatever items you'll need, such
as a new parent items and/or child items and/or change form. Then close all items ( Item ➔ Close All ) before opening the
Markup Wizard.

To use the Markup Wizard, you must have a Role that includes both ☑ Documents: Is an analyst  and ☑ Parts: Is an analyst
marked as True.

Clicking the Cancel  button on any panel discards all of your planned changes and closes the Markup Wizard. No new
parent iterations are made, no child items are added, and no items are copied to the Affected  list of your change form.

The Markup Wizard can work with child parts that are on part BOM  lists, and child documents that are on part or document
References  lists. It cannot affect parts that are on References  lists.

1. Open the Tools  menu and select Markup Wizard...  When the Markup Wizard  tool is shown, select Add one or more child items
and then click the Next  button.

2. Using the Item Explorer

A. Locate the parent item(s) that you want to revise. Drag these from the Item Explorer results list and drop them onto the
Revise these parent items...  list.

B. Locate the child item(s) that you want to add to these parent items. Add these child items by dragging them from the Item
Explorer results list and dropping them onto the second ...to add these child items  list. The set of all child items on the list
is added to each one of the parent BOMs.

You can only drop a pending or released item onto the list. If the most recent iteration of the added item is
canceled, you must make a new pending iteration before the Markup Wizard will accept it.

3. Preview the list of parent iterations that will be affected. If you wish, you can de-select a row, which skips adding a child row to a
parent item. You can also edit the child's Quantity  and reference designators ( RefDes ).

4. If you wish, you can identify the change form that should be used to release the revised items. You can only use a change form
that is Originated  or, if you're an analyst, Submitted . The Markup Wizard simply automates the drag and drop of each item
onto the change form. Items added to a change form's Affected  item list may include related unreleased item iterations and
their sources. See the Affected page  help topic.

An item that's on another change form will remain listed on that change form regardless of what you specify here.

5. When you're done, click the Commit  button. This makes any new parent iterations, adds the child items to the markups, and
—if you've identified a change form—copies these parent iterations to that change's Affected  item list.

6. After the data has been updated, the Markup Wizard  tool will show whether your requested iterations were successful or
encountered errors. Click the Close  button after you've noted the results.
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The Markup Wizard lets you replace one child item with a different item across multiple parent items.

Exactly one item can be replaced with exactly one item. If you need to replace multiple items with a single item or vice versa, pick one
item to replace; after completing the replacement, use the Markup Wizard again to add or remove the other items. For example, if a
rivet will replace a "fastener set" consisting of a bolt, washer, and nut: (a) replace the bolt with the rivet, and then (b) remove the
washer and nut items using the Remove one or more child items  option.

If the parent item doesn't have a pending iteration available for markup, then a new pending iteration is made automatically. The child
item on the parent item is marked as Remove  while the item replacing it is marked as Add  at the same find-item row.

The parent item must accept (in its Document Types or Part Types collection member) the child items that you want to
add. For example, if you're adding a part to a parent Assembly part type, that Assembly part type must have its ☑ Show
BOM tab  marked as True. Similarly, if you're adding a document to the parent's References list, then the appropriate
References Tabs system rule must be enabled.

Use the Markup Wizard only with items that have been saved to the database. First make whatever items you'll need, such
as a new parent items and/or child items and/or change form. Then close all items ( Item ➔ Close All ) before opening the
Markup Wizard.

To use the Markup Wizard, you must have a Role that includes both ☑ Documents: Is an analyst  and ☑ Parts: Is an analyst
marked as True.

Clicking the Cancel  button on any panel discards all of your planned changes and closes the Markup Wizard. No new
parent iterations are made, no child items are replaced, and no items are copied to the Affected  list of your change form.

The Markup Wizard can work with child parts that are on part BOM  lists, and child documents that are on part or document
References  lists. It cannot affect parts that are on References  lists.

1. Open the Tools  menu and select Markup Wizard...  When the Markup Wizard  tool is shown, select Replace one child item with
another item  and then click the Next  button.

2. Using the Item Explorer

A. Locate the child item that you want to replace. Drag this replaced item from the Item Explorer results list and drop it onto
the Replace this child item...  area.

The child item's Appears On  lists shows the parent items that will be affected. If the parent item is canceled,
then it won't be affected.

B. Locate the child item that you want to use instead. Add this child item by dragging it from the Item Explorer results list
and dropping it onto the second ...with this item at the same Find location  area.

You can only drop a pending or released item. If the most recent iteration of the replacement item is canceled,
you must make a new pending iteration before the Markup Wizard will accept it.

3. Preview the list of parent iterations that will be affected. If you wish, you can unselect a row on a parent item, and the cleared
child won't be replaced on that parent. You can also edit the child's Quantity  and reference designators ( RefDes ).

4. If you wish, you can identify the change form that should be used to release the revised parent items. You can only use a
change form that is at Originated  or Submitted . The Markup Wizard simply automates the drag and drop of each item onto the
change form. Items added to a change form's Affected  item list may include related unreleased item iterations and their
sources. See the Affected list  help topic.

An item that's on another change form will remain listed on that change form regardless of what you specify here.

5. When you're done, click the Commit  button. This makes any new parent iterations, removes the previous child items, adds
the replacement items, and—if you've identified a change form—adds these parent iterations to that change's Affected  item
list.



6. After the data has been updated, the Markup Wizard  tool will show whether your requested iterations were successful or
encountered errors. Click the Close  button after you've noted the results.
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The Markup Wizard lets you identify a list of one or more child items that are removed from their parent items.

If the parent item doesn't have a pending iteration available for markup, then a new pending iteration is made automatically. The child
item on the parent item is marked as Remove .

Use the Markup Wizard only with items that have been saved to the database. First make whatever items you'll need, such
as a new change form. Then close all items ( Item ➔ Close All ) before opening the Markup Wizard.

To use the Markup Wizard, you must have a Role that includes both ☑ Documents: Is an analyst  and ☑ Parts: Is an analyst
marked as True.

Clicking the Cancel  button on any panel discards all of your planned changes and closes the Markup Wizard. No new
parent iterations are made, no child items are removed, and no items are copied to the Affected  list of your change form.

The Markup Wizard can work with child parts that are on part BOM  lists, and child documents that are on part or document
References  lists. It cannot affect parts that are on References  lists.

1. Open the Tools  menu and select Markup Wizard...  When the Markup Wizard  tool is shown, select Remove one or more child
items  and then click the Next  button.

2. Using the Item Explorer, locate each child item that you want to remove from its parent. Drag each item from the Item Explorer
results list and drop it onto the Remove these items:  list. When you've identified all items to be removed, click the Next  button.

The child item's Appears On  lists shows the parent items that will be affected. If the parent item is canceled, then it
won't be affected.

3. Preview the list of parent iterations that will be affected. If you wish, you can unselect a row, which keeps the child item on the
parent item.

4. If you wish, you can identify the change form that should be used to release the revised parent items. You can only use a
change form that is Originated  or, if you're an analyst, Submitted . The Markup Wizard simply automates the drag and drop of
each item onto the change form. Items added to a change form's Affected  item list may include related unreleased item
iterations and their sources. See the Affected list  help topic.

An item that's on another change form will remain listed on that change form regardless of what you specify here.

5. When you're done, click the Commit  button. This makes any new parent iterations, removes the previous child items, and—if
you've identified a change form—adds these parent iterations to that change's Affected  item list.

6. After the data has been updated, the Markup Wizard  tool will show whether your requested iterations were successful or
encountered errors. Click the Close  button after you've noted the results.
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To ensure that all affected parties are fully aware of a change, a change form passes through a series of lifecycle states between
originating and completing the workflow. Although there are other possible paths, this is the principal workflow.

Select the change form so that you can see it.

1. The change form is made, or Originated . The originator is typically responsible for the clarity and completeness of the change
form's technical content. The originator attaches the affected items and provides more information to help the reviewers
evaluate the change form's effects. See Originate a new change form .

2. The originator may submit the change form to an analyst for review. The analyst checks that the change form's content meets
an accepted standard. This typically includes (a) review of the change form's purpose, priority, and costs; (b) validation of the

Affected  items list; and (c) verification that the appropriate reviewing groups have been included. See Analyze a submitted
change .

3. The change form is routed to reviewers for their approval. On behalf of their group, each reviewer can approve or disapprove
the change. The reviewer can also hold the change form while the originator or analyst answer a question about the change
form. Based on their responses, the reviewer can approve or disapprove it. See Review a routed change .

4. At the end of the review:

If any one required reviewer disapproves the change form, then it is Canceled  and removed by the analyst. See
Remove a canceled change .

If all required reviewers approve the change form, then it is Accepted  and forwarded to (a) the analyst for further review
or (b) the system to be Released . See Use a released change .

5. After the instructions contained in the change form have been implemented, the status can be set to Completed . See View a
completed change .

In most lifecycle states, an analyst can cancel the change form, or return it to Submitted  or Originated  status.
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You originate (that is, make) a change form because you want to formally notify interested parties about the release, revision or status
of managed items.

1. To originate a new change form, you can make a new change or copy from another change form:

In most cases , the change form Number  is generated automatically. Otherwise, enter the change form Number .

New (option 1): On the Item Explorer's New  tab, in the Changes  list, click on the appropriate row to create a new
change form.
New (option 2): Select the Create Change...  from the Item  menu (or press the F11  key). This opens a dialog in which
you select the appropriate change form from the Type  dropdown list. The other tabs are not used because the home
organization is always the owner of the change, and every change's lifecycle starts at Originated . Click the Finish
button to continue.
Copy: If you have a released change (for instance, a change request) that provides the basis for a subsequent change
(such as a change notice), you can create a duplicate ( Tools ➔ Snapshot Duplicate... ) and then convert it to the
subsequent change form by selecting the appropriate value from the Type  dropdown on the General  tab.

When you create a snapshot duplicate, the next number from the Change Forms member's Identifier
sequence  is assigned to the duplicate change form. If you convert to another change form that uses a different
Sequence: Identifier collection member, then the Number  value is replaced by the next value from the new
change form's Identifier sequence .

2. The new change form window opens with its lifecycle at Originated . To complete the new change:

A. On the General  page, enter the change description according to your organization's requirement.

Workflow emails include this description. Briefly summarize the change in the first sentence to help reviewers
quickly scan their email in-box for important changes.

If visible, specify the Problem source  and Change reason  from the drop-down list boxes.
B. Click on the Attributes  page, and enter more details to describe the change.
C. Select the Affected  list. On the Item Explorer, locate and then drag each part and document that is affected by the

change form onto the list.
On executing change forms:

A part or document row has one of three actions:
Release a pending iteration (no released iteration exists), with the item row shown in green. The single 
row shows the iteration to release. The change form does not have a released iteration to cancel.
Revise an item, with the item row shown in orange. It has two iteration rows: one row  cancels the
earlier iteration and the other row  releases the revised iteration.
Cancel a released iteration (no pending iteration exists), with the item row shown in red. The single  row
shows the iteration to cancel. The change form does not have a pending iteration to release.

This canceling iteration must be removed from parent relations (BOM, Sources, References lists)
before the change can be routed.

PDXpert automatically adds lower-level items to the Affected  list. This ensures that each item listed on the
BOM: Markup , Sources: Markup  and References: Markup  lists has at least one released iteration available. For

the rules that PDXpert applies, see the Affected page: How items are added  help topic.
You can add dispositioning information to each affected item's releasing or canceling iteration. Expand the item to
expose the iteration, and then select Add Disposition  from the iteration's context menu. See the Affected page:
Disposition rows  help topic

If you want to add an item that's open in your workspace, save it or close it before adding it to the change
form's Affected  list.



After you've added an item to a change form, if you further modify it (specifically: making a new pending
iteration, or changing the BOM, source or reference markups), re-drop the item onto the Affected  list to
refresh its releasing/canceling data.

Limit the number of items on the Affected  list. It's easier to make sure that your list is accurate, and reviewers
are more careful checking a tightly-focused set of items.

If you're changing a multi-level structure (for instance, an assembly with subassemblies), it's often easier to
work "from the bottom up". Drop the lowest-level items onto the Affected  list first, then the next-higher items.
Always review the list before routing the change for approval.

D. Add reviewing participants dragging members of the Groups collection from the Collection Explorer onto the Reviewers
page. Similarly, drag new observers from the Persons collection (or the Groups collection) onto the Observers  list.

E. If the Files  list is shown, you can add computer files or web links to the change form. Refer to the Attach an item file
and Attach an external link  help topics.

3. Save the change form by:
selecting Save  from the Item  menu; or,
selecting Lock Object  from the Edit  menu (or pressing your keyboard's F2  key); or,
locking the change using the Lock  selection in the form's status bar; or,

closing the change form window, which saves all modifications automatically.

Saving a change form clears all of the undo history; you cannot undo any action that happened before the most recent
save operation.

PDXpert may display Cannot save  or similar message when there is a conflict between the current database record
and a previously-saved version. This conflict is often the result of editing related records in parallel. For example,
adding a document to an engineering change updates both records; if the document has unsaved changes, the new
affected item relationship conflicts with the unsaved record.

To avoid this error, only one item at a time should be unlocked for editing. When you are done, close or lock the
window before working on another item. This avoids database conflicts, and allows PDXpert to understand how to
save your changes.

Next steps
After you've originated the change form, you can move it to the next step in the administrator-specified workflow.

To work with a change form, the record must be open. If it's open, select it to that you can fully view it.

If any item on the change form's Affected  list is unlocked in your workspace, lock or close it now.

Depending upon the enabled change workflow states, you may:
Select the Process  menu command Submit to Analyst . The analyst reviews the change form to ensure that it contains all of the
information necessary to approve it, and then forwards it to the reviewers for approval.
Select the Process  menu command Route for Approval . The groups specified on the Reviewers  list approve your proposed
change form, hold it for further consideration, or disapprove it.

If you see a Cannot route  status bar message:
Each released item on the Affected  list – which the change form will cancel – must have a pending iteration
that will be released; or the item must be removed from every pending or released parent item before routing.
At least one reviewing group must be shown in the Reviewers  list.

If you see a Routing Error  window, refer to the help topic How to work with change forms → Fix change routing
errors  to resolve the error.



After you submit or route the change, you cannot modify it unless it is returned to you.

When a routed change form is returned to the Submitted  or Originated  state, it contains information on who approved and
disapproved the change. Previous reviewers' name and response will be cleared when the change form is again moved to
the Routed  state.

1114



Snapshot a change form Home 80

Sometimes there's a change form similar to one that you need to make. It's easy to copy a change form (the "source") and then edit
the new copy (the "target").

Rules

Only a saved change form can be a source for a new copy. The source can be at any change lifecycle state.
The user must have a role that includes making new change forms.
A value in the source will be copied only when it is enabled in both source and target, and is not empty in the source.

Copied values
The system makes a new target change form, with its normal starting values, then copies the following data from the source change
form:

Primary discussion
Secondary discussion
Problem source
Change reason
Change classification
Priority
Person 1
Person 2
Analyst, if the source analyst's Persons record is active and the target Analyst  is empty
Starting date/serial
Ending date/serial
File attachments
Each custom attribute where its Name  and Scheme  match on source and target

To make a new change form as a snapshot

1. Use the Item Explorer to locate the existing change form that you want to copy.
2. Open the change form. If it's open, select it to that you can view it.
3. From the Edit  menu, select the Snapshot to Change  command.
4. In the Create Change  window:

A. Select a change form Type .
B. The system always identifies the Owner  as the home organization.
C. The system selects Generate Number  option (unless set in the Change Forms template ).
D. Click the OK  button. The source change form's transferrable data is copied to the new change form. Since change

form attributes can be quite different, some starting values may be substituted or ignored in the target item.

5. After the new change form is shown, update your new change form .
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Start and update a task Home 81

The Tasks  list lets you give yourself or others an informal reminder about preparing the item for release. Whether you want to confirm
a design parameter or call your supplier, you can enter the task and update it.

Tasks are requests or reminders, not requirements. Incomplete tasks do not prevent an item from being released. After
release, the task is no longer relevant and is locked at its current status.

Starting a task
To start a new task, the item window must be unlocked:

1. Open the Collection Explorer.
2. Open the Persons collection or enter the person's name into the Filter…  box.
3. Select the person, and drag the record onto an empty area of the Tasks list.
4. Enter the Assigned to , Due date , Status , Priority  and Task description  values.
5. Save the item. An email notice is sent to the person who assigned the task.

The task is shown in the assigned person's Item Explorer Tasks  list.

Changing and ending a task
You can edit a task while the item is not released.

To end a task, the item window must be unlocked:

1. Enter the final Status  as Completed, Deferred, or Canceled.
2. Save the item. An email notice is sent to the person who assigned the task.

The task is removed from the Item Explorer Tasks  list when:

The status is Completed, Deferred to a later time, or Canceled; or,
The item is released.

 

Related topics
Tasks (item)
Item Explorer: Tasks
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Analyze a submitted change Home 82

1. As the change analyst, you check the originator's work to ensure that the change conforms to your organization's change
procedure.

The change form clearly and accurately tells its purpose using the General  and Attributes  pages.
The Custom  attributes, if any, are correct.
All affected parts and documents are listed on the change's Affected  list, and their releasing and canceling states are
correct.
All responsible groups are listed on the Reviewers  list with the correct review selection ( Must act ⌵  or Can act ⌵ ).
The appropriate observers are listed on the Observers  list.
File attachments, if necessary, are listed on the Files  list.

2. After your review is complete, do one of the following:

If any item on the change form's Affected  list is unlocked in your workspace, lock or close it now.

If you're satisfied with the change form, route it to the group reviewer(s): Process ➔ Route for Approval .

If you see a Cannot route  status bar message:
Each released item on the Affected  list – which the change form will cancel – must have a pending
iteration that will be released; or the item must be removed from every pending or released parent item
before routing.
At least one reviewing group must be shown in the Reviewers  list.

If you see a Routing Error  window, refer to the help topic How to work with change forms → Fix change
routing errors  to resolve the error.

If the change requires corrections, then (a) update the change form as needed, or (b) return it to the originator: Process ➔
Return to Originator .
If it's no longer necessary, cancel the change form: Process ➔ Cancel Change . The change can be deleted by selecting
Remove Object  from the Item  menu.

When a routed change form is returned to the Submitted  or Originated  state, it contains information on who approved and
disapproved the change. Previous reviewers' name and response will be cleared when the change form is again moved into
the Routed  state.
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Fix change form routing errors Home 83

Each child item on a parent item's BOM , Sources  or References  list must be released with (or before) the parent item. A child item
can be canceled only when it's not used by a released parent item.

Rules for routing a change form
An executing change form can be routed when its Affected  list:

will release or cancel an item (part or document) that doesn't use, and isn't used by, a different item;

or
will release a parent item that uses a pending child item, and
that pending child item is released with (or before) the parent item;

or
will cancel a released child item that is used by a released parent item, and
that released parent item is revised to remove the child item, or is canceled with (or before) the released child item.

Fixing routing errors
PDXpert examines the routed change form's Affected  list and shows the Routing Error  window if any processing errors are found.
If an item is listed more than once, fixing that item may resolve other reported errors.

Remove from change: {child}, used by {parent} on {list}
The Routing Error  window shows released child items that may not belong on the change form's Affected  list, or are being
canceled without a replacement. For example, the change is canceling a released child part that's used by a released assembly.

Remove from change: child item, used by parent item on relation list

To solve this error, do one of the following options:
1. Remove the released child item from the change form's Affected  list. The change will not cancel the child item, which remains

available for the parent item.
2. Add a new pending iteration of the child item to the change form's Affected  list, to replace the previous iteration that's on the

parent item.

If the child item already has a pending revision, but it's not shown on the Affected  list, unlock the change form and
drag the child onto the list to add the pending revision.

3. If the parent item is released, revise the parent item to remove/replace the child item, and then add the parent to the change
form's Affected  list.

4. If the parent item is pending, remove the released child item from the parent item's relation list (the BOM , Sources  or
References  list).

5. Add the released parent item to the change form's Affected  list to cancel both parent and child items.

Add to change: {child}, needed by {parent} on {list}
The Routing Error  window shows pending child items that may be missing from the change form's Affected  list. For example, the
change is releasing an assembly that needs a pending part.

Add to change: child item, needed by parent item on relation list

To solve this error, do one of the following options:

If the child item's most recent iteration is canceled, make a new child pending iteration before following option 1 or option 2.

1. Add the pending child item to the change form's Affected  list to release it with the parent item.
2. If the child item is on another change form's Affected  list, release the other change before releasing the parent item on this

change form.

Or, remove the child item from the other change form, and then use option 1.



3. Remove the child item from the pending parent item's relation list (the BOM , Sources  or References  list).
4. Remove the parent item from the change form's Affected  list.

If the child item isn't ready for release at a production lifecycle and the parent item must be released, consider releasing
parent and child items at a pre-production lifecycle. Follow up with a production release later.
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Remove your change form Home 84

You can remove (delete) a change form from the database if it is not at the Released , Completed  or Rejected  lifecycle state.

You can remove the change form:

If you are the change form's originator, and the change form is at the Originated  lifecycle state.
If you are the change form's analyst, and the change form is at (or can be moved to) the Originated , Submitted  or Canceled
lifecycle state.

If you aren't the change form's analyst but have an analyst role, you can replace the analyst with your name, and then
save the record.

To remove a change form record from the database:

1. Open the change form. If it's open, select it to that you can view it.
2. If you are the change form's originator, then the change lifecycle must be at Originated . If it is not, you must ask for the

analyst's help.
If you are the change form analyst, use the Process  menu to move the change lifecycle to Originated , Submitted , or
Canceled .

Some workflow paths may need to be enabled on the change form template to let the change move from its current
lifecycle to one of these states.

3. On the Item  menu, select the Remove Object  command.

You cannot undo the Remove Object  command.
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Review a routed change Home 85

On behalf of your group, you review the routed change form to ensure that the change:

is necessary
appropriately addresses the issue, and
accurately and completely tells the changes that are proposed.

Based on your assessment, you decide whether to approve, disapprove, or hold the change for further information.

1. Select the change form's Reviewers  page.
2. Enter your comments, if any.

For Disapprove change ⌵  and Hold change ⌵  responses, you should supply a comment. The Reviewer's
comment required system rule  may block your response if the comment is missing.

The change is always on hold until a Must act ⌵  reviewer responds. Thus, if your change workflow enables a
Hold change ⌵  response, select this response only if your group is Can act ⌵ .

If you put the change on hold, then the analyst must move the change back to the Routed  state or to the Submitted
or Canceled  state.

3. Select the Response . The Reviewer Password  window is shown.

To confirm your response, enter your password and click the OK  button.
To change your response or comments, click the Cancel  button.

If you're the last person to approve the change, or you select Disapprove change ⌵  or Hold change ⌵ , the change
form is immediately moved out of Routed  state. You cannot change your response or comments.

You can edit your response and comments while the change lifecycle remains in Routed  state (but you can't reset
your response to Pending approval ⌵ ). Your response can't be changed by a different reviewer in your group.

Next steps
After you've saved your response, the change form moves to the next step in the administrator-specified workflow.

If you approve the change form, the system notifies the next reviewer or, if none, sets the change lifecycle as Accepted  or
Released  (or Completed ).

If you disapprove the change form, any remaining reviewers are skipped. Depending on the workflow design, the change form is
forwarded to one of several possible states: Stopped , Canceled , Rejected , or returned to the analyst as Submitted .
If you put the change form on hold while waiting for more information, an email notice may be sent to the change originator,
analyst or other interested persons based on the workflow's email notice settings. When you get the information you need, an
analyst removes the Held  state and you provide your final response.
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Resolve an on-hold change Home 86

As a reviewer, you put the change form "on hold" until you're satisfied that you have all of the information you need for approving or
disapproving the proposed change. The change form isn't forwarded to other reviewers until you decide what to do.

The Hold change ⌵  response is intended for Can act ⌵  reviewing groups, to prevent the Must act ⌵  reviewing groups
from releasing the change. For a Must act ⌵  reviewing group, this response isn't useful because the change is always "on
hold" until a response is provided.

If you decide that the change requires further work by the originator, you can request the change form's analyst to return it to the
Submitted  state.

If you're the reviewer who has Held  the change form, you may

Reset the change status to pending ( Response : Pending approval ⌵ ), which lets any other authorized reviewers in your group
offer their review;
Approve the change ( Response : Approve change ⌵ ), which automatically forwards it to the next reviewer; or
Disapprove the change ( Response : Disapprove change ⌵ ). Depending on your administrator's workflow design, this response
may immediately forward the change to an analyst for assessment, or may automatically cancel or reject it.

If you're an analyst working with a reviewer, you can

Return the change form to submitted status ( Process ➔ Submit to Analyst ) for further work (which also resets any approvals
obtained), or
Return the change form to routed status ( Response : Pending approval ⌵ ) to start the current group's review again (which
retains any approvals obtained), or
Cancel the change form ( Process ➔ Cancel Change )
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Analyze an accepted change Home 87

An accepted change form must be reviewed by an analyst prior to it being released for general use. After approval by all reviewers, the
system sets the change's state to Accepted  and notifies the designated analyst or other persons.

Although the change workflow may specify that a change form is automatically released upon all reviewers' approval, this can't happen
if the change has a routing error. For example, an affected item relies on a reference item that was canceled by a different change
form. Since the system can't release the change form, its lifecycle is set to Accepted , and the analyst must resolve the error.

As an analyst, you review the accepted change:

Select the Process  menu command Submit to Analyst  to delete all reviewers' approvals, and return the change for further work
and a new review cycle. While in the Submitted  state, the change form may be edited or returned to the originator.
Select the Process  menu command Release Change  to release the accepted change form.

When you select Route for Approval , you may see a Routing Error  window. See the Fix change routing errors  help
topic.

If you can resolve the error by releasing the invalid child item on a different change form, then you can use the Release
Change  menu command again without resubmitting the change to obtain new approvals.
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Use a released change Home 88

A Released  change form often includes dispositioning instructions to your organization for managing the affected product data. For
example, the change form may require documents to be distributed, parts to be purchased or reworked, serial numbers to be recorded,
and procedures to be changed.

If you have appropriate permissions, you can update this dispositioning information to confirm that these steps have been performed.

When the released change's disposition steps are complete, or temporary changes—such as deviations or stop ships—expire, then
the change may be promoted to completed state.

A completed change form ensures that its dispositioning information is locked. Completing the change form ( Process ➔ Complete
Change ) removes the change from the analyst's Item Explorer Tasks  list.

A released change form can't be returned to a pre-released state. If you need to fix a released item (for example, adding a
forgotten revision file), then make a new pending iteration and update the incorrect information. If appropriate, copy the
previous iteration's revision and lifecycle values to the pending iteration. Release the pending iteration using a new change
form, which cancels the incorrect iteration.
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View a completed change Home 89

If you're viewing a Completed  change form, the change's disposition activities are finished, or any temporary impact—such as those
described in a deviation or stop ship—has expired.

A completed change form ensures that the change's dispositioning information is locked.

An analyst can no longer modify any of the change's contents, and cannot move the change to any other lifecycle state. In short, the
change is now simply a historical record.
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Analyze a stopped change Home 90

A change form may be set to Stopped  when a reviewer disapproves of its contents or intent.

As an analyst, you determine why the change form was disapproved and, in consultation with the disapproving person and the change
originator, move the change form to the next appropriate lifecycle state.

Based on the reasons for the change's disapproval, you choose one of the following paths:

Cancel the change form ( Process ➔ Cancel Change ), which then lets you delete it from your system's history.
Reset the change form to Submitted  status ( Process ➔ Submit to Analyst ), where you or a different analyst can either (a) rework
the change or (b) return it to the originator.
Reject the change form ( Process ➔ Reject Change ), which stops further work and provides a permanent record of the original
change as proposed.
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View a rejected change Home 91

The Rejected  change form is a permanent record of a proposal that failed, and may be useful to review when similar changes are
proposed or the need for the change once again surfaces.

A rejected change form cannot be modified, moved to a different state, or deleted. Any items listed on the Affected  list are not, and
can never be, affected by the rejected change.

The rejected change form's lifecycle state cannot be moved to any other lifecycle state.
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Remove a canceled change Home 92

The change form's contents are locked, and listed items have not been changed.

As an analyst, you can no longer modify any of the change's contents, or move the change to any other lifecycle state. You can,
however, delete the change entirely from the system.

To delete a canceled change form:

1. Open the change form. If it's open, select it to that you can view it.
2. Select the Item ➔ Remove Object  menu command.
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Return a submitted change Home 93

An analyst may return a submitted change form to the originator for further work. 

If a change form's status is not at Submitted , select Process ➔ Submit to Analyst . Then, to return the change form to the originator,
select Process ➔ Return to Originator .

The originator examines the change and the reason that it was returned. The originator can

delete the change ( Item ➔ Remove Object ),
cancel it ( Process ➔ Cancel Change ), or
modify and resubmit it to the analyst ( Process ➔ Submit to Analyst ).
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Attach a revision file Home 94

To attach a file, the iteration must be pending, and cannot be on a working (for example, a Routed ) change form. To manage
a revision file, see the User roles & permissions  help topic.

Revision files are included ( isFileIn="Yes" ) in a PDX package.

Revision (iteration) files typically contain specific design and production data that you want to tightly control. Revision files are
permanently locked to a particular document or part record iteration during the release process. You may want to include both the
original design files (like mechanical or electronic CAD files, or Word documents), as well as more general-purpose equivalents (such
as Adobe PDF or JPG images).

After the item iteration has been released, the attached files cannot be added, modified or deleted. To add, revise or remove revision
files, you must create a new item iteration.

1. Select the item window's Files  tab, then select the Revision Files  tab.
2. Unlock the item window by pressing your keyboard's F2  key.
3. Use the context menu to add each file individually, or use Windows Explorer to drag-and-drop one or more files.

The file cannot be copied to the library unless PDXpert can have exclusive access to the file. If the file is open in
another application, you may receive a warning. Close the file in the other application and retry the attachment.

The file isn't copied into the library until you save or lock the item record. After the file is saved, any changes made to
your local copy won't affect the file that you attached to the Revision Files  list.

Do not attach a Windows link ( .lnk ) file. The real data file is not saved, and the link file doesn't contain information
that's useful to other computers.

Windows has a practical device:\path\filename.ext  length limit of 260 characters. To avoid problems when users
view or copy revision files from PDXpert to their computers, keep filenames under about 80 characters.

Windows may block downloaded files, which should be unblocked before attaching to an item record. See the File
tab  help topic.

Compressed archive files – .zip , .7z , .rar , and similar files – should be made only on a Windows PC. See the
File tab  help topic.

PDXpert does not move, change or delete the source file on your computer.

Right-click within the Revision Files  list to open the context menu. Select the Add New File...  command and then use the
Add File to Library  dialog to browse to your file. Select the file and click the Open  button.

Open Windows Explorer and select one or more files to drop. You can multi-select files by using shift-click, control-click
or by dragging a selection rectangle to highlight the files. Drag one of the highlighted files from Windows Explorer and
drop it onto the Files list (all selected files will follow).

Ensure that at least some part of PDXpert's file list area is visible before you start the drag.

4. Select Add Notes...  from the context menu to open the Add Notes  dialog. Enter a comment, and click the OK  button. The
note is attached to the file, and is shared across all iterations that use the file.

5. Save your work to the server: Item ➔ Save  ( Ctrl + S ) or lock the window ( F2  key).

Delete a revision file
To delete an attached file:

1. Select the revision file.
2. Press your keyboard's Delete  key, or select Remove File  from the context menu.
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Attach an item file Home 95

To manage an item file, see the User roles & permissions  help topic.

Item files are identified but not included ( isFileIn="No" ) in a PDX package.

An item file contains background information like quotes, emails, sketches or other information that is not useful for actual production.
These files are related to the item, not an iteration. Item files are not as tightly controlled as iteration files; any item file can be added,
modified or deleted regardless of the release state of the item's iteration(s).

1. Select the item's Files  page, then the Item Files  list.
2. Unlock the item window by pressing your keyboard's F2  key.
3. Within the files list area, right-click to open the context menu.

The file is not copied to the library unless PDXpert has exclusive access to the file. If the file is open in a different
application, you may receive a warning. Close the file in the other application and retry the attachment.

The file is not copied into the library until you save the item record. After the file is saved, any changes made to your
local copy won't affect the file that you attached to the Item Files  list.

Do not attach a Windows link ( .lnk ) file. The real data file is not saved, and the link file doesn't contain information
that's useful to other computers.

Windows has a practical device:\path\filename.ext  length limit of 260 characters. To avoid problems when users
view or copy item files from PDXpert to their computers, keep filenames under about 80 characters.

Windows may block downloaded files, which should be unblocked before attaching to an item record. See the File
tab  help topic.

Compressed archive files – .zip , .7z , .rar , and similar files – should be made only on a Windows PC. See the
File tab  help topic.

PDXpert does not move, change or delete the source file on your computer.

Right-click within the Item Files  list to open the context menu. Select the Add New File...  command and then use the
Add File to Library  dialog to browse to your file. Select the file and click the Open  button.

Open Windows Explorer and select one or more files to drop. You can multi-select files by using shift-click, control-click
or by dragging a selection rectangle to highlight the files. Drag one of the highlighted files from Windows Explorer and
drop it onto the Files list (all selected files will follow).

Ensure that at least some part of PDXpert's file list area is visible before you start the drag.

4. Save your work to the server: Item ➔ Save  ( Ctrl + S ) or lock the window ( F2  key).

Delete an item file
To delete an attached file:

1. Select the item file.
2. Press your keyboard's Delete  key, or select Delete File  from the context menu.
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Attach an external link Home 96

To manage an external link, see the User roles & permissions  help topic.

Links to external resources are included in a PDX package. PDX package users outside your local network may not see local
network links.

An external link points to information that's not copied into the PDXpert library, and isn't managed by PDXpert. The link may point to a
supply chain partner's website, regulatory agency homepage, or a file on your local network server. Since an external file or webpage
is outside PDXpert's direct control, the resource may not remain the same (or even exist) when a user clicks the link.

1. Select the item's Files  page, then the Item Files  list.
2. Unlock the item window by pressing your keyboard's F2  key.

Within the files list area:
A. Open the context menu, and select Add New External Link...
B. In the Add New External Link  window:

A. Type the internet URL or a network resource location, or
B. Click the Network...  button to browse for a network resource.

You must include the correct URI protocol prefix, such as http://  or https:// .

Or, drag a link from the address bar of your web browser, and drop it onto the list.

This feature is supported by most, but not all, current web browsers.

3. Save your work to the server: Item ➔ Save  ( Ctrl + S ) or lock the window ( F2  key).

After saving the form, you can click on the hyperlink to open the webpage or file.

Delete an item link
To delete an attached file:

1. Select the item link.
2. Press your keyboard's Delete  key, or select Delete File  from the context menu.

1160



Viewing a file Home 97

To view a file shown in a Files  list, click on the file, and select View File...  from the selected file's context menu.

If the file opens only when your computer has an application that recognizes the file extension.

You can also double-click the selected file.

The file is copied to a temporary folder on your local drive, and Windows opens the file using a related application.
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Copy a file Home 98

1. Select the file from the item's Files  list.
2. Select the Copy Library File...  command from the Tools  menu or the context menu. When the Copy Library File  dialog opens,

navigate to the location where you want to put the file, and then click on the dialog's Save  button. The file is copied from the
library to your specified location.

You can't copy the file if you do not have sufficient access permission, which is specified by the item trustee in the
File Permissions  dialog.

The source file remains in the data library, and is not changed or deleted.
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Check out a file Home 99

To prevent other users from modifying the same file you're working with, you should check out (rather than copy) the file.

You can only check out files that are attached to pending iterations.

When you check the file out from the data library, the system first copies the file to your computer, and then locks the library file from
further checkouts (other users can still view or copy the file).

1. Open the item record that contains the file and, if necessary, select the pending iteration from the status bar dropdown list of
iterations.

2. Select the item window's Files  tab, then select the Revision Files  tab.
3. Unlock the item window by pressing your keyboard's F2  key.
4. Select the file that you want to check out by clicking on the filename.
5. From the Tools  menu, select the Files ➔ Check Out and Lock...  command (or the similar command on the file's context menu) to

open the Check File Out of Library  dialog. Navigate to the folder where you want to save the file, and click the Save  button.
6. Update the item's status: Item ➔ Save  ( Ctrl + S ) or lock the window ( F2  key).
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Check in a file Home 100

When you check a file back into the library, your changed file replaces the library file. The file lock is freed so that others can check out
the file.

1. Use the Item Explorer to locate the item that contains the file. You can quickly view all files that you have checked out by
selecting the Files  tab of the Item Explorer. Open the item window, and select the pending record.

2. Select the item window's Files  tab, then select the Revision Files  tab.
3. Unlock the item window by pressing your keyboard's F2  key.
4. Select the file that you have checked out by clicking on the filename.
5. On the Tools  menu, select the Files ➔ Check In and Free...  command to open the Check File Into Library  dialog. Navigate to the

folder that contains the modified or replacement file, and click the Save  button. The file is copied to the data library, and
replaces the previous version of the file.

The previous pending file is permanently replaced and cannot be recovered.

The file in your local folder is not affected.

6. Save your work to the server: Item ➔ Save  ( Ctrl + S ) or lock the window ( F2  key).

1163



Free a file lock Home 101

When you check out a file from the data library, PDXpert locks the library file to prevent other people from making changes at the same
time. If you later decide not to modify the checked-out file, you should still free your lock on it. In this case, PDXpert does not copy the
file from your workspace, but simply removes the library file lock so that it can be checked out by others.

1. Use the Item Explorer to find the item that contains the checked-out file. You can quickly view all files that you have checked out
by selecting Files  on the Item Explorer. Open the item, and select the pending iteration.

2. Select the item window's Files  tab, then select the Revision Files  tab.
3. Unlock the item window by pressing your keyboard's F2  key.
4. Select the file that you have checked out by clicking on the filename.
5. On the Tools  menu, select the Files ➔ Free File Lock  command. The file in the data library remains the same as before it was

checked out. Other users can check it out.
6. Update the item's status: Item ➔ Save  ( Ctrl + S ) or lock the window ( F2  key).

If you're the item's trustee, you can free the lock on a checked-out file ( Tools ➔ Release File Lock ) even if a different user has
checked it out. After you free the lock, the other user must again check out the file (making sure not to overwrite the changed
file on their local computer), and then check the changed file back in.
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Remove a revision file Home 102

You must be the iteration's trustee. The iteration must be pending, and cannot be on an in-process (for example, a
Submitted  or Routed ) change form.

To remove (delete) the file attachment from a pending iteration:

1. Select the item window's Files  tab, then select the Revision Files  tab.
2. Unlock the item window by pressing your keyboard's F2  key.
3. Select the file that you want to delete by clicking on the filename.

Press your keyboard's Delete  key.
Open the context menu, and select the Remove File  command.

On an item's first pending iteration, the file is immediately deleted from the list. On later iterations, the file is marked to be
remove when the iteration is released on an approved change form.

4. Lock the window ( F2  key).
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Remove an item file or external link Home 103

To delete the file attachment or external link from an item's Item Files  list:

1. Select the item window's Files  tab, then select the Item Files  tab.
2. Unlock the item window by pressing your keyboard's F2  key.
3. Select the file or link that you want to delete by clicking on the filename.
4. Open the context menu, and select the Delete File  command (or press your keyboard's Delete  key).
5. Lock the window ( F2  key) to save your changes.
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Reports are opened using the context menu.

On item (document, part, change) forms, an Item Report  shows the complete contents of every page on an item; the Tab Report
includes only the data on the currently-selected page.

Multi-level BOM reports may include other relational data, such as the BOM with Sources  and BOM with References  reports.
These reports show the BOM parts' immediate (first-level) source or reference items, but do not recursively show non-BOM
items such as source parts on sources or references, BOM parts on sources or references, or reference items on sources or
references. These unusual structures can be handled in Transforms.

Running the report

Standard reports

Within an item form or on a Collection Explorer member node, open the context menu, and select one of the listed reports
(typically the last group of commands). The report is shown in a new form.

To open a context menu, click the secondary (usually right) mouse button while over an object.

To open the context menu in a list, such as the BOM: Markup  list, right-click on a row background.

Custom reports
PDXpert's standard reports and exports are listed first, followed by optional reports or exports specified by Transforms collection
members.

To show the results of a data transform in the Export/Report ⏵  submenu, its XML code must use a correct context location,
such as <context location="BillOfMaterialsMarkupList" part="true" /> . See the Transforms: <context /> element
help topic.

Using the report
The report window has the following controls on the toolbar (see picture below):

1. You can move between report pages using the page controls.



2. If you want to print the report, click the printer icon. If you prefer to export the report, select one of the formats from the
dropdown list.

3. Use the zoom dropdown control to see the entire report or to see details.
4. You can search for text by typing it into the textbox, and clicking the Find  button.
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A Product Data eXchange, or PDX, package is a compressed file that contains parts, multi-level BOMs, approved supplier sources,
reference documents and similar design data, as well as related file attachments. PDXpert exports PDX files in accordance with the
IPC-2571 and IPC-2578 standards ( www.ipc.org ).

The server computer builds a PDX package, then sends it to your client computer. The IPC-2570 standard specifies a
maximum size of 4GB, before compression (PDXpert offers an option for much larger packages). For large PDX packages,
server and client computers should have at least 8GB of memory, and 16GB of free disk space.

A simple part record can have a few hundred IPC-2570 XML elements; a very large product may have over a hundred
thousand elements (plus file attachments). Creating the package can take much longer than a multi-level BOM or pick list
report. ERP/MES/MRP importers, PDX viewers, and other tools may take a while to open a large package. Consider
excluding large or complex elements from the package (e.g., files, custom attributes, dispositioning), or export smaller
subassemblies.

Invalid text characters that are pasted or imported into item records can cause problems when creating and reading PDX
XML packages. For different types of data, the PDX exporter may:

remove selected whitespace characters ( HT  VT  FF  NBSP  NEL ), or replace them with a space ( SP );
in single-line text, remove LF  and CR  end-of-line characters, or replace them with a space ( SP ), and delete leading
and trailing spaces;
in multi-line text, replace Linux/MacOS end-of-line characters with the Windows standard ( CR LF ); and
remove all other characters in 0x0000–0x001F  and 0x007F–0x009F  ranges.

Exporting a PDX package
To export a PDX package:

1. Select an open item form, open the context menu, and select the  Export PDX Package  command.

To open the context menu: Move the mouse over a part, document or change form and click the secondary (usually
right) mouse button.

2. In the Export PDX Package  dialog:
Select the PDX export settings from the dropdown list at the bottom of the window, in the center.
You can override the selected export settings as desired using the lists and checkboxes shown in the General ,

Documents  and other tab pages.
3. Click the Export  button: move to the desired folder, accept or edit the suggested file name, and click the Save  button to

save the PDX package file.
Or, click the Cancel  button to cancel the export and return to the item record.

A PDX package viewer application enables users to open and browse PDX packages, and extract file attachments. Some
manufacturing (MRP/ERP) systems can import part and BOM data from a PDX package.

The PDXplorer PDX Viewer is available for free download at www.pdxplorer.com

Export settings reference

Settings
These settings control the IPC-2570 attributes that are included in the PDX package. Each page describes one of the IPC-2570
elements that can be changed.

When you hold the mouse pointer over a settings checkbox, text box or other setting control, the pop-up hint may show the
attribute's path name:action, such as PDXPackage.StdAttr.originatedByContactName:Load . Refer to the Transforms
collection  help topic for information about key-value pairs.



Settings page Package
The ProductDataeXchangePackage element is the root of the PDX package. These settings manage selected attributes and behaviors.

Include standard 'originatedByContactName', or this
When the checkbox is marked, the PDX package includes the ProductDataeXchangePackage element's
originatedByContactName attribute. The attribute value is the textbox contents or, if empty, the name of the person who
exported the package.
When the checkbox is cleared, the originatedByContactName attribute is not included in the package.

Include standard 'thisDocumentCopyright', or this
When the checkbox is marked, the PDX package includes the thisDocumentCopyright attribute. The attribute value is the
textbox contents or, if empty, the Contact where isTopLevel="Yes" is shown as the package copyright holder.
When the checkbox is cleared, the thisDocumentCopyright attribute is not included in the package.

Include a 'description' as this
When the checkbox is marked, the PDX package includes the description attribute. The attribute value is the textbox
contents or, if empty, no attribute value (there is no default value).
When the checkbox is cleared, the description attribute is not included in the package.

Sign the PDX.XML file (extension to IPC)
When the checkbox is marked, the PDX package is cryptographically signed. The package signature can be used to show the
package contents have not been altered after it is exported. The signature can be read and verified by PDXplorer.
When the checkbox is cleared, the PDX package does not contain a cryptographic signature, and will be compatible with
most PDX package viewing and importing tools.

This is a non-standard extension to the IPC-2570 specifications. Standard PDX package viewing and importing
tools (including older PDXplorer releases) may simply ignore the signature; export an unsigned package for those
that do not. Tools that compare the pdx.xml  Attachment entries to the package's actual files may show the hidden
PDXXML-{id}.sig  signature file as an extra attachment.

To enable PDX package cryptographic signing, your PDXpert software license key contains a unique digital signing
certificate. This signing certificate periodically expires and must be renewed through an active maintenance,
support, and upgrade subscription.

For technical information about the PDXpert cryptographic signature, search the web for
PDXpert package cryptographic signing

Allow more than 4GB of files (extension to IPC)
When the checkbox is marked, the PDX package is compressed using the ZIP64 algorithm. This can export a package limited
almost entirely by available disk space and the network's ability to move it. The package can be read by PDXplorer, starting
with 6.0 release.
When the checkbox is cleared, the package remains within the limits of the IPC-specified 32-bit compression algorithms.
Packages with large attachment sizes (totaling more than 4GB) or high counts (more than 65535 files) may not be exported.

This is a non-standard extension to the IPC-2570 specifications. Some PDX readers/importers may not open large
packages.

PDX packages with more than a few gigabytes are often difficult to save, transfer, open, and archive. Use the
attachment filter settings (see next section) to exclude large disk images, videos, CAD models, and similar files from
the package. Save and send very large files separately.

Settings pages Documents  Parts  Manufacturer Parts
This page manages attributes exported from a part or document record. The PDX package is identified as:
ProductDataeXchangePackage packageType="Manufacture"

The item's Class  and Owner  determines its IPC-2578 element, and which settings page manages its attributes.

All document records are assigned to the Item element with itemClassification="Document". The Documents  page manages
these records.



All home part records are assigned to the Item element with itemClassification="Part", and are managed on the Parts
settings page.
All partner part records are assigned to the ManufacturerPart element. These are managed on the Manufacturer Parts  settings
page.

A PDXpert item record's Part type  or Document type  (globalProductTypeCode) does not affect which settings page is used to
manage the item.

To learn how PDXpert objects are mapped to the IPC-2570 specification, search the web for
PDXpert IPC-2570 technical notes

Include all Document Types
Exclude all Document Types unless top level
Include marked Document Types or top level
Exclude marked Document Types unless top level

Include all Part Types
Exclude all Part Types unless top level
Include marked Part Types or top level
Exclude marked Part Types unless top level

This dropdown list sets which Part Types or Document Types are included in the package.
When the list selections show … marked …  instead of … all … , then use the checkbox list to select the item types to include or
exclude.
The part or document that you're exporting is automatically marked as the top-level item (isTopLevel="Yes"), and is always
included in the package. Use the Mark All  or Clear All  buttons to adjust all types in the list.

A PDX package transfers parts and their supporting data to manufacturing. Excluding parts (and related documents)
from the package can have unexpected results. PDX readers rely on complete part relationships for navigation and
for accurately representing the included items. Where these relationships are essential, an Item element may be
only partially excluded when it's a parent to other Item elements.
For example, excluding an Assembly part type in a multi-level structure collects all items, then deletes any lower-
level Assembly parts. This leaves all components in the package, but without their parent subassemblies (similar to
a Pick List report). Although the subassembly parts are gone, summary subassembly data (such as part number,
type, description) may remain on related parts.
PDXplorer and other PDX viewers often calculate relationships after reading the package, but cannot do this from
partial data. For example, the top Assembly may show subassembly summaries, but a multi-level BOM tree cannot
be calculated without the full subassembly relationships.
Excluding a limited set of items works well in simple PDX packages. Packages with multi-level BOMs should limit
filtering to standard attributes, custom attributes, and files/links.

Include these standard attributes
Each setting is applied to all items that are affected by the current settings page.

Include these custom attributes
Each setting is applied to all items that are affected by the current settings page. This list includes all custom attributes across
all types. Not all types will have the same custom attributes. Use the Mark All  or Clear All  buttons to adjust all attributes in
the list.

Include all Revision Files (isFileIn=Yes)
Include all Revision Files as summary (isFileIn=No)
Include all Revision Files, with these (pdf,txt,…) as summary
Include these Revision Files (pdf,txt,…)
Exclude all Revision Files
Exclude these Revision Files (pdf,txt,…)

Include all Item Files (isFileIn=Yes)
Include all Item Files as summary (isFileIn=No)



Include all Item Files, with these (pdf,txt,…) as summary
Include these Item Files (pdf,txt,…)
Exclude all Item Files
Exclude these Item Files (pdf,txt,…)

Physical file attachments can be included in the package; or only described ( …as summary ), or excluded entirely.
By selecting an option using …these… , you can define a list of files by their extension. Use a comma between each file
extension, and do not include the "dot" separator: pdf,txt,png  and not .pdf,.txt,.png  Do not use wildcard characters
like ?  or * .

Item files are not often included, or included …as summary , because they are not revision-controlled requirements.
Very large revision files, such as .iso  disk images or media, can be excluded to avoid PDX packages larger than
4GB.

Include all Item web links
Exclude all Item web links

External web links like https://example.com/price  are copied from each record's Files: Item Files  list. The setting is
applied to all items that are affected by the current settings page.

Settings page Change
This page manages attributes exported from the currently-selected change form. The PDX package is identified as:
ProductDataeXchangePackage packageType="ChangeNotification"

This settings page is not shown for the Manufacture package type.

Include these standard attributes
Each setting is applied to selected change form.

Include these custom attributes
Each setting is applied to selected change form. This list includes all custom attributes across all change form types. Not all
change types will have the same custom attributes. Use the Mark All  or Clear All  buttons to adjust all attributes in the list.

Revision files on Affected items:
Include all Revision Files (isFileIn=Yes)
Include all Revision Files as summary (isFileIn=No)
Include all Revision Files, with these (pdf,txt,…) as summary
Include these Revision Files (pdf,txt,…)
Exclude all Revision Files
Exclude these Revision Files (pdf,txt,…)

These settings manage revision files that are attached to affected items listed on the change form. The files are identified as
"markup" elements (IPC AttachmentMarkup). All affected items' revision files that have been added, removed or replaced – as
well as those that have not changed – are listed in the markups. Other parts and documents in the package that have not
been revised include only their current file attachments as specified on the other settings pages.
Physical file attachments can be included in the package; or only described ( …as summary ), or excluded entirely.
By selecting an option using …these… , you can define a list of files by their extension. Use a comma between each file
extension, and do not include the "dot" separator: pdf,txt,png  and not .pdf,.txt,.png  Do not use wildcard characters
like ?  or * .

Item files and links on Change form:
Include all Item Files (isFileIn=Yes)
Include all Item Files as summary (isFileIn=No)
Include all Item Files, with these (pdf,txt,…) as summary
Include these Item Files (pdf,txt,…)
Exclude all Item Files
Exclude these Item Files (pdf,txt,…)

The selected change form's Files  list can be included in the package; or only described ( …as summary ), or excluded entirely.
By selecting an option using …these… , you can define a list of files by their extension. Use a comma between each file
extension, and do not include the "dot" separator: pdf,txt,png  and not .pdf,.txt,.png  Do not use wildcard characters
like ?  or * .



Very large revision files, such as .iso  disk images or media, can be excluded to avoid PDX packages larger than
4GB.

Include all Item web links
Exclude all Item web links

External web links like https://example.com/share  are copied from the selected change form's Files  list.

Actions

Save As…
This button exports the current package settings as a file. The file content can be used to create or updated a Transforms
collection member. See the Create a PDX export transform  help topic.
After the transform is saved, when the Export PDX Package  dialog is next opened, the transform is shown in the Select PDX
starting values  dropdown list.

Select PDX starting values
The — PDX Standard Package — ⌵  exports a standard set of attributes and their default values. Other export settings may be
available from active PDXExport  members of the Transforms collection.
Selecting a new value from the dropdown list copies the selected transform's starting values into the Settings  control.

All values in the settings pages are immediately replaced with the new settings, and cannot be undone.

Export
This button exports the PDX package that's defined by the current settings.

Cancel
Click this button to close the window without exporting a PDX package.

IPC-2570 rules and effects
This section summarizes some of the PDX package limitations. The PDXpert website tells what data is included in a PDX
package, as well as technical limits of the PDX format. Search the web for PDXpert IPC-2570 technical notes

The IPC standards expect that the home organization owns all assemblies and their BOM parts, and that partner items need very few
attributes. Thus, a PDX package may affect how non-conforming data is exported.

An Item (a home organization part) can have a BOM and sources, but a ManufacturerPart (a partner organization part) cannot.
A partner part with a BOM includes its BOM components, but not the BOM structure.
Exporting an assembly owned by a partner organization may fail. Multi-level partner BOMs will almost always fail.
The PDX standard says that only a (home) Item can have a BillOfMaterial, and a BillOfMaterialItem must refer to a (home)
Item. A ManufacturerPart cannot have a BillOfMaterial, ApprovedManufacturerList or AdditionalAttributes for
PDXpert.References list.
The PDX package defines the BOM as the only multi-level recursive structure. At each BOM node, the child part may have a
BOM list, a Sources list and a References list. The node part's BOM is followed recursively, while only the first-level items are
included from the part's Sources and References lists. This means that a PDX package cannot describe Sources on Sources,
References on References, Sources on References, or References on Sources. Avoid these relationships in your product
structures. If you require these arrangements, then you must export these nodes as separate PDX packages.
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The DataGrid shows the results of a Transforms collection member.

To show a transform's results in the DataGrid, its XML code must use the <Provider>DataGrid</Provider>  setting. See the
Transforms: <Provider>  help topic.

The DataGrid supports about 100,000 data cells (columns × rows). Write the transform with this limit in mind. For larger
results or more complex data filtering, export the data using the <Provider>Table2</Provider>  transform setting.

Using the DataGrid

Open the DataGrid by running a transform from the Tools  menu ➔ Report/Export Wizard...  command, or from a context menu.
After the DataGrid opens, you can arrange columns and sort rows; filter unwanted data; and copy or export the results.
You can have more than one DataGrid open at the same time.

Adjusting the view

Adjust column width

Adjust a column's width by dragging its border. Double-click the column's right-side border to automatically adjust its width to the
text.

 Order column

Change the left-to-right column sequence by selecting the column header, and dragging the header box to the correct location.

The vertical line ▎  highlights where the column will be inserted.
Restore the original left-to-right column sequence by clicking the Reset Order  button.

Hide column

Hide a column by opening the column's context menu, and selecting the Hide Column  command.
Unhide (show) all hidden columns by clicking the Unhide All  button.

Sort rows by column

Sort the data rows by one or more columns. Click on a column header once to sort ascending ( ▲  as 0-9,A-Z). Click again to
sort descending ( ▼  as Z-A,9-0). Click once more to remove your sorting. Sorting is not case-sensitive. The Sort by:  text shows
the sorting rule.
Restore the original sorting by clicking the Clear Sort  button. This is confirmed by the Sort by:   Default  message.

Filter rows

Show only useful rows by entering text into the Filter by:  box. The filter characters are matched character-by-character to the
content of any column, and any non-matching rows are filtered out (excluded).

Matching is not case-sensitive.
Space characters are used to separate filter "tokens": each token must match at least one column in a row.
Extra whitespace (like TAB  CR  NBSP ) and control characters (like NUL ) are removed from tokens before matching. All
other alphanumeric and symbol characters are used for matching. If a table value contains extra whitespace or control
characters, these will not be matched.



Each token automatically begins and ends with a wildcard: typing the token PART  is immediately converted to *part*
Text in hidden ("housekeeping") columns is ignored.

Clear the filter by clicking on the ×  at the right end of the Filter by:  box. This restores the original set of data rows.

The row filter criteria is similar to:

((columnA has *token1*) OR (columnB has *token1*) OR ... OR (columnN has *token1*))
AND ((columnA has *token2*) OR (columnB has *token2*) OR ... OR (columnN has *token2*))
AND ...
AND ((columnA has *tokenX*) OR (columnB has *tokenX*) OR ... OR (columnN has *tokenX*))

where
 the data values in columnA  through columnN  are shown in the table (excluding links to Open the row's record)
 the user has entered token1  through tokenX  filter terms, separated by space characters
  *  is the wildcard (zero or more) character

Selecting rows for exporting and copying
Filter rows  before selecting.

Click anywhere on a data row to select it.
Select a continuous range of rows: (1) select the first row, (2) hold down the Shift  keyboard key, and (3) click on the last row in
the range.
Select several separated rows: (1) select the first row, (2) hold down the Ctrl  keyboard key, and (3) click on any other rows.
If most rows should be selected, but a few should not, first select the entire data grid by clicking on the upper left corner.

Then, hold down the Ctrl  keyboard key and click on any row to unselect it.
Clear the selected rows by clicking the Unselect All  button.

Exporting data to a file
Save the data to a file by clicking the Export All  or Export Selected  button. The file contains what remains after columns are hidden
and sequenced, and rows are sorted, filtered and selected.

Copying data to the Windows clipboard
Copy the data to the Windows clipboard by clicking the Copy All  or Copy Selected  button. The copied data contains what remains
after columns are hidden and sequenced, and rows are sorted, filtered and selected.

Opening a row item
If a column shows an Open link in some or all rows, clicking the link opens the related document, part, change form or collection
member. If the item is already open, its window is brought forward.

When the DataGrid is copied or exported, the Open column is not included in the data.

To learn how to make an Open link, see the Transforms: HK100 column  help topic.
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Standard reports are available on many of the application's context menus. The Report/Export Wizard exports data and prints reports
using the Transforms collection.

To use the Report/Export Wizard:

1. Open the Tools  menu and select Report/Export Wizard...  When the Report/Export Wizard  tool opens:

If the transform is an export file, then the Wizard exports your data in a standard delimited text format, such as CSV or
XML.

A. Select a dataset to export from the list of Transforms collection members. Click the Next  button.
B. Some exports may let you select items to include in the report. From the Item Explorer Search  or Recent  list,

drag an item to be included in the XML export and drop it onto the Report/Export Wizard  panel.
C. Click on the Finish  button. The Save As  dialog opens, and you can name the file and select the folder where the

table-formatted file is saved. Select one of the file formats from the Save as type:  dropdown list, and then click the
Save  button.

If the transform is a formatted report, then the Wizard opens a report that can be printed or exported as an Adobe
Reader, Microsoft Excel or Microsoft Word file.

A. Select a report from the list of Transforms collection members. Click the Next  button.
B. Some reports may let you select items to include in the report. From the Item Explorer Search  or Recent  list,

drag an item to be included in the XML export and drop it onto the Report/Export Wizard  panel.
C. Click on the Finish  button. The Save As  dialog opens, and you can name the file and select the folder where

the table-formatted file is saved. Select one of the file formats from the Save as type:  dropdown list, and then click
the Save  button.

2. When the Report/Export Wizard  tool is done, the form closes.

Transforms may be designed to export one or more selected iterations. You can choose the iteration by opening the Iteration(s)
dropdown, and marking the appropriate checkbox. If the transform is designed to allow more than one revision, multiple checkboxes
can be marked.
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Administrators open this window using Tools menu ➔ Batch Importer...  The menu command is shown when the user's role has ☑
Collections/Rules administrator  marked.

You can import new parts, documents and files, as well as update your existing item records, using the Batch Importer  tool. The tool
also simplifies setup by importing collections of related information such as organizations, groups, materials, and user accounts.

After your data is imported, you can put it under change control by releasing the pending iterations.

Many attributes on the item's General , Attributes , and Notes  pages can be imported in the Item Master import file. Lists of related
objects — BOM items, approved sources, references, materials, and file attachments — are imported using separate relationship
import files.

The Batch Importer is used to import correct data from another "known to be good" source (MRP/ERP, PDX packages,
Access/Excel, etc.). Import files must always contain correct and consistent data. PDXpert uses this good-quality data to
check rules, match collections, and construct relationships.
For every import using Batch Importer tool:

Save the database before importing.
Inspect the data before importing.
Monitor the import log for errors.
Review the data after import.

Do not "fix" failed items after they're imported into PDXpert. Failed imports may damage earlier items and
relationships.
If any import row shows a FAIL:

Correct the import file.
Restore the database to its most recent pre-import backup.
Re-import the corrected file.

The Batch Importer tool can make and update iteration details only on an item's first pending iteration. The tool can update
item-level values — such as part unit cost, custom attributes, materials and item files & external links — at any time.
Collection members can be imported and updated without regard to item release state. Each import file's help topic tells
whether it's a collection import, iteration-level import or item-level import. The item master import file contains a mix of
attributes; the Item Master help topic  shows the attributes that can be updated after the item's first release.

Importer controls

Import data template
This selection list shows all of the import options. Each of the options has its own import template and rules, and is described
in the related help topic.
Select an Import Type , and then click the Import  or Export  button.

Add missing collection members
When the checkbox is marked, a missing collection member is automatically added to the collection. For example, marking
the ☑ Organization  checkbox will add a new Organizations collection member when the imported row contains an Owner
value that doesn't exist.

These options are used only when importing the Item Master file .
A new collection member contains only the name and the collection's default values. After importing, each new
member must be configured.

When using these options, each imported row must have correct and consistent collection members. When the row
value is imported, the current collection members are searched for an exact match. A new collection member is
made when the imported member is simply misspelled or shortened; for example, even if Acme Manufacturing
exists, importing Acme Mfg.  isn't matched, and is created as a new member.



Using collection import templates (such as the Collection: Organizations import file ), and leaving the Item Master
import options unmarked, helps prevent unwanted collection members.

Copy Status
Click this button to copy the import status to the Windows clipboard.

Import
After selecting the Import Type , click the Import  button to find and import the related import file.

The status summary shows the import progress, and predicts when the import will finish based on rows already
imported. The estimate is adjusted based on other computer tasks; adding new items (slower) or updating existing
items (faster); and item complexity (documents are faster than parts, custom attributes are slower, small files and web
links are much faster than large attachments).

Cancel
Click the Cancel  button to stop importing the current file. There may be some delay before the server can respond.

Export
After selecting the Import Type , click the Export  button to export the related import template. The template contains the
columns described in each import file help topic.
For your convenience, exported templates include most data you've previously imported. Important exceptions are:

The Item Masters ⌵  export does not include any information for released iterations, such as current revision and
lifecycle.
The List: Revision Files ⌵  export contains only the column headers, and no revision file data rows.
The List: Item Files and Links ⌵  export contains only the item file names, without the original file path location.

Exporting a file import template does not copy files from the library.

Data not included in the exported templates can be exported using one or more Transforms collection queries.

Future PDXpert releases may change (or exclude) data in exported templates.

Close
Click the Close  button to stop all importing and close the tool.

General import procedure
Before importing your data, back up your database . The import tool can make big changes to your database, and can
overwrite data on previously-imported items. You cannot undo the changes it makes; you can only restore your backup
database.

You should be the only user logged into the system when using this tool.

The test software limits the number of items you can use without a license key. If you plan to import more than a few
thousand items, request a software license key.

The PDXpert website shows an on-line tutorial with example data. Search the web for PDXpert import tutorial .

If you want to import a single bill of materials into an assembly's BOM, refer to the Import a CAD BOM  topic.

1. Make your import file(s) after reading the related help topics for these files.
2. Click on the Tools  menu and select the Batch Importer...  command. The Batch Importer  tool opens.

The Batch Importer...  command is visible only to users with a Role that has been marked with the Collections/Rules
administrator  permission.

3. Select the Import Type  for the data file: Item Masters … ⌵ , List: BOM … ⌵ , List: References … ⌵ , List: Sources … ⌵ , etc.
4. When importing Item Master data, you can specify whether new collection members should be added during import. If you want

collection members added "on the fly", mark the appropriate Create missing collection member(s)  checkboxes.



The checkbox setting may apply to more than one column of the import file. For example, the Person  checkbox adds
members using data in the Trustee , Person1  and Person2  columns.

5. Click the Import  button, which shows the Open File  dialog.
6. Navigate to the file containing your formatted data, and click the Open  button. The import starts immediately.

To stop the file import, click the Cancel  button.

You can copy the status log messages to the Windows clipboard by clicking the Copy Status  button.

7. After your file(s) have been imported, click the Close  button to close the Batch Importer  tool.

After import, each new item is available within the PDXpert client for further editing and may ultimately be released on a change form,
exactly as though you'd added the record manually.

How to initialize your PLM database
PDXpert lets you import these records and relationships:

1. All item master records, which include home organization parts and documents, as well as your partner organization parts and
documents.

2. The relationships between your assemblies and their bill of materials components.
3. The relationships between your purchased parts and each approved source part.
4. The relationships between items and their supporting references.
5. The revision files that are attached to the item records' Revision Files  lists, and copied into the file Library.
6. The item attachments and external links that are attached to item records' Item Files  lists, and copied into the file Library.
7. The materials used to formulate a part.
8. The contact details (name, abbreviation, website, address, phone) of your partner organizations.
9. A list of persons who are contacts or account users in your system.

10. Lists of custom collection members.

Obtaining the import file templates
Each import file template can be exported as a CSV file.

1. Open the Batch Importer tool: Tools ➔ Batch Importer...
2. Select the appropriate format from the Import Type  dropdown list.
3. Click on the Export  button, and save the file.

When there is no data in the database, the exported files contain a single row of column headers, as specified in the import file
specification help topics.

When data is in the database, it may be included in the export. Use this data to validate how PDXpert interpreted your import file. You
can make the simple import template by deleting all data except the first row of labels. You can also use the exported item master data
as the basis for on-going updates of item properties (such as part cost).

Preparing your database and item master import file
Your data files must conform to the import file format specifications. The import procedure can use default values and add
new collection members "on the fly". To avoid data errors and make this task as efficient as possible, read the other help
topics on importing data before using this procedure.

The Batch Importer can detect certain errors in your data, such as inappropriate data types. It cannot detect problems such
as recursive (cyclic) BOM errors, assembly items added as children of component parts, or a part supplier with an
inconsistently-spelled name. A careful inspection of import results is your best protection against incorrect data.

If you don't normally have access to the computer containing the PDXpert Application Server, it may be useful to install a
copy of the PDXpert Application Server on your local computer. After you've performed these import tasks, you can move the
final database and library files to your production server, and uninstall your local PDXpert Application Server.



Collect all of your item data into a single ItemMaster.csv  file. Item data is everything that has a part or document number, from
whatever source: home items and partner items; individual components, consumables, subassemblies and top assemblies.
Ensure that file headers are correct (use the Export  templates).
Within PDXpert, enter or update any data that will remain constant throughout the import procedure. This would include, for
example, entering the software license registration key (if any), entering company name & abbreviation, and setting up user
accounts.
If your items include custom attributes, add the Part Types or Document Types collection members as needed, and then
define their custom attributes before importing the related items. If you're importing custom attributes that reference a custom
collection, then all members of the collection must exist before your import.

General procedure for importing each file
You should be the only user logged into the system when using the Batch Importer.

1. Load your data into the import template.
2. On the Batch Importer tool, select the correct import format from the Import Type  dropdown list.
3. Click the Import  button, and navigate to your import file. When you accept the file, its data is immediately loaded into the

database.

Collection members import
Collections organize similar data that are applied to parts and documents. It's most efficient to import the collections in this sequence:

Organizations  are your vendors, customers, regulatory agencies, and other entities that own the specifications of parts or
documents.
Persons  are PDXpert users as well as observers of the change workflow.
Groups  organize your persons into specified responsibilities and interests.
Materials  are the chemicals and substances that must be tracked for regulatory compliance.
Custom collections  apply a well-specified set of tags to your parts' and documents' custom attributes.

ItemMaster data import and validation tasks
The trial software limits the number of items you can use without a license key. If you plan to import more than a few
thousand items, request a software license key for your trial.

During the import, the Batch Importer often supplies a reasonable value if the imported value is empty. The default values are shown in
the Item Master import format: ItemMaster.csv format column definitions  help topic.

Repeat these steps until your imported item master data is accurate and complete:

1. Review and, if necessary, select the default member of each collection used in the import file, as shown in the Data type
column of the Item Master import format help topic. If the import file has a value that isn't yet a member of a collection, and that
value should be used as the default member for missing import values, add the missing member and set it as the collection
default.

You must specify a valid collection member in each imported item row that doesn't use the default collection member.

2. Compare the set of existing collection members to your import data, and edit any mismatched data. For example, if your import
data uses the abbreviation EA  for each, decide which you want to retain, and then edit the ItemMaster.csv  file or modify the
PDXpert collection member name.

3. Back up your database. If you're not satisfied with the import result, you can restore this backup and improve the data for
another import.

See the Back up the database and library  help topic.

4. Import your ItemMaster.csv  file containing parts and/or documents that are owned by your organization as well as those
owned by partner organizations.

Review the status results to identify (a) the collection members that were added, (b) which items used default
collection members, and (c) which rows were not imported.



Examine the collections to ensure that all new members are correct. In particular, look for "almost duplicate" collection
members. If an imported value has minor variations or errors (like each , EA , eahc ), these show as separate entries
in your collection. Modify your file to eliminate all but the preferred item.

Until you have a final "almost perfect" imported dataset, it's usually easier to restore your database backup, update your import file
and/or PDXpert collections, and re-import the ItemMaster.csv  file. See the Restore data from a backup  help topic.

Import your items' relations, materials and file attachments
These files establish bill of materials, source and file relationship between items, and specify relationship properties. All items
in these files are simply matched to document and part records in the database, and do not make any new item records. Your
import of the ItemMaster.csv  data should be complete before importing the relational data files.

Items, not iterations, are matched. Your imported data establishes relationships between the pending iteration of each
matched item.

Before importing each of these files, take a backup of your database. If you're dissatisfied with the import, you can restore
the backup and then edit and re-import the file.

For each parent item row, you can leave many of the columns empty and use the Batch Importer's default values. Blank (empty)
values are specified in the relational import column definition tables.

BOM (bill of materials) import
The BOM import file  identifies the parent-child (or assembly-component) relationship between two items in the PDXpert database,
and adds to this relationship a find-item number, quantity, unit of measure and other data. Before you can import the BOM file, both
assembly parent and component child must exist.

Parent items and child items must only be parts. If you want to add documents to a parent item, import the relationships using the
ItemReferences.csv  file.

If you override any of the default values, ensure that each set of assembly records have no duplicate Find  numbers, that each
Quantity  is a positive number, and the Unit  (if provided) is compatible with (and preferably identical to) the Default unit of measure
selection on the child item's record.

Sources import
Each purchased part-manufacturer source  (parent-child) pair can be given a rank, or preference, on the import row. Since a purchase
part in your PLM database can have more than one approved source, you can use duplicate Rank  values for interchangeable sources.
For example, if there are three equally-qualified primary sources for one purchased part, the import file has 3 rows with the same rank
value 1  for each row.

Add child source parts only to parent purchased parts. A document record cannot be a source parent.

References import
An item-reference  (parent-child) pair links the supporting children to the referencing part or document. For example, an assembly part
may have reference documents that show the assembly procedure, inspection procedure, and calibration procedure. Each of these
documents are shown on the assembly's References  list after the relationships are imported.

Files file
There are separate import formats for revision files, and for item attachments and external links . An item in your PLM database can
have more than one file attached to either of the file lists.

Each listed file is copied from the location specified into the PDXpert library, and the file attributes are extracted, then listed on the item
record's appropriate Files  list.

An imported file attachment must be a fully-qualified folder and filename to a local drive or a network share. If the file is not found at the
location specified, then no file is attached.



Final tasks
After you've imported/updated all of your part and document data:

1. Check that new collection members have correct attributes. Your Sequences: Identifier collection should be updated to
ensure that future item numbers won't conflict with your imported items' identifiers.

2. Re-index the database: Tools ➔ Index Status...  and click the Re-index  button.

1033



Item Master import Home 109

Before importing your data, back up your database . The import tool can make major changes to your database, and can
overwrite data on previously-imported items. You cannot undo the changes it makes; you can only restore your backup
database.

The Batch Importer  tool can make an import file ItemMaster.csv  template. Select Item Masters ⌵  from the dropdown list,
click the Export  button, and save the file to a convenient location. The file contains existing item data, to check earlier
imports or use for updating existing data.

The ItemMaster.csv  file lets you import new items with their pending iterations, and update the item-level attributes of existing items.
Import items can include custom attributes.

Item master data must be imported to provide a foundation for the relational imports of BOMs, sources, references, materials and files.

General guidelines

The header names are not case-sensitive.
Imported items that rely on collections (Part Types, Units of Measure, Make/Buy Categories, etc.) will only be matched to
collection members that exist in the Collection Explorer. However, you can force the system to add new members within
selected collections by marking the Create missing collection member(s)  checkbox. The new member is given only the name, and
the default settings are used for all other values. After importing your data, you should review all new collection members'
attributes to ensure they're set correctly.
The first row of the import file (the "header" row) must contain the column names as specified in this reference, or must match a
custom attribute name that's been specified on a Part Types or Document Types collection member. Custom attributes must
be specified within PDXpert before importing the item file.
Do not include more than one column with the same header name.
Extra (unmatched) columns are ignored.
Every value must conform to the column's specified data type (collection member, string, number, etc.) or be empty. For
example, an attribute that requires a numeric value cannot include non-numeric characters in its value.
The item search engine uses natural language rules, similar to a web search engine. The engine collects search tokens, which
are alphanumeric strings separated by space characters. Punctuation is usually ignored. For best search results, imported item
descriptions, notes, and other text should use space characters between searchable tokens; for example:
Screw, Phillips, M4 x 0.7mm  not Screw,Phillips,M4x0.7mm  See the notes at General (document): Document title  and
General (part): Part name  help topics.

While descriptions with Unicode characters (like cm² and kΩ) might look better, they're often hard to use. For example, searches
are more difficult if some keyboards don't show the character, and older software applications may not know how to import or
display these characters.
Depending upon the custom attribute scheme, there may be one or two columns for each custom attribute. The first column
contains the custom attribute value, and the second column contains the value's unit of measure (for UOM scheme) or currency
code (for Money scheme). This second column isn't used for other custom attribute schemes. If the value of either column is
empty, then the custom attribute's default value is applied.
Special characters: ERP/MRP and other software may export data that's incompatible with Windows. Microsoft Excel can
modify data in unexpected ways. Data copied from Linux and Mac systems, and from some web pages, use incompatible line
endings.

If you're importing Unicode characters, the import file must be encoded as UTF-8, rather than DOS/Windows ANSI.
You can import multi-line text in the larger text fields, such as item Description , RevisionNote , and Notes . The import
file must use Windows CR LF  newline pairs. Linux/Mac software may export LF  only, and some text editors may
remove newlines in the CSV file format.
Do not import newlines into fields that should not have them, such as item Number  and Revision  fields.

Text editors such as Notepad++ can show Unicode and control characters, and enforce encoding. Before importing, inspect
Unicode and non-printing control characters in the CSV file. After importing, check that PDXpert correctly displays the Unicode
and multi-line text.



Import rate is about 50 to 250 items per minute, depending on hardware resources (primarily disk speed) and data complexity
(especially custom attributes). Import from the client's local disk, not from network resources. For each imported data row, the
system checks for duplicates, imports the new item using its type's default values, validates the imported values against the
type's and system's rules, matches collection members, updates default values with the imported values, and adds the item to
the indexing queue. In other words, there's a lot going on.

Importing new items

If this import file specification doesn't define a column for a PDXpert data attribute, then the new item uses the default collection
member. For example, the Item Master import template doesn't contain a column for BOM Type Code  so each imported part
uses the default member in the BOM Type Codes collection, usually Direct material. Before importing, ensure each of your
collections has the correct default member.
All columns except Number  are optional. When a specified column is missing, then the new item uses the default value (if any)
for the column.
Attributes use their default values (if any) unless a different value is given in the column.
Blank values are treated according to the column's data type. If the value is blank and the column expects a:

collection member (say, the CostCurrency ), then the collection's default member (for example, USD) is used.
number, then the default value for that attribute is used.
Boolean (Yes/No), then a No (False) value is used.
text string, then a blank zero-length string is used.

Leading and trailing spaces are removed ("trimmed") from each data element before it's imported.
Each imported item has exactly one iteration, which is imported at a Pending  release state.

Use the Product Families import template  to add product families to new and existing items. The administrator's Add these
product families to every new item that I create  user setting list is not applied during batch importing.

Updating items in the database

Each imported item is matched against all items in the database according to the rules specified in Tools ➔ System Rules... , Item
uniqueness specified by: Number, Organization, Class, Type . All columns except Number  are optional. If a match occurs, then the
item row is not imported, but is used to update the existing part or document record. This update occurs regardless of the
iteration release state (pending, released or canceled) of the existing item.
Leading and trailing spaces are removed ("trimmed") from each data element before it's matched.
If an attribute column is omitted from the import file, then items won't have that column's attribute updated. When the attribute
column exists in the import file, then the current attribute value is replaced. When the imported value is

Empty: the attribute's default value is used.
Not empty: the new value overwrites the previous attribute value.

An item's iteration-level (revision-level) attributes cannot be updated after the item's first release. These are shown as
 Updateable  = No in the table below. If the item has been released, these values are not included in an ItemMaster.csv
export file.

ItemMaster.csv format column definitions
If you use Excel as your CSV file editor, it may make undesired changes to values that it interprets as a number or date. For
example, part number strings beginning with zero (e.g., 01234 ) may be silently converted to a numeric value ( 1234 );
similarly, Excel may convert a text value like 2024-08  to the date Aug-2024 . Consider using a CSV file editor, Windows
Notepad, or other plain text editor (not Word) to edit your import file.

Column name Updateable Data type
Value if
empty

Description

Class No
string Part or
Document

Part
If not specified, then the item's Class  is a part. Part records have
physical attributes like a unit of measure, cost, mass and package
quantity; documents do not.



Owner No Organizations
default

member
Identifies the organization that is primarily responsible for the item's
specification and which issues the item Number . See note 1.

Type No
Document Types

or Part Types
default

member

If not specified, then the appropriate type collection is given by the
item's Class , and the record's Type  selection uses the default member
of the calculated type collection. See note 1.

Number No
string: 1 ≤ length ≤

70 characters
row is

skipped
REQUIRED: This value is imported as the new part or document
Number  value. If the value is empty, the row is not imported.

Revision No
string: length ≤ 10

characters
no value  

Description Yes
string: length ≤

1000 characters
no value

This value is imported as the new Part name  or Document title  value.
See note 6.

Lifecycle No
Item Lifecycle

Phases
default

member

If the value is empty, then the item record Lifecycle phase  is given the
default lifecycle phase (typically Production) according to the
specified Type  value. See note 1.

Trustee Yes Persons
default

member
If the value is empty, then the default person is assigned as the
record's Trustee  selection. See note 1.

DefaultUOM No Units of Measure
default

member

This value applies only to items where Class=Part. If the value is
empty, then the record's Default unit of measure  selection is given the
default Units of Measure collection member (typically each).

MakeBuy Yes
Make/Buy

Categories
default

member

This value applies only to items where Class=Part. If the value is
empty, then the record's Make/buy  selection is given the default
Make/Buy Categories collection member (typically Unspecified).
See note 1.

GlobalNumber Yes
string: length ≤ 50

characters
no value

This value applies only to items where Class=Part. This is imported
into the Global number (GTIN, UPC, etc.)  value.

Location Yes
string: length ≤

1000 characters
no value

This value applies only to items where Class=Part. This value is
imported into the record's part Location  value.

RevisionNote No
string: length ≤

1000 characters
no value

This value is imported into the record's Release description  value. See
note 6.

CostPerUnit Yes double ≥ 0.0 0.0
This value applies only to items where Class=Part, and is used by the
record's Unit cost per default unit  value.

CostCurrencyShort Yes Currencies
default

member

This value applies only to items where Class=Part. Use the
Currencies member's Currency code  value in this column. If the
value is empty, then the record's cost Currency  selection uses the
default Currencies collection member (typically USD).

PackageQty Yes double > 0.0 1.0
This value applies only to items where Class=Part. This is imported
into the Standard packaging quantity  value.

PackageUOM Yes Units of Measure
part's

default
UoM

This value applies only to items where Class=Part. You must ensure
that it's within the same UOM Category as the part's DefaultUOM
value. If the value is empty, then the part's Default unit of measure
(typically each) is assigned as the Standard packaging quantity  unit of
measure selection.

Certify Yes Boolean False
This value applies only to items where Class=Part. This value is
imported into the record's Part requires: Certified  checkbox.



Serialize Yes Boolean False
This value applies only to items where Class=Part. This value is
imported into the record's Part requires: Serialized  checkbox.

Complies Yes Boolean False
This value applies only to items where Class=Part. This value is
imported into the record's compliance checkbox (by default, labeled
Meets regulatory requirements ).

Notes Yes
string: length ≤

32000 characters
no value This value is assigned to the record's Notes  page. See note 6.

EffectiveDate No date no value
This is used for an assembly's Effectivity  or a document's Effective
date  value.

Person1 No Persons
empty
value

This value may not be visible in item record unless the additional
person #1 is enabled in the Part Types or Document Types
collection member. See note 2.

Person2 No Persons
empty
value

This value may not be visible in item record unless the additional
person #2 is enabled in the Part Types or Document Types
collection member. See note 2.

Mass Yes double ≥ 0.0 0.0
This value applies only to items where Class=Part. This is assigned to
the Part mass (weight)  value.

MassUOM Yes
Units of

Measure: Mass /
weight

default
member

This value applies only to items where Class=Part. Use the Mass /
weight member's Name  value in this column. If the value is empty,
then the record's Part mass (weight)  unit of measure selection uses the
default Mass / weight collection member (typically g).

custom (note 5) Yes string no value

Custom attribute value that must be compatible with the specified
scheme (numeric, Boolean, collection, etc.). If the custom attribute's
scheme is a collection (e.g., Countries or Persons), then the value
must exist within the collection.

custom_Unit
(note 5)

Yes collection member
default

unit

Where custom attribute value's scheme is
UOM : unit of measure name (such as each), or
Money : 3-character currency code (such as USD)

Add _Unit  to show the column's relation to the custom attribute; for
example, a custom attribute Length  will have its unit of measure in
the Length_Unit  column.

Notes:
1. The cell must (a) contain an existing collection member Name  value; or (b) be a blank value, which will cause the default member to be assigned;

or (c) contain a new member that will be added if the related Create missing collection member(s)  checkbox is marked. If the value fails these tests,
the row is not imported.

2. The cell must (a) contain an existing collection member Name  value; or (b) be a blank value, which will cause a blank (null) value to be assigned;
or (c) contain a new member that will be added if the related Create missing collection member(s)  checkbox is marked. If the value fails these tests,
the row is not imported.

3. Matching of collection member names is not case-sensitive.
4. String length limits are provided for guidance, but these limits are not enforced during import. Lengths longer than those specified may be

successfully imported but could be difficult to use or may be affected in future releases.
5. Before importing custom attributes, see the Custom attributes  help topic for naming and use guidelines.
6. You can import multi-line text in these and other text fields. The import file must be UTF-8 encoded, and use Windows-compatible CR LF  newline

pairs. Other software (such as ERP/MRP and Excel) may export LF only, may use other file encoding, or may not allow newlines in the CSV file
format. Before importing, inspect text in the CSV file. Check that you do not import newlines in fields that should not have them, such as item
Number and Revision fields.

Definitions
Boolean



A logical True/False or Yes/No value (not case-sensitive). If the value is True  or Yes , then the related checkbox is marked,
otherwise the checkbox is cleared.

date
A date value in the local system format, which is derived from the importing computer's Regional and Language  settings in the
Windows Control Panel. The value must be between 1753-01-01 and 9998-12-31 in the local system date format.

double
A floating-point number, such as 2.5 and 92.5418, formatted using the importing computer's Regional and Language  settings.

string
A series of displayable letter, number and symbol characters, such as BOLT . The length of the string Steel Bolt  is 10
characters. Multi-line text fields can include Windows-compatible CR LF  newline pairs, but not single LF  and CR

characters. Avoid non-printing control characters like NUL , TAB , and most other characters in the range 0x00 to 0x1F.
Characters beyond ANSI/ASCII 0x7F (such as ANSI Extended alphanumeric and Unicode) can be imported using UTF-8
encoding. However, many of these are difficult to use in text searches, and many software applications cannot import them.

value
The complete contents contained between two CSV delimiters.

1024



Iteration-level relational imports Home 110

Use iteration-level relational files to initialize your database from legacy data sources, such as an MRP database or Excel files. These
existing iteration records may have been imported in bulk using the ItemMaster.csv  file, although they can also be made in the
normal course of using PDXpert.

Relational import files add relationships between a parent item's pending iteration and its child items. These relationships are under
change control.

Except in the case of file attachments, the import file simply adds a new relationship between existing items; both parent and child
items must be in the database. Any number of parent items may be in the import file, and each parent can be related to one or more
child items. It's common for some child items to be added to several different parents.

Iteration-level relationships can be added only on a parent item's first pending iteration. After the parent's first pending
iteration is released, do not try to import new relationships for that parent item.

Guidelines for importing iteration-level relationships
Before importing your data, back up your database . The import tool can make major changes to your database, and can
overwrite data on previously-imported items. You cannot undo the changes it makes; you can only restore your backup
database.

Do not try to add or modify an iteration-level relationship after the parent item's first iteration is released. Only item-level data
can be updated after an item's first iteration is released.

If you use Excel as your CSV file editor, it may make undesired changes to values that it interprets as a number. For
example, part number strings beginning with zero (e.g., 001234 ) will often be silently converted to a numeric value ( 1234 ). If
you have any part numbers, document numbers or other data with leading zeroes, don't use Excel. Instead, use a CSV file
editor, Windows Notepad, or other plain text editor (not Word) to edit your import file.

The Batch Importer  tool can make an import file .csv  template. Select the correct Import Type  template, then click the
Export  button. Most export files contain previously-imported pending data that can be used to confirm that the import is

correct.

Import rules

Parent and child items in these import files are matched according to the identification rule specified in Tools ➔ System Rules...
Item uniqueness specified by:  Number, Organization, Class, Type . Columns not specified by the rule ( Class  or Type ) are ignored
during matching.
Iterations (revision and lifecycle) are always ignored in the matching (in fact, none of the relational import files include columns
for specifying iteration values).
Each parent item's list (BOM items, approved sources, references, file attachments) is a complete replacement set. First, the
parent item's entire previous list is deleted. Then, the new list is added. If any one row of the parent's set cannot be imported,
then the list is not imported.
Replacement set members are collected for a parent based on the import file's data. Therefore, the set's parent must be
identified consistently in the import file: if you explicitly identify the class or type for one row, the same values must be used for
all other rows in that parent's set.
The column names in the first row of the import file (the "header" row) must match the definitions in the help topic. The header
names are case-sensitive and must be spelled exactly as shown. Every column with data must have a conforming header. Do
not include more than one column with the same header name.
specified columns may be in any sequence. Extra (undefined) columns in the import file are ignored.
Every value must conform to the column's specified type (collection member, string, number, etc.) or be empty. For example, a
column that requires a numeric value cannot include non-numeric characters.



Leading and trailing spaces are removed from each data element before it's matched or applied. Other space characters are not
affected. For example, the value   many  spaces    becomes many  spaces .

1022



Bill of materials import Home 111

This file defines how PDXpert adds parts to their parent assemblies.

Each row in the import file represents a pending parent assembly and a single pending or released child component. The row also
specifies values such as the quantity of child item required by the parent. The same child part may be added to more than one row on
the parent assembly's BOM list.

This file is used to add parts to the first pending iteration of an assembly. Do not import parts onto any assembly that has a
released or canceled iteration.

For important rules that affect this import, see the Iteration-level relational imports  help topic.

If a pending parent item has an existing list, the parent item's entire previous list is deleted and is completely replaced by the
new list.

The Batch Importer tool can generate a CSV template file, which can be used to import your data. Select List: BOM ⌵  from
the dropdown list, click the Export  button, and save the file to a convenient location.

If you want to import a CAD BOM file into an assembly's BOM markup list, see the Import a CAD BOM  help topic.

Column
name

Data type Value if empty Description

Class string Part Part Must be Part or remain empty.

Owner Organizations
home

organization

Identifies the organization that is primarily responsible for the parent
assembly's specification and which issues the item Number . If not
specified, then the home organization is used.

Type Part Types default member
If not specified, then the parent part is matched against the default
Part Types collection member.

Number string row is skipped
REQUIRED: Part number. If the value is empty, the row is not
imported.

ChildClass string Part Part Must be Part or remain empty.

ChildOwner Organizations
home

organization

Identifies the organization that is primarily responsible for the child
part's specification and which issues the child part Number . If not
specified, then the home organization is used.

ChildType Part Types default member
If not specified, then the child part is matched against the default Part
Types collection member.

ChildNumber string row is skipped
REQUIRED: Part number. If the value is empty, the row is not
imported.

Find integer ≥ 1 last find-item + 1
This value is the Find  row identifier. A parent assembly cannot have
two rows with the same Find  number.

Quantity double > 0 1.0
This value is the row's Quantity  value, and represents the number of
child parts required to produce a parent.

Unit Units of Measure default member If this value is empty, then the part's Default unit of measure  is applied.
If the value is not empty, and the ☑ Lock part default unit of measure on
BOM  system rule is

True: the unit must be the part's default UOM.



False: the unit must be in the same UOM Category as the
part's default UOM.

RefDes
string: length ≤ 32000

characters
no value

This value is used for the child part's RefDes  ("reference designator")
area, and should follow the rules for reference designators .

Notes
string: length ≤ 32000

characters
no value This value is the Notes  area.

Per string Per Assembly Must be Per Assembly, Per Setup, As Needed or remain empty.
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This file defines how PDXpert adds reference items to their parent items.

Each row in the import file represents a pending item—a part or document record—and a single pending or released child reference.
The row can also specify a note on how the child item applies to the parent. The same child item may be used on more than one row
of the parent's References  list.

This file is used to add items to the first pending iteration of a part or a document. Do not import data onto any parent item
that has a released or canceled iteration.

For important rules that affect this import, see the Iteration-level relational imports  help topic.

If a pending parent item has an existing list, the parent item's entire previous list is deleted and is completely replaced by the
new list.

A row is rejected if it contains invalid child items, as specified by the References Tabs system rule for its parent item.

The Batch Importer tool can generate a CSV template file, which can be used to import your data. Select List: References ⌵
from the dropdown list, click the Export  button, and save the file to a convenient location.

Column
name

Data type Value if empty Description

Class string Part or Document Part If not specified, then the parent item's Class  is a part.

Owner Organizations
home

organization
Identifies the organization that is primarily responsible for the parent
item's specification and which issues the item Number .

Type
Document Types or Part

Types
default member

If not specified, then the appropriate type collection is determined by
this parent item's Class , and the default member of the resulting type
collection is used to match the record's Type  selection.

Number string row is skipped
REQUIRED: Part or document number. If the value is empty, the row
is not imported.

ChildClass string Part or Document Part If not specified, then the child item's Class  is a part.

ChildOwner Organizations
home

organization
Identifies the organization that is primarily responsible for the child
item's specification and which issues the item Number .

ChildType
Document Types or Part

Types
default member

If not specified, then the appropriate type collection is determined by
the child item's Class , and the default member of the resulting type
collection is used to match the record's Type  selection.

ChildNumber string row is skipped
REQUIRED: Part or document number. If the value is empty, the row
is not imported.

Row integer ≥ 0 last row + 1
This value is given to the Row  identifier. A parent item can have
several child items with the same Row  value. (Do not mix numbered
values and empty values on the same parent item.)

Notes
string: length ≤ 32000

characters
no value This value is the reference's Notes  area.
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This file defines how PDXpert attaches files to document and part records' pending iterations.

Each row in the import file represents an item record with one file that must be imported into the library, and attached to the pending
iteration's Files: Revision Files  list.

This format imports revision files that are managed under change control.

For historical or background files, use the Item files & links import  format.

This import file is used to add a file to the first pending iteration of a part or a document. Do not import a revision file for
any item that has a released or canceled iteration.

For important rules that affect this import, see the Iteration-level relational imports  help topic.

If a pending parent item has an existing revision files list, the parent item's entire previous list is deleted and is completely
replaced by the new attachments list.

Before each new import, ensure there's enough disk space to accept all files in the import list.

Do not attach multiple files with the same name (including extension) to one item revision.

Do not import a Windows Link ( .lnk ) file. The real data file is not saved, and the link file doesn't contain information that's
useful to other computers.

Windows has a practical device:\path\filename.ext  length limit of 260 characters. Verify that deep folder paths and their
files are within this limit. To avoid problems when users view or copy revision files from PDXpert to their computers, keep
revision filenames under about 80 characters.

Each new import copies revision files into the \Data\Library  folder, even if those files were previously imported. Files that
are no longer needed are not automatically deleted from the folder. Test your import carefully with a small set of data before
importing the complete set of files.

The Batch Importer tool can generate a CSV template file, which can be used to import your data. Select
List: Revision Files ⌵  from the dropdown list, click the Export  button, and save the file to a convenient location. Unlike

many other templates, current file data in PDXpert is not included in the exported CSV file (add a Transforms member if
you need this list).

Column name Data type Value if empty Description

Class string Part or Document Part If not specified, then the parent item's Class  is a part.

Owner Organizations
home

organization
Identifies the organization that is primarily responsible for the parent
item's specification and which issues the item Number .

Type
Document Types or Part

Types
default member

If not specified, then the appropriate type collection is determined by
this parent item's Class , and the default member of the resulting type
collection is used to match the record's Type  selection.

Number string row is skipped
REQUIRED: Part or document number. If the value is empty, the row
is not imported.

RevisionFile file: length ≤ 1000 characters row is skipped REQUIRED: This is the full file path and name of the imported file,
e.g., C:\MyData\MyFile.txt . The file is attached to the item's

Files: Revision Files  list. When the file is copied into the system library,
its attributes are copied to the file's attachment record.



If the file does not exist at the specified path, then the file won't be
attached. If the file is one of several files related to an item, none of
the files will be attached to that item.

It is highly recommended that the imported files are located on the
same physical machine—that is, not on a network or mapped drive—
as the importing PDXpert client.

RevisionFileNote
string: length ≤ 4000

characters
no value This value is imported into the file's Notes  area.
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This file defines how PDXpert adds approved sources to their part records.

Each row in the import file represents a pending home part and a single approved partner source component, which can be pending or
released. The row also specifies values such as the preference rank on the parent.

This file is used to add source parts to the first pending iteration of a purchase part. Do not import parts onto any parent
part that has a released or canceled iteration.

For important rules that affect this import, see the Iteration-level relational imports  help topic.

If a pending parent part has an existing list, the part's entire previous list is deleted and is completely replaced by the new
list.

Do not add the same child part on more than one row on the parent part's Sources: Markup  list.

The Batch Importer tool can generate a CSV template file, which can be used to import your data. Select List: Sources ⌵
from the dropdown list, click the Export  button, and save the file to a convenient location.

Column
name

Data type Value if empty Description

Class string Part Part Must be Part or remain empty.

Owner Organizations
home

organization

Identifies the organization that is primarily responsible for the parent
part's specification and which issues the item Number . If not
specified, then the home organization is used.

Type Part Types default member
If not specified, then the parent part is matched against the default
Part Types collection member.

Number string row is skipped
REQUIRED: Part number. If the value is empty, the row is not
imported.

ChildClass string Part Part Must be Part or remain empty.

ChildOwner Organizations
home

organization

Identifies the organization that is primarily responsible for the child
part's specification and which issues the child part Number . If not
specified, then the home organization is used.

ChildType Part Types default member
If not specified, then the child part is matched against the default Part
Types collection member.

ChildNumber string row is skipped
REQUIRED: Part number. If the value is empty, the row is not
imported.

Rank integer ≥ 1  1
This value is given to the Rank  value, and shows the child part's
standing relative to other approved sources. A parent part can have
several child parts with the same Rank  value.

Notes
string: length ≤ 32000

characters
no value This value is the source's Notes  area.
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Item-level relationships are not under change control. Item-level relational import files can be imported whenever needed.

The import file doesn't make new items, it simply adds a new relationship between existing items. Both parent and child items must be
in the database (except in the case of file attachments, where only the parent item is in the database). Any number of parent items
may be in the import file, and each parent can be related to one or more child items. It's common for some child items to be used on
several different parents.

You can also use item-level relation files to update item files and external links, as well as to keep parts' materials lists current.

Guidelines for importing item-level relationships
Before importing your data, back up your database . The import tool can make major changes to your database, and can
overwrite data on previously-imported items. You cannot undo the changes it makes; you can only restore your backup
database.

If you use Excel as your CSV file editor, it may make undesired changes to values that it interprets as a number. For
example, part number strings beginning with zero (e.g., 001234 ) will often be silently converted to a numeric value ( 1234 ). If
you have any part numbers, document numbers or other data with leading zeroes, don't use Excel. Instead, use a CSV file
editor, Windows Notepad, or other plain text editor (not Word) to edit your import file.

The Batch Importer  tool can make an import file .csv  template. Select the correct Import Type  template, then click the
Export  button. The file contains existing item data, to check earlier imports or use for updating existing data.

Parent and child items in these import files are matched according to the identification rule specified in Tools ➔ System Rules...
Item uniqueness specified by:  Number, Organization, Class, Type . Columns not specified by the rule ( Class  or Type ) are ignored
during matching.
Iterations are always ignored in the matching (in fact, none of the relational import files include columns for specifying iteration
values).
Rows are added cumulatively. That is, you can import a different row without affecting the current list. If you want to replace
an existing materials list, you must explicitly clear the list using the special value specified for that import file.
The column names in the first row of the import file (the "header" row) must match the definitions in the help topic. The header
names are case-sensitive and must be spelled exactly as shown. Every column with data must have a conforming header. Do
not include more than one column with the same header name.
specified columns may be in any sequence. Extra (undefined) columns in the import file are ignored.
Every value must conform to the column's specified type (collection member, string, number, etc.) or be empty. For example, a
column that requires a numeric value cannot include non-numeric characters.
Leading and trailing spaces are removed from each data element before it's matched or applied. Other space characters are not
affected. For example, the value   many  spaces    becomes many  spaces .

1025



Item files & links import Home 116

This file defines how PDXpert attaches item-level files and external links to document and part records.

Each row in the import file represents an item record with
a file that is imported into the library, and attached to the record's Files: Item Files  list; or
an external URI (with protocol such as http:  or file: ) that is attached to the record's Files: Item Files  list.

The import file adds or updates parent-child relationships regardless of the parent item's iteration status (pending, released or
canceled).

This format imports historical or background files and web links that are not under change control.

For revision files under change control, use the Revision files import  format.

For important rules that affect this import, see the Item-level relational imports  help topic.

Rows on the Files: Item Files  list are added cumulatively. That is, you can import a different row (say, a new website link)
without affecting the current list. If you want to replace an existing list, clear the list using the DELETE-ITEMFILE-LIST  or
DELETE-ITEMLINK-LIST  special values.

Before each new import, ensure there's enough disk space to accept all files in the import list.

Do not attach multiple files with the same name to one item record.

Do not import a Windows Link ( .lnk ) file. The real data file is not saved, and the link file doesn't contain information that's
useful to other computers. Use a URI item link if you don't want PDXpert to manage the actual file.

Windows has a practical device:\path\filename.ext  length limit of 260 characters. Verify that deep folder paths and their
files are within this limit. To avoid problems when users view or copy item files from PDXpert to their computers, keep item
filenames under about 80 characters.

A new import copies item files into the \Data\Library  folder. Files that are no longer needed are not automatically deleted
from the folder. Test your import carefully with a small set of data before importing the complete set of files.

The Batch Importer tool can generate a CSV template file, which can be used to import your data. Select
List: Item Files and Links ⌵  from the dropdown list, click the Export  button, and save the file to a convenient location.

Column
name

Data type Value if empty Description

Class string Part or Document Part If not specified, then the parent item's Class  is assumed to be a part.

Owner Organizations
home

organization

Identifies the organization that is primarily responsible for the parent
item's specification and which issues the item Number . If not
specified, then the home organization is used.

Type
Document Types or Part

Types
default member

If not specified, then the appropriate type collection is determined by
this parent item's Class , and the default member of the resulting type
collection is used to match the record's Type  selection.

Number string row is skipped
REQUIRED: Part or document number. If the value is empty, the row
is not imported.

ItemFile file: length ≤ 1000 characters see note 1 This is the full file path and name of the file, e.g.,
C:\MyData\MyFile.txt , that is copied and attached to the
corresponding item's Files: Item Files  list. As the file is copied into the
system library, its attributes are copied to the file's attachment record.



If the file does not exist at the specified path, then the file is not
attached. If the file name is the same as an existing attachment, then
the imported file replaces the existing file. The special value DELETE-
ITEMFILE-LIST  removes all item files (but not links) from the item.

It is highly recommended that the imported files are located on the
same physical machine—that is, not on a network or mapped drive—
as the importing PDXpert client.

ItemFileNote string: length ≤ 4000 characters no value This value is imported into the file's Notes  area.

ItemLink URI: length ≤ 1000 characters see note 1

This identifies the location of an external resource ("URI"), such as a
supplier website. The URI is added to the parent item's

Files: Item Files  list. Your string should conform to a standard URI
scheme, such as http://  or file:// . For example, see
http://en.wikipedia.org/wiki/File_URI_scheme#Windows

The importer warns about an invalid URI (such as UNC) but the value
is accepted. The resource is not checked that it actually exists. If the
URI value is the same as an existing URI, then the URI details (like
date) are updated. The special value DELETE-ITEMLINK-LIST
removes all item links (but not item files) from the item.

Be cautious about importing local URIs, such as network file shares,
where the path may be renamed or deleted. A resource name
resolved using DNS is usually better than a hard-coded IP address.

ItemLinkNote string: length ≤ 4000 characters no value This value is imported into the URI's Notes  area.

Notes:
1. At least one of these two columns must have a value. We recommend importing files and links on separate rows. One data row can import both an

item file and item link, but if either value fails then the entire row (both columns) fails.
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This file defines how PDXpert materials – that is, chemical substances – are added to existing part records.

Each row in the import file represents an item record with a material name, and possible quantity and notes.

The import file adds, updates or deletes part-material relationships regardless of the parent item's iteration status (pending, released or
canceled).

For important rules that affect this import, see the Item-level relational imports  help topic.

Rows on the Materials  list are added cumulatively. That is, you can import a different row (say, a newly-regulated
substance) without affecting the current list. If you want to replace an existing materials list, clear the list using the DELETE-
MATERIAL-LIST  special value.

The Batch Importer tool can generate a CSV template file, which can be used to import your data. Select List: Materials ⌵
from the dropdown list, click the Export  button, and save the file to a convenient location.

Column name Data type Value if empty Description

Class string Part Part Must be a Part or remain empty.

Owner Organizations home organization
Identifies the organization that is primarily responsible for the parent
item's specification and which issues the item Number . If not
specified, then the home organization is used.

Type Part Types default member
If not specified, then the part is matched against the default Part
Types collection member.

Number string row is skipped
REQUIRED: Part number. If the value is empty, the row is not
imported.

MaterialName Materials row is skipped
REQUIRED: If the value is empty, the row is not imported. The special
value DELETE-MATERIAL-LIST  deletes the materials list from the part.
Other rows in the import file can add new materials.

MaterialValue double ≥ 0 0.0 Material's mass quantity or a ratio of material to the total part mass.

MaterialUnit Units of Measure g  (gram)

If this value is
Matched within the UOM category of Mass (e.g., g  or lbm ),
then MaterialValue  is treated as a mass quantity.
Matched within the UOM category of Proportion (e.g., %  or
ppm ), then MaterialValue  mass is calculated using the part's
total mass.
Empty, then the default mass unit of measure (gram) is applied.

MaterialLocation string no value Imported as the material's Location  value.

Part mass and imported materials mass
A part's mass is specified on the part's Materials  page by the Part mass (weight)  value. It can be entered manually or is imported
using the Item Master import format  values of Mass  and MassUOM .

When the materials list is imported, the part's mass is compared to the sum of all materials imported into that part. The imported
materials' MaterialUnit  says how to use the MaterialValue  value:

as a mass by using a mass unit of measure like g  or mg , or
as a proportion by using a ratio unit of measure like %  or ppm , which calculates each imported material's mass from the part's
total mass.



Any Units of measure collection members in the Mass / weight or Proportion (ratio) categories can be used as a MaterialUnit
value.

Part mass (weight)
is…

MaterialUnit
category

Calculation effect

0 (zero) Proportion
The material's proportion of part mass can't be calculated, thus the MaterialValue  is imported as
0.

Equal to the sum of
MaterialValue

Mass or
Proportion

The sum of imported values does not change the part mass, and is 100% of the part mass.

Less than the sum of
MaterialValue

Mass or
Proportion

The part mass is changed to the sum of imported values. If the imported materials list is used to set
the part mass, then the part mass should be 0 before importing.

If the list of imported materials is incomplete (for example, unregulated materials like
water are not imported), then the part's mass in PDXpert is less than the actual part's
mass. While each material's mass is correct, the material's proportion of the part is
overstated.

 If the imported materials list is used to set the part mass, then change the part mass
back to 0 before importing a replacement materials list.

Greater than the sum
of MaterialValue

Mass or
Proportion

The sum of imported values does not change the part mass.

The sum of materials is less than 100% of the part mass. If the part's mass is correct,
then each material's mass and proportion is correct, even if some materials (such as
unregulated materials) are not included in the materials import list.
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This file defines how product families are added to existing document and part records.

Each row in the import file represents an item record with a product family name.

The import file adds, updates or deletes item-product family relationships regardless of the parent item's iteration status (pending,
released or canceled).

For important rules that affect this import, see the Item-level relational imports  help topic.

Rows on the Product Families  list are added cumulatively. That is, you can import a different row without affecting the
current list. If you want to replace an existing list, clear the list using the DELETE-PRODUCT-FAMILY-LIST  special value and
then import the new list.

The Batch Importer tool can generate a CSV template file, which can be used to import your data. Select
List: Product Families ⌵  from the dropdown list, click the Export  button, and save the file to a convenient location. The

exported template includes all items and their product families, if any.

Column name Data type Value if empty Description

Class string Part or Document Part If not specified, then the parent item's Class  is assumed to be a part.

Owner Organizations home organization
Identifies the organization that is primarily responsible for the parent
item's specification and which issues the item Number . If not
specified, then the home organization is used.

Type Part Types default member
If not specified, then the part is matched against the default Part
Types collection member.

Number string row is skipped
REQUIRED: Part number. If the value is empty, the row is not
imported.

ProductFamily Product Families row is skipped

REQUIRED: If the value is empty, the row is not imported.
The special value DELETE-PRODUCT-FAMILY-LIST  deletes the Product
families  list from the part. Other rows in the import file can add new
product families to the empty list.
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This file defines how to add new members of the Groups collection , and add existing members of the Persons collection to the
group.

The import file cannot delete a group, or remove or replace a person in the group.

The Batch Importer tool can generate a CSV template file, which can be used to import your data. Select
Collection: Groups ⌵  from the dropdown list, click the Export  button, and save the file.

Column name Data type Value if empty Description

Name string row is skipped

REQUIRED: Group name. If the value is empty, the row is not
imported. If the Name  value cannot be matched to an existing
collection member, then a new collection member is added; otherwise,
the matching collection member's properties are updated.

Description string no value

Description of group's function or responsibility. A group's rows are
collected into a set, so only one description is applied per import.
Delete this column from the import file if you don't want the description
changed.

Person Persons member no value

If specified, then the text is matched against members of the
Persons collection. If the value is empty, then no person is added. If
the person is specified but cannot be matched, then the row is not
imported.
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The import file adds or updates Materials collection members. Existing database records that link to an updated collection member
show the updated information.

Each row in the import file represents one material record with name and regulatory details.

The Batch Importer tool can generate a CSV template file, which can be used to import your data. Select
Collection: Materials ⌵  from the dropdown list, click the Export  button, and save the file to a convenient location.

Column name Data type
Value if
empty

Description

Name string
row is

skipped

REQUIRED: This is the common or CAS-approved name of the
material. If the value is empty, the row is not imported. If the Name
value cannot be matched to an existing collection member, then a new
collection member is added; otherwise, the matching collection
member's properties are updated.

Description string no value Descriptive information or notes about the material.

CASNumber string no value
The Chemical Abstracts Service (CAS) registry number uniquely
identifies the imported material.

DeclarationCategory string A, B, or N N
This categorizes the material's disclosure requirement as Level A,
Level B, or None. See the Materials collection  help topic for
interpretation.

Threshold double ≥ 0 0.0
This number represents the value that triggers reporting of the
material. If the imported value is negative, it is set to 0.

ThresholdUOM
Units of Measure:
Proportion (ratio)

default
member

Use a Proportion member's complete Name  value—such as %,
ppm, ppb—in this column. If the value is empty, then the default
Proportion member is used.

MaterialCategory Material categories
default

member

The material's category. Use a Material categories member's
Name  value in this column. If the value is empty, then the default
collection member is used.
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The import file adds or updates the Organizations collection  members. Existing database records that link to an updated collection
member show the updated information.

Each row in the import file represents one organization record with name, contact details and classifications.

The Batch Importer tool can generate a CSV template file, which can be used to import your data. Select
Collection: Organizations ⌵  from the dropdown list, click the Export  button, and save the file to a convenient location.

If your data doesn't have DisplayName values, leave the value empty to let the importer create the first set. If you want to
improve on the calculated values, export the collection members, edit any of the calculated values, and import the updated
file with the final values.

Column name Data type Value if empty Description

Name string row is skipped

REQUIRED: This is the name of the company, agency or other
organization. If the value is empty, the row is not imported. If the
Name value cannot be matched to a collection member, then a new
collection member is added; otherwise, the matching collection
member's properties are updated.

DisplayName string
up to 10

characters
Organization's abbreviation or acronym. When empty, an abbreviation
is calculated from the Name value.

DUNS string no value Dun & Bradstreet D-U-N-S nine-digit identification identifier.

DUNS4 string no value
D&B issues a 13-digit (9+4) value that identifies the organization and
its geographic location.

Language Languages default member

The organization's preferred language for communications. Use the
Languages member's Name  value in this column. If the value is
empty, then the default collection member (e.g., English) is used as
the record's selection.

PartnerClassification
Partner

Classifications
default member

The organization's relationship to your own organization. Use the
Partner Classifications member's Name  value in this column. If
the value is empty, then the default collection member (e.g.,
Manufacturer) is used as the record's selection.

CurrencyShort Currencies default member

This is the organization's preferred currency. Use the Currencies
member's Currency code  value in this column. If the value is empty,
then the default collection member (e.g., USD) is used as the record's
selection.

URL string no value The organization's home page or intranet page.

POBox string no value Post office box number.

Street string no value Physical street address.

City string no value City.

Region string no value State, province or similar area.

PostalCode string no value ZIP, PIN or similar post code. See note 1.

Country Countries default member
Use the Countries collection member's Name  value in this column.
If the value is empty, then the default collection member (e.g., United
States of America) is used as the record's selection.



EmailPrimary string no value Primary email address (email 1).

EmailSecondary string no value Secondary email address or IM/chat identifier (email 2).

PhoneMain string no value Main office phone number (phone 1).

PhoneFax string no value Facsimile phone number (phone 2).

PhoneAlternate string no value Alternate/mobile phone number (phone 3).

PhoneEmergency string no value Emergency/pager phone number (phone 4).

Notes string no value Miscellaneous information.

Notes:
1. Do not update this value for the home (default) organization. It is specified in the software license key. Differences during import may disable your

license. Use the Tools ➔ Software License Key…  menu to import a new license with the correct postal code.
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This file defines how to add new members of the Product Families collection , and add existing members of the Persons collection
to the Product Team.

The import file cannot delete a product family, or remove or replace a person in the Product Team.

Rows on the Product Team  list are added cumulatively. That is, you can import a different row without affecting the current
list. If you want to replace an existing list, clear the list using the DELETE-PERSON-LIST  special value and then import the new
list.

The Batch Importer tool can generate a CSV template file, which can be used to import your data. Select
Collection: Product Families ⌵  from the dropdown list, click the Export  button, and save the file.

Column name Data type Value if empty Description

Name string row is skipped

REQUIRED: Product family name. If the value is empty, the row is not
imported. If the Name  value cannot be matched to an existing
collection member, then a new collection member is added; otherwise,
the matching collection member's properties are updated.

Description string no value

Description of product family's function or responsibility. A product
family's rows are imported one row after the next, so only the final
description is applied (including empty descriptions). Delete this
column from the import file if you don't want the description changed
while working with the Product Team list.

TeamPerson Persons member no value

If specified, then the text is matched against members of the
Persons collection. If the value is empty, then no person is added. If
the person is specified but cannot be matched, then the row is not
imported.
The special value DELETE-PERSON-LIST  deletes the Product Team
persons from the product family. Other rows in the import file can add
new persons to the empty list.
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The import file adds or updates the Persons collection  members. Existing database records that link to an updated collection
member show the updated information.

Each row in the import file represents one person, with their name and contact details. A row may include optional information for
adding a user account for the person. A person's user account cannot be updated or deleted using this import file.

The person record is always added before the user account. If the person import fails, then the account cannot be added. An import
failure is counted if either the person or the user account, or both, cannot be added.

The Batch Importer tool can generate a CSV template file, which can be used to import your data. Select
Collection: Persons ⌵  from the dropdown list, click the Export  button, and save the file to a convenient location.

Column name Data type Value if empty Description

Name string row is skipped

REQUIRED: This is the full name of the person. If the value is empty,
the row is not imported. If the Name  value cannot be matched to an
existing collection member, then a new collection member is added;
otherwise, the matching collection member's properties are updated.

JobTitle string no value The person's job function

Organization Organizations default (home) member
The person's organization or affiliation. Use the Organizations
member's Name  value in this column. If the value is empty, then the
home organization is assigned.

EmployeeID string no value
The person's employee number (do not use any identifier that should
remain private).

Supervisor Persons no value
This is the person's manager, which may be useful for preferred
currency. Use the Persons member's complete Name  value in this
column. If the value is empty, then no value is used.

StartDate date record import date
The date when a person joined the organization, or first had access to
PDXpert.

EndDate date no value
The date when a person left the organization, or last had access to
PDXpert.

POBox string no value Post office box number.

Street string no value Physical street address.

City string no value City.

Region string no value State, province or similar area.

PostalCode string no value ZIP, PIN or similar post code.

Country Countries default member
Use the Countries collection member's Name  value in this column.
If the value is empty, then the default collection member (e.g., United
States of America) is assigned.

EmailPrimary string no value Primary email address (email 1).

EmailSecondary string no value Secondary email address or IM/chat identifier (email 2).

PhoneMain string no value Main office phone number (phone 1).

PhoneFax string no value Facsimile phone number (phone 2).



PhoneAlternate string no value Alternate/mobile phone number (phone 3).

PhoneEmergency string no value Emergency/pager phone number (phone 4).

Access string FF or RO no value

The user account is added if:
the Persons collection member does not have a user account;
and
there are available user accounts remaining on the license; and
the access value is specified as FF or RO.

Role Roles default member
Use the Roles collection member's Name  value in this column. If the
value is empty, then the default collection member (e.g., Normal user)
is used.

AccountName string no value
If the value is empty or has been given to a different user account,
then the user account is not added.

Password string no value
If the value is empty, the new user account has a blank (empty)
password.
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The import file adds or updates custom collection members. Existing database records that link to an updated collection member show
the updated information.

Each row in the import file represents a custom collection member record that's added to an existing custom collection.

The Batch Importer tool can generate a CSV template file, which can be used to import your data. Select
Collection: Custom Members ⌵  from the dropdown list, click the Export  button, and save the file to a convenient location.

Column name Data type Value if empty Description

CollectionName string row is skipped
REQUIRED: If the value is empty or the Custom  collection does not
exist, then the row is not imported. Otherwise, this row is matched to
an existing custom collection.

Name string row is skipped

REQUIRED: If the value is empty, the row is not imported. If the
collection member exists, then the collection member's Abbreviation
and Description  fields are updated. Otherwise, a new member is
added. See note 1.

Abbreviation string no value This value is imported into the collection member's Abbreviation  field.

Description string no value This value is imported into the collection member's Description  field.

Notes:
1. If the custom collection has no members, then the first data row in the import file is used as the default member of the collection. This can be

edited after the import.
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The PDXpert database includes a set of read-only views that contain part, document and change form records. You can use these
views as the basis for Transforms and, via an Open Database Connectivity ("ODBC") client, extract data for part lookup, reporting
and other applications.

There are 3 kinds of read-only views within PDXpert:

Public views are built into the PDXpert database. They can provide data to ODBC clients, SQL Server client applications,
Transforms, or user-specified views.
Changes to the PDXpert database attempt to keep public views as stable as practical, minimizing rework to your queries after
an upgrade.
The viewer  schema contains the most recent pending and released items. If both pending and released relationships exist, the
pending relationship is shown. These views are used primarily for item-level look-up data for CAD and for client-side local
database queries.
Public views always end with the characters …View  (such as ItemView ). Within the view's name, …Pair…  is a parent-child (for
example, assembly-component) view. …Master…  views include each item's custom attributes.
An ODBC client using a public view directly must

handle all data types/sizes in the table; or
SELECT only those columns that contain data types that it can handle.

Otherwise, the ODBC client application must extract compatible data from a public view via a user-specified view.
User-specified views ("UDV") can be added to the PDXpert database using the Views collection, in the Collection Explorer's
General  group. UDVs select data from public views and other user-specified views to support CAD applications on the PDXpert
client computer. A UDV can exclude columns, filter data, perform calculations, reformat data and CAST()  data types to other
more convenient types. User-specified views are always contained in the viewer  schema, and begin with the characters My… ;
for example, viewer.MyReleasedParts .
A UDV selects data from a limited set of public views ( viewer.ItemView , viewer.ItemMasterView ,
viewer.SourceItemMasterView , and viewer.FilePairMasterView ) that are created on the client. The UDV query SELECT
statement must conform to SQLite or SQL Server syntax, depending on the option chosen in the User Settings: Enable local
views  option.
Private views are written to support internal requirements of the PDXpert application, and normally used only for advanced
queries. These views may be modified or deleted when upgrading to a new PDXpert release; queries using these should be
tested and updated after an upgrade. Private views are always contained in SQL Server's default dbo  schema, and end with
the characters …_View ; for instance, dbo.Item_View  or just Item_View .

Client-side and server-side connections
Product data is contained in the server machine's Microsoft SQL Server database, and a subset can be copied to the SQLite or SQL
LocalDB database on the client workstation. Client-side views are designed for fast and secure CAD part lookup. More powerful and
flexible server-side views are useful for general reporting and data extraction to downstream systems, such as ERP/MRP. See the
Make an ODBC connection  help topic.

Effect of PDXpert upgrades
Do not add your own views, tables, functions or other objects to the PDXpert ( PDXpertDB ) database. Views are often deleted
and rebuilt during an upgrade, and PDXpert will not know how to rebuild your views. Unknown objects may interfere with
normal operations or damage your data. Use a separate database to contain your own database objects.

Public views typically remain stable from one release to the next. Revisions to public views are given in the upgrade's release notes.

User-specified views contained in the PDXpert Views collection are retained during upgrades. After upgrading to a new PDXpert
release, test (and, if needed, update) user-specified views.
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An Open Database Connectivity ("ODBC") driver enables compatible third-party software – CAD, MRP, reporting tools, office
applications – to read data from PDXpert's database using industry-standard database queries.

Many ODBC client applications, such as Microsoft Access, will have their own connection instructions or wizard. Look for a
"connect to external data" or similar command.

The most recent Microsoft ODBC Driver for SQL Server is preferred for all new development. Microsoft is deprecating the
SQL Server OLE DB provider and the SQL Server Native Client for Windows.

ODBC connection options

Connecting to client-side SQLite or SQL LocalDB

Advantages of using SQLite or SQL LocalDB on the client workstation:

Some data is materialized locally to increase query performance.
Data obtained from local views has no network delay.
Even when the workstation is disconnected, the local database provides static snapshot of previous part data.
The server-side SQL Server can be completely firewalled from the network.

When you enable local views, the SQLite database is automatically installed. However, SQL Server LocalDB is recommended because
queries are compatible with, and can be tested on, the server instance. If you prefer to use SQL Server LocalDB, then you must install
it as given in the PDXpert Installation Guide on-line: search the web for PDXpert LocalDB client

Connecting to server-side SQL Server
This is the recommended connection to the PDXpert database instance.



Advantages of using SQL Server on the server computer:

SQL Server can manage concurrent queries.
Data obtained from the server is immediately available, and has no refresh delay.
Any public view (not just the CAD-related basic subset) can be used in queries.
Queries can use SQL Server's full range of built-in data manipulation functions.
Table column names are somewhat more flexible for Custom Attribute names.
The local workstation doesn't require the PDXpert client to update its data.
SQL Server offers powerful development tools with better documentation, support and complementary products.
The PDXpert client starts faster because there's no client-side data to download.

If your PDXpert system uses SQL Server LocalDB, then you must upgrade to SQL Server Express (or higher) and open firewall ports
to access the database from client workstations.

Using client-side local views with SQLite ODBC driver
SQL Server LocalDB is a different client-side database option. It may be used where SQL Server compatibility, multi-session
access and performance are important. LocalDB supports some CAD applications that don't access SQLite as a shared
resource. See the PDXpert Installation Guide on-line (search the web for PDXpert LocalDB client ).

The PDXpert client can enable a subset of public views and user-specified views for use with CAD or other local applications. These
local views are contained in a SQLite database that PDXpert makes when the ☑ Enable local views: Using SQLite database  user setting is
marked.

SQLite ODBC driver setup
The following example procedure uses a free open source SQLite3 driver. If you use a commercial SQLite ODBC driver, follow the
supplier's installation and DSN configuration procedure instead.

1. Enable the PDXpert.db  database file on the client workstation.
A. Open the PDXpert client application.
B. From the Tools  menu, select the User Settings...  command.
C. On the User Settings  tool, mark ☑ Enable local views  with the Using SQLite database  option. Save the setting: Item ➔

Save , or Ctrl + S .

The ☑ Enable local views  option is available only when the current user has been given a Roles collection
member that includes the ☑ Allow local views on user computer  permission. If local views are not enabled, then
the client machine's local views database is not made or, if made before, is no longer refreshed.

2. The SQLite3 ODBC driver is available at http://www.ch-werner.de/sqliteodbc/ . When connecting 64-bit CAD tools, install
the 64-bit version of the driver. When connecting 32-bit tools, install the 32-bit version.

3. Click on the Windows Start  menu and select the Control Panel , and then select Administrative Tools . Open the Data Sources
(ODBC)  tool.

4. On the ODBC Data Source Administrator  window, select the User DSN  tab, and click the Add...  button. The
Create New Data Source  window opens.

5. From the list of drivers, select the SQLite3 ODBC Driver . Click the Finish  button.
6. On the SQLite3 ODBC DSN Configuration  window, do the following:

Enter a Data Source Name : PDXpertSQLite3 .
Click the Browse...  button, navigate to the %LocalAppData%\PDXpert  folder (similar to
C:\Users\user\AppData\Local\PDXpert ), and select the PDXpert.db  file.
Enter a Lock Timeout [ms] : 10000  (10 seconds).
Select from Sync.Mode : NORMAL ⌵ .

Click the OK  button to close the DSN configuration window.
Click the OK  button to close the ODBC Data Source Administrator  window.

Developing a SQLite ODBC query



The PDXpert.db  database has data objects in three categories:

A set of public views that your ODBC client can query directly. These end with …View  (for example, ItemView ).
Client user-specified views that are saved as members of the PDXpert Views collection. These begin with My…  (for example,
MyReleasedParts ). Although all Views collection members are shown, your ODBC client can query SQLite views only using
SQLite-compatible syntax.

See view naming tips and query limitations in the Views collection  help topic.

Private views are prefixed as _Private . Do not query these tables, as their design can change.

Develop queries for your ODBC client application using a SQLite development tool. Search the web for SQLite manager  or similar,
and install your preferred tool.

Example: DB Browser for SQLite at http://sqlitebrowser.org

Using instructions from your installed development tool, select the PDXpertSQLite3  data source to access the PDXpert.db
database. This is usually done using the Select Data Source  window and clicking on the Machine Data Source  list. The PDXpert.db
database is located in the %LocalAppData%\PDXpert  folder. It does not require user name or password.

Do not add new or delete tables or views in the PDXpert.db  database. Use only SELECT  statements; do not update or delete
any data contained in the database.

Using a SQLite ODBC query with your ODBC client application
Using instructions from your installed ODBC client, select the PDXpertSQLite3  data source to access the PDXpert.db  database.
This is usually done using the Select Data Source  window and clicking on the Machine Data Source  list. The PDXpert.db  database is
located in the %LocalAppData%\PDXpert  folder. It does not require user name or password.

After the queries are developed, add a new Views collection member with the desired SQL statement. Your ODBC client obtains the
desired data from the named view.

Using the server-side SQL Server with Microsoft's ODBC driver
If your PDXpert system uses the SQL Server LocalDB database, you must replace it with SQL Server Express (or higher) to
allow connections from network computers. After this install, use the PDXpert Application Server's Change Database Server
button to move the database from SQL Server LocalDB into the new SQL Server instance.

Microsoft often changes the ODBC driver; for current information, search the web for
Microsoft ODBC Driver for SQL Server on Windows . Some ODBC drivers will show or hide the schema (such as dbo

and viewer ), which may affect your client application. Your ODBC client application may have different requirements, and
you should follow those instructions instead.

If SQL Server is installed on a network computer, you may also need to:
Use the SQL Server Configuration Manager application to enable the Named Pipes and TCP/IP protocols within SQL
Native Client Configuration  + Client Protocols , and SQL Server Network Configuration  + Protocols for PDXPERT . Microsoft
SQL Server must be restarted before the changes will take effect.
Make sure that the firewalls and/or antivirus on both server and network computers allow communication to the SQL
Server TCP port. Seach the web for Microsoft's help topic
Configure the Windows Firewall to Allow SQL Server Access

SQL Server ODBC driver: Initial setup
This example makes a database source name ( .dsn ) file.

1. Click on the Windows Start  menu and select the Control Panel , and then select Administrative Tools . Open the Data Sources
(ODBC)  tool.



2. On the ODBC Data Source Administrator  window, select the File DSN  tab, and click the Add...  button. The
Create New Data Source  window opens.

3. From the list of drivers, select the most recent version of ODBC Driver for SQL Server  driver. Click the Next  button.
4. Provide a new file name, such as PDXpertSQLViewer , and ensure that you know where the file will be saved. Click the Next

button.
5. After you confirm the summary, click the Finish  button. The basic file is saved, and a new page accepts more details.
6. Enter a Description  (such as PDXpert SQL viewer data source ). In the Server  location, enter the fully-qualified server

machine name and SQL Server instance name, such as PLMSERVER\PDXPERT . Click the Next  button.
7. Select the With SQL Server authentication  option to make sure that SQL Server examines the log-in ID. Apply the appropriate

log-in ID  and Password  values, and click the Next  button.

Use the default log-in name PDXpertViewer  and password By2Go4Me8  unless you've added a different account or
changed the password. You can manage log-in accounts using Microsoft's SQL Server Management Studio.

8. Mark the checkbox to set the default database to PDXpertDB . Click the Next  button.
9. If you want to encrypt the data, mark the ☑ Use strong encryption for data  checkbox and, depending on your server

configuration, the ☑ Trust server certificate  checkbox. If you're on a trusted network, clear both checkboxes to avoid certificate
errors. Click the Finish  button.

10. Click the Test Data Source...  button to make sure that your connectivity settings are correct. You should see the message
TESTS COMPLETED SUCCESSFULLY!

If you have errors making the connection, examine your Microsoft SQL Server configuration, firewall and antivirus settings,
and ODBC client application's connection procedure. (See the next section to add a port number to the DSN file.) ODBC
clients must account for differences in 32b/64b applications and operating systems. Microsoft offers extensive help on the
web. For example: Microsoft ODBC Driver for SQL Server
https://docs.microsoft.com/en-us/sql/connect/odbc/microsoft-odbc-driver-for-sql-server . At the time of writing,
Microsoft offers a wizard for Solving connectivity errors to SQL Server
https://support.microsoft.com/en-us/help/4009936/solving-connectivity-errors-to-sql-server

SQL Server ODBC driver: Final settings
The .dsn  file is a simple text file containing the connection information. It can be viewed and edited by Windows Notepad or similar
text editor. This example includes the PWD=  argument to simplify log-in.

[ODBC]
DRIVER=ODBC Driver XX for SQL Server
UID=PDXpertViewer
PWD=By2Go4Me8
SERVER=PLMSERVER\PDXPERT
DATABASE=PDXpertDB
WSID=PLMCLIENT
APP=Microsoft® Windows® Operating System
DESCRIPTION=PDXpert SQL viewer data source

If your SQL Server is listening on a port other than the default port, then the SQL Server log file will show the port number:

07/18/2019 12:34:56,Server,Unknown,Server is listening on [ 'any' <ipv4> 16361].

Add the address parameters to the DSN file using the server's IP address or machine name ( ADDRESS=server,port ):

ADDRESS=10.1.1.1,16361
ADDRESS=PLMSERVER,16361

Using SQL Server Management Studio
SQL Server Management Studio can be used to develop views which, after testing, can be saved as members of the Views collection.

SQL Server Management Studio is both powerful and potentially dangerous to your PDXpert database. The complete set of
undocumented PDXpert database tables and private views may be visible. These private objects, which use the default Database
Owner ( dbo ) database schema, are compiler-generated and may change from one release to the next.



Use only SELECT  commands, and only objects within the viewer  and released  database schemas. Only very experienced
SQL developers should consider updating or deleting data in the PDXpert PLM database.

Do not add your own table, view, stored procedure, or other resource directly into the PDXpertDB database. A PDXpert
system upgrade deletes unknown objects before rebuilding public views and members of the Views collection. Make a
separate database to hold your own objects.

When writing SQL code, query views, not tables.

PDXpert PLM database objects may change after an upgrade. Where possible, base your queries on public views and user-
specified views.

PDXpert's documented public views, as well as members of the Views collection, are within the safe viewer  database schema, such
as PDXpertDB.viewer.ItemView  or PDXpertDB.viewer.MyReleasedParts .

The default public views log-in name is PDXpertViewer  and password is By2Go4Me8 , unless you add a different account or change
the password. You can manage log-in accounts using Microsoft's SQL Server Management Studio.

1172



ItemView & ItemMasterView reference Home 127

The ItemView  contains all part and document records with standard item attributes. The ItemMasterView  contains all columns of the
ItemView  plus all custom attributes. These views are available in both the viewer  and the released  schemas.

A basic SQL statement is SELECT * FROM ItemView

The Class  column is coded: the value 1  specifies that the item is a part, while the value 2  shows that it's a document. For
example:

SELECT ClassName = CASE Class WHEN 1 THEN 'Part' WHEN 2 THEN 'Document' ELSE 'Unknown' END FROM ItemView

All dates are shown using SQL Server's default format. If you need a different format, such as ISO 8601, then a conversion is required.
For example:

SELECT convert(varchar(23),CostDate,126) AS IsoCostDate FROM ItemView

Booleans ("checkbox values") are zero or non-zero integers. A value =0  is false while value <>0  is true. Null values are possible.
For example:

SELECT
 CASE
  WHEN [Complies]<>0 THEN 'Pass'
  WHEN [Complies]=0 THEN 'Fail'
  ELSE 'Unknown'
  END AS CompliesState
FROM viewer.ItemView

You can use the IsCanceled , Revision  and PendingRevision  values in the viewer  schema to obtain insight into the item's
current release state.

Release state IsCanceled Revision PendingRevision

Pending false null not null

Released false not null null

Released (with Pending) false not null not null

Canceled true not null null

Canceled (with Pending) true not null not null

Both of these views are also contained in the local views database. Client-side ODBC applications can select from these
views and from SQLite-compatible Views collection members based on these views.

Column definitions
There may exist in the view one or more "housekeeping" columns that have been reserved for PDXpert's private use. These
columns' names begin with the prefix HK  (for instance, HK1 ). Housekeeping columns may be changed or eliminated in a
future PDXpert release. These columns are not documented, and you should ignore them in your SQL queries. Do not add
any custom attributes that use the HK  prefix. You may want to make a user-specified view that excludes the housekeeping
columns.

The column sequence may not be exactly as shown in this table, and may change in a future PDXpert release. Use the
column name, not ordinal position, in your SQL queries.

Column name Note Data type Attribute name



ItemId   GUID (item primary key) unique record identifier; not visible within PDXpert client

Class   integer 1 (part) or 2 (document) item Class

Owner   Organizations Name item Owner

OwnerShort   Organizations Display name item Owner

IsHomeItem 1 Boolean calculated; not visible within PDXpert client

Type   Document Types or Part Types Name item Type

TypeShort  
Document Types or Part Types

Abbreviation
item Type

Number   string item Number

RevID 2 GUID (iteration primary key)
unique released (or canceled) record identifier;

not visible within PDXpert client

IsCanceled   Boolean
released iteration has been canceled

not visible within PDXpert client

Revision 2 string released (or canceled) iteration's Revision

RevisionNote 2 string released (or canceled) iteration's Revision description

PendingRevID   GUID (revision primary key)
unique pending record identifier;
not visible within PDXpert client

PendingRevision   string pending iteration's Revision  value

PendingLifecycle   Item Lifecycle Phases Name pending iteration's Lifecycle phase

PendingRelativeMaturity  
Item Lifecycle Phases Relative maturity

integer
pending iteration's Lifecycle phase  maturity value

PendingRevisionNote   string pending iteration's Revision description

ReleasedOn   date released iteration Released  date

EffectiveOn   date
released iteration Effective date  (document) or Effectivity

(assembly)

Description   string item Document title  or Part name

Lifecycle 2 Item Lifecycle Phases Name released iteration's Lifecycle phase

RelativeMaturity 2
Item Lifecycle Phases Relative maturity

integer
released iteration's Lifecycle phase  maturity value

Version 2 string released iteration Version

Trustee   Persons Name item Trustee

DefaultUoM 3 Units of Measure Name part Default unit of measure

MakeBuy 3 Make/Buy Categories Name part Make/buy

GlobalNumber 3 string part Global number (GTIN, UPC, etc.)

Location 3 string part Location



Handling 3 Handling/Storage Categories Name part Handling/storage advisory

Recovery 3 Recovery Methods Name part End of life recovery method

CostPerUnit 3 real number part Unit cost per default unit  value

CostCurrencyShort 3 Currencies Code part Unit cost per default unit : Currency

CostDate 3 date part Unit cost per default unit : As on

PackageQty 3 integer part Standard packaging quantity  value

PackageUOM 3 Unit of Measures Name part Standard packaging quantity  units

Certify 3 Boolean part Part requires: Certification

Serialize 3 Boolean part Part requires: Serialization

Complies 3 Boolean part Meets regulatory requirements

Notes   string item Notes

ProductFamily   string semicolon-delimited list of item Product families

Mass 3 double part Part mass (weight)  value

MassUOM 3 Mass / weight Name part Part mass (weight)  unit of measure

custom 4 string custom attribute text or numeric value

custom_Member 4 collection member Name
custom attribute value's UOM or currency units, or other

collection member

Notes:
1. A True value represents a home part or document; a False value is a partner item. This value will never be NULL.
2. If the item has neither a released nor canceled iteration, then the iteration-related value (e.g., RevID ) is null.
3. Document rows (that is, where Class  is 2) are NULL for part attributes.
4. These columns are included in the ItemMasterView, and are not in the ItemView. Custom attribute ("CA") names are shown in value/unit columns;

the name is used in the column header. All identically-named CAs are shown in the same column, regardless of item type. Where a custom
attribute name conflicts with a system reserved attribute name (such as Number  or Type ) then your custom attribute name is shown with a leading
underscore ( _Number  or _Type ). See the Custom attributes  help topic for naming guidelines. If a custom attribute name is longer than 120
characters, it is truncated. Custom attribute values are NULL if the item hasn't been assigned the custom attribute.
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The ReferencePairView  and ReferencePairMasterView  are parent-child lists of items and their reference items. The view is a side-
by-side set of the parent item attributes; a single child item's attributes; and the parent-child relation attributes of row number and
notes. The parent part or document may have zero, one, or many child reference records.

The ReferencePairView  is derived from the ItemView  list of items, and excludes custom attributes from the parent and child items.
The ReferencePairMasterView  is derived from the ItemMasterView  list of items, and includes custom attributes.

When a parent item has a pending iteration (that is, the PendingRevID  is not null), then its markup row numbers, items, and notes are
displayed. When a parent item has only a released iteration ( RevID  is not null, IsCanceled  is false, and the PendingRevID  is null),
then it displays each current released child iteration ( Revision_Child , Lifecycle_Child , etc.) with row numbers and notes. If a child
item has a pending iteration, that's shown in separate columns ( PendingRevision_Child , PendingLifecycle_Child , etc.) but is not
yet assigned to the parent's current configuration. A query that requires the current released parent must test that the parent
PendingRevID  is null and IsCanceled  is false.

The basic SQL statement is SELECT * FROM ReferencePairView

Column definitions
There may exist in the view one or more "housekeeping" columns that have been reserved for PDXpert's private use. These
columns' names begin with the prefix HK  (for instance, HK1 ). Housekeeping columns may be redefined or eliminated in a
future PDXpert release without notice. These are not documented, and you should ignore these columns in your own SQL
queries. Do not create any custom attributes that use the HK  prefix. You may want to create a user-defined view that
excludes the housekeeping columns.

The column ordering may not be exactly as shown in this table, and may change in a future PDXpert release. Use the
column name, not ordinal position, in your SQL queries.

ReferencePairView

Column name Data type Record attribute

ItemId ... Notes see: ItemView columns parent item standard attributes

ItemId_Child ... Notes_Child see: ItemView columns child item standard attributes

Row integer reference Row  number

RowNotes string reference row Notes

ReferencePairMasterView

Column name Data type Record attribute

ItemId ...  custom_Member see: ItemMasterView columns parent item standard and custom attributes

ItemId_Child ... custom_Member_Child see: ItemMasterView columns child item standard and custom attributes

Row integer reference Row  number

RowNotes string reference row Notes
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The SourcePairView  and SourcePairMasterView  are parent-child lists of all items. A parent may have zero or more source child
records. If a source child exists, the child's item attributes, preference rank and notes are included in the row; otherwise, these values
are null.

The SourcePairView  is derived from the ItemView  list of items, and excludes custom attributes from the parent and child items. The
SourcePairMasterView  is derived from the ItemMasterView  list of items, and includes custom attributes.

When a parent part has a pending iteration (that is, the PendingRevID  is not null), then it displays the markup rank, items, and notes.
When a parent part has only a released iteration (the PendingRevID  is null, RevID  is not null, and IsCanceled  is false), then it
displays the current released child iteration ( Revision_Child , Lifecycle_Child , etc.) with rank and notes. If a child part has a
pending iteration, that's shown in separate columns ( PendingRevision_Child , PendingLifecycle_Child , etc.) but is not yet assigned
to the parent's current configuration. A query that requires the current released parent must test that the PendingRevID  is null and
IsCanceled  is false.

A basic SQL statement is SELECT * FROM SourcePairView

Column definitions
There may exist in the view one or more "housekeeping" columns that have been reserved for PDXpert's private use. These
columns' names begin with the prefix HK  (for instance, HK1 ). Housekeeping columns may be redefined or eliminated in a
future PDXpert release without notice. These are not documented, and you should ignore these columns in your own SQL
queries. Do not create any custom attributes that use the HK  prefix. You may want to create a user-defined view that
excludes the housekeeping columns.

The column ordering may not be exactly as shown in this table, and may change in a future PDXpert release. Use the
column name, not ordinal position, in your SQL queries.

SourcePairView

Column name Data type Record attribute

ItemId ...  Notes see: ItemView columns parent item standard attributes

ItemId_Child ...  Notes_Child see: ItemView columns approved source item standard attributes

Rank integer source row Rank

RowNotes string source row Notes

SourcePairMasterView

Column name Data type Record attribute

ItemId ... custom_Member see: ItemMasterView columns parent item standard and custom attributes

ItemId_Child ... custom_Member_Child see: ItemMasterView columns approved source item standard attributes

Rank integer source row Rank

RowNotes string source row Notes
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The SourceItemMasterView  is specifically intended for use in a CAD environment for part look-up, where the CAD tool may require
dedicated custom parameters and/or display up to three approved part sources.

The SourceItemMasterView  identifies a parent item and up to 3 approved sources side-by-side; each set of source columns are
identified by the suffixes _1 , _2 , and _3 . The parent item's columns are identical to the ItemMasterView  columns. Source item
columns are obtained from the ItemView  list (without custom attributes). Sources are listed in the order defined by the Rank  shown on
the parent list. Sources sharing the same rank value do not have a specified column order.

When a parent part has a pending iteration (that is, the PendingRevID  is not null), then it displays the markup rank numbers, items,
and notes. When a parent part has only a released iteration (the PendingRevID  is null, RevID  is not null, and IsCanceled  is false),
then it displays the current released child iteration ( Revision_Child , Lifecycle_Child , etc.) with rank and notes. If a child part has a
pending iteration, that's shown in separate columns ( PendingRevision_Child , PendingLifecycle_Child , etc.) but is not yet assigned
to the parent's current configuration. A query that requires the current released parent must test that the parent PendingRevID  is null
and IsCanceled  is false.

The basic SQL statement is SELECT * FROM SourceItemMasterView

This view is also contained in the local views database. Client-side ODBC applications can select from this view and from
SQLite-compatible Views collection members based on this view.

Column definitions
There may exist in the view one or more "housekeeping" columns that have been reserved for PDXpert's private use. These
columns' names begin with the prefix HK  (for instance, HK1 ). Housekeeping columns may be redefined or eliminated in a
future PDXpert release without notice. These are not documented, and you should ignore these columns in your own SQL
queries. Do not create any custom attributes that use the HK  prefix. You may want to create a user-defined view that
excludes the housekeeping columns.

The column ordering may not be exactly as shown in this table, and may change in a future PDXpert release. Use the
column name, not ordinal position, in your SQL queries.

Column name Data type Record attribute

ItemId ...  custom_Member refer to the ItemMasterView reference  help topic parent item standard and custom attributes

Rank_1 integer source 1 row Rank

RowNotes_1 string source 1 row Notes

Class_1 ... Notes_1 see: ItemView columns source 1 item standard attributes

Rank_2 integer source 2 row Rank

RowNotes_2 string source 2 row Notes

Class_2 ... Notes_2 see: ItemView columns source 2 item standard attributes

Rank_3 integer source 3 row Rank

RowNotes_3 string source 3 row Notes

Class_3 ... Notes_3 see: ItemView columns source 3 item standard attributes
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The StructurePairView  and StructurePairMasterView  are parent-child lists of all BOM items. The view is a side-by-side set of the
parent item attributes; a single child item's attributes; and the parent-child relation attributes such as find (row) number, quantity and
unit of measure. The parent (typically an assembly) may have zero, one, or many child (component) records.

The StructurePairView  is derived from the ItemView  list of items, and excludes custom attributes from the parent and child items.
The StructurePairMasterView  is derived from the ItemMasterView  list of items, and includes the parent and child items' custom
attributes.

When a parent part has a pending iteration (that is, the PendingRevID  is not null), then it displays the markup Find numbers, items,
RefDes, and notes. When a parent has only a released iteration (the PendingRevID  is null, RevID  is not null, and IsCanceled  is
false), then it displays the current released child iteration ( Revision_Child , Lifecycle_Child , etc.) with Find, RefDes and notes. If a
child part has a pending iteration, that's shown in separate columns ( PendingRevision_Child , PendingLifecycle_Child , etc.) but is
not yet assigned to the parent's current configuration. A query that requires the current released parent must test that the
PendingRevID  is null and IsCanceled  is false.

The basic SQL statement is SELECT * FROM StructurePairView

In earlier PDXpert releases, the structure views contained reference documents. These are now contained in separate
ReferencePair  views.

Column definitions
There may exist in the view one or more "housekeeping" columns that have been reserved for PDXpert's private use. These
columns' names begin with the prefix HK  (for instance, HK1 ). Housekeeping columns may be redefined or eliminated in a
future PDXpert release without notice. These are not documented, and you should ignore these columns in your own SQL
queries. Do not create any custom attributes that use the HK  prefix. You may want to create a user-defined view that
excludes the housekeeping columns.

The column ordering may not be exactly as shown in this table, and may change in a future PDXpert release. Use the
column name, not ordinal position, in your SQL queries.

StructurePairView

Column name Data type Record attribute

ItemId ... Notes see: ItemView columns parent item standard attributes

ItemId_Child ... Notes_Child see: ItemView columns child item standard attributes

Find integer row Find  number

Per integer (note 1) row Per

Quantity real number row Quantity

Unit Unit of Measure Name row Unit

RefDes string row RefDes

RowNotes string row Notes

Notes:
1. BOM quantity category values are: 0=Per Assembly; 1=Per Setup; 2=As Needed

StructurePairMasterView



Column name Data type Record attribute

ItemId ...  custom_Member see: ItemMasterView columns parent item standard and custom attributes

ItemId_Child ... custom_Member_Child see: ItemMasterView columns child item standard and custom attributes

Find integer row Find  number

Per integer (note 1) row Per

Quantity real number row Quantity

Unit Unit of Measure Name row Unit

RefDes string row RefDes

RowNotes string row Notes

Notes:
1. BOM quantity category values are: 0=Per Assembly; 1=Per Setup; 2=As Needed
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The ChangeView  contains all change forms with standard item attributes. The ChangeMasterView  contains all columns of the
ChangeView  plus all custom attributes. These views are available in both the viewer  and the released  schemas.

The Lifecycle  column is coded

Value Lifecycle Abbreviation

0 Originated ORG

1 Submitted SUB

2 Routed RTD

3 Held HLD

4 Approved APP

5 Disapproved DIS

6 Canceled CAN

7 Stopped STP

8 Rejected REJ

9 Accepted ACC

10 Released REL

11 Completed CMP

For example:

SELECT
Type
,Number
,Priority
,CASE [Lifecycle]
 WHEN 0 THEN 'Originated'
 WHEN 1 THEN 'Submitted'
 WHEN 2 THEN 'Routed'
 WHEN 3 THEN 'Held'
 WHEN 4 THEN 'Approved'
 WHEN 5 THEN 'Disapproved'
 WHEN 6 THEN 'Canceled'
 WHEN 7 THEN 'Stopped'
 WHEN 8 THEN 'Rejected'
 WHEN 9 THEN 'Accepted'
 WHEN 10 THEN 'Released'
 WHEN 11 THEN 'Completed'
 ELSE ''
 END AS [Lifecycle]
FROM [viewer].[ChangeView]

Column definitions
There may exist in the view one or more "housekeeping" columns that have been reserved for PDXpert's private use. These
columns' names begin with the prefix HK  (for instance, HK1 ). Housekeeping columns may be redefined or eliminated in a
future PDXpert release. These columns are not documented, and you should ignore them in your SQL queries. Do not create
any custom attributes that use the HK  prefix. You may want to create a user-defined view that excludes the housekeeping
columns.



The column ordering may not be exactly as shown in this table, and may change in a future PDXpert release. Use the
column name, not ordinal position, in your SQL queries.

Column name Data type Attribute name

ItemId GUID (item primary key) unique record identifier; not visible within PDXpert client

Type Change Forms Name Type

TypeShort Change Forms Abbreviation Type  as displayed in the Item Explorer

Number string Number

Summary string Name  as displayed in the Item Explorer

Lifecycle
integer 0 (ORG) to 11 (CMP) - see

table
Lifecycle

WillReleaseCancelItems Boolean on Change Forms member as Releases/cancels items on Affected tab

Analyst Persons Name Analyst

Trustee Persons Name Trustee

OriginatedDate date Origination date

ReleasedDate (note 1) date Release date

ProblemSource Problem Sources Name Problem source

ChangeReason Change Reasons Name Change reason

ChangeClassification Change Classifications Name Change classification

ChangePriority Change Priorities Name Change priority

BeginSerialNo string [administrator defined]

BeginEffectiveDate date (none)

EndSerialNo string [administrator defined]

EndEffectiveDate date (none)

MaximumQuantity integer Maximum quantity  value

MaximumQuantityUOM Units of Measure Name Maximum quantity  count units

MaximumDuration integer Maximum duration  value

MaximumDurationUOM Unit of Measures Name Maximum duration  time units

FirstAuxiliaryPerson Persons Name [administrator defined]

SecondAuxiliaryPerson Persons Name [administrator defined]

PrimaryDiscussion string [administrator defined], typically the change description

SecondaryDiscussion string
[administrator defined], typically an optional supporting problem

statement

Notes string Notes  tab

custom (note 2) string custom attribute text or numeric value



custom_Member (note
2)

collection member Name custom attribute value's units, or other collection member

Notes:
1. If the change has not yet been released, then this value is empty and affected items have not yet been updated to their planned release/cancel

states.
2. These columns are included in the ChangeMasterView, and are not in the ChangeView. All administrator-assigned custom attribute ("CA") names

are displayed in value/unit columns; the name is used in the column header. All identically-named CAs are displayed in the same column,
regardless of change type. Where a custom attribute name conflicts with an existing system-assigned attribute name (such as Number  or Type )
then the custom attribute name is displayed with a leading underscore ( _Number  or _Type ). See the help topic Collections reference > Custom
attributes  for naming guidelines. If a custom attribute name is longer than 120 characters, it is truncated.
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The ChangePairView  and ChangePairMasterView  are parent-child lists of all changes (parent), as well as items on their Affected  list
(child). The view is a side-by-side set of the change form attributes; a single affected item's attributes; and the change/affected item
relation attributes for released and canceled iterations. The parent change form may have zero, one, or many affected item child
records, which determines the number of rows in the view.

The ChangePairView  is based on the ChangeView  and ItemView  lists, and excludes custom attributes from the change form and
affected items. The ChangePairMasterView  is derived from the ChangeMasterView  and ItemMasterView  lists, and includes custom
attributes.

The affected item always reflects the most current item data, as obtained from the ItemView  and ItemMasterView  lists. Therefore,
only the most recent change pairs indicate the affected item's current iteration; earlier change pair views accurately reflect the items
(class, owner, type, number, etc.) that were affected, but not the actual iteration that was released or canceled. To obtain non-current
change data that includes the actual released or canceled iterations, use a custom SQL query based on the [AffectedItem_View]
and related non-public views.

Column definitions
There may exist in the view one or more "housekeeping" columns that have been reserved for PDXpert's private use. These
columns' names begin with the prefix HK  (for instance, HK1 ). Housekeeping columns may be redefined or eliminated in a
future PDXpert release without notice. These are not documented, and you should ignore these columns in your own SQL
queries. Do not create any custom attributes that use the HK  prefix. You may want to create a user-defined view that
excludes the housekeeping columns.

The column ordering may not be exactly as shown in this table, and may change in a future PDXpert release. Use the
column name, not ordinal position, in your SQL queries.

ChangePairView

Column name Data type Record attribute (note 1)

ItemID ... Notes see: ChangeView columns change form standard attributes

ItemId_Child ... Notes_Child see: ItemView columns affected item standard attributes

LineNumber integer affected item row number

ReleaseRevision string if affected item was released: new iteration's revision identifier

ReleaseLifecycle Lifecycle Name if affected item was released: new iteration's lifecycle

ReleaseNote string if affected item was released: new iteration's Release description

CancelRevision string if affected item was canceled: old iteration's revision identifier

CancelLifecycle Lifecycle Name if affected item was canceled: old iteration's lifecycle

CancelNote string if affected item was canceled: old iteration's Release description

ChangePairMasterView

Column name Data type Record attribute (note 1)

ItemId ... custom_Member
see: ChangeMasterView

columns
change form standard and custom attributes

ItemId_Child ... see: ItemMasterView columns affected item standard and custom attributes



custom_Member_Child

LineNumber integer affected item row number

ReleaseRevision string if affected item was released: new iteration's revision identifier

ReleaseLifecycle Lifecycle Name if affected item was released: new iteration's lifecycle

ReleaseNote string
if affected item was released: new iteration's Release

description

CancelRevision string if affected item was canceled: old iteration's revision identifier

CancelLifecycle Lifecycle Name if affected item was canceled: old iteration's lifecycle

CancelNote string
if affected item was canceled: old iteration's Release

description
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The FilePairMasterView  is a parent-child list of all items and the database properties of their file attachments. The view is a side-by-
side set of the parent item attributes; a single file's name, Size (bytes), and AddedOn date. The parent item (for example, a document
object) may have zero, one, or many file records, one per row.

The FilePairMasterView  is derived from the ItemMasterView  list of items, and includes custom attributes.

When a parent item has a pending iteration (that is, the PendingRevID  is not null), then its markup revision files are displayed. A
parent item that has only a released iteration ( RevID  is not null, IsCanceled  is false, and the PendingRevID  is null) displays each
current released revision file. A query that requires the current released parent must test that the parent PendingRevID  is null and
IsCanceled  is false. The complete set of item files and external links is always displayed.

The basic SQL statement is SELECT * FROM FilePairMasterView

The database row contains only the file attachment's database properties. It is not the actual file object, which is not
contained within the database.

This view is also contained in the local views database. Client-side ODBC applications can select from this view and from
SQLite-compatible Views collection members based on this view.

Column definitions
There may exist in the view one or more "housekeeping" columns that have been reserved for PDXpert's private use. These
columns' names begin with the prefix HK  (for instance, HK1 ). Housekeeping columns may be redefined or eliminated in a
future PDXpert release without notice. These are not documented, and you should ignore these columns in your own SQL
queries. Do not create any custom attributes that use the HK  prefix. You may want to create a user-defined view that
excludes the housekeeping columns.

The column ordering may not be exactly as shown in this table, and may change in a future PDXpert release. Use the
column name, not ordinal position, in your SQL queries.

FilePairMasterView

Column name Data type Record attribute

ItemId ... Notes see: ItemView columns parent item standard attributes

FileList string: Item, Revision, External list that contains file attachment

Filename string original file name, as seen in the PDXpert client's file list

LibraryName string physical file name (notes 1, 2)

Size integer byte count (note 2)

AddedOn date date that file was attached (note 2)

Notes:
1. To ensure uniqueness, PDXpert assigns a separate alias filename when the file is copied into the library folder.
2. Value is null when FileList  is External
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Open the window by selecting Tools ➔ User Settings...

User settings are reset when you select ☑ Reset my account settings  checkbox on log-in, and if your user account is deleted
or replaced (for example, the account access is changed from read-only to full-function).

General
Out of office agent

While you are out of the office, you can select a different user to work on your behalf. Each time you log into the PDXpert
client application, your agent is shown in the status bar. Notify the selected person before you leave, and clear your selection
when you return.

You can select only a person with a full-function user account.

A system administrator can change or remove your selected agent with the User Management tool .

The agent is a temporary setting. If the user should always have your permissions, the administrator can add the
user to your reviewing groups or assign to the user a different role.

Your agent can manage all items where you are the trustee. A Product Families Denied  list won't affect your
agent's access to your items.
Your agent receives your task notices. In the Item Explorer's Tasks  list, your agent sees tasks that are given to you,
and given by you.
Your agent receives your change workflow notices, and can review your change forms. When the agent approves or
disapproves a change, the agent – not you – is shown as the change reviewer. Your agent may work on change forms
where you are the analyst.
If you are listed on the Product Team  of a Product Families collection member, then the agent is also a temporary
member of that product team.
If you are an analyst, your agent is also an analyst – even if your agent hasn't been given a role with ☑ Is an analyst
permission.
If you are a system administrator, then your agent is also an administrator. However, if you are the super administrator,
your agent is not given the super administrator permissions.
Your agent cannot authorize anyone else to work on your behalf. If your agent selects an agent, your permissions
aren't passed to that person.

Item Explorer: Recent items tracking limit
You can specify the number of items that are listed in the Item Explorer's Recent  list. If you have a slow network connection,
try using a smaller value to reduce data transfers.

Markup list style
Use font styles and colors to highlight changes in an item's Markup  lists. These settings never affect Current  lists.

These are your settings, and won't affect how other users see your markups. For example, you may see errors in
yellow, but others may not.

After you save new settings, close and then re-open items to refresh their styles.

Add
On  Add rows, all text in each changed field is underlined. Where the entire row is new, all fields are styled; if the
row is replacing a removed row, then only changed fields are styled.
While the list is unlocked, the style is not shown in fields that you can edit.

Remove
On  Remove rows, all text in each changed field is italicized. Where the entire row is removed, all fields are
styled; if the row is replaced by an added row, then only changed fields are styled.



Errors
Markup rows with errors have all text shown as bold, with an optional yellow background. The parent item can be
locked or unlocked. Errors are shown when:
When a user account is first made or is reset, all markup style settings, except ☑ RefDes as + − = , are marked.

The row's item has a lifecycle that's incompatible with the parent's lifecycle; for example, a markup contains a
Prototype part and a parent assembly is at Production.
There are RefDes errors; for example, the number of RefDes values doesn't match the Quantity, or the same
RefDes is used on more than one row.

Errors are never shown on Current  lists. They are also hidden on released and canceled Markup  lists when the
☑ Only on Pending  setting is marked.

Colors
When marked, fields that have a style are also shown with text and background colors: Add style, Remove style,
Errors style.

RefDes as + − =
When the assembly part is locked, this setting shows the RefDes differences between the  Remove and  Add
row values at the same Find location. Instead of showing the final list of RefDes values (like R2, R8 ), the list shows
added, removed and no-change reference designators as +count:add −count:remove =count:same , like
+1:R2 −2:R4,R7 =1:R8 .

This setting shows RefDes changes on your own Markup  list only when it's locked. While you're editing, the actual
reference designator list – not changes to the removed row – is shown. The actual values are always shown on the

Current  list after the assembly is released, on standard BOM reports, and in PDX packages. When you add a new
Find row, there's no difference to show: when the assembly is locked, the RefDes values are shown exactly as
entered.

Only on Pending
When marked, all markup styles are shown only on an item's pending iteration, and not on the Markup  list of a
released or canceled iteration.

Add these product families to each new item
If you design a group of items for a product, or consistently work with a product team, you can specify them here. The listed
product families are automatically copied to each new item you make, and you can modify the new item's list. This list is not
copied when you revise a previously-released item.

To assign or clear the Product families  list on many items, an administrator can use the Product Families import
template  within the Batch Importer tool .

Use standard Windows cursors
Some virtualization applications or utilites can use only Windows standard cursors. Custom cursors – showing, for example, a
dragged part with its status icon – may be poorly rendered or disappear on the virtual desktop. Mark this setting to replace
custom cursors with the default Windows cursors.

Copy me on email notices that I trigger
As you work with a change form or assign tasks, emails may be sent to other people. You know about these, so the system
doesn't normally send these notices to you. However, mark this checkbox to include yourself in the email distribution.

Confirm exit when application is closed
If you sometimes click on the client application's close box instead of an item window close box, or press Alt+F4  (close
application) rather than Ctrl+F4  (close window), marking this checkbox will show a confirmation dialog.

Enable local views
Mark this checkbox if you want PDXpert to make and maintain a CAD part database on the local client machine. An ODBC
application can obtain part data faster from the client's local database than from the server-side database. The local database
contains a limited set of views for parts, parts with custom attributes, source part relationships, and file names (principally for
links to manufacturer websites); user-defined views are limited to the data contained in these starting views.
For details about connecting your CAD tool, see the Make an ODBC connection  help topic.

The ☑ Enable local views  option is available only when the user has been given a Roles collection member that
includes the ☑ Allow local views on user computer  permission. If local views are not permitted or enabled, then the



client machine's local views database is not made or, if previously made, is no longer refreshed.

When the PDXpert client is open, the local database is refreshed every 10 minutes. New items and items with
modified summary data (owner, number, description) are also copied to the local views database whenever the
PDXpert client requests any data from the server (for example, running a search or opening any record).

When the PDXpert client is closed, the local database isn't refreshed. However, your ODBC application can use the
previously-copied data.

There are two client-side ODBC database options available:
Using SQLite database : When you enable local views, PDXpert installs a SQLite 3 database. Choose this option if you
want PDXpert to always use SQLite, even if SQL Server LocalDB is installed on the client computer. You must
separately install a SQLite 3 ODBC driver for your ODBC client application, and use SQLite syntax in your user-
specified views.
Using SQL Server LocalDB : Install LocalDB when SQL Server compatibility, performance and multi-session access are
important. LocalDB supports some CAD applications that can't be used with SQLite. The PDXpert website's Installation
Guide may have more detail about installing the LocalDB and ODBC driver on the client computer.

If your computer doesn't have LocalDB installed, then PDXpert updates the SQLite database instead. For
example, your office computer may have LocalDB installed, but your preference is ignored if your home
computer does not. To support both SQLite and SQL Server LocalDB, use generic SQL syntax that's
compatible with both, write distinct user-specified views for each, or use your ODBC client application to
query the public views.

Task workdays
When you add a new task to an item, the Task workdays  setting calculates the default due date. The task due date uses the
number of available workdays from today (holidays are not considered). After the task's due date is calculated, you can adjust
the date to any date, even if the workday is not set as active.

The Default workdays  is the period that is automatically added to today's date to get the task's due date. If you specify
zero, then the due date is today, even if today is not an active workday.
Set the active workdays ( ☑ Sunday  through ☑ Saturday ) to match your workweek.
When all workdays are active: The Default task period (workdays)  is added to today's date without adjusting for
weekends.
At least one workday must be active: If you clear the only marked workday, then the following day is automatically
marked.

When a user account is made or reset, all days except ☑ Sunday  and ☑ Saturday  are marked, and the default period is 5
workdays.

The Administrator override  user setting has been moved to the Tools menu: Administrator Override command .
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You use the Item Explorer and Collection Explorer (the "Explorers") to search for, select and drag collection members (like units of
measure) and items (documents, parts and changes). You can drag objects from the Explorers onto lists in the item workspace.

The Explorers can be arranged to best suit the tasks you're performing.

Window management

Pinning and unpinning (Auto Hide)
Auto Hide allows you to minimize Explorers along the edges of the PDXpert application window so that the windows do not occupy
valuable space. By minimizing Explorers, you can increase the viewable area of the workspace.

You pin or unpin an Explorer by clicking on the thumbtack icon, which toggles between the two modes.

 When an Explorer is "pinned" to the workspace, the window will remain open while you perform other tasks.
 You can unpin your Explorers, which lets them slide back to a tab on the edge of your workspace where the Explorer is

docked. If you position the mouse over the tab, the Explorer will "slide out" from the tab area.

Docking and floating
The Explorers may be "floated" anywhere on the screen, fully independent of the PDXpert application window.

To create a floating Explorer, the window must first be pinned. Then, select the Explorer's title bar and drag it until the preview outline
does not snap to any dockable areas. When you release the mouse, the Explorer will float in its own window.

You can dock the Explorer along any edge of the PDXpert application workspace. Select the Explorer's title bar and drag it to one of
the four docking images near each window edge.

You can re-dock a floating Explorer window by selecting the Window | Reset Explorer Docking  command.

Horizontal splitting
When the windows are stacked, adjust how much workspace is dedicated to each one by dragging the splitter bar.

A splitter bar sets the Explorers within their minimum and maximum sizes. When an Explorer is minimized, only its title bar is
displayed.

Adjusting size
You can increase the size of an Explorer by dragging the edge furthest from its docked edge. The dragged edge position can be
different for pinned and unpinned modes.

Grouping as tabs or side-by-side
This feature automatically groups the Explorers together with tabs representing each Explorer. Only the contents of one tab may be
displayed at a time. Only the active tab is closed when the Close  button is clicked and only the active Explorer is unpinned when the
thumbtack icon is clicked.



You can arrange the Explorers to be side-by-side, top-and-bottom or overlapping. Drag one Explorer on top of the other, and a
positioning aid will appear. Drop the Explorer on one of the four outside images to arrange the Explorers next to each other, or drop the
Explorer onto the middle image to overlay the two Explorers.

Item Explorer grid adjustments

Row selection
Click on the row to select it. Once the row is selected, you can drag the contents onto another grid, or double-click to open the item.

Column width & location
You can adjust a column width by dragging the grid line that separates the rows.

Drag a column header to move the related column to a new position.

Column sorting
Click on the column header to sort the rows by that header. One click will sort the rows in ascending order, a second click will sort the
rows in descending order.

Layout suggestions

Guests



Guest users who are primarily interested in looking for items can unpin or close the Collection Explorer. You may prefer to dock the
Item Explorer along the bottom edge of the workspace if many items have long document titles and part descriptions.

Normal users
During periods where you're creating many parts or documents, it may be easiest to keep the Collection Explorer pinned on the left
window edge, and the Item Explorer pinned along the bottom edge. After you've created the items, you can search for items to drag
onto your new items' BOM  and Source  markups, and when dragging items onto the releasing change form's Affected  tab. (The
Explorers overlay also works well for these tasks.)

Administrators
For most administrative tasks, the Collection Explorer can be pinned to the left or right edge of the workspace. Auto-hide (unpin) the
Item Explorer.
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In the PDXpert client application:

1. From the Help  menu, select Technical Support...
2. On the About PDXpert PLM  window, Technical Support  shows the methods for contacting us.
3. Include the PDXpert Application Server and the PDXpert client log files with your technical support question. See the next

section of this help topic.

Or, search the web for PDXpert technical contact .

Log files
PDXpert Application Server and the PDXpert client log files may help solve your technical support question.

You must start PDXpert at least once to make these files.

You normally click a Save Log Files  button, which is available in the server and client. However, in some cases you may need to go to
a Windows folder to obtain the log files. In this case, you'll go to an "environment variable" location such as the %ProgramData%  folder.
Windows expands these variables into actual file paths as needed.

Server application log files
The PDXpert Services and the PDXpert Application Server application log files contain a record of normal and unusual events. The
target files are saved only on the computer where the PDXpert Application Server has been installed.

Server UI is open and responsive
Using the PDXpert Application Server  window:

1. Run the PDXpert Server  application.
2. On the Manage  tab, click on the Save Log Files  button, and save the file to a convenient location.

Server UI can't be opened or doesn't respond
If the PDXpert Server  can't be opened or is unresponsive, find the log files.

Target files: PDXpert.Service.log  and PDXpert.Server.log
PDXpert environment folder: %ProgramFiles%\PDXpert\PDXpert PLM\Logs

To obtain a copy of the log files:

1. Locate the target log files folder in Windows Explorer ( described below ).
2. In Windows Explorer, right-click the log files' folder and select Copy  from the context menu.
3. Right-click on an open area of your Windows Desktop and select Paste  from the context menu.
4. Right-click and select Send to ⏵ Compressed (zipped) folder  to save a Logs.zip  file.

Client application log files
The PDXpert client log file contains a record of normal and unusual application events. The client target file is saved only on a
workstation with the PDXpert client installed.

Client UI can be opened
If you do not have the PDXpert PLM client application open:

1. Run the PDXpert PLM  client application.
2. On the PDXpert log-in window, click the Options  button.
3. Click on the Save Log Files  button, and save the file to a convenient location.

If you have the PDXpert PLM  window open:



1. On the Help  menu, select the Technical Support...  command.
2. On the Technical Support  window, click on the Save Log Files  button, and save the file to a convenient location.

Client UI can't be opened
If the PDXpert PLM  client application can't be opened or is unresponsive, find the log files.

Target file: PDXpert.log
Windows environment folder: %LocalAppData%\PDXpert\Logs

To obtain a copy of the log files:

1. Locate the environment folder in Windows Explorer ( described below ).
2. In Windows Explorer, right-click the log files' folder and select Copy  from the context menu.
3. Right-click on an open area of your Windows Desktop and select Paste  from the context menu.
4. Right-click and select Send to ⏵ Compressed (zipped) folder  to save a Logs.zip  file.

Environment variable folders
To locate an environment variable folder, do one of these:

Open File Explorer and type the value into the address bar and then press the Enter  key.

Enter the value into the Windows Start menu's search box and then press the Enter  key.
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Administrators open this window using Tools menu ➔ User Management...  The menu command is shown when the user's role has ☑
Collections/Rules administrator  marked.

PDXpert software is licensed for a specified number of named user accounts.

A named user account is a unique log-in username that is given to only one person, and which no other person may
use.

A workgroup may share a named user account to look up product data on a kiosk computer. The kiosk uses a read-only
user account on a single computer at a specified physical location. If you follow the rules (see below), then for licensing
purposes you may count the kiosk computer as one person, regardless of how many actual people use the kiosk computer.

A PDXpert software license may not be used with more than one server computer. The PDXpert client may not be used to
provide concurrent, shared, floating, enterprise, site or other non-exclusive user access.

A full-function named user account  lets users make new part, document and change records; add file attachments to the system
library; review, comment on, and approve change forms; and configure the system through the administrator role. You can easily select
(and edit) which permissions are applied to each user account by giving the user an appropriate role from the Roles collection.

A read-only named user account  lets a user view—but not add or change—data records and attached files.

Whenever you wish, you can give an available full-function user account to a read-only user, and vice versa. You can also delete one
person's user account and give it to a different person.

Open the User Management  tool ( Tools ➔ User Management... ) to:

Add a new user account
Add a new kiosk account
Set a person as the super administrator
Change the default Admin name
Give a new role to a user
Reset (clear) a forgotten password
Add, modify or remove a user's out of office agent
Convert between full-function and read-only access
Modify a user account name
Set a person's status to inactive
Delete an existing user account
Read column reference information

If desired, you can give a read-only role to a user with a full-function user account, which then acts as a read-only user account.

If the number of log-in accounts exceeds the maximum permitted by your license, then only the super administrator account
can log into PDXpert. Use the Super Admin account to remove any excess log-in accounts.

To manage user accounts, you must have an administrator role. See the Roles: Collections/Rules administrator  help topic.
The super administrator always has permissions to add and remove user accounts.

Any change that you make to a user's account may not take effect until after that user closes the PDXpert client.

Add a new user account
The Batch Importer tool can add persons and their user accounts in a single import file. See the Persons collection import
help topic.

A user account is licensed for the exclusive use of one person. The new user account has a role, a username and an optional
password, and the default set of user settings.



A new user account row is shown when (1) unused licenses are available, and (2) a Persons collection member doesn't yet
have a user account.

Open the User Management  tool ( Tools ➔ User Management... ):

1. In the Access  column, select whether you are adding a Full-function ⌵  or Read-only ⌵  user account.
The total number of licensed user accounts is specified by your PDXpert software license. To open the Software License Key
tool, select the Software License Key...  command from the Tools  menu.

2. In the Person  column, select the person whom you want to have a user account.
If you don't see the correct person in the list, (1) close this User Management  tool, (2) add a new person record in the Persons
collection, in the Collection Explorer ( Places/Organization/Persons ▷  Persons ), and (3) re-open the User Management  tool.

Include the person's email address. When the user account is created, the person gets an email with the account
name and PDXpert client download link.

3. In the Role  column, select the set of permissions that a user will have within PDXpert.
Roles are managed in the Roles collection. If you don't see the correct role in the list, (1) close this User Management  tool, (2)
add a new role record in the Roles collection, in the Collection Explorer ( Places/Organization/Persons ⏵ Roles ), and (3) re-open
the User Management  tool.

4. Enter the Account name  that the person should use for the log-in dialog. The log-in name is not case-sensitive: LEE  and lee

refer to the same user.

If you want the user authenticated by your organization's Active Directory (AD) or Lightweight Directory Access
Protocol (LDAP) service, enter both the domain name and user name as {domain}\{username} . User names are
validated within a domain; for example, company\lee  and engineering\lee  are different accounts. Specify an
AD/LDAP server name or IP address and, if needed, include the colon-prefixed port number (usually :389 or :636); for
example, 10.1.2.3:389\lee

The PDXpert server (not client) computer sends the user's credentials for AD/LDAP authentication, and must join the
AD/LDAP domain. PDXpert uses the default .NET settings for credential validation. Edit the LDAPContextOptions
setting in the PDXpert service configuration file to use other options: search the web for
PDXpert LDAPContextOptions

This username is used only for account log-in. Within the PDXpert application, users are shown with their Persons
member name.

Use an account name that's clearly related to the person's name. It's impractical to manage software license
compliance using a generic account name like quality .

User authentication systems often don't allow spaces, and the Account name  follows this practice by removing spaces
as you type. To include one or more spaces in the account name, enter the name without spaces and then insert
them. You cannot use a space at the beginning or end of the account name.

5. If you wish, enter the Password  that the person should use for the log-in dialog. Although a user's password is case-sensitive,
this temporary password does not need to meet the requirements you specify in the Password policy system rule . For
example, you can provide the user with a blank temporary password even though you specify a minimum password length.

If you're using AD/LDAP to authenticate the user, this password is not used and should be left blank.

The password value is hidden after you add the account.

6. In the Action  column, click the Create  button to save the new user account. If you have set up the system email account , the
system sends an email with a PDXpertClientSetup  download link and the user account name and password.

Add a new kiosk account
A kiosk account provides read-only access to any number of people in a workgroup on one physical computer. The new kiosk account
must have read-only access and an account username that begins with kiosk… characters.

Open the User Management  tool ( Tools ➔ User Management... ):



1. Add a new member in the Persons collection using the kiosk computer's network name, such as SERVICE02. If necessary,
close the User Management  tool, add the member, and then re-open the User Management  tool.

2. In the Access  column, select the Read-only ⌵  user account.

If you don't see a Read-only ⌵  user account, you can select a Full-function ⌵  user account. The role that you select
in Step 4 (below) must have the ☑ Restrict access to read-only  checkbox marked.

3. In the Person  column, select the kiosk computer's name that you added in Step 1.
4. In the Role  column, select the set of viewing permissions that kiosk users will have within PDXpert.
5. Enter the Account name  that kiosk users should enter for the log-in dialog. The username must begin with kiosk, such as

kiosk2  or kiosk-service .

If you want the kiosk user authenticated by your organization's Active Directory (AD) or Lightweight Directory Access
Protocol (LDAP) service, read the Enter the Account name  topic note in the section above .

6. If you wish, enter the Password  that the person should use for the log-in dialog. The password should meet the requirements
you specify in the Password policy system rule.

If you're using AD/LDAP to authenticate the user, this password is not used and should be left blank.

The password value is hidden after you add the account.

7. In the Action  column, click the Create  button to save the new user account.

Set a person as the super administrator
The system's super administrator handles unusual situations: the PDXpert Server can reset this user's password, and this user can
delete excess user accounts to comply with the license. The super administrator can also act as an analyst and edit item data after the
item is released, regardless of the role assigned to the user. See the Persons: Default member of collection  and Administrator
override  help topics.

Set the super administrator as the default member of the Persons collection:

1. In the Collection Explorer, go to the Persons collection  (within the Places/Organizations/Persons  group).
2. Select the person who will be given the super administrator permissions.

This person must have a user account with full-function access.

3. Right-click the person's name in the list, and select Set as Super Admin  on the context menu.

Change the default Admin name
The first time you use PDXpert, you use the default user account.

This user account has:
A Persons collection member called Admin.
A user account log-in name admin  with a blank (empty) password. This user account has full-function access and an
administrator role.



This topic tells how to change both of these to something more useful.

Change the Admin name in the Persons collection
Your data should always show the real name of the person managing your data. Update the Persons collection's Admin record to
something useful.

1. Log into PDXpert using any administrator account, typically admin  (see the Log into PDXpert  help topic).
2. In the Collection Explorer, go to the Persons collection within the Places/Organizations/Persons  group, and expand the Persons

collection.
3. Open the Admin  member by double-clicking the node.
4. Change the Admin value in the Name  to your name (or whomever is the principal application administrator). Add whatever

other information you'd like.
5. Save your changes.

Renaming the record has no effect on the account log-in name, which remains admin  until the account is changed. See the
next section.

Change the admin account log-in name
If you don't want to log into PDXpert with the admin  user name, replace the admin user account with a new user account that has the
correct log-in name.

To do these steps, your license must have two or more full-function user accounts.

1. Set another Persons collection member as the super administrator .
2. Close PDXpert, and then log in using the super administrator user account.
3. Open the User Management  tool ( Tools ➔ User Management... ), find the user account with the Account name  of admin , and

click the Delete  button.
4. Use the correct log-in name to add your new user account .
5. Set the super administrator to the correct Persons collection member.

Give a new role to a user
Open the User Management  tool:

Select the role from the dropdown list box in the Role  column. Your selection is saved immediately.

The new assigned role takes effect after the user closes, and then re-opens, the client.

Reset (clear) a forgotten password
Open the User Management  tool:

Click on the X  button in the password textbox. You can leave the password blank or enter a new password, and then click the
✓  button to save it.

An administrator cannot see the user's password. PDXpert hides an existing password before you clear it, and
immediately after you save the new password.

Add, modify or remove a user's out of office agent
Only persons with a full-function user account are listed as agents.

The agent is a temporary setting. If the user should always have another user's permissions, add the user to reviewing
groups or assign to the user a different role.

Open the User Management  tool:

Select the agent from the dropdown list box in the Agent  column. Your selection is saved immediately.
To remove a user's agent, select the blank value from the dropdown list. Your selection is saved immediately.



Convert a user account between full-function and read-only access
The system identifies a user account by its account access and account name. To change a user's access, the system must build a
new user account using the new Access  value.

1. To remove the existing access and free the log-in name, delete the existing user account.
2. Add the new user account.

Modify a user account name
The system identifies a user account by its account access and account name. To change a user account log-in name, the system
must build a user account using the new Account name .

1. To remove the existing user account log-in name, delete the existing user account.
2. Add the new user account.

Set a person's status to inactive
When users leave your PDXpert system, keep their history of making and revising items, assigning and completing tasks, adding file
attachments, and reviewing change forms. Don't delete or rename the Persons collection member. Instead, set the person as
inactive.

Before removing the user account, give an agent control of the user's in-work items and tasks; released and canceled items
may be ignored. During this period, keep the user's account or convert to a read-only user account , and set the user's
Agent  value in the Tools menu ➔ User Management  tool. The assigned agent needs a full-function user account with sufficient
permissions.

To set the person's status to inactive in the Persons collection:

1. If the person is set as the system's Super Administrator (that is, the person is shown in bold in the Collection Explorer's
Persons collection), then select a different person as the Super Administrator by right-clicking the other person's name, and
selecting Set as Super Admin .

2. If the person participated in your change workflow:
A. In all Groups collection members, remove the person from each group's Persons  list. If this is the only person listed,

then add an active user as the group's reviewer.
B. In all Change Forms collection templates: On the Attributes  page, if the person is the change form's Default analyst ,

select a different person. On the Participants  page, remove the person from Observing groups and persons  list.

3. On this Persons collection member window:
A. On the General  page, unmark the ☑ Active: users can select  checkbox. When the record is saved, the user account is

automatically deleted .

Setting a person as inactive deletes that person's search history, recent items list, favorites, and user settings. If
you make a new user account for that person, then user settings (such as ☑ Enable local views  and Out of office
agent ) are set to their default values, and may need to be adjusted.

B. On the Address  page, delete the person's Primary email address .

4. Close or lock the window to save your changes.

Delete a user account
Deleting a user account prevents the person from opening PDXpert, and lets a different person have the user account. This is also
used when switching the person's access from a read-only to a full-function user account, or the reverse.

To keep the person's activity history, set the Persons collection member's status to inactive . Do not rename the Persons
record to show a new user.



Deleting a user account deletes that person's search history, recent items list, favorites, and user settings. If you make a new
user account for that person, then user settings (such as ☑ Enable local views  and Out of office agent ) are set to their default
values, and may need to be adjusted.

If the former user has selected an out of office agent, deleting the user account also removes the agent's permissions to the
user's items and tasks.

Open the User Management  tool:

To remove a person's log-in credentials and release the license, click the Delete  button on the appropriate row.
You cannot delete your own account. Another administrator must delete your account.
You cannot delete the super administrator's account. Close the User Management  tool, and set a different person as
the super administrator . Return to the User Management  tool to delete the previous super administrator's user
account.

Columns reference

Id
System-assigned value for internal use. Value cannot be assigned or edited. Column can be sorted.

Access
The user account permissions: Full-function ⌵  or Read-only ⌵ . Value is needed to create the user account. User account
must be deleted to give the person different access. Column can be sorted.

After updating the software license, re-open this window to update the available Full-Function and Read-Only user
account counts.

Person
A Persons collection member that identifies the person who has the user account. Value is needed to create the user
account. User account must be deleted to change the person. Column can be sorted.

After adding or deleting a Persons collection member, or changing the Name , re-open this window to update the
dropdown list.

Role
A Roles collection member that defines the full-function or read-only user account permissions. Value is needed to create the
user account, and may be edited whenever needed. Column can be sorted.

After adding or deleting a Roles collection member, or changing the Name , re-open this window to update the
dropdown list.

Agent
A person who is assigned the current user account's permissions to act when the person is not available. It is not used to
create the user account, and may be edited or cleared whenever needed. Column can be sorted.

Account
User name used to log into the PDXpert client application, and normally used to confirm a change reviewer's response. Value
is needed to create the user account. User account must be deleted to change the account log-in name. If the value includes
a domain (entered as domain-name\user-name ), then the account log-in name and password are passed to the domain's
Active Directory or LDAP server for authentication. Column can be sorted.

Password
User account password. A value is not needed to create the user account, and the password does not need to match the
Password policy system rule. If the Account  column includes a domain, then this password value is ignored. The assigned
password is reset to empty/blank using the X  button. A new password is assigned using the ✓  button. Column cannot be
sorted.

Action
Command button to create the new user account, or delete the existing account. The Delete  button is not available to
delete the current administrator's account or the Super Administrator's account. Column cannot be sorted.
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Administrators open this window using Tools menu ➔ Email Management...  The menu command is shown when the user's role has ☑
Collections/Rules administrator  marked.

Settings
The PDXpert Application Server – not the PDXpert client – uses the email account on this window to send email notices.

Setting up the email account
The PDXpert server computer name is used as the hostname. The server computer name must contain only
ANSI Basic alphanumeric and hyphen/minus ("-") characters, and cannot start or end with a hyphen. RFC 1123, Section 2.1:
<let-or-digit>[*[<let-or-digit-or-hyphen>]<let-or-digit>].

If notices have been sent before an email account is set here, the queue may contain emails. Before configuring the email
account, review the Queue  email list and delete any obsolete notices.

1. Get a new email account, such as PDXpert.NoReply@MyCompany.com  or possibly use a third-party email service like
PDXpert.MyCompany@gmail.com .

Just like a printer or other simple device, PDXpert can't respond to multi-factor authentication (MFA or 2FA) requests.
When you set up this email account, disable secondary authentication. Errors like Client not authenticated
to send mail  or Authentication unsuccessful  may be related to MFA settings.

Ensure that the email account can forward all outbound notices. SMTP servers may place limits on the source or
destination of the emails, or the total number that can be forwarded within a given time.

Ensure that emails sent from the account do not fill up the account storage and prevent new emails being forwarded.

If your SMTP server accepts connections only from known senders, confirm that the PDXpert server computer is not
blocked.

To help recipients know the true email sender, use a dedicated email account rather than a personal email account.

PDXpert does not handle any inbound email traffic, and won't respond to replies by email recipients. Consider adding
an auto-responder notice to the account.

Although a "forwarding only" account can be used, you won't receive test confirmations at the end of this setup
procedure.

2. On the Settings , enter the email address into the Email address for sending notices  textbox.

The SMTP server typically sends mail from the same address that was used during email setup. In most cases, the
email address here exactly matches the account Name  that you enter in the account credentials, below. A mismatch
may show an error like Client does not have permissions to send as this sender.

If the email account uses a common service (like @outlook.com  @gmail.com ) but you're unsure of the settings, try
the Auto Configure  button after entering the address. You'll be prompted to provide the account password. The
PDXpert Application Server tests typical service settings like ports 587, 465 and 25; and SSL/TLS enabled/disabled.
This may take a couple minutes. If useful settings are discovered, the settings are saved and a test email is sent from
PDXpert to your email account.

3. Enter the email account values. You should first specify the Outgoing mail server (SMTP)  of your outbound email (SMTP) server.
An SMTP server is an internet domain, often with a sub-domain prefix, such as mail.mycompany.com  or smtp.office365.com ,
or an IP address like 192.168.23.105 .

If the PDXpert Application Server is installed on a computer that has a local Windows SMTP server enabled, you can use
the value of localhost .



You can obtain the SMTP server name from your IT administrator, or look in your email client (such as Microsoft Outlook)
for the server your own email account uses.
To get the SMTP settings for a commercial email service, search the web for outgoing smtp settings for service ,
such as outgoing smtp settings for Office 365  or outgoing smtp settings for gmail .
You can enter the IP address of your Microsoft Exchange server. If you don't know the Exchange server's IP address, but
you do know its machine name, you can determine its IP address by "pinging" it from the Windows command line: Start
⏵ cmd , and then type ping servername  where you substitute your Exchange server's computer name for servername
(for example, ping msexchange  or ping mailserver ). The screen shows the IP address for that server in the first line,
between the square brackets. In the following example, the IP address of myserver is 192.168.23.105 :

C:\>ping myserver
 
Pinging myserver [192.168.23.105] with 32 bytes of data:
Reply from 192.168.23.105: bytes=32 time<1ms TTL=128
...

4. If your SMTP server does not use the default TCP port 25, enter the server's preferred Port number  (for example, 587 ).

Your PDXpert server computer's firewall and other software (antivirus/antispam) must let a TCP connection through
this port.

5. If your SMTP server requires an encrypted connection, mark ☑ Use encryption with explicit SSL/TLS [STARTTLS] . For example,
mark this checkbox when using smtp.gmail.com  with port 587 .

There are two types of SSL authentication for SMTP, explicit and implicit.

The Microsoft .NET mail client used by PDXpert supports explicit SSL/TLS in accordance with internet standard RFC
2228. Explicit SSL/TLS connects to a normal SMTP port (typically 25 or 587) in plaintext. The .NET mail client then
issues a STARTTLS  to start encryption.

Implicit SSL is an unofficial protocol that begins immediate encryption using an agreed port (often 465). By design, the
Microsoft .NET mail client used by PDXpert does not support implicit SSL/TLS. Some email service providers will
accept port 587 instead of their preferred SSL port.

6. Enter the account Name  for the email account that is used to send notices to PDXpert users.
7. Enter the account Password  for the email account name provided in the Name  textbox, and re-type it in the Confirm password

textbox.
8. Click on the Save Settings  button, then click the Test Settings  button. An email notice is sent from the email account that

you've specified back to that same account. A new email in the account's in-box confirms that the account settings are correct.

Test emails are relayed from the SMTP server to the same email account. To make sure that the test notices are being
correctly received, look in the inbox of the email account. If the receiving POP account is unable to store and show the
test emails (for example, it's a forwarding-only account and there's no inbox), then you won't be able to directly
examine the emails.

Common email issues

To receive a workflow notice, each recipient must have a valid email address entered into the Persons member record. Ensure
the email address has the correct spelling.



The change form's workflow sends notices to identified users during the expected workflow event. For example, if observers
should be sent email notices when a change form moves from Accepted  to Released , then the Observers  checkbox on
template workflow path 24  must be marked and all observing persons must be shown in the change form's Observers  list.
A notice recipient must truly be assigned the related task: the person must be listed in the reviewing group, selected as the
change analyst, shown as an observer, etc.
To reduce email inbox clutter, the system doesn't include the person who triggers a workflow notice. If you prefer to receive
these emails, open the Tools ➔ User Settings...  and mark ☑ Copy me on email notices that I trigger .
The email server must accept emails from the PDXpert server's IP address or machine name.
An email server often forwards any email to another address within the local domain. However, the server typically requires
client authentication to forward emails outside the local domain. Authentication requires the client's assigned user account name
and password, and maybe an encrypted connection.

If the PDXpert email service has been assigned an outside email account (like PDXpert.MyCompany@gmail.com ), confirm
that the account is allowed.
If emails sent to addresses within your company ( User1@MyCompany.com ) are successful and emails sent outside your
company ( User2@gmail.com ) are not (or vice versa), then check: the SMTP server name, port and encryption settings
are correct; the username and password are valid; the email server is configured for external domains; and the server
applies the correct rules to the email account.

If you have an enterprise anti-spam list, allow PDXpert's assigned email address in the spam filter definition file. Users with
individual anti-spam filters must also allow this email address.
A change workflow may send many notices to many recipients, so appropriately configure any limits on PDXpert's assigned
email account (such as the maximum SMTP relays).
Emails are sent with some delay after the triggering event. PDXpert checks the Queue  list every few minutes for new email
notices to send. The email server has a separate queue with its own delay.

Templates
PDXpert sends email notices when certain events occur. For example, when a new user account is made, the person may get an
email showing how to download the PDXpert client application, and log into the new user account. Other notices are sent to a user
who must act on a change form, or who is an observer to the change workflow action. And, there are emails related to tasks assigned
by one user to another user.

PDXpert uses a standard set of email templates. Emails always have a plain-text Subject line and HTML-formatted Content.

Instructions are online to:
Adjust the content of emails sent to new user accounts, as defined in the PDXpert Server service configuration file.
Replace PDXpert's standard workflow and task email templates with your own templates.

Search the web for PDXpert email notice templates setup .

Queue
Sometimes email notices cannot be sent because, for instance, the email SMTP server is unavailable due to system maintenance,
network interruption or other issue. The PDXpert Application Server holds the email notices in a queue and tries to re-send them every
few minutes.

The list shows the status of each unsent email:

 Email ready: The email notice is in the queue and is sent during the next connection to the SMTP server.

 Email blocked: The email notice has not been sent, often because the SMTP server is not available. The system continues to
attempt to send blocked notices for up to 24 hours.

 Email failed: When all attempts have failed, the system will stop trying to send the email notice. A failure often occurs because (1)
the current email settings are not correct; or (2) the Persons collection member's email address is blank or invalid.



If the email server has been unavailable for a while, unsent emails may no longer be useful to their intended recipients. In
this case, delete selected (or all) notices from the email queue before re-enabling the email server.
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Administrators enable this option using Tools menu ➔   ✔ Administrator Override  The menu option is shown when the user's role ☑
Collections/Rules administrator  setting  is marked.

Select this menu option to correct minor text or list selection errors in released or in-process items.

WARNING: This suspends system rules that protect approved database records.
CAD software, manufacturing systems, and supply chain partners may rely on a current value in PDXpert. Check that
other systems will accept (or ignore) your changes.
Before making changes to a production system, back up your database and confirm that no other users are using the
system.
After making changes, test your changes in item records, related reports, PDX packages, and Transforms to ensure
there are no unexpected effects in PDXpert or other computer systems.
Edit only the attributes shown below. Never use the ✔ Administrator Override  option to add or remove BOM, reference,
source, or revision file relationships, or a change form's affected item list. Use the standard change revision process to
add or remove items on these lists.

To protect data from accidental changes, select this option only when necessary, and clear it as soon as the task is finished.
As a further safety measure, this option is cleared every time you close your PDXpert client.

While the option is selected, the status bar shows Administrator Override tool is active , and the following attributes may be edited:

Documents
Number

If the Document Types collection member has its ☑ User cannot edit assigned number  checkbox  marked,
then the setting must be cleared and saved to allow editing. After editing the Number , restore the checkbox
value.

Item-level attributes (except Class  and Type) : Owner , Description , Product families , Attributes , Custom , Notes
Item-level relationships: Item Files  list
Iteration attributes: Revision , Lifecycle , etc. and Tasks  relationships
Iteration relationships: Can add/delete References  and Revision Files  while item is at Originated  or Submitted

Parts
Number

If the Part Types collection member has its ☑ User cannot edit assigned number  checkbox  marked, then the
setting must be cleared and saved to allow editing. After editing the Number , restore the checkbox value.

Item-level attributes (except Class  and Type) : Owner , Description , Product families , Attributes , Custom , Notes
Default unit of measure

Modifying a part's Default unit of measure  value affects bills of materials, and may affect (or damage) related
data records in CAD or manufacturing systems. See the Attributes page (part): Default unit of measure  help
topic.

Item-level relationships: Materials , Item Files  lists
Iteration attributes: Revision , Lifecycle , etc. and Tasks  relationships
Iteration relationships: Can add/delete BOM , Sources , References , and Revision Files  while item is at Originated  or
Submitted

Edit the Markup  list, and re-open the part window to see your changes in the Current  list.

The BOM row unit of measure is controlled by the ☑ Lock part default unit of measure on BOM  system rule .
Modifying a row's Unit of measure  value may affect (or damage) related data records in other computer
systems. Check the impact carefully. You may also need to update the row's Quantity . See the Attributes page
(part): Default unit of measure  help topic.



Change Forms
Change form attributes (except Class  and Type) : General , Attributes , Custom , Notes
Change form relationships: Related , Observers , Files , Tasks  relationships
Releasing relationships: Can add/delete Affected  and Reviewers  while change lifecycle is at Originated  or Submitted

Custom collection member
Default member of collection

This allows a custom collection's default member to be removed so that the collection can be deleted. See
Deleting a custom collection .
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Administrators open this window using Tools menu ➔ Index Status...  The menu command is shown when the user's role has ☑
Collections/Rules administrator  marked.

The Index Status  tool shows the status of indexed items (documents, parts, change forms) and file attachments.

There are two index functions, with different purposes:

A SQL Server database table index determines how fast a data table can be scanned to find a specific data record, and how
fast it's linked to related records in other tables. These table indexes are used for item searches; making new items; opening
existing records; running reports and transforms; and anything else that gets data from the SQL Server database.
The search engine index selects documents, parts, change forms and file attachments in response to an Item Explorer search
request. This index only affects what text can be found using the Item Explorer; it has no impact on how fast it can be found.
This index has no performance effect on creating or viewing items; processing change forms; running reports; or using
transforms.

Although both indexes are automatically managed, you can use the Re-index  button to rebuild the database table indexes and then
update the search engine index.

After you click the Re-index  button, you can close the Index Status  tool – the indexing process continues to run on the server
computer until it's finished.

Re-index during a quiet time:
Rebuilding the database table indexes requires noticeable system resources.
Until search engine indexing is finished, some items may not be shown in Item Explorer search results.

A typical computer indexes about 2000 items per minute, but indexing can be much faster or slower depending on many
factors.

Database table index

Maintain database performance by re-indexing at least once a year. More frequent re-indexing is normally not needed.
The Batch Importer tool  can fragment database table indexes, particularly when importing items that have custom attributes.
Re-index after you finish a large import project.
If frequent re-indexing noticeably improves performance, consider scheduling a task to regularly de-fragment the table indexes.
If you're comfortable using Transact-SQL, search the web for sql server reorganize rebuild fragmented index

Search engine index

Item index

The search index is updated by the server computer's PDXpert Server service. The index service selects a new group of
records from the index queue every few seconds.
When you save a record, it's added to the service's indexing queue. If there's nothing else in the queue, then indexing starts on
the next index cycle.

After making or changing a data record, the record and all of its direct relationships are re-indexed; the indexed results
may not be instantly available.
After changing a collection member, every item using that member must be re-indexed. If you edit a frequently-used
member (for example, an item lifecycle name or unit of measure), then most items in the database may need re-indexing.

Server hardware, storage connection bandwidth, SQL Server edition, and transaction load have a big effect on index speed.
Item indexing is first-in, first-out. If the queue is working on other records, these are completed before new items are started. If a
group of items is added to the queue, some items become searchable before others. A search may return a few — but probably
not all — matching items, and then more may appear in a new search, until all have been indexed.
If the same item is added to the queue several times, then the system indexes the item once, and deletes the duplicate entries.



An item's indexed terms may include information about related items. For example, a change form may mention a part number
that it released, and the change form may appear in that part's search results.
Adding, changing or removing a type's custom attribute definition adds all related items to the queue. Unlike standard attributes,
a custom attribute cannot be optimized and needs more time to index. Indexing speed is directly related to the number of
custom attributes multiplied by the number of items with those attributes.

File index

File attachments are indexed using software components ("IFilters") installed on the server computer. There may be a
noticeable delay before file indexing starts, and the filter service runs at a much slower speed than item indexing.
Adding a new file to an item automatically schedules the file for indexing. In normal operation, there's never a need to use the

Re-index  button.
Restoring a database PDXZ file automatically indexes all files. When you restore a database .BAK  and separate library folder,
and do not restore the contents of the Data\Filter  folder, use the Re-index  button.
Indexing speed and quality depend on file size, language/culture settings, source application, and IFilter capabilities. These
capabilities may be affected by Microsoft Windows and .NET updates, as well as third-party plug-ins installed on the server
computer.
Most IFilters are designed to extract normal text from files; only specialized IFilters can convert scanned images to usable text
characters (OCR).
After installing or upgrading an IFilter, restart the server computer.
For simpler IFilters, such as the File Properties filter, results may be directly saved in the item index, not in the Data\Filter
folder. If you assign a new IFilter to (for example) CAD files that previously used the File Properties filter, use the Re-index
button to re-index these files.
An IFilter produces the same results each time a file is indexed. Previously-indexed results that have been saved in the
Data\Filter  folder are not re-indexed. In general, older files should be re-indexed only when an IFilter is changed or
upgraded; for example, if the Windows default Reader Search Handler is replaced with a different PDF filter.
In the special case when a complete re-index of all library files is required, select one of these options to delete the
Data\Filter  folder contents:
Option A: Preferred for all systems.

On the PDXpert Server window, note the location of the current data directory.

.
Close the PDXpert Application Server  window and all PDXpert clients.
Stop the PDXpert Server service and, if asked, the PDXpert Filter Service.
Delete all files in the server data directory's Data\Filter  folder.

Do not make any changes in other data directory folders.

Restart the server computer. Do not simply restart the PDXpert Server service.
After Windows restarts, open a PDXpert client to re-index all files using the Re-index  button.

Option B: Acceptable for smaller systems using the .PDXZ  backup format.
Resetting the system deletes the content of all folders, including the Data\Filter  folder.

Back up the database and library.
Reset the database and library.
Restore the backup.
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Administrators open this window using Tools menu ➔ Recursion Assistant...  The menu command is shown when the user's role has ☑
Collections/Rules administrator  marked.

Recursion (also cyclic or looping) errors are infinite loops of product BOMs, where an item is shown on its own BOM, or on one of its
lower-level child items. They're often discovered when a multi-level BOM report fails. An example would be a multilevel assembly list
like:

... continues ...
Assembly 100123
  Assembly 100101
    Assembly 120456
      Assembly 100123
        Assembly 100101
          Assembly 120456
          ... continues ...

In this example, assembly 100101 cannot automatically be identified as the top-level item, because it's also a child of 100123. You may
see an error message like The maximum recursion has been exhausted before statement completion  when running a
multilevel BOM report or adding an affected assembly to a change form.

The Recursion Assistant searches your database for recursions, and lets you select the true top-most parent item.

The Recursion Assistant lets you update items that were previously released. Back up your database before using this tool,
and examine your results after the test is finished.

To ensure data integrity, you must be the only one user logged into the system while using the tool.

Another type of recursion error occurs when References  are cross-linked: where ItemA shows ItemB as its reference, and
ItemB shows ItemA as its reference. The cross-linked items must be found, and then one side of the relationship must be
removed. Cross references complicate revision management, can't be represented in PDX packages, and make some types
of Transforms difficult to write.

The Recursion Assistant...  menu command is only visible to users who have a Roles member that includes the
Collections/Rules administrator  permission.

1. Click on the Item menu ➔ Close All  to close all part, document and change form records before you begin.
2. Click on the Tools  menu and select the Recursion Assistant...  command. This opens the Recursion Assistant  tool and

automatically starts the recursion search.
The Recursion Assistant may show one or more recursion groups. In each group, a random assembly is selected.
Review and select the correct top-level assembly. If you need to investigate further, mark the ☑ Skip this and fix later
option.

If you select an assembly that is not the top assembly, then the correct relationship is broken and the incorrect
relationship is not fixed.

Click the Continue  button to make the necessary changes to the selected BOMs.
If the test doesn't find any recursion errors, then the list is empty. Click the Continue  button.

3. When the tool shows Recursion test finished , click the Close  button.
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 Create Member...
Opens a wizard to make a new member of any collection. This command is available only if your role includes the
administrator permission.

 Create Document...
Opens a wizard that prompts you for the document's identification, and then saves this new document and opens a window
for further editing.

 Create Part...
Opens a wizard that prompts you for the part's identification, and then saves this new part and opens a window for further
editing.

 Create Change...
Opens a wizard that prompts you for the change form's identification, and then saves this new change and opens a window
for further editing.

 Search
This command shows the Item Explorer's Search  page.

 Close
Closes the selected window. If you've edited the item, then it's saved.

 Close All
Closes all open windows in the application workspace. If you've edited any items, then those items are saved.

 Save
Saves all changes to the selected item, and clears the undo buffer.

 Save All
Saves all changes to all modified items, and clears each undo buffer.

 Remove Object
Deletes the active object (the front-most window in the workspace) from the database.
If the active window is:

A part or document with a pending iteration and at least one released or canceled iteration, then the pending iteration
is deleted. If the part or document does not have a released or canceled iteration, then the complete item is removed:
Remove your document  and Remove your part

An originated, submitted or canceled change form, then the change form is deleted: Remove your change form
A collection member, then the member is removed: Remove a collection member

See the related help topics for rules (such as user permission, use by other items, release state) that may prevent deleting
the record.

 Exit
Closes the PDXpert client application.
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 Undo
PDXpert has extensive undo capabilities. In general, you can undo all edits made to an item in reverse sequence to how they
were originally added. Saving your edits clears that item's undo list.

 Redo
If you've undone several steps, you may decide you've gone "too far back". Redo lets you restore any steps that were
accidentally undone.

 Cut
This command copies the selected data to the system Clipboard, and then deletes the selected data.

 Copy
This command copies the selected data to the system Clipboard. The source data remains unmodified.

 Paste
This command copies the system Clipboard's contents to the selected control or list.

 Delete
This command deletes the selected text.

 Select All
Where more than one object can be selected, this selects all objects.

 Revert to Last Saved
Undoes all changes that have been made to the selected item since the last time it was saved, and clears its undo list.

 Refresh
An item's data is copied from the database when the item is first opened. If other users make changes to the record, your
open copy may become out of date. To obtain a fresh copy of the selected record's data, you can close and then re-open the
record or use the Refresh  command.

The command only refreshes data on the selected object, including "child" relationships like the BOM, Sources and
References lists. It doesn't refresh "parent" relations as shown on the Appears On  lists.

 Lock Object,  Unlock Object
If you have permissions to modify the current object, this unlocks the form. When you lock the form, your modifications are
saved.
When you're the trustee of, or on the product team for, an unreleased document, part or change then the attributes that you
can edit are immediately available. However, if the item is released or canceled, you can only modify the product team
attributes after you unlock the item.

 Snapshot Duplicate...
In most product management environments, often a new item is quite similar to another existing item. You can take a
"snapshot" (exact copy) of the displayed item iteration, and then add the new item's unique data. This command (1) creates a
new blank item of the same class and type, and (2) copies much of the source item's data (including BOM, source, reference
and custom attribute values) into the new item. The copied value of Lifecycle phase  controls whether the new item's Revision
starts with its Initial revision sequence  or Subsequent revision sequence  value.

 Snapshot Convert...
Similar to the Snapshot Duplicate  command, you can make a copy of the displayed item iteration, and then add the new item's
unique data. Before the item is created, you can select any existing part or document type from a pop-up window, and the
source item's transferrable data is copied to the target item. Since part and document attributes can be quite different, some
starting values may be substituted in the new item.
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User tools

 Report/Export Wizard...
Opens the Report/Export Wizard for exporting data files and running specialized reports using members of the Transforms
collection. This command is available when the user's role has ☑ Allow Transforms  marked. See the Use the Report/Export
Wizard  help topic.

 Markup Wizard...
Opens the Markup Wizard for revising the list of child items that are shown on groups of parent items. This command is
available when the user's role has ☑ Is an analyst  marked for both Documents  and Parts . See the Use Markup Wizard  help
topic.

 User Settings...
Opens the User Settings  form, which lets you manage personal settings. See the Adjust your user settings  help topic.

 Passwords...
Opens the Set Password  dialog, which lets you change your local account password. This command is not available if you
have logged into PDXpert using a domain account, which is like {domain}\{username} . See the Set your password  help
topic.

 Export/Report ⏵
Shows selected members of the Transforms collection. Commands are shown only when the user's role has ☑ Allow
Transforms  marked, and where the transform's context location is UserArea . See the Running the report: Custom reports
help topic.

Administrator tools
These commands are available when the user's role has ☑ Collections/Rules administrator  marked.

Before using an administrator tool, read the help topic carefully.

✔ Administrator Override
If you have been given an administrator role, then you can select this option to correct minor text or list selection errors in
released items. This option isn't used to edit attributes normally managed by the item trustee, analysts and product team
members. While the option is enabled, the status bar shows Administrator Override tool is active . See the Use Administrator
Override  help topic.

WARNING: This suspends system rules that protect database records.
CAD software or supply chain systems may rely on a current value in PDXpert. Check that other systems will
accept (or ignore) your changes.
Before making changes to a production system, back up your database and confirm that no other users are
using the system.
After making changes, test your changes in item records, related reports, PDX packages, and Transforms to
ensure there are no unexpected effects in PDXpert or other computer systems.
Edit only the attributes shown below. Never use the ✔ Administrator Override  option to add or remove BOM,
reference, source, or revision file relationships. Use the standard change revision process to add or remove
items on these lists.

To protect your data from accidental changes, select this option only when necessary, and clear it as soon as the
task is finished.

 Batch Importer...
To load data from another source, and to update part and document records, see the Use the Batch Importer  help topic.

 Email Management...



Opens the Email Management  tool, which lets administrators manage the outbound email notice settings and queue. See the
Email management  help topic.

 Index Status...
The Index Status  tool shows the status of indexed items (documents, parts, change forms) and file attachments.
The Re-index  button rebuilds the database table indexes and replaces the search engine index. See the Index Status  help
topic.

 Recursion Assistant...
The Recursion Assistant examines your database for cyclic errors on multi-level bills of materials. See the Use the Recursion
Assistant  help topic.

 Software License Key...
To enter your license key, see the Enter the software license key  help topic.

 System Rules...
Opens the System Rules  tool, which lets administrators manage the software's functions. See the System Rules tool  help
topic.

 Update Currencies...
You can update the exchange rate for members of the Currencies collection. If you change the default member and then
run this tool, the default member's Exchange rate  is set to 1 and the exchange rate for every other currency is re-calculated.

This free currency update service relies on one or more third-party providers to get exchange rates for your
convenience. These providers' accuracy, reliability, licensing, service interface, and availability are not guaranteed.
You may need to update PDXpert to reflect provider changes; future PDXpert releases may not include a free
update service. If the service is unavailable or doesn't meet your needs, then manually edit the exchange rates or
update values with a SQL query.

 User Management...
To manage your user accounts, see the Manage user accounts  help topic.

 Export/Report ⏵
Shows selected members of the Transforms collection. Commands are shown only when the administrator's role has ☑
Allow Transforms  marked, and where the transform's context location is AdministratorArea .
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All of these menu items are used to move a change from one change lifecycle state to a different lifecycle. Only certain steps may be
available, depending on (a) the change's status and (b) the lifecycle states enabled by the current workflow. For example, if you've just
finished making a new change, you may only submit it to an analyst; you cannot approve, release or cancel it, and therefore these
menu items aren't available.

To process a change form, it must be open and selected.

 Return to Originator
Return a change form to the originator for more technical information or corrections.

 Submit to Analyst
Submit a change form to an analyst, who reviews it to ensure that it conforms to the change process: required data is
provided, affected items are identified, and the appropriate groups will review it.

 Route for Approval
Notify the reviewers in each listed group that the change is available for their review and approval.

 Release Change
If the change form has not been automatically released by the workflow, this command lets the change to be released after a
review of any comments made by reviewers while the change form was routed for approval.

 Reject Change
Sets the change form to the permanently rejected lifecycle state. A rejected change has no effect on the affected items, and
cannot be modified or removed from the database.

 Cancel Change
Sets the change form to the permanently canceled lifecycle state. A canceled change has no effect on the affected items, and
may be removed from the database.

 Complete Change
A completed change form ensures that the change's content, including dispositioning information, is permanently locked.
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 Reset Explorer Docking
Restores the Item Explorer and Collection Explorer to their default docked location.

 Open Item Explorer
Shows the Item Explorer dockable window, if it's previously been closed.

 Open Collection Explorer
Shows the Collection Explorer dockable window, if it's previously been closed.

 Cascade
Overlays and offsets all item windows within the workspace.

 Tile Vertical
Resizes all item windows to fit within the workspace side-by-side.

 Tile Horizontal
Resizes all item windows to fit within the workspace top-to-bottom.

 1 (window title) ...
Allows you to select an item or member window from all windows in the workspace.

 More items...
If this menu selection is displayed, more than 9 items are currently open and available for selection. This selection opens the

Select Window  dialog, from which you can restore any minimized window.
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 PDXpert PLM Help
Opens the help file to the best topic.

 Contents
Opens the help file to the Contents  tab.

 Index
Opens the help file to the Index  tab.

 Shortcuts
Opens the help file to the Keyboard shortcuts  topic, which shows function keys, Alt  and Ctrl  keys, and other tips.

 Setup Guidance
Opens the help file to the Setup introduction  topic, which summarizes the steps for configuring the software.

 Technical Support...
Opens the Technical Support  dialog, which contains PDXpert's support information. You can save the client log files from
this window.

 PDXpert on the Web
Launches your computer's default web browser, and opens the PDXpert website's home page.

 About PDXpert PLM...
Opens the About PDXpert PLM  dialog, which shows information about the application and your computer.
Use the checkbox to manage the PDXpert Error Reporting Service (PERS). PERS is an important tool for discovering
unexpected behavior, analyzing run-time errors, and improving software quality. PERS never includes any of your product
data. It includes the PDXpert profile, software environment, and .NET exception stack trace.
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A single document is shown in a Document  form.

At a minimum, a document consists of an owning organization that's responsible for its technical content, document type, document
number, title, technical content revision and business lifecycle.

Since documents may be physically managed and distributed, you can specify the media or storage location of the document.

Most documents are CAD, images, and text files, and thus you can attach computer files to the document record's Files  lists.

Class icon
The document class icon shows the most recent iteration's release status:

 Pending
 Released
 Canceled

You can drag the icon and drop it onto a destination, such as a different item's markup list or a change form's affected list.

The form always opens the released iteration. If the document doesn't have a released revision, the pending iteration is opened. If
there's no pending iteration, then the most recent canceled iteration is opened.

Status bar controls
The status bar controls let you:

Unlocked the form for editing using the Lock / Unlock selection. Locking the window automatically saves any changes.

Select an iteration using the dropdown box. Each iteration shows its current release state (pending, released, canceled) as an
icon; its revision and lifecycle; and the executing change form that released it.

 Pending
 Released
 Canceled

Iterations in the list are shown with most recent first, and the oldest last.
Make a new pending iteration by selecting <..New..> ⌵  from the list. This option is not shown if the document has a pending
iteration.

Document pages

General
Attributes
Custom
References: Current
References: Markup
Appears On: References
Appears On: Changes
Files: Revision Files



Files: Item Files
Tasks
Notes
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The General  page provides the basic information about the document: its unique identity (owner, number, name), a selected technical
content identifier (revision), and how that technical content may be used (lifecycle).

Owner
This is the organization that gives the document number, controls the document's contents and approves its release.
Typically, your organization owns documents that define its designs and procedures. Other partner organizations can also
own documents, such as (a) regulatory agencies that publish industry requirements, (b) manufacturers that publish product
datasheets, or (c) customers that issue product requirements to your designers.
The value is locked on first release.

 Document type
The type defines the document's attributes and behaviors (like numbering, revision format, custom attributes, etc.), which are
controlled by its Document Types collection  member. The class icon shows the most recent iteration's release status:

 Pending
 Released
 Canceled

The type defines the document's attributes and behaviors (like numbering, revision format, custom attributes, etc.), which are
controlled by its Document Types collection  member.

The Type  cannot be edited. If you want to apply a different document type, you must convert the document  and let
PDXpert copy whatever it can from the old document using the new Document Type's rules. You can then remove
the unwanted document  from your system or, if it's been released, cancel the released iteration . If the new item
must use the same Number, then search the web for this application note:
PDXpert Switching an existing item to a different type .

Number
The document Owner  and Type  determine the document number rules:

Documents designed and controlled by your home organization are given a number based on the document type:
Manually: You can enter your own number or click the  button to give a new number, and further edit the
given value. The Number  textbox and the  button are both enabled.
Automatically: The Number  field, as well as the  button on the right-most end of the textbox, is locked and
the document number is present.

Documents designed and controlled by partner organizations are given document numbers by those organizations.
The Number  field is editable and the  button disabled.

The auto-number format and value are specified in a Sequences: Identifier collection  member.
The value is locked on first release.

Document name (title)
The document title provides an indexed, searchable description of the document's contents or purpose.

The starting value is copied from the document type's Text template  value. See the Document types: Document title
template  help topic.

The Name{a}  button inserts the values on the Custom  page into the document type's Text template . The button
is visible only when custom attributes have been specified on the document type. To make a new document title,
first enter the custom attribute values, and then click the Name{a}  button to make the title. The new name
completely replaces the previous name. You can edit the new name after the custom attributes have been inserted.

The search engine finds and indexes search tokens, which are alphanumeric strings separated by space
characters. When a document title like Spec, Screw, Metric  is indexed, individual tokens Spec Screw Metric
are found (the commas ,  are removed). The item's complete set of tokens includes the description, owner,
number, custom attributes, notes, and other data fields. Search results are ranked based on how many tokens are
matched: when searching for metric screw specifications, metric screw spec  ranks higher than screw spec .
The item's list of tokens gives search flexibility: you won't care that other users use SCREW, SPEC, METRIC  or
Spec, metric screw  for the title. You may also look for spec*  to find titles with specification . The token list



also lets you omit items that include an unwanted token: spec metric -screw . See the Search for items  and
Search commands  help topics.

While descriptions with Unicode characters (like cm² and kΩ) might look better, they're often hard to use. For
example, searches are more difficult if some keyboards don't show the character, and older manufacturing
applications may not know how to import or display these characters.

The value is locked on first release.

Trustee
This is the person who has overall responsibility for the document's contents. The trustee can edit various fields, add
references, attach files, and add the document to a change form's Affected  list. The trustee, as well as analyst, can give the
document to a different user, who becomes the new trustee.

Product families
Permissions defined within a Product Families collection member change how other users can view or edit this item. Add a
product family by dragging it from the Product Families collection in the Collection Explorer.
Double-click a product family in the list to show the Product Families collection member.

The User settings tool  can define a list of Product Families collection members that are copied to each new
item.

Administrators can use the Batch Importer tool to add Product Families collection members to this list, or reset
the list.

— Iteration: Revision at Lifecycle —

This area shows the selected iteration's current status – Pending  Released  Canceled  – with supporting details.

Revision
A document revision identifies each step in the evolution of a document's technical content.
Depending upon the rules adopted by your company, a document revision can specify a major non-interchangeable change,
or a minor ("clerical") difference. Normally, technical content that has major changes is given a new document number.
Changes that simply add minor content, clarify technical information, or correct clerical errors usually retain the same
document number, but require a new revision.
The revision's  button sets the revision to the starting value of the current revision sequence, based on the selected
Lifecycle phase .
The value is locked on release.

Lifecycle phase
Independent of technical content revisions, a document can be given a level of "business maturity". You may have relatively
little confidence in a first-draft document: you may need to circulate it for comment, try out its procedures, or build prototype
parts with it. As your confidence in the document's accuracy and relevance develops, the lifecycle progresses. When the
document is fully validated, you release it for production use.
Lifecycle selections are specified in the Item Lifecycle Phases collection .

If the Document Types collection member specifies a Subsequent revision sequence , after selecting a new Lifecycle
phase  value, make sure that the Revision  is correct.

The value is locked on release.

Version
A version is used to distinguish documents with the same document number. The Version  field may be shown or hidden,
depending on whether the Document Types collection member lets documents have versions.
Like a revision, a document version distinguishes earlier iterations of a document from later ones. Unlike a revision, which is
managed by PDXpert, the version is made by an outside entity—a person or a different computer application, such as a
software compiler—and manually entered here. If both revisions and versions are used for a document, you must make a
new iteration to change the version.

The Document Types collection  member's ☑ Show Version field  setting shows or hides this field.



The value is locked on release.

Person #1
Person #2

These fields can show people with responsibility for the selected iteration's contents. This list is managed in the Persons
collection .

The Document Types collection  member's ☑ Show a Person #1/#2 role  settings show or hide these fields, and
can show custom labels, such as Author  or Reviewed by .

Revision area
Identify where document changes have been made ("pages 7-9", "Appendix B", "zone A-3").
The value is locked on release.

Release description
The Release description  summarizes how or why the iteration has been changed. The change form's Affected  list shows the
first 50 characters as a brief note to reviewers.
The value is locked on release.

Created on
The system-assigned date when the selected iteration was created. Users cannot change it.

Release status
The system shows when the selected iteration is released for use.

If the iteration is not on any executing change form's Affected  list, then the status is shown as Pending  and the text
field is empty.
If the iteration is added onto an executing change form but is not yet released, then the status is shown as Pending
and the text field shows the change form that will release the iteration.
If the iteration is released, then the status shows Released  and the change form that released it.

Double-click the change number to open the related change form.

Release date
This date is set by the system to show the release date of the selected iteration. Users cannot change it.

Effective date
The effective date shows when the iteration is permitted for use. If you do not set the date, then the system copies the
iteration's Release date ; that is, the document is immediately available for use as needed.
The value has no effect on PDXpert's operation; the technical content is correct on its release date.

A document's Effective date  is almost always its release date. The document's availability must support the physical
parts' effectivity (which is often immediate) and the resulting procurement/production schedule.

Cancel status
The system shows when the selected iteration is replaced by a new released iteration, or the item is withdrawn from use.

If the iteration is not shown on any executing change form's Affected  list, then these fields are not shown.
If the iteration is added onto an executing change form but is not yet canceled, then the status is shown as To be
canceled , and the text field shows the change form that will cancel the iteration.
If the iteration is canceled, then the status shows Canceled  and shows the change form that canceled it.

Double-click the change number to open the related change form.

Cancel date
This date is set by the system to show the cancel date of the selected iteration. Users cannot change it.

Related topics
How to manage documents
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Language
The document is written in this language, which need not be the same language as that used by PDXpert. When a new
document is made, the owning organization's default language is copied to this field, but can be overridden.

Media/location
This lets you specify the document's medium (e.g., paper, film, CD, DVD) or its physical storage location, according to the
Media/Locations collection  members specified by your administrator.

Snapshot from
If the document is copied from a snapshot source ( Edit ➔ Snapshot... ), then this shows the original source. Open the source
item by double-clicking it. Removing the source item deletes this reference.

This field is shown only when the item was copied from another item. Removing (deleting) the source item from the
system deletes this reference.

Related topics
How to manage documents
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These controls are visible only when custom attributes have been specified on the related Document Types , Part
Types , or Change Forms  collection member.

The custom attributes list extends PDXpert's standard attributes with properties that are unique to your organization. Custom attributes
are specified by your administrator for all items of a particular item type.

Custom attributes can be changed at any time by the item trustee, an analyst or member of the product team.

Related topics
Specifying custom attributes
Document Types collection
Part Types collection
Change Forms collection
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The References  lists show parts and documents that affect, influence or validate the document's content. For instance, a product
performance specification document may refer to a set of industry standards or regulations.

The References  lists are shown when documents and parts are enabled as references. See the References Tabs system
rule .

Do not make cross references (where ItemA shows ItemB as its reference, and ItemB shows ItemA as its reference). Cross
references complicate revision management, can't be represented in PDX packages, and make some types of Transforms
difficult to write.

Use the item icon to drag a part or document from the list to any other location that accepts the item. To select multiple
items, click on the first row, press the keyboard Shift  (range) or Ctrl  (individual), then click on a different row.

Markup list
This is the initial set of child items that will be approved for use on the iteration. The mark-up list is used to modify the list of items
referenced by the document iteration.

While the document iteration is pending, a reference record's most recent pending or released iteration is shown.

To change the contents of the References: Markup  list:

Add a new reference to the list by dragging an item (document or part) from the Search  or Recent  lists on the Item Explorer,
and then dropping it onto the References: Markup  list. Add notes as needed.

You can only drop documents and parts onto documents that will accept them. The ☑ References accept parts  and ☑
References accept documents  checkboxes are specified in the References Tabs system rule.

Modify the Row  and Notes  values by unlocking the record and editing the value. (This can also be done after the document
iteration is released.)
Replace an existing reference by dragging an item from the Item Explorer and dropping it onto an existing References: Markup
row. The notes are copied to the replacement row, and can be edited.
Remove an existing reference by selecting the reference, opening the context menu, and selecting the Remove Item From List
command (or pressing your keyboard's Delete  key). The row is still shown, but is marked to be removed upon release.

Releasing the part iteration on a change form copies the References: Markup  list to the References: Current  list. (Removed references
aren't copied.) The iteration's References: Markup  list cannot be changed. It permanently shows the released child iteration as the
row's starting point.

Current list
This is the most recent set of child items that are approved for use on the iteration. While a document iteration remains pending, its

References: Current  list of references remains hidden.

After a document iteration is released, its References: Current  list always shows the latest released iteration of a referenced item. That
is, each time a referenced item is revised and released, the document's References: Current  list of references is automatically updated
each time it's opened.

When a document iteration is canceled, the References: Current  list shows the reference iteration that was valid at the time of
cancelation. If a referenced item is subsequently revised, the canceled document's References: Current  list of references won't be
updated.

Markup and Current data fields
The document's trustee can edit the References: Markup  list while the iteration remains pending. The document's References: Markup
and References: Current  lists are locked when the iteration is released or canceled.



Row
This is the sequence in which the references list is sorted. Enter any non-negative (≥0) integer value.

Item
This identifies the item referenced by the document.

Notes
You may use this text for any purpose.

The contents of this field are indexed, and will return the reference item.

The Notes  field is not under revision control, and can be edited by the trustee and product team members.
To change the released iteration's value without creating a new iteration, unlock the released iteration, select
the Markup  list, and edit the data.
To keep the previous iteration's value, create a new iteration. On the Markup  list's context menu, select the
Modify Item  command, then edit the data.

Use the sort buttons along the top of each list to temporarily adjust the references.

The IPC-2570 standard does not define References. PDXpert uses the AdditionalAttributes element to include a
referenced item, which is added to the Items list. That item includes the referenced item's attributes; attachments for revision
(isFileIn=Yes) and item (isFileIn=No) files; materials; and change history.

The PDX specification's AdditionalAttributes element doesn't support a recursive structure, and therefore a PDX package
excludes the referenced item's own references, sources and BOM items. If your supply chain partner needs these details,
the referenced item must be exported in its own PDX package.

Related topics
Manage document references
How to manage documents
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This is a view of where the document appears within other items ("where used").

References  The document is used as a reference by the listed items. Reference documents — such as a requirement,
specification or procedure — are often identified to support a design, production or inspection task.
Each row of the References list shows when the item was first added to the parent item ( From ), its current state or when it was
removed ( To ), and some relationship details. The row's pop-up shows more detail about the relationship, including the latest
iteration of the parent. If any information in the relationship changed – such as the reference Notes  – then a separate row is
shown.

Changes  The list shows each change form that includes the document on its Affected  list. Use the lifecycle filter buttons,
above the list, to include or exclude change forms that affected the item.
Rows in the Changes list show release/cancel details for executing change forms  and only item information for
advisory change forms .

To view higher-level items where
the document is shown, regardless of iteration, select the This Item appears on these: ⌵  option.
only the selected iteration is shown, select the This Revision appears on these: ⌵  option.

To open a listed item, double-click on its icon or select Open Item  from the context menu.

Select any item to drag it from the list to any other location that accepts that class of item. To select multiple items, click on
the first item, press the keyboard Shift  (range) or Ctrl  (individual), then click on a different item.

Related topics
How to manage documents
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These controls are visible only when the ☑ Show Files tab  checkbox is marked on the related Document Types , Part
Types , or Change Forms  collection member.

PDXpert can directly operate on the files that define a product. You tell PDXpert where the file is, and whether you want PDXpert to
copy it into the data library or just point to it as an external browser link.

All commands for file management are on the Tools ➔ Files  submenu, as well as on each list's context menu.

There are 3 general categories of files: closely managed revision files, item attachments saved in the system library, and external links
to resources that PDXpert doesn't manage.

In a standard PDX package, part/document revision files and change form files are included ( isFileIn="Yes" ). Item files
attached to documents and parts are identified in the PDX package but are not included ( isFileIn="No" ).

Links to external resources are included in a PDX package. Some users may not see the linked resource if, for example, the
link points to a private server on your local network.

All files' Notes  are included in PDX attachment descriptions.

Revision Files
A revision file is related to a particular technical revision of a part or document, and is permanently saved within the data library when
the related item iteration is released by a change form.

Objects that don't have revisions (such as Change Forms and Organizations) don't have revision files.

Because a revision file is identified by revision and not by lifecycle, PDXpert uses the accepted term revision file even though the file is
attached to an iteration (revision + lifecycle) record. A new iteration that simply modifies the record's lifecycle usually copies its revision
files forward with the same technical content. The file's Notes  text is tied to the file, and is shown on all iterations that use that file.

Item Files
An item file isn't as tightly controlled as a revision file. It can be added, changed or deleted throughout the item's life regardless of any
iteration's release status.

An item file can be saved within the PDXpert server's library, or saved as an external link.

An item attachment saves an exact copy of a file. These may be background sketches, customer notes, vendor quotes or
production records.
An external link is a resource on the local network or internet that PDXpert doesn't copy or control. It may be updated, moved or
deleted without PDXpert knowing. Use an external link when you want to point to the latest version of "background information"
data, such as a supplier's web page.

File commands
These commands are shown on the file context menu. Some commands are shown only for a revision file or for an item file.

 View File...
Copies the file from the server to a temporary location on your computer, and asks Windows to open the copy. See the
Viewing a file  help topic.

 Copy Library File...
Copies the file from the server to a location that you specify. See the Copy a file  help topic.

 Add New File...
Adds a file to the Revision Files  or Item Files  list. See the Attach a revision file  or Attach an item file  help topics.

 Add New External Link...



Lets you specify a link to an external resource, such as a website or network file. See the Attach an external link  help topic.

 Add Notes...
Add a brief comment about the file.

 Permissions...
Sets permissions for viewing and managing the file.

 Check Out and Lock...
Copies a revision file to a location you specify, and locks the file so other users can view and copy the file, but can't check it
out. See the Check out a file  help topic.

 Check In and Free...
Replaces the checked-out revision file from a location that you specify, and frees the file lock so that other users can check it
out. See the Check in a file  help topic.

 Free File Lock
Removes a checked-out file's lock without replacing the file with an updated version. See the Free a file lock  help topic.

 Delete File
Deletes the selected file from the list.

A revision file can be immediately deleted if it's not on an earlier released iteration. Otherwise, it can be marked for
removal after processing an executing change form. See the Remove a revision file  help topic.
An item file or external link can be deleted without processing a change form. See the Remove an item file or external
link  help topic.

Microsoft Windows provides good cross-platform file support. However, archive files – .zip , .7z , .rar , and similar general
purpose lossless compression formats – should be made only on a Windows machine.
All files, including compressed files, are copied unchanged into the PDXpert library. If a compressed file is later included in a
PDXZ backup file or a PDX package, Windows may try to optimize files that can be decompressed by the .NET
System.IO.Compression namespace. If any file was compressed on a non-Windows platform or downloaded from the
internet, this Windows optimization may create an invalid PDXZ file or PDX package without warning.

Backup: If you're unsure about the source of any compressed file attachment, then do not use the .PDXZ  file format.
Instead, use the Database without Library (*.bak)  backup format, and save the Library  folder files separately.
PDX package: Before attaching a non-Windows compressed file, decompress the archive's content and then re-
compress it on a Windows machine. This applies only to revision file attachments; a PDX package does not include
item file attachments.

Windows may block unknown files that are downloaded from sources outside your network. Windows sets a hidden NTFS
Alternate Data Stream (ADS) that must be changed.



Before attaching a file to a PDXpert item, open the file's Properties  window to see that the file is unblocked. Administrator
permission may be needed to unblock a file.
If you're careful about downloads and have a good antivirus program, you can configure Windows to stop blocking files using
a group policy or registry setting. Search the web for disable windows file blocking  Or, save the file to a non-NTFS
drive (e.g., FAT) which doesn't support ADS. For more technical discussion, read about the IAttachmentExecute  Windows
API and IZoneIdentifier  interface.

Related topics
Item Explorer: Files
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Give yourself or others an informal reminder about preparing the item for release using the Tasks  list. Whether you need to make
sure of a design parameter, write a procedure, or call your supplier, you can enter the task and update it.

Tasks are requests, not requirements. Incomplete tasks do not prevent an item from being released. After release, the task is
no longer relevant and is locked at its current status.

Assigned to
This is the person that has been given a task. The task is made by dragging this person's name from the Collection Explorer's
Persons collection, and dropping that onto an empty area in the list.

Due on
The day when the task should be completed.

Status
Shows the progress of the task:

Not Started: When the task is given, before work has begun.
In Progress: The assigned person is working on the task.
Waiting on Another: The assigned person needs information from a different person to complete the task.
Completed: The task is finished.
Deferred: The task will not be completed for the current release, but may be considered for a later release.
Canceled: The task will not be performed. The notes should discuss why the task is no longer useful.

Status on
The date that the status was changed (managed by the system).

Priority
Select the urgency of the task. The person's task list shows the highest priority tasks first, then the soonest due dates, and
finally by the most-recently modified tasks.

Assigned by
The person who gave the task (managed by the system).

Assigned on
The day that the task was given (managed by the system).

Task description
Describes the task.

Related topics
Working with tasks
Item Explorer: Tasks
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You can use this to keep the item's history, meeting minutes, or for any other purpose you choose.

You can enter up to about 10 printed pages of general information.

1059



Part window Home 158

A single part is represented in a Part  tab.

At a minimum, a part consists of an owning organization that's responsible for its technical content, part type, part number, name,
technical content revision and business lifecycle.

The Attributes  page shows more information about the part and how it's used in production.

The Materials  list lets you specify the part's total weight, which can be used:

as the basis for rolling up an assembly's total weight, and
to specify the percentage of various materials that makes up the part and, in turn, roll-up the constituent materials in its parent
assemblies.

A part may have a bill of materials ("BOM"), parts and documents as references, and parts as approved sources. Any part can also
show on the BOM of a higher-level assembly, can be a source for a different part, and be a reference on other document or part
records.

You can choose whether to attach CAD files, part specifications and other electronic files directly to a part's Revision Files  list, or
attach the files to a document record and list that document on the part References  list.

Class icon
The part class icon shows the most recent iteration's release status:

 Pending
 Released
 Canceled

You can drag the icon and drop it onto a destination, such as a different item's markup list or a change form's affected list.

The form always opens the released iteration. If the part doesn't have a released revision, the pending iteration is opened. If there's no
pending iteration, then the most recent canceled iteration is opened.

Status bar controls
The status bar controls let you:

Unlocked the form for editing using the Lock / Unlock selection. Locking the window automatically saves any changes.

Select an iteration using the dropdown box. Each iteration shows its current release state (pending, released, canceled) as an
icon; its revision and lifecycle; and the executing change form that released it.

 Pending
 Released
 Canceled

Iterations in the list are shown with most recent first, and the oldest last.
Make a new pending iteration by selecting <..New..> ⌵  from the list. This option is not shown if the part has a pending
iteration.



Part pages

How to work with parts
General
Attributes
Custom
Materials
BOM: Current
BOM: Markup
Sources: Current
Sources: Markup
References: Current
References: Markup
Appears On: BOM
Appears On: Sources
Appears On: References
Appears On: Changes
Files: Revision Files
Files: Item Files
Tasks
Notes
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The General  page provides the basic information about the part: its unique identity (owner, number, name), a selected technical
content identifier (revision), and how that technical content may be used (lifecycle).

Owner
This is the organization that is responsible for the design and construction of the part, and controls its technical content.
Typically, your own organization is responsible for parts that are fabricated according to your designs and procedures. Partner
organizations can own parts, which your organization then can use in your products or for supporting your production
process.
The value is locked on first release.

 Part type
The type defines the part's attributes and behaviors (like numbering, revision format, custom attributes, etc.), which are
controlled by its Part Types collection  member. The class icon shows the most recent iteration's release status:

 Pending
 Released
 Canceled

The Type  cannot be edited. If you want to apply a different part type, you must convert the part  and let PDXpert copy
whatever it can from the old part using the new Part Type's rules. You can then remove the unwanted part  from your
system or, if it's been released, cancel the released iteration . If the new item must use the same Number, then
search the web for this application note: PDXpert switching an existing item to a different type .

Number
The part number uniquely identifies a physical item located in a particular inventory location. The Owner  and Type  set the
part number rule:

Parts designed and controlled by your home organization are given a number based on the part type:
Manually: You can enter your own number or click the  button to give a new number, and further edit the
given value. The Number  textbox and the  button are both enabled.
Automatically: The Number  field, as well as the  button, is locked and the part number is present.

Parts designed and controlled by partner organizations are given part numbers by those organizations. The Number
field is editable and the  button disabled.

The auto-number format and value are specified in a Sequences: Identifier collection  member.

A part number uniquely identifies the item and is a distinct inventory location. You should expect that home parts
with the same number but different part types or revisions are freely mixed in the same inventory bin.

The value is locked on first release.

Part name
The part name provides an indexed, searchable description of the part's purpose and application.

The starting value is copied from the part type's Text template  value. See the Part Types: Part name template  help
topic.

The Name{a}  button inserts the values on the Custom  page into the part type's Text template . The button is
visible only when custom attributes have been specified on the part type. To make a new part name, first enter the
custom attribute values, and then click the Name{a}  button to make the name. The new name completely replaces
the previous name. You can edit the new name after the custom attributes have been inserted.

The search engine finds and indexes search tokens, which are alphanumeric strings separated by space
characters. When a part name like LED, Red, 5mA  is indexed, individual tokens LED Red 5mA  are found (the
commas ,  are removed). The item's complete set of tokens includes the description, owner, number, custom
attributes, notes, and other data fields. Search results are ranked based on how many tokens are matched: when
searching for red surface-mount LEDs, red 5ma led  ranks higher than 5ma led . The item's list of tokens gives
search flexibility: you won't care that other users use RED 5MA LED  or LED, red 5mA  for the name. The token list



also lets you omit items that include an unwanted token: led 5ma -red . See the Search for items  and Search
commands  help topics.

While descriptions with Unicode characters (like cm² and kΩ) might look better, they're often hard to use. For
example, searches are more difficult if some keyboards don't show the character, and older manufacturing
applications may not know how to import or display these characters.

The value is locked on first release.

Trustee
This is the person who has overall responsibility for the part's contents. The trustee can edit fields, build the part's BOM and
add sources or references, attach files, and add the part to a change form's Affected  list. The trustee, as well an analyst,
can give the part to a different user, who becomes the new trustee.

Product families
Permissions defined within a Product Families collection member change how other users can view or edit this item. Add a
product family by dragging it from the Product Families collection in the Collection Explorer.
Double-click a product family in the list to show the Product Families collection member.

The User settings tool  can define a list of Product Families collection members that are copied to each new
item.

Administrators can use the Batch Importer tool to add Product Families collection members to this list, or reset
the list.

— Iteration: Revision at Lifecycle —

This area shows the selected iteration's current status – Pending  Released  Canceled  – with supporting details.

Data revision
A part revision identifies each step in the evolution of a part record's technical content.
Normally, a physical part that is not interchangeable with earlier versions is given a new part number. Changes that simply
add to the data record's content in minor ways, clarify technical information, or correct clerical errors likely retain the same
part number, but require a new record revision identifier.

PDXpert automatically shows the part's currently-released iteration on a parent assembly. Immediately upon release
of the new iteration, all higher-level BOMs, Sources and References will refer to the new iteration; the higher-level
items aren't otherwise affected.

Good configuration management practice says that a physical part has no revision identifier. The PDXpert part Data
revision  field refers to a specific database metadata record, which may be revised without affecting part
interchangeability. Parts with the same number but different metadata revisions can be freely mixed with earlier
parts in the same inventory bin. If a part iteration is not interchangeable with the part's preceding iterations, then the
new iteration requires a separate inventory location, and therefore a new part number. The revision identifier should
never be considered relevant for inventory management, production or servicing; marking a metadata revision on
the physical part is usually discouraged.

The revision's  button sets the revision value to the starting value of the current revision sequence, based on the selected
Lifecycle phase .
The value is locked on release.

Lifecycle phase
Independent of technical content revisions, a part is given a level of "business maturity." For instance, your initial design may
use a Preliminary lifecycle, intended for internal discussion. As your confidence in the part's accuracy and relevance
develops, you may build a small quantity of Prototype parts to make sure of fit and performance. When the part is proven,
you release it at an unlimited, or Production, lifecycle. These lifecycle states represent business uses, and may include
multiple technical revisions or a single design.
Lifecycle selections are specified in the Item Lifecycle Phases collection .



If the Part Types collection member specifies a Subsequent revision sequence , after selecting a new Lifecycle phase
value, make sure that the Revision  is correct.

The value is locked on release.

Version
A version is used to distinguish parts with the same part number. The Version  field may be shown or hidden, depending on
whether your administrator lets the selected part type have versions.
A part version distinguishes earlier iterations of a part from later ones. Unlike a record revision, which is managed by
PDXpert, the version is made by an outside entity - a person or a different computer application, such as a software compiler
- and manually entered here. If versions are used for a part, making a new version also changes the part record revision.

The Part Types collection  member's ☑ Show Version field  setting shows or hides this field.

The value is locked on release.

Person #1
Person #2

These fields can show people with responsibility for the selected iteration's contents. This list is managed in the Persons
collection .

The Part Types collection  member's ☑ Show a Person #1/#2 role  settings show or hide these fields, and can show
custom labels, such as Designed by  or Validated by .

Revision area
If a part has been affected in a particular location (for example, "main valve", "power switch") or database attribute ("BOM at
Find 3") you can highlight that information here.
The value is locked on release.

Release description
The Release description  summarizes how or why the iteration has been changed. The change form's Affected  list shows the
first 50 characters as a brief note to reviewers.
The value is locked on release.

Created on
The system-assigned date when the selected iteration was created. Users cannot change it.

Release status
The system shows when the selected iteration is released for use.

If the iteration is not on any executing change form's Affected  list, then the status is shown as Pending  and the text
field is empty.
If the iteration is added onto an executing change form but is not yet released, then the status is shown as Pending
and the text field shows the change form that will release the iteration.
If the iteration is released, then the status shows Released  and the change form that released it.

Double-click the change number to open the related change form.

Release date
This date is set by the system to show the release date of the selected iteration. Users cannot change it.

Effectivity
Effectivity shows when is the earliest permitted use of the released iteration. If you do not set the date, then the system
copies the iteration's Release date ; that is, the part can be immediately scheduled for production.
The value has no effect on PDXpert's operation; the technical content is correct on its release date.

The Effectivity  value is shown only for assemblies, where the BOM: Markup  list is available. A BOM's effectivity
determines the demand for its components, thus an individual component is effective on its Release date .

The value is locked on release.

Cancel status
The system shows when the selected iteration is replaced by a new released iteration, or the item is withdrawn from use.

If the iteration is not shown on any executing change form's Affected  list, then these fields are not shown.



If the iteration is added onto an executing change form but is not yet canceled, then the status is shown as To be
canceled , and the text field shows the change form that will cancel the iteration.
If the iteration is canceled, then the status shows Canceled  and shows the change form that canceled it.

Double-click the change number to open the related change form.

Cancel date
This date is set by the system to show the cancel date of the selected iteration. Users cannot change it.

Related topics
How to manage parts
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Default unit of measure
The unit of measure specifies how a part is purchased and consumed. Although most parts are individual units, and therefore
each is often appropriate, some production items are measured using categories such as length, volume or weight.
Some units of measure aren't useful for counting parts, so each unit's Unit of Measure Categories collection  defines
whether it is included in this list. For example, manufactured parts are not purchased in units of voltage or torque.
The part's default unit of measure may be modified when the part is added to a BOM. In this case, the default unit determines
the set of compatible units of measure that can be applied. See the Lock part default unit of measure on BOM system
rule  help topic.
After the part has been released, an administrator can modify the part's default unit of measure by using the Tools menu:
Administrator override command .

After the part has been released, changing the part's default unit of measure may have unexpected effects.
If you can't be sure of the impact, the safest path is to treat a new UOM as a non-interchangeable change: Create a
new part record with the preferred Default unit of measure , revise all BOMs to replace the old part, and cancel the
old part when you release its replacement.
Changing a released Default unit of measure  value may affect or damage data records shared with other computer
systems. Check that other systems can accept a unit change, and that inventory balances, purchase orders and
other records can be updated.
Check the effect on your BOMs. Use the part's Appears On: BOM  list to identify all affected assemblies, quantities,
and units of measure.
The new Default unit of measure  must be in the same UOM Category  as the previous unit. Do not change the unit
from one UOM category to a unit in a different UOM category. For example, do not assign a Length category
unit (like cm) if the part uses a Count category unit (like each).
After changing the value, check that the Minimum order quantity  and Standard package quantity  units are correct;
also check the Unit cost per default unit  value.
If the ☑ Lock part default unit of measure on BOM  system rule is marked, then all related BOM rows are
automatically updated to use the part's new default unit. The quantity is not affected. You may need to revise
the quantity on each BOM. If the ☑ Lock part default unit of measure on BOM  system rule is not marked, then review
(and perhaps revise) each affected BOM to ensure that the part's quantity and unit are correct.

Make/buy
Select the method used to get the part. The available selection is managed in the Make/Buy Categories collection .

BOM type code
This value identifies how the part is aggregated or consumed in production. While Direct material is most common, parts
may be usefully given other classifications, such as Phantom (a virtual assembly) or Kit (left unassembled). The available
selection is managed in the BOM Type Codes collection .

Global number (GTIN, UPC, etc.)
Use this field for an equivalent part number known by a third party such as NATO NSN, GS1 GTIN or UPC EAN-13, or a
customer.

Location
This specifies the place where the item can be found, such as a warehouse shelf or storage bin identifier. This value is
included on the Pick List (sometimes called a "knock-down kit") report.

Handling/storage advisory
This shows any health or safety hazard, or special handling or storage considerations, for the part. The list is specified in the
Handling/Storage Categories collection .

Meets regulatory requirements
When marked, the part meets the requirement shown.

Your administrator may have hidden this field, or specified a more appropriate label such as RoHS compliant  or
Meets UL 508 , in the Part Types collection  member window.



Language
The part may have labels or other nomenclature in this language, which need not be the same language as that used by
PDXpert. When a new part is made, the owning organization's default language is copied to this field, but the value can be
overridden.

Process time
Enter the length of time that it takes to fabricate, machine, assemble or otherwise produce the part. Internally-fabricated
components often have process time and no lead time.

Lead time
Enter the time that it takes to receive the part or material from a supplier. Purchased components typically have lead time and
no process time.

Minimum order quantity
If the part supplier requires a minimum order, or your production line is scheduled based on economically efficient production
quantities, then enter the value here.
The unit of measure value is first given the part's Default unit of measure  value. While the unit matches the Default unit of
measure , it follows any change to the Default unit of measure . If the value is given a different part unit of measure, then
changes to the Default unit of measure  are ignored.

Before changing this unit of measure, check that your manufacturing systems accept a unit of measure different
than the part default.

Standard package quantity
The part supplier may define a package quantity, such as a wire reel of 100 meters, which you can record here.
The unit of measure value is first given the part's Default unit of measure  value. While the unit matches the Default unit of
measure , it follows any change to the Default unit of measure . If the value is given a different part unit of measure, then
changes to the Default unit of measure  are ignored.

Before changing this unit of measure, check that your manufacturing systems accept a unit of measure different
than the part default.

End of Life (EOL) recovery method
Specify the method by which the part can be reclaimed or recycled. Many parts can be refurbished or disassembled, while
others can be broken down for their basic chemicals. The list is specified in the Recovery Methods collection .

Cost: Unit cost per default unit, Quoted quantity, As on
This information is used for calculating the total cost for an assembly that includes the part. It also can provide useful
information to other designers about the cost of the part for their own applications.
On assembly parts, this value is normally left empty. To always get the current assembly cost, the cost is calculated "on
demand" using a cost roll-up report. When a non-zero value is shown on an assembly, it's added to the BOM roll-up cost; for
example, you can show an overhead or labor cost.

Part must be: Certified, Serialized
Mark these checkboxes if the part is a critical component that requires certification (or "first article" acceptance) prior to use,
and/or requires each production unit to be uniquely identified.

Do not include in roll-up: Cost
This checkbox zeroes out the cost of the item during cost rollup calculations. For instance, if the item is floor stock (such as a
machine screw) and is expensed in manufacturing overhead, you may want to exclude it from the unit assembly cost. If you
exclude a subassembly's cost, then the costs for all items within its lower-level structure(s) are also ignored.

Do not include in roll-up: Mass & materials
When the checkbox is marked, the item's mass and materials aren't included in a mass roll-up, materials content, materials
declaration or similar report.

Do not include in roll-up: Lower-level mass/materials
This checkbox is enabled on parts that have the ☑ Show BOM tab  checkbox marked in the part's Part Types collection
member.
When the checkbox is marked, the mass and materials reported to higher-level assemblies in roll-up reports is simply
whatever is contained in this item's Part mass (weight)  and Materials list . Any mass or materials contained in items on the



current item's BOM are ignored.
When the checkbox is cleared, the mass and materials reported to higher-level assemblies in roll-up reports is the recursive
sum of items on the current item's BOM, plus the current item's Part mass (weight)  and Materials list .
Regardless of the setting of this checkbox, the value reported to higher-level assemblies are excluded (reported as zero) if
the Exclude item from roll-up: Mass & materials  checkbox on the part Attributes  is marked.
Items shown on Sources  lists have no effect on mass or materials roll-up calculations.

Snapshot from
If the part is copied from a snapshot source ( Edit ➔ Snapshot... ), then this shows the original source. Open the source item by
double-clicking it. Removing the source item deletes this reference.

This field is shown only when the item was copied from another item. Removing (deleting) the source item from the
system deletes this reference.

Related topics
How to manage parts
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These controls are visible only when custom attributes have been specified on the related Document Types , Part
Types , or Change Forms  collection member.

The custom attributes list extends PDXpert's standard attributes with properties that are unique to your organization. Custom attributes
are specified by your administrator for all items of a particular item type.

Custom attributes can be changed at any time by the item trustee, an analyst or member of the product team.

Related topics
Specifying custom attributes
Document Types collection
Part Types collection
Change Forms collection
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These controls are visible only when the ☑ Show Materials tab  checkbox is marked on the Part Types collection member .

Part mass (weight)
This value is used in calculations to determine the proportion of a particular substance entered into the materials list, and the
total mass of an assembly that includes the current part.

Materials list
You can identify the part's substances that should be tracked for regulatory compliance and reporting. Each line item consists of (a) the
material, (b) the quantity and its unit of measure, (c) a calculated proportion (based on the Part mass  value, supplied above), and (d)
an optional location of the substance within the part. Click on a column header to sort the list.

Materials values can be changed by the part trustee (and analysts) until the part is released. After release:
A change to the released materials data is treated as non-interchangeable. This requires a new part number, not a
revision to the released part.
The materials list is updated by using the Tools menu: Administrator override command  or the Batch Importer tool .

Material name
A chemical substance is added by dragging this material from the Collection Explorer's Materials collection, and dropping in
onto an empty area in the list.

Quantity
The total amount of the chemical substance at the Location  specified.

Units
Although any unit of measure may be used, in most industries gram (g) is the preferred measurement unit for regulatory
reporting.

%
The material as a percentage of the part, calculated by the system as 100% × Quantity / Part mass.

PPM
The parts-per-million of the material, calculated by the system as 106 × Quantity / Part mass.

Location
Location of the substance within the part (for instance, connector plating). You can use the same material, with different
quantity at different locations.

Related topics
Manage materials
How to manage parts
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The BOM  (the Bill of Materials) lists show the parts (with quantities) that are required to build the assembly.

The BOM  lists are shown only if ☑ Show BOM tab  is marked on the Part Types collection  member.

The BOM is changed by specifying the desired result on the Markup  list.

If a part iteration has not yet been released, then the Current  list isn't shown.

After an assembly has been released, the Current  list will always show the latest released iteration of each BOM component. And, a
BOM component's new iteration automatically shows on its parents' BOMs as soon as the component is released.

Since a part's most recently released iteration is always listed on the BOM, you must follow this best practice rule: parts with
the same identifying number are interchangeable, and non-interchangeability cannot be controlled using only a revision. If a
part is not interchangeable with its previous iteration, the modified part must be given a new identifying number - not a new
revision.

Assemblies and their BOM components are typically owned by the home organization.

Some organizations adopt vendors' proprietary part numbers for their internal manufacturing/purchasing system (ERP) and
reference them directly on their product BOMs. While this approach may seem simple in the short-term, it limits your
purchasing department to exactly one source for each part, and may cause some assemblies to carry one vendor part while
other assemblies carry a different but equivalent part. Changing a vendor part also requires changing each assembly where
it's used.

The better method is to make an internal part with your own part number, list the various sources that meet your
requirements, and use this internal part on BOMs.

When the Allow partner parts on BOM  system rule is enabled, a part's name shows the owner's Display name .

When an assembly iteration is canceled, the Current  list will show the child part iteration that was valid at the time the parent was
canceled. If a child part is subsequently revised, that later iteration does not show on the canceled assembly's BOM.

Markup list
This is the initial set of parts that will be approved for use on the iteration. The BOM mark-up identifies changes to the assembly's
components. A component may be designed or purchased, or may be a subassembly with its own bill of materials.

While the assembly iteration is pending, a component part's most recent pending or released iteration is shown.

To modify the contents of the Markup  list:

Add a new part to the list by dragging it from the Item Explorer Search  or Recent  list, and then dropping it onto the Markup
list. Add quantity and other details as needed.
Change an existing part by selecting the component, opening the context menu, and selecting the Change Row with Same Item
command. A new row is added, and the row details can be edited.
Replace an existing part by dragging a part from the Item Explorer and dropping it onto an existing Markup  row. The details
are copied to the replacement row, and can be edited.
Remove an existing part by selecting the part, opening the context menu, and selecting the Remove Item From List  command (or
pressing your keyboard's Delete  key). The row is still shown, but is marked to be removed upon release.

If you're working with the parent assembly's first pending iteration, you can freely adjust the parts on the markup list by editing their
Find numbers.

Releasing the part iteration on a change form copies the Markup  list to the Current  list. (Removed parts aren't copied.) The
released iteration's Markup  list cannot be changed after release, except when using the Administrator Override option. The markup
always shows the child iteration that was active at the moment that the parent was released.



The Markup  list can be sorted using the buttons in the list header, or commands on the context menu. Use the Tools ➔ User settings
to adjust the markup data styles.

Current list
This is the most recent set of parts that are approved for use on the iteration. While an assembly's iteration remains pending, its

Current  list of parts remains hidden.

After the assembly iteration is released, its Current  list always shows the latest released iteration of each component part. That is,
every time a child part is revised and released, the parent assembly's Current  list is automatically updated to the new child's iteration.

When the assembly's iteration is canceled, the Current  list is locked to show the final component iterations that were valid at the time
of cancelation. If a child part is subsequently revised, the canceled assembly's Current  list won't be updated.

You can see all of the parts that are approved for use on the assembly. Drill down to deeper levels by clicking on the expansion icons (
 and ) on the left edge of each panel.

Markup and Current data fields
Use the part icon to drag a part from the list to any other location that accepts a part. To select multiple parts from the
Markup list, click on the first row, press the keyboard Shift  (range) or Ctrl  (individual), then click on a different row.

These fields can be edited on a parent assembly pending iteration ("markup"), and are locked on the released ("current") list.

Find
This relates a physical location to a part number, and is useful for tracking revision changes to the row. A BOM's find number
is 1 or greater, and unique for each row on a released assembly. Find numbers (that is, the general part location on the
assembly) are stable for the life of the assembly, even if the part number changes. If the part is no longer needed, the BOM
row is removed and the find number is left unused.

To ensure compatibility with multilevel BOM reports and transforms, as well as other software applications such as
MRP, use values from 1 to 999 only.

In mechanical assembly drawings, a part's location is assigned a Find ("drawing bubble" or "callout") number. Users
don't want to re-learn the physical location after every drawing revision, so both the drawing and BOM row keep the
original find number from one revision to the next. For example, production users learn that Find 8 is a brass insert,
initially part number 10101.
If a part is deleted from the assembly, the remaining Finds are not renumbered. Removing a part at Find 5 leaves a
gap so that users (a) learn that there's no Find 5 part to be installed, and (b) continue to see all other parts are their
previous Find locations. For example, the brass insert remains at the Find 8 locations.
If you replace the part at Find 8 to perform a similar function (say, with a stainless steel insert, part 12402), the BOM
part is replaced at Find 8 – the BOM and drawing Finds don't change.
Find numbers also let you skip a part list on the assembly drawing. Without the part numbers, changing a part
number on the BOM may not require any change to the drawing. For example, substituting the brass insert 10101
with stainless steel insert 12402 may not change how the Find 8 locations appear.
In an electronics assembly drawing, the RefDes  value relates a physical location to a part number, and the Find
simply identifies rows that have changed.

Quantity (value, units of measure)
Give the quantity of child parts that are required to build the parent assembly.
A system rule setting determines whether the part's default unit of measure is locked on a BOM. If it's unlocked, then you can
give a different measure in the same unit of measure category (count, length, mass, etc.). See the Lock part default unit of
measure on BOM  system rule help topic.

Whenever the component part's default unit of measure is modified, review the part's quantity and unit on each
affected BOM.



To show an "as required" quantity, enter a typical or average value and select As needed for the BOM quantity
category . This helps manufacturing forecast how many to get. If you don't have an estimate or the part is bought as
floor stock, then use 1 .

RefDes (Reference Designator)
A reference designator (RefDes, also component designator or part locator) connects a single part instance in a diagram to its
unique location in an assembly.
While editing the Markup  list, RefDes  values are separated, counted and compared to the Quantity  value according to these
rules:

A reference designator has a prefix of at least one alphabetic (A-Z, a-z) character. The prefix is immediately followed
by at least one numeric (0-9) character; for example, S2  or R0012 , but not FA  or J 7 . Different prefixes are OK:
D8,VR2 . A RefDes can have a suffix, like U43C .

Individual reference designator values are separated by a comma , , semicolon ;  or vertical line | ; for example,
U1A, U1B  or LED7;LED9 . Spaces can be used between each RefDes but are not required.

A hyphen -  or colon :  identifies a range of reference designator values, starting with the lowest value; for example,
R6-R12  or C036:104 . This starting value's format is applied to the entire range (only the numeric value of the upper

limit is used). The upper value doesn't need a prefix, but if it's included then it must match the lower value's prefix. A
range value cannot have a suffix.
Reference designator data is stored exactly as entered. However, characters in a valid RefDes are converted to upper
case for comparison, counting and exporting to a PDX package.
A reference designator is one unit of the Quantity  unit of measure. Fractional Quantity  values can't be compared.

A count or format error (such as missing or duplicate values, or invalid range endpoints) changes the text background color,
and is shown in the RefDes  tooltip. After changing the RefDes  or Quantity  value, press the keyboard Tab  key to save the
value and update the calculation.

These rules are used to separate reference designators into PDX package  ReferenceDesignator elements. Use
the Notes  field for normal text.

The ☑ Show RefDes changes on Markup  user setting  lets you choose whether to show the actual values, or their
differences, when a new row is replacing a removed row at the same Find. The differences are shown only when
the assembly is locked.

The content of the RefDes  field is not indexed for search.

BOM quantity category
BOM quantity categories are used in roll-up and pick list calculations.

A part quantity is typically specified Per assembly. The quantity is summed into its higher-level parent, then multiplied
by that parent's quantity, continuing to the top assembly.
Parts specified as Per setup (such as a disposable fixture) and As needed (lubricants, fasteners, or floor stock) are
included in roll-up and pick list reports, but are always treated as having zero quantity.

You can use the Per setup or As needed setting to apply custom calculation rules for your manufacturing
system in your Transforms and Views.

Notes
This text may contain information for any purpose, such as an instruction for the current row.

The content of the Notes  field is indexed for search.

The Notes  field is not under revision control, and can be edited by the trustee and product team members.
To change the released iteration's value without creating a new iteration, unlock the released iteration, select
the Markup  list, and edit the data.
To keep the previous iteration's value, create a new iteration. On the Markup  list's context menu, select the
Change Row with Same Item  command, then edit the data.

In some industries, especially electronics, an assembly may show a part as do not place or do not populate ("DNP"), do not
install ("DNI"), no load ("NL"), or similar term.



The DNP location shows an optional part that changes the assembly's function (product variations), adds some temporary
capability (in-process test), or allows manual adjustment after assembly (calibration). The assembly's documents say how
and when the DNP part is used. The normal assembly process ignores the DNP part.
Thus, there's a difference between the parts shown on the BOM and the actual parts required to produce the assembly. This
difference can be handled in several ways, depending on how manufacturing makes the intended assembly while skipping or
postponing the DNP part:

Do not show a DNP part on the BOM. Instead, DNP parts are described only in documents – like the schematic,
assembly drawing, or test/calibration procedure – that are intended for people and invisible to software systems.
Identify both normal and DNP parts in the same BOM row:

Show the normal part with correct RefDes  and matching Quantity .
Show the DNP part's reference designators in the Notes .

When the BOM is exported to downstream systems, there are no DNP part rows to filter. The BOM row's Notes  can
be exported or not, as needed.
Create one DNP part number that's used for any DNP location, and appears as a separate row in the BOM. The single
BOM row can show all reference designators (e.g., C56, R21, U3) and the DNP row's quantity matches the RefDes
count. The BOM that's exported to production can include or leave out this one DNP row.
Create a DNP non-inventoried/phantom equivalent of the standard part, as needed. For example, a placed resistor
may have a DNP equivalent using a different part number. The CAD places accurate DNP schematic symbols and
component footprints; each DNP part is separated from the normal placed parts; the CAD and PLM BOMs show an
accurate quantity and RefDes of each DNP part; DNP parts may be filtered when exported to the production BOM;
and BOM revisions clearly show markup differences when switching from DNP to the normal placed part (or vice
versa).
Where a supply chain partner needs the placed part in one row and the DNP part (with zero Quantity ) in a separate
row, the Limit part to one BOM row  system rule can be changed.
The DNP rows will show a warning for RefDes with 0 quantity. You can avoid this by putting the reference designators
into the Notes  field, or by setting the correct DNP quantity and As Needed ⌵  category.
However, this system rule allows any BOM to show duplicate part rows with non-zero quantities. Duplicate rows
complicate BOM maintenance, and may cause import problems for some manufacturing systems. In most cases, it's
the partner's production engineer that needs the DNP parts; the DNP rows must still be filtered before importing into
the manufacturing system. Using one of the other methods (a) can show DNP parts to humans while filtering them for
production software; and (b) keeps the preferred system rule setting for simpler BOM management and exporting.

Related topics
Add, modify or remove BOM parts
Import a CAD BOM
How to manage parts
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The Sources  lists show approved parts that are purchased from one or more approved vendor sources. A sources list is sometimes
called an Approved Manufacturer List ("AML") or Approved Vendor List ("AVL").

Source parts are provided by partner organizations, and these partners assign their own part numbers.

The Sources  lists are shown only if ☑ Show Sources tab  checkbox is marked on the Part Types collection member .

You first make the source record with the partner's information in the part's Owner  and Number  data fields, along with related
information such as the purchased part Type  and partner's Part name . You can also attach files, such as datasheets or supplier
specifications, to the source record. The iteration's Revision  lets you to track information changes (such as datasheet or catalog files),
while the business Lifecycle  tends to be quite static, often simply Production or perhaps Approved.

After you've made and saved the source part, you add it as an approved part onto the Markup  list of your organization's purchased
part record.

If a part iteration has not yet been released, then the Current  list isn't shown.

After the part is released, the Current  list always show the latest released iteration of each approved source. And, a source
component's new iteration automatically shows on its parents' Sources list as soon as the component is released.

When you want to revise the list of approved sources, you make a new part record iteration and show on the Markup  list the parts to
keep, add or remove.

Although your supply chain partners are your normal part sources, your own organization may also be the source for a part. This may
occur if you want to consolidate several interchangeable parts with different part numbers under a single preferred number, or if you're
switching to a different part numbering system and want the old parts to be a temporary source for the new part numbers.

Markup list
This is the initial set of parts that will be approved for use on the iteration. The Markup  list shows parts that have been previously
approved for use, as well those parts that are being added or removed as approved sources.

While the part iteration is pending, a source record's most recent pending or released iteration is shown.

To change the contents of the Markup  list:

Add a new source to the list by dragging a part from the Search  or Recent  lists of the Item Explorer, and then dropping it onto
the Markup  list. Modify the Rank  and add Notes  as needed.
Edit the Rank  or Notes  on an existing item by selecting the source, opening the context menu, and selecting the Change Row
with Same Item  command. A new row is added, and the notes can be edited.
Replace an existing source by dragging an item from the Item Explorer and dropping it onto an existing Markup  row. The
notes are copied to the replacement row, and can be edited.
Remove an existing source by selecting the source, opening the context menu, and selecting the Remove Item From List
command (or pressing your keyboard's Delete  key). The row is still shown, but is marked to be removed upon release.

Releasing the part iteration on a change form copies the Markup  list to the Current  list. (Removed sources aren't copied.) The
released iteration's Markup  list cannot be changed. It permanently shows the released child iteration as the row's starting point.

Current list
This is the most recent set of parts that are approved for use on the iteration. While a part iteration remains pending, its Current  list
remains hidden.

After a part iteration is released, its Current  list always shows the latest released iteration of a source item. That is, each time a
source item is revised and released, the part's Current  list is automatically updated to the new child's iteration.



When a part iteration is canceled, the Current  list is locked to show the source part iterations that were valid at the time of
cancelation. If a source item is subsequently revised, the canceled part's Current  list won't be updated.

Markup and Current data fields
Use the part icon to drag a part from the list to any other location that accepts a part. To select multiple parts, click on the
first row, press the keyboard Shift  (range) or Ctrl  (individual), then click on a different row.

The part's trustee can edit the Markup  list while the iteration remains pending. Both Sources  lists are locked when the iteration is
released or canceled.

Rank
Rank is product advice to help purchasing and production.
All source (partner) parts meet the parent (home) part's technical requirements. The home part's inventory location may freely
intermix preferred and non-preferred sources without further selection.
A source part that has the most-preferred technical properties is ranked as 1 . Ideally, all sources equally meet the
requirement without further qualification, all have similar technical properties, and all are ranked as 1 .
An interchangeable but less desirable source may not be ranked as 1  although it fully meets the technical requirement. For
example, if the service life requirement is 20,000 hours, a preferred source may offer 30,000 hours while a non-preferred part
is rated for 22,000 hours. In this case, the preferred part is the better choice – unless purchasing finds it is too expensive or
affects the production schedule.
Use the Notes  to explain why the source received its rank: incoming inspection time; sorting labor and scrap cost; production
yield; service life; etc. All inspection, testing or other processing of a non-preferred part must occur before intermixing it with
existing inventory.
A revised requirement or new partner datasheet may affect rank. However, changing the rank typically doesn't affect the
technical content of the source part or its parent part, since all sources remain interchangeable regardless of rank.

A source's technical rank isn't affected by business considerations like price, payment terms, or current inventory.
Downstream activities in purchasing and production apply their own business rules: Which source is available today
to meet the production schedule? Can we get a special price today by bundling other purchases? Can we get a part
today that's almost as good, if we accept a higher scrap rate? The downstream team uses the part's technical rank
as one factor of many to decide today's strategy.

The Rank  field is not under revision control, and can be edited by the trustee and product team members.

The Rank  field is not under revision control, and can be edited by the trustee and product team members. See the
Notes  data field, below.

Item
This identifies the approved source: partner organization, its part number and description.

Notes
You may use this text for any purpose.

The content of this field is indexed, and returns the source item.

The Notes  (and Rank ) field is not under revision control, and can be edited by the trustee and product team
members.

To change the released iteration's value without creating a new iteration, unlock the released iteration, select
the Markup  list, and edit the data.
To keep the previous iteration's value, create a new iteration. On the Markup  list, select the Remove Item
from List  command. Find the same part in the Item Explorer, or drag the removed part's icon into the empty
area on the Markup  list. Then edit the data.

Use the sort buttons along the top of each list to temporarily adjust the sources.

Hints for identifying your supply chain partners



Every purchased part in your warehouse has at least one, and preferably several, approved original manufacturer sources. Parts are
interchangeable with each other because their relevant functional and physical properties are equivalent. Part interchangeability –
form, fit, and function equivalence – states that any approved source can be used for the application.

One of a product designer's principal tasks is identifying which items are sourced from outside the company, and then qualifying those
sources to ensure that they comply with the design requirements. The qualification task requires a review of the manufacturer's
specifications, and possibly testing the part's performance within the intended environment. In summary:

Part requirements are defined by the home organization.
Part functional and performance specifications are defined by the part's original manufacturer.
When the part meets its published specifications, it's the result of the original manufacturer's engineering and production
procedures.
When the part fails to meet the published specification, only the original manufacturer can address the problem.

Of course, manufacturer's representative, reseller or distributor often helps communications between you and the manufacturer. But an
agent can't be more than an assistant: if you have a problem with the part meeting the published spec, the agent may give you a
refund but certainly won't revise the original design documents, examine the production procedure, or write a corrective action.

Engineering has qualified the source using the manufacturer's technical data, and identifies it using the manufacturer's –
not agent's – name and part number.

From a requirements perspective, engineering is neutral on how the part is obtained. Purchasing chooses the best way to obtain the
qualified part, and this choice is affected by the dynamics of business relationships, contracts, schedules, shipping rates, payment
terms and (especially) prices. If a new distributor can offer better terms, or quicker delivery, then the decision is within the scope of
production rather than design, and no engineering participation is expected.

While supply chain details don't always belong in the product definition, designers often have useful knowledge about where to get
parts. Designers can add supply chain details to assist their purchasing colleagues. If supply chain details would be helpful, then:

Use the source's rank to distinguish your primary (truly qualified) manufacturer part(s) from secondary (indirectly qualified)
distributor part(s). For example, you may want to establish a rule that all indirectly-qualified sources are given ranks higher than,
say, 20. If you include distributors on your sources list, any updates would require bumping the parent part's revision and
releasing a change form. – OR –
Add distributors' part numbers into the manufacturer part record's Notes  field or in a set of custom attribute fields selected from
members of the Organizations collection. Since these are item-level properties, updates won't require a change form.

Related topics
Manage approved sources
How to manage parts
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The References  lists show documents and parts that are used to make or validate the part. For instance, the list can refer to
documents that specify fabrication and inspection procedures, or tools needed for fabrication.

The References  lists are shown when documents and parts are enabled as references. See the References Tabs system
rule .

Do not make cross references (where ItemA shows ItemB as its reference, and ItemB shows ItemA as its reference). Cross
references complicate revision management, can't be represented in PDX packages, and make some types of Transforms
difficult to write.

Use the item icon to drag a part or document from the list to any other location that accepts the item. To select multiple
items, click on the first row, press the keyboard Shift  (range) or Ctrl  (individual), then click on a different row.

Markup list
This is the initial set of child items that will be approved for use on the iteration. The mark-up is used to modify the list of items
referenced by the part iteration.

While the part iteration is pending, a reference record's most recent pending or released iteration is shown.

To change the contents of the Markup  list:

Add a new reference to the list by dragging an item (document or part) from the Search  or Recent  lists on the Item Explorer,
and then dropping it onto the Markup  list. Add notes as needed.

You can only drop documents and parts onto parts that can accept them. The ☑ References accept parts  and ☑
References accept documents  checkboxes are specified in the References Tabs system rule.

Modify the Row  and Notes  values by unlocking the record and editing the value. (This can also be done after the document
iteration is released.)
Replace an existing reference by dragging an item from the Item Explorer and dropping it onto an existing Markup  row. The
notes are copied to the replacement row, and can be edited.
Remove an existing reference by selecting the reference, opening the context menu, and selecting the Remove Item From List
command (or pressing your keyboard's Delete  key). The row is still shown, but is marked to be removed upon release.

Releasing the part iteration on a change form copies the Markup  list to the Current  list. (Removed references aren't copied.) The
iteration's Markup  list cannot be changed. It permanently shows the released child iteration as the row's starting point.

Current list
This is the most recent set of child items that are approved for use on the iteration. While a part iteration remains pending, its Current
list of references remains hidden.

After a part iteration is released, its Current  list always shows the latest released iteration of a referenced item. That is, each time a
referenced item is revised and released, the part's Current  list of references is automatically updated each time it's opened.

When a part iteration is canceled, the Current  list shows the reference iteration that was valid at the time of cancelation. If a
referenced item is subsequently revised, the canceled part's Current  list of references won't be updated.

Markup and Current data fields
The part's trustee can edit the Markup  list while the iteration remains pending. The part's Markup  and Current  lists are locked
when the iteration is released or canceled.

Row
This is the sequence in which the references list is sorted. Enter any non-negative (≥0) integer value.



Item
This identifies the item referenced by the part.

Notes
You may use this text for any purpose.

The content of this field is indexed, and returns the reference item.

The Notes  field is not under revision control, and can be edited by the trustee and product team members.
To change the released iteration's value without creating a new iteration, unlock the released iteration, select
the Markup  list, and edit the data.
To keep the previous iteration's value, create a new iteration. On the Markup  list's context menu, select the
Modify Item  command, then edit the data.

Use the sort buttons along the top of each list to temporarily adjust the references.

The IPC-2571 standard does not define References. PDXpert uses the AdditionalAttributes element to include a
referenced item, which is added to the Items list. That item includes the referenced item's attributes; attachments for revision
(isFileIn=Yes) and item (isFileIn=No) files; materials; and change history.

The PDX specification's AdditionalAttributes element doesn't support a recursive structure, and therefore a PDX package
excludes the referenced item's own references, sources and BOM items. If your supply chain partner needs these details,
the referenced item must be exported in its own PDX package.

Related topics
Manage part references
How to manage parts

1068



Appears On (part) Home 166

This is a view of where the part is shown within other items ("where used").

BOM  The part is assembled into, consumed by, or modified for the listed parent items. This list is often called where used in
manufacturing systems.

Sources  The part has been approved for purchase to fulfill the requirements of the listed parts. There's usually only one part
on this list, unless the part is qualified for use on more than one purchased part.

References  The part is used as a reference by the listed items. Reference parts – such as a tool, fixture or test equipment –
are often identified to support a production or inspection task.
Each row of the BOM, Sources and References lists shows when the item was first added to the parent item ( From ), its current
state or when it was removed ( To ), and some relationship details. The row's pop-up shows more detail about the relationship,
including the latest iteration of the parent. If any information in the relationship changed – such as the BOM Quantity , source
Rank , or reference Notes  – then a separate row is shown.
Changes  The list shows each change form that includes the part on its Affected  list. Use the lifecycle filter buttons, above the

list, to include or exclude change forms that affected the item.
Rows in the Changes list show release/cancel details for executing change forms  and only item information for
advisory change forms .

To view higher-level items where
the part is shown, regardless of iteration, select the This Item appears on these: ⌵  option.
only the selected iteration is shown, select the This Revision appears on these: ⌵  option.

To open a listed item, double-click on its icon or select Open Item  from the context menu.

Select any item to drag it from the list to any other location that accepts that class of item. To select multiple items, click on
the first item, press the keyboard Shift  (range) or Ctrl  (individual), then click on a different item.

Related topics
How to manage parts
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These controls are visible only when the ☑ Show Files tab  checkbox is marked on the related Document Types , Part
Types , or Change Forms  collection member.

PDXpert can directly operate on the files that define a product. You tell PDXpert where the file is, and whether you want PDXpert to
copy it into the data library or just point to it as an external browser link.

All commands for file management are on the Tools ➔ Files  submenu, as well as on each list's context menu.

There are 3 general categories of files: closely managed revision files, item attachments saved in the system library, and external links
to resources that PDXpert doesn't manage.

In a standard PDX package, part/document revision files and change form files are included ( isFileIn="Yes" ). Item files
attached to documents and parts are identified in the PDX package but are not included ( isFileIn="No" ).

Links to external resources are included in a PDX package. Some users may not see the linked resource if, for example, the
link points to a private server on your local network.

All files' Notes  are included in PDX attachment descriptions.

Revision Files
A revision file is related to a particular technical revision of a part or document, and is permanently saved within the data library when
the related item iteration is released by a change form.

Objects that don't have revisions (such as Change Forms and Organizations) don't have revision files.

Because a revision file is identified by revision and not by lifecycle, PDXpert uses the accepted term revision file even though the file is
attached to an iteration (revision + lifecycle) record. A new iteration that simply modifies the record's lifecycle usually copies its revision
files forward with the same technical content. The file's Notes  text is tied to the file, and is shown on all iterations that use that file.

Item Files
An item file isn't as tightly controlled as a revision file. It can be added, changed or deleted throughout the item's life regardless of any
iteration's release status.

An item file can be saved within the PDXpert server's library, or saved as an external link.

An item attachment saves an exact copy of a file. These may be background sketches, customer notes, vendor quotes or
production records.
An external link is a resource on the local network or internet that PDXpert doesn't copy or control. It may be updated, moved or
deleted without PDXpert knowing. Use an external link when you want to point to the latest version of "background information"
data, such as a supplier's web page.

File commands
These commands are shown on the file context menu. Some commands are shown only for a revision file or for an item file.

 View File...
Copies the file from the server to a temporary location on your computer, and asks Windows to open the copy. See the
Viewing a file  help topic.

 Copy Library File...
Copies the file from the server to a location that you specify. See the Copy a file  help topic.

 Add New File...
Adds a file to the Revision Files  or Item Files  list. See the Attach a revision file  or Attach an item file  help topics.

 Add New External Link...



Lets you specify a link to an external resource, such as a website or network file. See the Attach an external link  help topic.

 Add Notes...
Add a brief comment about the file.

 Permissions...
Sets permissions for viewing and managing the file.

 Check Out and Lock...
Copies a revision file to a location you specify, and locks the file so other users can view and copy the file, but can't check it
out. See the Check out a file  help topic.

 Check In and Free...
Replaces the checked-out revision file from a location that you specify, and frees the file lock so that other users can check it
out. See the Check in a file  help topic.

 Free File Lock
Removes a checked-out file's lock without replacing the file with an updated version. See the Free a file lock  help topic.

 Delete File
Deletes the selected file from the list.

A revision file can be immediately deleted if it's not on an earlier released iteration. Otherwise, it can be marked for
removal after processing an executing change form. See the Remove a revision file  help topic.
An item file or external link can be deleted without processing a change form. See the Remove an item file or external
link  help topic.

Microsoft Windows provides good cross-platform file support. However, archive files – .zip , .7z , .rar , and similar general
purpose lossless compression formats – should be made only on a Windows machine.
All files, including compressed files, are copied unchanged into the PDXpert library. If a compressed file is later included in a
PDXZ backup file or a PDX package, Windows may try to optimize files that can be decompressed by the .NET
System.IO.Compression namespace. If any file was compressed on a non-Windows platform or downloaded from the
internet, this Windows optimization may create an invalid PDXZ file or PDX package without warning.

Backup: If you're unsure about the source of any compressed file attachment, then do not use the .PDXZ  file format.
Instead, use the Database without Library (*.bak)  backup format, and save the Library  folder files separately.
PDX package: Before attaching a non-Windows compressed file, decompress the archive's content and then re-
compress it on a Windows machine. This applies only to revision file attachments; a PDX package does not include
item file attachments.

Windows may block unknown files that are downloaded from sources outside your network. Windows sets a hidden NTFS
Alternate Data Stream (ADS) that must be changed.



Before attaching a file to a PDXpert item, open the file's Properties  window to see that the file is unblocked. Administrator
permission may be needed to unblock a file.
If you're careful about downloads and have a good antivirus program, you can configure Windows to stop blocking files using
a group policy or registry setting. Search the web for disable windows file blocking  Or, save the file to a non-NTFS
drive (e.g., FAT) which doesn't support ADS. For more technical discussion, read about the IAttachmentExecute  Windows
API and IZoneIdentifier  interface.

Related topics
Item Explorer: Files
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Give yourself or others an informal reminder about preparing the item for release using the Tasks  list. Whether you need to make
sure of a design parameter, write a procedure, or call your supplier, you can enter the task and update it.

Tasks are requests, not requirements. Incomplete tasks do not prevent an item from being released. After release, the task is
no longer relevant and is locked at its current status.

Assigned to
This is the person that has been given a task. The task is made by dragging this person's name from the Collection Explorer's
Persons collection, and dropping that onto an empty area in the list.

Due on
The day when the task should be completed.

Status
Shows the progress of the task:

Not Started: When the task is given, before work has begun.
In Progress: The assigned person is working on the task.
Waiting on Another: The assigned person needs information from a different person to complete the task.
Completed: The task is finished.
Deferred: The task will not be completed for the current release, but may be considered for a later release.
Canceled: The task will not be performed. The notes should discuss why the task is no longer useful.

Status on
The date that the status was changed (managed by the system).

Priority
Select the urgency of the task. The person's task list shows the highest priority tasks first, then the soonest due dates, and
finally by the most-recently modified tasks.

Assigned by
The person who gave the task (managed by the system).

Assigned on
The day that the task was given (managed by the system).

Task description
Describes the task.

Related topics
Working with tasks
Item Explorer: Tasks
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You can use this to keep the item's history, meeting minutes, or for any other purpose you choose.

You can enter up to about 10 printed pages of general information.
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A single change form is shown in a Change form  tab. A change form is owned by the home organization (which is responsible for
managing its contents), and has a unique change identifier.

The Change form  is used to manage other items and has a unique set of tabs:

items that are affected
groups that must review and approve
observers who will be notified
related change forms
files that implement the change, such as rework instructions

Attributes
Since changes have different behavior than other items, they require special attributes describing their

Purpose: reasons for change, alternatives investigated, problem source
Effects: items affected and date, disposition instructions
Constraints: production quantity, serial/lot numbers, or time limits

Affected items
These are the items that are the subject of the change. If the change is an executing change, then the pending items are released, the
released items are canceled, and all of the listed items' BOM, source and reference lists are updated according to their Markup  lists.

Related changes
Many times, a change form is one of a related set. For example, a new part must be released for prototyping before revising an
assembly to use it. You can show this sort of interdependency by adding other change forms.

Reviewing groups and observers
Specified groups, such as engineering, manufacturing, and quality assurance, approve change forms. Group members can respond on
the group's behalf. PDXpert lets you add any licensed user with appropriate permissions to be a reviewer for any group.

Authorized reviewers can sign a change form once it has been submitted by an analyst; a reviewer approves (or disapproves) it on
behalf of the group. A group's reviewer can never sign on behalf of a different reviewer, or undo a signed change form if a subsequent
reviewer has acted on it or the change is no longer in the Routed  lifecycle state.

Change forms can notify other persons, groups and organizations as a change goes through its lifecycle. For example, a major
customer may be notified when the change affects its customized product.

Page selector

Class icon
The class icon shows the change lifecycle status:

In work:
 Originated
 Submitted to analyst
 Routed for approval
 Held awaiting more information
 Stopped after disapproval, wait for an analyst to select the next step
 Accepted, and waiting for analyst final review

Success:
 Released. All reviewers approved the change. The analyst completes the change.
 Completed. The affected items are dispositioned.



Failure:
 Canceled, after a reviewer disapproved. The analyst deletes the change.
 Rejected, after a reviewer disapproved. The change form is kept permanently.

You can drag the icon and drop it onto a destination, such as a different change's Related  list.

Status bar control
The status bar control lets you unlock the form for editing using the Lock / Unlock selection. Locking the window automatically saves
any changes.

Change Form pages

General
Attributes
Custom
Affected
Related
Reviewers
Observers
Files
Tasks
Notes
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The General  page provides the basic information about the change form: its name, its identifier number, its lifecycle state, who
originated it and when, and descriptive information.

 Change type (Executing/Advisory)
The Type  defines the change form's properties such as numbering, workflow, participants, effect on items listed in its

Affected  list, etc. These are controlled by its Change Forms collection  member. The type shows that it is an Executing or
Advisory change form.
The class icon shows the current change lifecycle:

 Originated
 Submitted to analyst
 Routed for approval
 Held awaiting more information
 Stopped after disapproval, wait for an analyst to select the next step
 Accepted, and waiting for analyst final review
 Released. All reviewers approved the change. The analyst completes the change.
 Completed. The affected items are dispositioned.
 Canceled, after a reviewer disapproved. The analyst deletes the change.
 Rejected, after a reviewer disapproved. The change form is kept permanently.

The Type cannot be edited.

Number
The number, with the Type  above, uniquely identifies the change within PDXpert. In most cases, this value is automatically
given based on the Change Forms member's Identifier sequence  selection.

Problem source
If the change is the result of a problem that was found in an existing item, you can identify how or where that problem was
discovered based on the Problem Sources collection .

Originator (Trustee)
This is the person with overall responsibility for the change form's contents. The originator can edit various fields, build the

Affected  list, submit the change to an analyst, and designate a new originator.

Analyst
This person manages the change after the originator has finished. When the change is in the Submitted  state, the analyst
can modify any of the trustee's work, add or remove file attachments, and route the change to the reviewing groups. The
analyst may separately receive workflow notices.
Other analysts cannot modify the change or its file attachments. However, they may set the change workflow (for example,
move the change from Routed  to Submitted ), and can replace the analyst with a different analyst, including themselves.

Change reason
This selection categorizes why the change form is necessary, and is selected from the Change Reasons collection .

Change lifecycle
Changes are given a lifecycle state based on their progress through your organization's workflow. This state can be changed
only by using the workflow specified in its Change Forms collection  member.

Origination date
The date when this change form was made.

Release date
The date when this change form's lifecycle was set to Released . All items on the Affected  list of an executing change form
are given this date for their own released/canceled dates.

Product families
Product families are automatically added as you add items to the change's Affected  list. The change form's product families
list is obtained from each affected item's product families. The list cannot be edited, but will be recalculated if you change an
affected item's product families.



This field is shown if any Affected items have been assigned product families, or the change has not been Routed.

Change description
Gives the change form's purpose and expected results. The label may be different to reflect the particular change form, such
as Request proposal  or Deviation description .

1091



Attributes (change form) Home 172

These fields show a change form's:
Classification, priority, and responsible parties (for example, an initiator and a validator)
Estimated cost effect
Effective limits, such as the production quantity, serial/lot numbers, or time period

Your administrator may have hidden some of these fields, or given other labels, in the Change Forms collection  member
window.

Change classification
You can select the change class, which typically identifies the change form's effect on part interchangeability (and thereby
suggests that new item identifier numbers have been given), customer impact, or contractual requirements. The available
selection is managed in the Change Classifications collection .

Priority
You can inform your colleagues about the urgency, and possibly the scope, of the change. Selecting a particular priority may
also require entering the beginning serial number and/or date when the change must take effect. The available selection is
managed in the Change Priorities collection .

The change form's priority is shown in Item Explorer's Tasks  list according to the Task priority  selected in the
Change Priorities member.

Person #1
Person #2

These fields show people who have some role or responsibility for the change's contents. The list is managed in the
Persons collection .

These can be shown or hidden, and their labels changed, in the Change Forms collection member.

Cost estimate
This section gathers costs as: one-time expenses not allocated to specific affected items; one-time (non-recurring) expenses
related to affected items; and recurring expenses that are added to each affected item whenever it's produced.

Other costs (or −savings)
This is the cost for tasks not otherwise given in the individual disposition expenses on the Affected  list. A negative
value, such as -1000.00 , is a one-time savings or income; for example, unused inventory is sold.

Non-recurring
This is the total of all one-time costs from each affected item that has a non-recurring dispositioning cost.

One-time total
This is the sum of the Other costs (or −savings)  and the Non-recurring  costs, and shows the immediate cost of the
change.

Recurring
This is the total of future per-unit costs from each affected item that has a recurring dispositioning cost.

Effective limits
These values can be used in any combination to limit the effect of the change.
Starting values may be used to specify when an executing change form takes effect, or the starting point of an
advisory change form. Ending values are normally used only for advisory changes, such as a Deviation/Waiver.
The data labels may be changed in the Change Forms collection member.

Start on (serial number / date)
The serial number, lot code, event, or production date of the first production unit affected by the change form.

End on (serial number / date)
The serial number, lot code, event, or production date when production is no longer affected by the change form.

Maximum quantity affected



The maximum number of production units that can be affected by this change.

Maximum period
The maximum time that production that can be affected by this change.

Snapshot from
If you've copied the change from a different change, then that other change is shown. Double-clicking on the item will open it.

This field is shown only when the item was copied from another item. Removing (deleting) the source item from the
system deletes this reference.

Discussion
If this field is shown, enter the related information.
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These controls are visible only when custom attributes have been specified on the related Document Types , Part
Types , or Change Forms  collection member.

The custom attributes list extends PDXpert's standard attributes with properties that are unique to your organization. Custom attributes
are specified by your administrator for all items of a particular item type.

Custom attributes can be changed at any time by the item trustee, an analyst or member of the product team.

Related topics
Specifying custom attributes
Document Types collection
Part Types collection
Change Forms collection
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A change form's Affected  list shows those items that are impacted by the release of the change.

When an executing change form is released, the listed items are released or canceled, and child items listed on their parents'
… Markup  lists are added on or taken off the lists. With an advisory change form, the status of items shown on the Affected  list is

not changed as a result of the change form being released.

Limit the number of items on the Affected  list. A smaller list is easier and faster to review and approve.

Item rows
Add an item to the change form by dragging it from the Item Explorer, and dropping it onto the Affected  list. When working with an
executing change form, this item drop may add other items automatically; see How items are added , below.

If you have a preferred sorting sequence for the affected items, you can sort the list using a context menu command (for example, Sort
by Number ), and then select the Update line numbers  menu item to renumber the list. After the change has been routed, the list can be
temporarily sorted, but the line numbers are permanent.

A part or document can be dragged from the Affected  list to any other location that accepts the item. Only one item at a
time can be selected.

Use the filter buttons to change what's shown in the list:

 Show/hide home items
 Show/hide partner items
 Show/hide parts
 Show/hide documents
 Collapse list to hide details
 Expand list to show details

An executing change acts on an item to:

Release a pending iteration. The single  row releases the iteration. The change form does not have a released iteration to
cancel.
Revise an item. It has two iteration rows: one row  cancels the earlier iteration and the other row  releases the revised
iteration.
Cancel a released iteration. The single  row cancels the iteration. The change form does not have a pending iteration to
release.

This canceling iteration must be removed from parent relations (BOM, Sources, References lists) before the change
can be routed.

Iteration rows
On an executing change form, each affected item has one or two rows that show the revision and lifecycle that will be released or
canceled, and the Release description .

The icons show what happens when the executing change form is released:

 If the iteration is pending when the change form is routed, then it is released when the change form is released. This row is
shown when the affected item:

Doesn't have a released iteration, and you want to release its pending iteration; or
Has a released iteration that is being replaced by this pending iteration.

 If the iteration is released when the change form is routed, then it is canceled when the change form is released. This row is
shown when the affected item:



Doesn't have a pending iteration, and you want to cancel its released iteration; or
Has a pending iteration that is replacing this released iteration.

Disposition rows
A disposition specifies how to move production items from canceled to released configurations, and calculates the cost of the change.
Canceled items are reworked or discarded, and released items are prepared for use. These activities are authorized only after the
change form's review, approval, and release. Although physical parts are commonly dispositioned, you can also disposition
documents; for example, recovering or destroying canceled drawings, and distributing released replacements.

Dispositions are linked to iterations that an executing change form is releasing or canceling. The Change Forms collection →
Release/Cancel iterations on Affected list  setting must be marked. Advisory change forms don't accept dispositions.

Disposition tasks are performed when the change moves to the Released  state. The Change Forms collection → Pause at
Released state  setting must be marked. Changes that immediately move to the Completed  state after approval don't accept
dispositions.

Each iteration can have one or more disposition rows, each describing a specified activity (or cost) at a specified location.

Adding a disposition row
To add disposition information to an affected iteration:

1. Select the iteration, and do one of the following:
Select the iteration, open the context menu, and select the Add Disposition  command; or,
At the top of the Affected list, click on the  button.

2. In the disposition detail at the bottom of the form, enter the disposition information.

Disposition detail panel
When a disposition row  is selected, its detail panel at the bottom of the form shows this information:

Activity
The disposition action or category.

Location
The location of the items to be dispositioned (as of the date shown in the Quantity ).

Recurring activity
Mark this checkbox if the activity represents an expense for all future items, such as a per-unit licensing fee or tooling
amortization cost.

Quantity
The number of items to be dispositioned, their units, and the date of the item count.

Unit cost
The unit cost for each item to be handled in accordance with the disposition instructions at the specified location.

Subtotal cost
The total cost for the dispositioning activity is calculated by multiplying the quantity by the unit cost.

Assigned to
You can assign the activity to a particular person, who can then view the assignment in the Tasks  list on the Item Explorer.

Target completion
Specify the date when the dispositioning activity should be done.

Actual completion
The assigned person can update this (as well as the quantity and unit costs fields) after the change form has been released
to show when the actual dispositioning activity was completed.

Notes
Instructions for performing the dispositioning activity.



Deleting a disposition row
To delete disposition information from an affected iteration:

Select the iteration, and do one of the following:
Select the disposition row, open the context menu, and select the Delete Disposition  command; or,
At the top of the Affected list, click on the  button.

How items are added

Advisory change form
When you add an item to the Affected  list of an advisory change, only that item is added to the list. PDXpert does not add any other
items automatically.

Executing change form
When you add an item to the Affected  list of an executing change, PDXpert looks at the item's BOM , References  and Sources
lists to decide what other items should be automatically added:

1. If you add a parent item, and that item has a BOM, source or reference child item with a pending iteration, then that child is
automatically added to the Affected  list. You can manually remove any released child with a pending iteration from the

Affected  list.
2. All child items that are automatically added to the Affected  list are examined. If the child item has a BOM, source or reference

child item (a "grandchild") that has never been released, then that grandchild item is automatically added to the Affected  list.
This process is repeated for each lower level until all automatically-added items have been examined, and all never-released
items have been added.

You must select lower-level pending iterations that are not visible on the parent you add. That is, you must manually
add to the Affected  list any released grandchild that has a pending iteration.

Before routing the change for approval, always review the Affected  list to make sure that PDXpert is doing what you intend.

An item on a change form should be re-dropped onto the Affected  list each time you modify the item's BOM , References
or Sources  lists.

Conflicts may arise when a child item (a) is listed on a different change form, (b) has no pending or released iteration
available, (c) has edits that aren't saved, or (d) has been revised after the parent item has been added to the change form. To
resolve these conflicts, fix the underlying problem and then re-drop the parent item onto the Affected  list to correctly add
the child item's iteration.

The most efficient way to ensure your intended changes get onto a change form's Affected  list is to work from the bottom of
your revised product structure to the top. That is, add each higher-level revised item onto the change only after you've added
all lower-level iterations.

There may be times when a previously-released item has an incomplete pending iteration, and you don't want it added
automatically to any change forms. In this case, make a separate executing change and add the item to the Affected  list.
When its parent items are later added to other change forms, the pending iteration is on a change form and thus can't be
added.
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Many times, a change is part of a larger set of changes. For example, a deviation may need a change request, which in turn needs a
change notice. Similarly, you may need to implement one change notice before you can proceed with a dependent set.

You can show this relationship by dragging any number of change forms from the Item Explorer onto the list.
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A person with a full-function account can review and approve change forms on behalf of a group (identified in the Groups collection).

Before the change form is routed for review, you can add and delete reviewing groups to the approval list. You can also specify the
sequence in which the reviewers are notified and whether the reviewing group's participation is required or optional.

Authorized reviewers examine a routed change form. A reviewer can never sign on behalf of a different reviewer, or undo a signed
change form if a subsequent reviewer has acted on it or the change is no longer in the Routed  lifecycle state.

As the change originator or analyst

Order
The review sequence determines the sequence that reviewing groups are notified of the routed change. You can have several
groups with the same review order value. All groups that share the same review order are notified at the same time.

Group
Specify the group that reviews the change.

Participation
Specify whether the reviewing group is required — Must act ⌵  — to approve the change. If the group's response is optional
— Can act ⌵  —, the change will simultaneously notify the next group in sequence while waiting for the group's response.

As a reviewer

Comments
Add comments to explain the reason for your response.

The Reviewer's comment required system rule  may require your comment before your response is saved.

Reviewer response (and status date)
Specify whether you approve, disapprove or want to hold (suspend) the change form.

 Approve
 Disapprove
 Hold

Reviewer
When you provide a response for the group, your name is automatically shown.

Password
After providing your response, you're prompted to enter your password. After you type in your password, your response is
recorded, all fields are locked, and the workflow lifecycle is updated.

When a routed change form is returned to the Submitted  or Originated  state, it shows the current reviewer names,
responses and comments. When the change form is again sent to the Routed  state, each reviewer's name and response is
cleared, and the comment is retained. Any person currently in the group can provide a response for the re-routed change.
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As the change lifecycle state is updated, the observers shown on this list are sent an email notice.

The people listed on the Observers  list are usually only interested in major events in the workflow (such as when the change is
released or rejected). The change workflow used by the change form determines the workflow paths when email notices are sent.

To add a group of observers, drag the group's name from the Groups collection of the Collection Explorer onto this list.
To add an observer, drag the person's name from the Persons collection of the Collection Explorer onto this list.

Delete an observer or group by clicking on it, and then pressing your keyboard's Delete  key.
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These controls are visible only when the ☑ Show Files tab  checkbox is marked on the related Document Types , Part
Types , or Change Forms  collection member.

PDXpert can directly operate on the files that define a product. You tell PDXpert where the file is, and whether you want PDXpert to
copy it into the data library or just point to it as an external browser link.

All commands for file management are on the Tools ➔ Files  submenu, as well as on each list's context menu.

There are 3 general categories of files: closely managed revision files, item attachments saved in the system library, and external links
to resources that PDXpert doesn't manage.

In a standard PDX package, part/document revision files and change form files are included ( isFileIn="Yes" ). Item files
attached to documents and parts are identified in the PDX package but are not included ( isFileIn="No" ).

Links to external resources are included in a PDX package. Some users may not see the linked resource if, for example, the
link points to a private server on your local network.

All files' Notes  are included in PDX attachment descriptions.

Revision Files
A revision file is related to a particular technical revision of a part or document, and is permanently saved within the data library when
the related item iteration is released by a change form.

Objects that don't have revisions (such as Change Forms and Organizations) don't have revision files.

Because a revision file is identified by revision and not by lifecycle, PDXpert uses the accepted term revision file even though the file is
attached to an iteration (revision + lifecycle) record. A new iteration that simply modifies the record's lifecycle usually copies its revision
files forward with the same technical content. The file's Notes  text is tied to the file, and is shown on all iterations that use that file.

Item Files
An item file isn't as tightly controlled as a revision file. It can be added, changed or deleted throughout the item's life regardless of any
iteration's release status.

An item file can be saved within the PDXpert server's library, or saved as an external link.

An item attachment saves an exact copy of a file. These may be background sketches, customer notes, vendor quotes or
production records.
An external link is a resource on the local network or internet that PDXpert doesn't copy or control. It may be updated, moved or
deleted without PDXpert knowing. Use an external link when you want to point to the latest version of "background information"
data, such as a supplier's web page.

File commands
These commands are shown on the file context menu. Some commands are shown only for a revision file or for an item file.

 View File...
Copies the file from the server to a temporary location on your computer, and asks Windows to open the copy. See the
Viewing a file  help topic.

 Copy Library File...
Copies the file from the server to a location that you specify. See the Copy a file  help topic.

 Add New File...
Adds a file to the Revision Files  or Item Files  list. See the Attach a revision file  or Attach an item file  help topics.

 Add New External Link...



Lets you specify a link to an external resource, such as a website or network file. See the Attach an external link  help topic.

 Add Notes...
Add a brief comment about the file.

 Permissions...
Sets permissions for viewing and managing the file.

 Check Out and Lock...
Copies a revision file to a location you specify, and locks the file so other users can view and copy the file, but can't check it
out. See the Check out a file  help topic.

 Check In and Free...
Replaces the checked-out revision file from a location that you specify, and frees the file lock so that other users can check it
out. See the Check in a file  help topic.

 Free File Lock
Removes a checked-out file's lock without replacing the file with an updated version. See the Free a file lock  help topic.

 Delete File
Deletes the selected file from the list.

A revision file can be immediately deleted if it's not on an earlier released iteration. Otherwise, it can be marked for
removal after processing an executing change form. See the Remove a revision file  help topic.
An item file or external link can be deleted without processing a change form. See the Remove an item file or external
link  help topic.

Microsoft Windows provides good cross-platform file support. However, archive files – .zip , .7z , .rar , and similar general
purpose lossless compression formats – should be made only on a Windows machine.
All files, including compressed files, are copied unchanged into the PDXpert library. If a compressed file is later included in a
PDXZ backup file or a PDX package, Windows may try to optimize files that can be decompressed by the .NET
System.IO.Compression namespace. If any file was compressed on a non-Windows platform or downloaded from the
internet, this Windows optimization may create an invalid PDXZ file or PDX package without warning.

Backup: If you're unsure about the source of any compressed file attachment, then do not use the .PDXZ  file format.
Instead, use the Database without Library (*.bak)  backup format, and save the Library  folder files separately.
PDX package: Before attaching a non-Windows compressed file, decompress the archive's content and then re-
compress it on a Windows machine. This applies only to revision file attachments; a PDX package does not include
item file attachments.

Windows may block unknown files that are downloaded from sources outside your network. Windows sets a hidden NTFS
Alternate Data Stream (ADS) that must be changed.



Before attaching a file to a PDXpert item, open the file's Properties  window to see that the file is unblocked. Administrator
permission may be needed to unblock a file.
If you're careful about downloads and have a good antivirus program, you can configure Windows to stop blocking files using
a group policy or registry setting. Search the web for disable windows file blocking  Or, save the file to a non-NTFS
drive (e.g., FAT) which doesn't support ADS. For more technical discussion, read about the IAttachmentExecute  Windows
API and IZoneIdentifier  interface.

Related topics
Item Explorer: Files
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Give yourself or others an informal reminder about preparing the item for release using the Tasks  list. Whether you need to make
sure of a design parameter, write a procedure, or call your supplier, you can enter the task and update it.

Tasks are requests, not requirements. Incomplete tasks do not prevent an item from being released. After release, the task is
no longer relevant and is locked at its current status.

Assigned to
This is the person that has been given a task. The task is made by dragging this person's name from the Collection Explorer's
Persons collection, and dropping that onto an empty area in the list.

Due on
The day when the task should be completed.

Status
Shows the progress of the task:

Not Started: When the task is given, before work has begun.
In Progress: The assigned person is working on the task.
Waiting on Another: The assigned person needs information from a different person to complete the task.
Completed: The task is finished.
Deferred: The task will not be completed for the current release, but may be considered for a later release.
Canceled: The task will not be performed. The notes should discuss why the task is no longer useful.

Status on
The date that the status was changed (managed by the system).

Priority
Select the urgency of the task. The person's task list shows the highest priority tasks first, then the soonest due dates, and
finally by the most-recently modified tasks.

Assigned by
The person who gave the task (managed by the system).

Assigned on
The day that the task was given (managed by the system).

Task description
Describes the task.

Related topics
Working with tasks
Item Explorer: Tasks
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You can use this to keep the item's history, meeting minutes, or for any other purpose you choose.

You can enter up to about 10 printed pages of general information.
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Administrators open this window using Tools menu ➔ System Rules...  The menu command is shown when the user's role has ☑
Collections/Rules administrator  marked.

Before editing a system rule, ensure that no other users are using the system. After editing a system rule, close the PDXpert
client and start it again.

System rules are managed by persons who have been given a Roles collection  member that includes the ☑ Collections/Rules
administrator  permission.

Refer to the individual System Rules reference help topics for information about each system rule.

General: Item uniqueness specified by...
General: Reviewer's comment required on...
General: Unlock change form Files
General: Unlock change form Tasks
General: Copy previous tasks
General: Copy files to snapshot
Password Policy
References Tabs
BOM: Allow duplicate parts
BOM: Lock part default unit of measure
BOM: Allow partner parts
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Before editing a system rule, ensure that no other users are using the system. After editing a system rule, close the PDXpert
client and start it again.

Administrators open this using the Tools ➔ System Rules…  menu.

Purpose
Determines the behavior of attached files when items are duplicated.

Description
True: All files attached to a source item are copied to any snapshot of that item.

False: Files are not copied from an item, and the user should manually add any relevant files to the item snapshot.

Data type
True/false

Recommended or default value
False

Details
Files are typically attached to an item (and to a particular iteration of an item), and usually can't be used on new items copied from a
snapshot.
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Before editing a system rule, ensure that no other users are using the system. After editing a system rule, close the PDXpert
client and start it again.

Administrators open this using the Tools ➔ System Rules…  menu.

Purpose
Determines whether tasks on a part/document iteration (revision) are copied to the new pending iteration or a snapshot.

Description
True: All tasks shown on the existing item iteration are copied to the new pending iteration. In the case of a snapshot, tasks are copied
to the new part or document. Each copied task's status is reset to Not Started .

False: Tasks are not copied from the existing iteration, and the user must manually add tasks.

Data type
True/false

Recommended or default value
False

Details
Tasks may be consistent from one iteration to the next, in which case they can be automatically copied forward. However, copying old
tasks may not be useful and requires careful review before saving the new iteration (which sends task-related emails).

When using the Edit  menu's Snapshot ...  commands, the existing item's most recent tasks are copied to the new item's first iteration if
this system rule is True.

A change form's tasks are not affected by this setting.
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Before editing a system rule, ensure that no other users are using the system. After editing a system rule, close the PDXpert
client and start it again.

Administrators open this using the Tools ➔ System Rules…  menu.

Purpose
Specifies the identifier set that's used to determine item uniqueness. The identifier set prevents duplicate items. An item can't be saved
if the values in its identifier set are the same as an existing item's.

Description
True: Include the data element to validate that an item's identifier set is unique.

False: Ignore the data element while validating that an item's identifier set is unique.

Data type
True/false

Recommended or default value
Data element Element description Default

Number Part or document number True

Organization Item owner True

Class Part  or document False

Type Part Type or Document Types collection member False

Details
When a data element is set as True (that is, the checkbox is marked), it's included in the test for uniqueness. Or, you can think of it this
way: setting a data element to False makes that element a passive attribute that will be ignored, just like the item's Name, Language or
Trustee.

Reducing an identifier's "degrees of freedom" by clearing checkboxes reduces ambiguity and communication errors.
However, be cautious about removing data elements after items have been given identifiers using a larger set of elements. If
you reduce the identifier set so that previously-unique items are now considered duplicates, you may need to modify at least
one element of the item's identifier set to re-establish uniqueness before saving.

Selecting the Number  as True with the Organization  as False would mean that many legitimate overlaps between two
organizations' part numbers would be invalid. Except in special circumstances, if you mark ☑ Number , you should also mark
☑ Organization .

Identification goal Example & configuration Number Organization Class Type

Within any organization, there can be
no duplicate part numbers and no

duplicate document numbers. No part
may have the same number as a
document. Recommended goal.

You give number 12005 to any organization's document.
No other document or part owned by that organization

can be given number 12005.
You could have a single Identifier Sequence shared by
all Part Type and Document Type members. You could
also define Identifier Sequence members with distinct
formats for documents and parts; for example, a 5-digit

True True False False



number is given to a document and a 6-digit number is
given to a part.

Within any organization, there can be
no duplicate part numbers and no

duplicate document numbers.
However, a part and a document may

share the same number.

There can be only one part 103006 and one document
103006. The document 103006 may (but doesn't need to)

specify the design details of part 103006.
You'd have a single Identifier Sequence shared by all

Part Type and Document Type members, and
manually give (edit) the identifier of one related part to

match the document number (or vice versa).

True True True False

Within any organization, there can be
duplicate part numbers and document

numbers, provided that they are of
different types.

You could give 120406 to a part such as a bare printed
circuit board (Part Type: PCB), and overlay related
document types: Schematic 120406, Drill Pattern

120406, and Silkscreen 120406.
Each part and document type could have their own
Identifier Sequence, but they all share the same

length and format. When appropriate, you'd manually
give (edit) the identifier(s) for related items.

True True True True

The software performs no validation,
and duplicates items are OK. Not

recommended for normal use.

You could give any value to any item data element. This
is for unusual circumstances, such as when legacy data

contains duplicate items.
To reduce the chance of giving the same identifier to new

items, ensure that your Sequences: Identifier
collection members cannot overlap by either giving

unique prefixes to each one and/or by minimizing the
number of members specified in the Sequences:

Identifier collection.

False False False False
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Before editing a system rule, ensure that no other users are using the system. After editing a system rule, close the PDXpert
client and start it again.

Administrators open this using the Tools ➔ System Rules…  menu.

Purpose
Specifies whether a user who reviews a change form is required to provide a comment for specified responses.

Description
True: The authorized reviewer for a group must provide a reason for the response.

False: The authorized reviewer for a group may, but is not required to, provide a reason for the response.

Data type
True/false

Recommended or default value
Reviewer's comment required on

Approve: False
Disapprove: True
Hold: True

Details
Approvals are the expected response and typically don't require any comment. The decision to disapprove or hold is an unexpected
response and the reviewer should provide a reason, unless the change originator and reviewers will always be quite familiar with the
issues involved in the decision.

Regardless of how the system rule is marked, a comment can always be added at the reviewer's option.
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Before editing a system rule, ensure that no other users are using the system. After editing a system rule, close the PDXpert
client and start it again.

To avoid unexpected effects, all change forms should be Completed , Canceled  or Rejected  before editing this system rule.

Administrators open this using the Tools ➔ System Rules…  menu.

Purpose
Determines when the Files  list is unlocked and available for attaching and removing files and external links.

Description
Allows change form Files  list to be modified while the change has not yet been routed for review, or until the change form is
Completed  or Rejected .

Unlock change form Files while change

◉  Is at Originated or Submitted
Select this when change form files and external links must be attached for review and approval. After a change is Routed
(and beyond), files are locked. Returning the change form to Originated  or Submitted  unlocks the Files  list, and files can
be attached and removed.

◉  Is not Completed or Rejected
Select this when change form files and external links may be added during the preparation and review cycles, and locked only
when the change is finished.

To add or remove files when the change is Released , the Change Forms collection member must have its ☑
Pause at Released state  checkbox marked.

Data type
Option selection

Default value
Unlock change form Files while change ◉  Is at Originated or Submitted

Details
These values define when the change originator and product teams can add, replace, and remove change form files.
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Before editing a system rule, ensure that no other users are using the system. After editing a system rule, close the PDXpert
client and start it again.

To avoid unexpected effects, all change forms should be Completed , Canceled  or Rejected  before editing this system rule.

Administrators open this using the Tools ➔ System Rules…  menu.

Purpose
Determines when the Tasks  list is unlocked and available for assigning and completing tasks.

Description
Allows change form Tasks  list to be modified while the change has not yet been routed for review, or until the change form is
Completed  or Rejected .

Unlock change form Tasks while change

◉  Is at Originated or Submitted
Select this when change form tasks are used only to prepare the change for routing. After a change is Routed  (and beyond),
tasks are locked. Returning the change form to Originated  or Submitted  unlocks the Tasks  list, and tasks can be assigned
and closed.

◉  Is not Completed or Rejected
Select this when change form tasks are used to prepare the change for completion, and are available during most of the
workflow. Tasks can be used for general dispositioning instructions where detailed instructions aren't required, or for advisory
changes without an iteration on the Affected  list.

To work with tasks when the change is Released , the Change Forms collection member must have its ☑ Pause at
Released state  checkbox marked.

Data type
Option selection

Default value
Unlock change form Tasks while change ◉  Is at Originated or Submitted

Details
These values define when the change originator and product teams can add, adjust, remove and close change form tasks.
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Before editing a system rule, ensure that no other users are using the system. After editing a system rule, close the PDXpert
client and start it again.

Administrators open this using the Tools ➔ System Rules…  menu.

Purpose
Specifies the password characteristics for all user accounts.

This password policy is only for user accounts authenticated by PDXpert. If user accounts are authenticated by your
organization's Active Directory (AD) or Lightweight Directory Access Protocol (LDAP) service, then the domain password
policy applies.

Passwords are tested against these rules only when the user creates or changes their password. Users are not required to
change their password if it met the previous rules. Use the Password period  to force a password expiration. After the period
has expired, users will have new passwords, and the Password period  can be adjusted or returned to 0  (never expires).

Description
Administrators specify the numeric, symbolic, and upper-/lower-case alphabetic characters, as well as the minimum number of
characters, that are required of all users' passwords.

Data type
True/false; integer

Recommended or default value
Assess your environment (number of users, sensitivity of product information, computer locations, regulatory requirements, etc.) to
determine your password policy. See comments for each control.

Details

Separate password required
Marking this value specifies that the user must make a unique password for change reviews. Clearing this checkbox lets the
user enter the account log-in password for saving a change reviewer response.

This value is typically not marked unless a separate signature validation is essential. In most cases, it's unnecessary
to require a user to manage two separate passwords.

Must have at least one uppercase letter: A to Z

Must have at least one lowercase letter: a to z

Must have at least one number: 0 to 9

Must have at least one symbol: !@#$%^&*(~)+[-]<|>/?\{_}
When one of these checkboxes is marked, the user's password must use at least one character from the specified character
set.

Mark at least two, and preferably 3, of these checkboxes to ensure a minimal level of security.

Minimum password length
The maximum length is 28 characters. If you set this value to zero, then the user can have a blank password.

The password length, coupled with a rich set of Must have at least...  values (above), determines the overall password
strength. A length of at least 8 characters ensures a minimal level of security.

Password period



The number of days that a password remains valid. The maximum period is 1000 days. A user's password never expires if
you enter 0.
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Before editing a system rule, ensure that no other users are using the system. After editing a system rule, close the PDXpert
client and start it again.

Administrators open this using the Tools ➔ System Rules…  menu.

Purpose
Determines whether part and document records' References  lists will accept child parts or documents.

Description
True: Items of the specified class can be added onto the item's References list.

False: Items of the specified class can't be added onto the item's References list.

Data type
True/False

Recommended or default value

Parts
If both checkboxes are cleared, then the References  selection is not shown on part records.

References accept parts
Default is True. Set as True to let part records reference other parts (for example, designed parts may identify tooling or
fixtures).
A multi-level part relationship is normally shown as an assembly/components list on the BOM , not as References .

References accept documents
Default is True. Set as True to part records reference documents (for example, assemblies may identify assembly
instructions).

Documents
If both checkboxes are cleared, then the References  selection is not shown on document records.

References accept parts
Default is False. Set as True if you let document records identify parts as references.

Because a document doesn't consume or otherwise rely on the existence of a part, this relationship is typically not
allowed.

References accept documents
Default is False. Set as True if you let document records identify other documents as references (for example, procedures
may identify requirements).

Multi-level document references are not shown in standard reports or supported by the IPC-2570 "PDX" export
standard.

Details
Avoid cross-references where two records reference each other. You can easily discover a cross-relationship by looking at
the referenced item's Appears On: References  list.

Simplify the relationship by limiting which items can reference other items. Reference relationships should be single-level ("flat"), not
multi-level ("deep"). Deep relationships require custom transforms to show, and cannot be exported in a PDX package.



2152



Limit part to one BOM row (rule) Home 190

Before editing a system rule, ensure that no other users are using the system. After editing a system rule, close the PDXpert
client and start it again.

Administrators open this using the Tools ➔ System Rules…  menu.

Purpose
Determines whether a part record's BOM  list can have more than one row with the same part number.

Description
Lets multiple rows of the same part number (for example, a wire of various specified lengths) to be added to a BOM list.

Data type
Option selection

Recommended or default value
A part number can be added to a bill of materials

Within a single row only
Default (recommended) setting. Select this if a part can't be used on more than one row. If a user tries to add a part that
exists on the BOM markup, the system blocks the added part and shows an error message.

This setting tests for duplicate parts only as the part is added to the BOM. If existing BOM lists contain duplicate part
numbers when you select this system rule setting, the existing assemblies are not changed.

On one or more rows (show warning)
Select this if a part can be used on more than one row, but duplicates are unusual. When a user tries to add a part that exists
on the BOM markup, the system shows an option to cancel or continue.

On one or more rows (no warning)
Select if a part number can be used on more than one row, and duplicates are common. No warning is shown.

Details
In almost all industries, the default setting (Within a single row only) is preferred practice. Manufacturing systems typically expect all
individual instances of a part number to be consolidated into one row (at one Find). The assembly's total required quantity is not split
across several rows.

However, a few specific manufacturing processes may need several rows with the same part number; for example, a wiring harness
manufacturer must specify different lengths of the same wire.

Some manufacturing systems may not accept duplicate part numbers within a bill of materials. Before letting duplicates,
make sure that downstream software systems can work with multiple rows of the same part number.

When the setting is Within a single row only , then importing a BOM file with duplicates will fail; otherwise, duplicate parts are
treated as correct and no warning is shown.
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Before editing a system rule, ensure that no other users are using the system. After editing a system rule, close the PDXpert
client and start it again.

To prevent unit of measure conversion errors in MRP exports and roll-up reports, this rule is a one-time setting. If this rule
is saved as False, then it cannot be reset as True.

To avoid problems with your internal systems and supply chain partners' software, keep this rule set as True.

Administrators open this using the Tools ➔ System Rules…  menu.

Purpose
Ensures that a part's default unit of measure is always used on a bill of materials (BOM).

Description
True: Every BOM uses the Default unit of measure  that's been specified on the part's Attributes  page. The unit cannot be edited on
the BOM.

False: The unit of measure specified on a part can be overridden with a compatible unit of measure on a BOM markup. For example, a
part with a default unit (for example, length cm) can be added to a BOM markup, and then be re-specified with a compatible unit (say,
mm or inch).

While this rule is False: If you change a part's default unit of measure, use the part's Appears On: BOM  list to make sure that
the quantity and unit of measure is correct on each BOM.

Data type
True/False

Recommended or default value
True.

Details
It's highly recommended to keep the default value (True). Many production planning systems and contract manufacturers use a
part's default unit of measure everywhere, including on the BOM.

Setting this rule to False gives users greater freedom to specify units of measure on assembly BOMs. However, this is generally useful
only in small-volume engineered-to-order or one-of-a-kind products, and is risky for volume manufacturing.
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Before you begin editing a system rule, ensure that no other users are using the system. After you finish editing a system
rule, close the PDXpert client and start it again before working with items.

Administrators open this using the Tools ➔ System Rules…  menu.

Purpose
Determines whether a bill of materials must contain only home organization parts, or can include partner organization parts.

Description
True: A partner part—that is, where the owning organization is not the home organization—may be added to a BOM: Markup  list.

False: Only home parts can be added directly to a BOM: Markup  list. A partner part can be added indirectly to the BOM by making a
home part, adding the partner part to the home part's Sources: Markup  list, and then adding the home part to the BOM.

Data type
True/false

Recommended or default value
False

Details
It's highly recommended to keep the default value (False). Standard practice says that the BOM shows only home parts, and never
partner parts. The home part on the BOM specifies requirements, while partner parts (source parts) meet those requirements.
Standard practice reduces production and servicing costs by making it easier to re-use, substitute, disqualify, and specify alternate
sources.

Setting the value to True is generally useful only in small-volume engineered-to-order or one-of-a-kind products, and is risky for volume
manufacturing.

Some manufacturing systems can't show partner parts on the bill of materials. Before letting partner parts on the BOM, make
sure that downstream software systems (including contract manufacturing ERP/MRP) identify parts using both organization
and number.

The IPC-2570 standard doesn't allow partner parts directly on the bill of materials. PDXpert's PDX package  implementation
exports the owning organization as an additional (non-standard) attribute.

When the setting is false, then importing a BOM file with partner parts will fail.

When partner parts are allowed, the BOM list shows the Owner  sort button, and includes the part's Display name  in the
part name.
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Collections can have system-wide impact.

Other users should not be using the system while you're making changes to your collections.
Close all item records in your workspace before you begin.
Change forms should be Released , Completed , Canceled , or Rejected  before editing the Change Forms
collection.
Close the PDXpert client and start it again when you've finished.

Each collection contains one or more members with attributes or rules. Each collection member may be simple (like a country name)
or complex (a Change Notice). More complex members may reference simpler members, and items (parts, documents, change forms)
are assembled from simple members (like Organizations), complex members (Part Types) and user-entered text and relationships.

A collection member has at least a name, description, three common attributes (below), and often a lot more.

Referenced and copied attributes
Each collection member has a set of attributes that are either referenced by, or copied to, the items that use them.

Referenced attributes are defined on the collection member and cannot be changed on the item that uses it. If an administrator
edits a collection member's referenced values, then all items that reference the member immediately show that new referenced
value.
For example, a unit of measure each is defined as a unique member of the Units of Measure collection. While a user may
select the each member for a part's default unit of measure, the user can't edit the name from each to EA. If an administrator
edits the collection member's name, every part that previously showed each would now show EA.
Copied attributes have an initial value in the collection member. This value is copied as a starting value that can be edited. If an
administrator edits a collection member's copied values, then previous items values are not affected; only new items created
after the update are affected.
For example, users can edit an individual part's Number  after the Sequences:Number value has been copied to the part.
Previous items' numbers won't be changed as a result of changing the Part Types member to use to a new number sequence,
or editing the sequence to use a different Prefix  or Next number  value. Creating a new Units of Measure collection member
has no effect on parts that have been assigned a unit of measure.

In summary: If a user cannot change the setting value on the item (say, the Type  name or whether the Files  list is shown), then this
is a referenced value. All administrator edits are passed to all related items (past, current and future). However, if the user can edit a
member setting on the item, then this is a copied value. Administrator edits on the related collection member won't affect the assigned
value on existing items.

Custom attributes are similar to copied attributes but have their own rules for how existing items are affected. See the
Custom attributes  help topic.

Common attributes
Each collection member has a Name , which should be unique among all members in the collection. Some collections have an
Abbreviation  (or Code  or Display name ), which should be unique among all of the collection's Active  members. After a new member
name is entered, the system may suggest an abbreviation, which can be accepted, changed or replaced.

Active: users can select
When this checkbox is marked, the member shows in selection lists for new objects. When cleared, the member shows only
on previous records and cannot be selected for new objects. You can modify this checkbox. At least one member of each
collection must be active; setting all members of a collection inactive may cause system errors.
An inactive collection member name is shown as dimmed in the Collection Explorer tree: Inactive member

Default member of collection



When this checkbox is marked, the member is given to new items that use the collection. Only one member of a collection
can be set as the default member . If this checkbox is marked, then ☑ Active: Users can select  is also marked and locked.
The default collection member name is shown as bold in the Collection Explorer tree: Default member

Permanent member of collection
This is a system-managed value. When the checkbox is marked, the member is required for proper operation. The member
cannot be deleted from the collection. Even when the checkbox value is locked, most other member attributes can be
modified.

Related topics
Add a new collection member
Change a collection member
Delete a collection member
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Back up your database before editing custom attributes. Editing (adding, modifying, deleting) custom attributes has a large
impact on your database. It modifies all related items, rebuilds the search index and public views, and replaces the client
cache.

Before you begin editing custom attributes, ensure that:

Other users have exited the system.
All data transfer services (e.g., ERP/MRP queries, ODBC connections) are stopped.
ODBC applications that use local views are closed. Changes to custom attributes can affect the local views database.
In your own PDXpert client, all parts, documents and change forms are closed.

Deleting a custom attribute removes its label and data from every related item. You cannot undo this removal; you can only
restore the database backup.

After you delete a collection member's custom attributes and before adding new custom attributes, save your edits and then
close the PDXpert client and start it again. This ensures that the client's local cache is using the updated database schema.

After you finish editing custom attributes, close the PDXpert client and start it again. Other users should start the PDXpert
client before resuming work with an ODBC application that relies on local views. This ensures that the client's local cache is
using the updated database schema.

Items affected by your edits must be re-indexed, which may affect search results until indexing is finished.

Purpose
Custom attributes are useful for specifying unique data about your product design. You can define custom attributes for any item type,
and those attributes are then attached to instances of that item.

A custom attribute is always related to an item, not an iteration. It can be modified by the item trustee, any analyst, and any Product
Team member regardless of the iteration's release state.

The document, part and change form windows let users provide a value for any custom attributes that you have specified in the
collection's member.

An item's custom attribute values can be inserted with its naming template (as specified on the Part Type or Document Type) to
automatically give the item's name.

Where used
Documents, parts, change forms

Data fields
Sort

This integer value (1, 2, 3, ...) determines the sequence in which the custom attribute is shown on the item (left to right, from
top to bottom). Missing values do not affect the layout sequence. If the same Sort  value is used by more than one attribute,
then these attributes are sorted by Name  value.

Using gaps between values (2,4,6,…; 10,20,30,…) allows new rows to be inserted without renumbering the current
values.

Scheme
The scheme determines the data type of the custom attribute value, as well as whether there's a unit of measure shown.
There are 3 principal schemes: UOM, data type and collection.

When a custom attribute's scheme is selected, it can never be changed.



The UOM scheme is used for numeric values with units of measure. For example, a part type (such as Machine Screw)
defines a custom attribute (for example, Length ) with a unit of measure (say, cm). As users make Machine Screw parts, they
can supply the actual Length  numeric value and unit of measure.
The Data: schemes specify a value with a particular format and data-entry method. On the item window:

Data: Boolean ⌵  becomes a checkbox.

Data: Date ⌵  provides a calendar dropdown control.

The same value is shown to all users, regardless of their computer's time zone. The value is not stored as
UTC or converted to local time.

Data: Float ⌵  accepts a numeric value with fractional element.

Data: Integer ⌵  accepts whole numbers only.

Data: Money ⌵  is similar to a Float, but also shows a member of the Currencies collection.

Data: String ⌵  is normal text (alphabetic, numeric, punctuation and symbol characters).

Data: URI ⌵  is a universal resource identifier, prefixed with ftp:// , http:// , file://  or similar, and has an
Open  button.

The Collection schemes specify that users can choose a member of the selected collection. For example, selecting the
Languages ⌵  scheme lets users select English, French or other active member of the Languages collection.

A custom collection  shows as Custom: collection name ⌵  such as Custom: Colors ⌵ .

Name
This is the name of the custom attribute, which is shown as the control's label on the item.

The strings _#_ , _##_  and _###_  are reserved and cannot be used for custom attribute names. Avoid using HK  as
the first two letters in your name to prevent conflicts with system "housekeeping" columns ( HK1 , HK2 , ...).

 See Naming custom attributes , below.

Description or use (mouse hover text)
This describes the custom attribute's purpose. The text is shown in a pop-up when the mouse is moved over the control.

It's helpful to show the expected range of values and data format. For example, instead of a general instruction like
Enter the maximum power  it's more helpful to say Maximum rating from 1W to 50kW . Users rely on these

suggestions to improve their search results.

Default value
Although a default value is not required, you can suggest one to the user. If you do not specify a default value, then a numeric
value is 0  and a Boolean value is false ; other scheme default values can remain empty.

Modifying the Default value  on an existing custom attribute does not change the value on existing items.

Default unit of measure
Units of measure are related to the UOM ⌵  and Data: Money ⌵  schemes. If you do not select a unit of measure in the item
type (for example, your data is text), then the item record's custom attribute unit of measure is also blank.

Changing the Default unit of measure  on a custom attribute is possible but may impact downstream conversions. Items
using the original unit of measure are not updated to the new value.

Setup
Custom attribute definitions follow these rules:

When a new custom attribute definition is added to an item type, all existing items of that type are updated to include the new
custom attribute. The default value, if any, of the new custom attribute is applied to each item.
If a custom attribute definition is deleted from the item type collection member, all items of that type lose that custom attribute.
An item's custom attribute is added or deleted regardless of its release status. The changes are seen when the affected item is
opened.

Consider limiting the length of the custom attribute Name  to less than 30 characters.



Adding a custom attribute
Read all warnings at the beginning of this topic.

To add a custom attribute to a Document Types, Part Types, or Change Forms collection member:
1. In the Collection Explorer, open the collection member that will have the custom attribute.
2. On the Custom  list, select a scheme, and name the new custom attribute. See Naming custom attributes , below.
3. Save the custom attribute: Item ➔ Save , or Ctrl + S .

Deleting a custom attribute
Read all warnings at the beginning of this topic.

Deleting a custom attribute automatically deletes its label and data value from every document, part, or change form that
uses to it.

To delete an existing custom attribute on a Document Types, Part Types, or Change Forms collection member:
1. In the Collection Explorer, open the collection member that has the custom attribute to be deleted.
2. On the Custom  list, click on an empty area within the row's background to select and highlight the row.

3. Press the Delete  key on your keyboard to remove the row.
4. Save the collection member: Item ➔ Save , or Ctrl + S .

Design guidelines
Also refer to the help topics under View & export via ODBC  for related information.

Each custom attribute requires two database columns: one is for a data value (string, number, date, etc.), the other for a collection
member selection.

Naming custom attributes
Custom attribute names show as column headers in public views and database queries.

Many types can share the same custom attribute Name . In this case, the item types' custom attribute values, regardless of scheme
differences, are inserted into a single value/member pair of database columns.

Almost any character (including the space character) may be used in the custom attribute name. However, limiting your character set
makes SQL queries easier to write, improves compatibility with members of the Transforms and Views collections, and simplifies
data exchange with other software systems.

Attribute name summary

The best custom attribute name (a) doesn't conflict with a standard PDXpert data column name, (b) begins with a letter, (c)
contains only ANSI Basic alphanumeric and underscore characters, (d) is short, and (e) is not a Microsoft SQL Server or
SQLite reserved key word.

Begin an attribute Name  with a letter character. Avoid special symbols, punctuation, and doubled space characters.
Use short Name  values, preferably fewer than 40 characters. Long labels are difficult to use when designing custom SQL
queries and reports, and when defining text templates to insert custom values . Use the Description or purpose  text for longer



explanations or instructions.
Avoid using attribute names as questions. You'll avoid the leading word as well as question mark ☑ Have you confirmed cost?
becomes ☑ Cost confirmed .
Use checkboxes (scheme is Data: Boolean ⌵ ) for simple either-or options. When there are three or more options, use a
custom collection  to limit users' choices like Not applicable ⌵  / Yes ⌵  / No ⌵ .

Avoid using unnecessary uppercase letters, which need extra space on small screens; for example, Organization  is often better
than ORGANIZATION .
PDXpert uses the Sort  numbers to automatically lay out attributes from left to right, and top to bottom. On the item's Custom
list, the right-hand columns are wider than the left. So, when the Sort  numbers are sequential, use the odd numbers (1,3,5,...)
for shorter labels and data, and even numbers (2,4,6,...) for longer labels and text responses.

SQL Server constraints
SQL Server column names must be a regular identifier that:

begins only with letter characters specified by Unicode Standard 3.2 (which includes A-Z  and a-z ), @  and #
limits subsequent characters to Unicode letters, 0-9 , _ , $ , @  and #
is not a Transact-SQL reserved word: http://msdn.microsoft.com/en-us/library/ms189822.aspx

Refer to this Microsoft SQL Server help topic for naming guidance:
http://msdn.microsoft.com/en-us/library/ms175874.aspx

SQLite constraints
SQLite column names must:

begin with a letter or underscore character, and
limits subsequent characters to alphanumeric and underscore characters.

PDXpert constraints
If you give a custom name that matches a system name, such as Number  or Type , then your values are prefixed in the view with an
underscore (like _Number  or _Type ).

PDXpert's public views and Batch Importer templates (for example, the ItemView  and ItemMaster template ) show common
system names. A complete list of data names requires a SQL query: SELECT * FROM (SELECT DISTINCT COLUMN_NAME AS
[Name] FROM information_schema.columns) C ORDER BY [Name]

PDX package XML constraints
The IPC-2750 standards use the W3C XML technology standard. While PDXpert handles most of the details, your custom attribute
names must conform to the XML standard, particularly regarding letter case and whitespace.

Your custom attribute's name is exported into PDX packages as an XML AdditionalAttribute element's name attribute value.
Differences in letter case or whitespace may prevent an export, or create inconsistent PDX export packages, or cause errors importing
the PDX package into other software.

Characters in the XML attribute name are case-sensitive. No case conversion ("folding") is performed before strings are
matched, thus A and a are not the same.
Rule: When a custom attribute name is used on more than one item type, use the same letter case for every type's name. For
example, a Purchase part's custom attribute name="RoHS" and a Design part's name="ROHS" may cause processing errors.
A validating XML importer may normalize attribute values by replacing whitespace ( 0x09 , 0x0A , 0x0D , 0xA0 ) with a space
( 0x20 ) character; discarding leading and trailing whitespace; and compacting multiple whitespace characters to a single space.
Rule: Use only normal space characters. Do not use new line or tab characters, leading or trailing space characters, or
sequences of space characters.

Number of custom attributes
PDXpert has no architectural limitation on the number of custom attributes specified, but there are practical constraints imposed by
SQL Server and search indexing.



A table or view in SQL Server is limited to about 1000 columns. PDXpert's public views may include multiple side-by-side items, each
with their own custom attributes. After deducting PDXpert's standard attributes from the total available SQL columns, the maximum
number of unique custom attributes specified across all item types is about 200 (that is, 400 SQL columns).

This maximum number:
Is specified on, and limited at, the item type collections. Custom attributes can be added to or removed from Part Types,
Document Types or Change Forms as needed, but the sum of the custom attribute definitions should remain within the limit.
Refers to uniquely-named custom attributes. If you have a Part Types collection member Design with the custom attribute
Tolerance , there is a pair of SQL view columns, Tolerance  and Tolerance_Member . Adding the Tolerance  custom attribute

to a different Part Types member, such as Purchase, doesn't make any new columns.
Does not limit the number of items that use a custom attribute list. Although the custom attribute definition limits should be
observed, you can have virtually unlimited item records with those custom attributes.

Compared to PDXpert's standard attributes, indexing a custom attribute for search needs much more time. Its name and
scheme must be examined, and then attached to the item's standard index results. Adding or deleting a custom attribute
updates all related items, which requires time to assign the starting value and re-index the items.

Batch Importer: Importing custom attribute values
See the Batch Importer: Definitions  help topic section for rules on importing custom attribute values.

Inserting custom attribute values into an item name
Each member of the Part Types and Document Types collections includes a name format definition, called a text template. The text
template is copied from the part or document type to the new item. The text template can include parameters that are replaced by the
values of custom attribute values.

Custom attribute values can be inserted into the item's name exactly as they're shown on the item's Custom  page. Values can also
be modified with formatting commands. For example, most custom attribute values can be converted to all uppercase characters.
Dates and numbers can be formatted for a consistent look. Some values can have extended properties, and some text can be
converted to title case.

After inserting, extra space characters are always removed from the name: two or more adjoining spaces are replaced with a single
space, and leading and trailing spaces are deleted.

Setting up a type's custom attribute for inserting
In the Collection Explorer, make or open a Part Types or Document Types collection member:

1. On the collection member's Custom  list, add a new custom attribute  or find an existing custom attribute. Notice the custom
attribute's Scheme  and Name . In this example, we'll say the Scheme  is Data: String ⌵  and the Name  value is Rating .

2. On the collection member's Attributes  page, use the custom attribute's Name  value in the Part name template  or Document
title template . Show the custom attribute's Name  value as {value}, along with any other text you want in the template. In our
example, let's use: Motor, {Rating} . The Data: String ⌵  scheme allows the inserted value to be formatted as uppercase :
Motor, {Rating@U} .

In the Item Explorer, make an item that's based on this collection member:

1. On the new item's Custom  page, enter the value into the custom attribute. For example, in the Rating  custom attribute, enter
100 watts .

2. On the new item's General  page, click the Name{x}  button to insert the actual rating value into the default part name. In our
example, Motor, {Rating}  becomes Motor, 100 watts . If the template is Motor, {Rating@U} , then the item description
becomes Motor, 100 WATTS .

Basic substitution
You can use a parameter more than once, and each can have its own format command.



Names and format commands are case-sensitive. Your parameter name in the text template must exactly match the custom attribute's
name.

When the scheme is Data: Boolean ⌵ , then the custom attribute Name, not the true/false value, is inserted into the item description. In
other words: when the custom attribute checkbox is marked, the checkbox's label is inserted into the item name; if the checkbox is not
marked, an empty string replaces the parameter.

Short, simple custom attribute names are more useful for inserting. In particular, a short Data: Boolean ⌵  custom attribute
like RoHS-compliant  is better for inserting than, say, Part complies with RoHS standard .

Extended values
Some custom attributes have a pair of values: a primary value and an extended value. You can use one or both values in the text
template.

Scheme Primary value {name} Extended value {name++}

UOM Numeric value Unit of measure

Data: Money Numeric value Currency 3-character code

Collection member Name Abbreviation

To insert an extended value into the text template, add ++  to the end of the custom attribute's name. For example, if you have a
custom attribute named Length based on the UOM scheme, then use {Length}  for the primary numeric value (e.g., 59 ), and
{Length++}  for the unit of measure (e.g., cm ). A collection member's abbreviation may also be called its Display name  or Short

name ; some collections may not have abbreviations.

Format commands
A format command contains one or more characters that begin with the @  character.

Number format commands
A number format command is a set of characters that specify leading zeroes, trailing zeroes, group separators (e.g., thousands) and
decimal separator (as "." point or "," comma). Some commands can be single characters; for example, the format command @D
specifies an integer without fractional element.

The client workstation's Windows Control Panel ⏵ Region  settings affect which characters are used for group separators and decimal
separator.

The most common format commands are briefly described in the following table. Each custom attribute value can be formatted using a
single "Standard" format command (like @F3 ), or several "Custom" format commands (like @0.00##E+00 ).

Some formats may overlap with the attribute's data scheme. For example, if you've specified a custom attribute as
percentage or currency, applying these format commands will be redundant, and the extra formatting may be misleading.

Style
Format

command
Description Example output

Standard D
Decimal value with optional negative sign.

An optional numeric value specifies the number of digits.
Valid only for the Data: Integer scheme.

D  applied to 12345 is 12345
D6  applied to 12345 is 012345

Standard E, e

Exponential value with optional negative sign.
An optional numeric value specifies the number of digits after the

decimal separator.
The format command's case defines the exponent as "E" or "e".

E  or E6  applied to 1234.5 is
1.234500E+003

e2  applied to 1234.5 is 1.23e+003



Standard F
Fixed-point value with optional negative sign.

An optional numeric value specifies the number of digits after the
decimal separator.

F  or F2  applied to 12345.6 is
12345.60

F0  applied to 12345.6 is 12346

Standard N

Numeric value with optional negative sign. Result is n,nnn,nnn.nn…
where n is 0-9, comma is the group separator, and period is the

decimal separator.
An optional numeric value specifies the number of digits after the

decimal separator.

N  or N2  applied to 12345.6 is
12,345.60

N0  applied to 12345.6 is 12,346

Custom 0
The zero-placeholder symbol forces a "0" where the converted digit is

empty.

000000  applied to 12345.6 is
012346

0.00  applied to 12345.6 is
12345.60

Custom # The digit symbol accepts a digit where the converted value is specified.
######  applied to 12345.6 is 12346
#.##  applied to 12345.6 is 12345.6

Custom . Inserts a localized decimal separator into the formatted value. See examples above.

Custom
E0, E+0, E-0
e0, e+0, e-0

Exponential value with optional negative sign.
An optional numeric value specifies the number of digits after the

decimal separator.
The format command's case defines the exponent as "E" or "e", and +

forces the sign character.

0.###E+00  applied to 1234.5 is
1.235E+03

0.00000e-0  applied to 1234.5 is
1.23450e3

For information on these and other format commands, search the web for .NET standard numeric format .

Date format commands
A date format command uses date and time parts, such as year, month and day. Put together commands to convert a date value: the
command @yyyy-MM  formats the custom attribute value of March 6, 2019 to 2019-03 . Some commands can be single characters; for
example, the format command @Y  is equivalent to @yyyy MMMM .

The Windows Control Panel ⏵ Regional and Language Options  settings affect non-numeric commands, such as names for days and
months. If consistency is important across computers, use only format commands that define numeric results.

The most common custom format commands are briefly described in the following table. The example shows the output when using a
date input value of Wednesday, March 6, 2019.

Format command Description Example output

d The numeric day of the month from 1 through 31 6

dd The numeric day of the month from 01 through 31 06

ddd The abbreviated, localized name of the weekday Wed  in the en-US culture, or the local culture equivalent

dddd The full, localized name of the weekday Wednesday  in the en-US culture, or the local culture equivalent

M The month as a number from 1 through 12 3

MM The month as a number from 01 through 12 03

MMM The abbreviated, localized name of the month Mar  in the en-US culture, or the local culture equivalent

MMMM The full, localized name of the month March  in the en-US culture, or the local culture equivalent

yy The last two digits of the year 19

yyyy The four digits of the year 2019



For information on these and other format commands, search on the web for .NET standard date format .

Text format commands
Custom attributes values – except numbers  and dates  – can be inserted as uppercase or lowercase. Add the @U  or @L  format
command to the custom attribute's name {name@U}  / {name@L} , or extended name {name++@U}  / {name++@L} . For instance, if
you have a Part Types collection member named Assembly with an abbreviation Assy, adding name@U  inserts ASSEMBLY  while
adding name++@L  inserts assy . A Data: Boolean ⌵  called RoHS  that's formatted in the template as {RoHS@U}  will be inserted as
ROHS  when the value is true.

Text can be inserted using Windows title case when it's a collection member name, a Data: String ⌵  attribute, or a Data: URI ⌵
attribute. Words that are in uppercase are treated as acronyms, and are ignored. You can apply localized Windows CurrentCulture
rules with @t  (lowercase) or a consistent Windows InvariantCulture using @T  (uppercase). Microsoft's title casing rules may change
over time.
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Collection Explorer  ◢  Places/Organization/Persons group ◢  Languages collection

Purpose
Identifies the language in which an item is written or used, in accordance with ISO 639 standard.

This is information about the item (principally documents, product labels and packaging), and does not affect any language
attributes or capabilities within PDXpert.

Where used
All items

Data fields
Name

This is the complete name for the language.

ISO 639 short code
The two-character ISO code was devised primarily for use in terminology and includes identifiers for most of the major
languages of the world. Most technology standards bodies (such as W3.org) use this code.

Terminology (abbreviation)
This should be one of the values specified for ISO three-character codes, and is required by PDXpert.

Bibliography code
This is an alternative ISO three-character code.

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Setup
You should identify the languages of your organization's international products and the likelihood of exchanging information in foreign
languages, and then make those languages available to your users.
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Collection Explorer  ◢  Places/Organization/Persons group ◢  Currencies collection

Purpose
Defines currencies for purchase and dispositioning costs.

Costing reports convert all calculated costs to the default currency.

The active currency exchange rates can be updated using the Tools ◢  Update Currencies...  menu command .

Where used
Countries, parts

Data fields

Name
This is the name of the currency.

Currency code
The system uses the ISO standard 3-character currency code. With the important exception of the Euro (EUR), this code
typically consists of a 2-character country code prefix, followed by a one-character currency letter: for example,
Japan:Yen=JPY, Switzerland:Franc=CHF, Canada:Dollar=CAD.

Exchange rate
This numeric value defines how many units of a currency that another currency can buy. The currency exchange rate is
referenced to the default currency ( ☑ Default collection member  is marked).
This value represents the number of units required to purchase a single default currency unit. That is, there are [this
currency's exchange rate] units per [default currency] unit. The default member's exchange rate is, by definition, equal to 1.

Example: It costs 100 Japanese Yen (JPY) to purchase one United States Dollar (USD). If the default currency
member is USD (exchange rate = 1), then the exchange rate for JPY would equal 100. Conversely, if the JPY
member is the default currency (exchange rate = 1), then the exchange rate for USD would equal 0.01.

Exchange date
This specifies when the exchange rate was acquired.

Active: users can select
Default member of collection
Permanent member of collection

After marking an inactive member as ☑ Active , update the Exchange rate  value.
After setting a Currencies collection member as the default, update all active Exchange rate  values.
See the Managing collections: Common attributes  help topic.

Setup
Although the collection members will change infrequently, if you do much business using other currencies you may wish to schedule
regular updates to the exchange rate information.
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Collection Explorer  ◢  Places/Organization/Persons group ◢  Countries collection

Purpose
Defines countries for addresses, telephone access codes and currencies.

The correct country is required for validating PDXpert's software license key.

Where used
Organizations, Persons

Data fields

Name
This is the complete (official) name for the country.

Short name
This is the common name of the country that's shown in most country-related fields.

Country code
The system uses the ISO standard 2-character abbreviation.

Internet domain
This specifies the Internet country code top-level domain issued by IANA.

Default language
This is the country's preferred business or technical language. Most companies that operate within this country communicate
in this language.

Default time zone (GMT/UTC)
This field is used to suggest local time zones for organizations that are in this country. If this country has more than one time
zone, it's usually most useful to select the time zone of the capital city or principal commercial center.

Telephone country code
Enter the numeric telephone country code. Although the telephone access code is usually unique, some countries share
codes (e.g., the US, Canada and the Caribbean are all 1) and other countries may have more than one code.

Currency
Select the country's currency from the Currency collection list.

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Setup
To reduce the number of countries they have to scroll through, users will appreciate if you mark ☑ Active: users can select  only for those
countries that affect your PLM procedure. Consider design groups, vendors, purchasing and (possibly) currencies. If you export your
products, then you may want to include destination countries.
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Collection Explorer  ◢  Places/Organization/Persons group ◢  Partner Classifications collection

Purpose
Classifies organizations and their function in your supply chain.

Where used
Organizations

Data fields
Name

This is the complete name for the partner classification.

Description
This gives the partner classification and its function.

PDX partner classification code
This should be one of the standard values specified for PDX packages, although you can create a non-standard (other)
value. For the set of standard PDX enumerated values, see IPC-2571, Section 9.1: globalPartnerClassificationCode

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Setup
Identify your organization's partner relationships: customers, suppliers, regulatory agencies are all likely. If you must track your source
materials or production for traceability or product recall, you may want to identify individual elements of a complex supply or distribution
channel (e.g., country distributor, regional distributor, reseller, manufacturer's rep).
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Collection Explorer  ◢  Places/Organization/Persons group ◢  Roles collection

Other users should not be using the system while you're working. Users (including you) may not see changes to their
assigned role until the next time they log into PDXpert.

Purpose
Specifies the permissions users have for accessing information, which should correspond to their job responsibilities. A role may be
given to any number of users, and each user has exactly one role.

Where used
To specify permissions to user accounts in the User Management  list.

Data fields

General

Name
This is the complete name for the role.

Description
This gives the role and its function.

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Collections/Rules administrator
An administrator manages the Collections and Rules. If the Tools menu: Administrator Override command  is marked and the
role also permits access to documents, parts and changes, the administrator can modify many attributes of items after they've
been released.

Marking this checkbox marks all View  and Edit  settings in the Collections  page, which can then be edited
individually.

It's a good idea to have an administrator role assigned to two or more users. Set one administrator as the Super
Administrator .

Allow Transforms
When marked, the Report/Export Wizard and other custom report, DataGrid and table export functions can be used.
When cleared, the Report/Export Wizard is not shown on the Tools  menu. Custom report, DataGrid and table export functions
cannot be used.
Regardless of this setting, users can always use the standard reports and their "export as file" functions.

Allow local views on user computer
When enabled, the ☑ Enable local views  option can be enabled in the user's Tools ◢  User Settings...  menu.

Restrict access to read-only
This checkbox controls whether a full-function user account can change data. When marked, a full-function user account
cannot add or edit items, add file attachments, approve change forms, or act as an administrator. Viewing permissions are
controlled by the other role permissions.

Marking this checkbox disables all ☑ Manage  settings in the Collections  page.

Documents

View pending



The role has access to documents that have not yet been released.

View released
The role has access to documents that have been released, and are not canceled.

View canceled
The role has access to documents that have been canceled.

Create new
The role can add new documents, edit documents, and be a trustee for those documents.

Is an analyst
A document analyst can change trustees, be the trustee for any document, and manage changes that affect documents.

Parts

View pending
The role has access to parts that have not yet been released.

View released
The role has access to parts that have been released, and are not canceled.

View canceled
The role has access to parts that have been canceled.

Create new
The role can add new parts, edit documents, and be a trustee for those parts.

Is an analyst
A part analyst can change trustees, be the trustee for any part, and manage changes that affect parts.

Change forms
To view change forms, the Roles member must also allow View items owned by: All organizations .

View unreleased
The role has access to changes that have not yet been released, or have been canceled or rejected.

View released
The role has access to changes that have been released or completed.

Create new
The role can add (originate) new changes and submit them for review.

Submitted items can be edited
An item's Trustee edits an item's pending iteration before it's added to an executing change form, and while the executing
change is at Originated  state.
When this setting is not marked, after an item's executing change is submitted, only analysts can edit the item iteration.
When this setting is marked, the trustee may edit the affected iteration while its executing change form is at Submitted  state.
While helpful when the item trustee is not the change form's originator, it requires close communication between trustees and
the change analyst.

This setting doesn't affect users whose role includes ☑ Is an analyst  because an analyst can always edit items on a
submitted change.
This value is always enabled for the super administrator, regardless of the Administrator Override  menu setting.

View items owned by

User's organization
Users can always view items when the item's Owner  matches their organization.

User's and home organizations
When this option is selected, users can view items owned by the home organization, along with their own organization's
items.

All organizations



When this option is selected, users can view items owned by the home organization and all partner organizations.

Each user is assigned to an organization, which is given by the Persons collection  member's Organization  selection. When the user
is in the home organization, then the options User's organization  and User's and home organizations  are equivalent.

Setting a permission other than All organizations  may hide items in:

Search results
A part Sources  list
A part or document References  list
A part or document PDX package export
Built-in reports

Edit after first release
Some item data is locked at the first release, and cannot be changed on later iterations. When the following options are marked, the
data can be changed after the first release.

Disabling these options can remind administrators of your preferred practice, but administrators are never completely
blocked:

Any administrator can use the Batch Importer tool  or edit their own Roles collection member to change this data.
The Super Administrator can edit these item data fields, regardless of the setting. Set these options for other
administrator roles that use the Tools menu ➔ Administrator Override  setting.

Item description
A document title or part name can be changed after the first iteration has been released. The user must be the item's trustee
or an analyst for the item.

Accepted configuration management practice is to lock the original item name after the first release. Documents and
item catalogs may use the original name, and downstream systems (such as production and sales) may not update
item descriptions.

Custom attributes
Attributes shown on a document or part Custom  page can be changed after the first iteration has been released. The user
must be the item's trustee, an analyst or a member of the item's Product Team.

If a custom attribute value is used to generate the original item name, then consider whether to also mark the ☑
Item description  to allow a different name.

Mass and materials
A part's mass and materials list can be changed after the first iteration has been released. The user must be the item's
trustee, an analyst or a member of the item's Product Team.

For regulatory reporting (like RoHS compliance), a non-interchangeable change to the Materials  list normally
requires a new part number, rather than revising the list. For changes that don't affect regulatory report results, such
as adding non-regulated substances, the current part can be updated after release.

Collections
Restrict roles that can add or change members of the Transforms collection. Transforms directly access your database,
and inexperienced or malicious users can damage or destroy your data.

The role can view or edit any collection within the Collection Explorer. Most users should be allowed to view members of various
collections and, as needed, use the collections as a drag-and-drop source (for example, to assign persons to tasks). Some non-
administrative users may be allowed to manage selected collections, such as Organizations (e.g., to add new suppliers), Views (for
CAD users) and Units of Measure.

Marking an ☑ Edit  checkbox marks the related ☑ View  checkbox. Clearing a ☑ View  checkbox clears the related ☑ Edit  checkbox.

Setup



A person who belongs to a reviewing group on an executing change form has permission to view the change form and its
affected items, expanding the viewing permissions of the person's assigned role. See the Groups collection: Group reviewer
permission  help topic.

Throughout this user help guide:

An analyst is specified by marking ☑ Changes: Create new , as well as ☑ Documents: Is an analyst  and/or ☑ Parts: Is an analyst .
Analysts may be specialized by item class:

A document analyst has ☑ Documents: Is an analyst  marked.
A part analyst has ☑ Parts: Is an analyst  marked.
A system analyst has both ☑ Documents: Is an analyst  and ☑ Parts: Is an analyst  marked.

An administrator is specified by marking ☑ Rules/Collections administrator .

A reviewer should be given a role where, as a minimum, the related ☑ View pending  and ☑ View released  are marked. This allows
review of items affected by the change form, as well as related items (e.g., unchanged items on an assembly's BOM).

Typically, users employed by the home organization can view items owned by all organizations.
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Collection Explorer  ◢  Places/Organization/Persons group ◢  Persons collection

Purpose
Specifies people who have an interest in your product data and, optionally, lets you add and manage PDXpert user accounts for them.

Where used
System-wide

Data fields

General

Name
This is the complete name for the person.

Always use the actual name of a real person or kiosk machine. Unknown names like Engineer1 hide valuable
history and make software license compliance more difficult.

Before changing the person's Name  or deleting the person record, refer to the Setup below.

Email address
The Email address  is used for system notices, such as change reviews and task assignments. To send a person's notice to
several email addresses, separate each by a comma: user.name@mycompany.com, username@alternate.com

Use your email client (e.g., Microsoft Outlook) to act on incoming notices – for example, to sort into topic folders, set
a priority or schedule a reminder. The default email subject contains useful filtering criteria, such as the change type
abbreviation and workflow state.

Job title
This gives the person's job function.

Organization
Select the employing organization from the dropdown list.

Employee identifier
In larger organizations, this may be useful to distinguish between similarly-named employees.

Do not enter privacy-sensitive information such as social security number. Use an organization-issued identifier
instead.

Supervisor
Select the employee's supervisor from the dropdown list. This information may be useful when the employee cannot be
contacted.

Start at the highest level that you'll need of a company's organization chart. As you work down the chart, you'll
always have an employee's supervisor available as you enter their data.

Start date
You may wish to record when a person joined the organization, or first had access to PDXpert.

End date
You may wish to record when a person left the organization, or last had access to PDXpert.

Default member of collection
The default member of the Persons collection is called the super administrator. This user has full ability to view, create and
edit items, collections and system rules, even when assigned a Roles collection member with limited permissions. See the
Roles collection  and Manage user accounts: Setting a user as the super administrator  help topics.

Use the super administrator account to access your system under these unusual conditions:



All known log-in accounts or passwords have been lost. On the PDXpert Application Server, click the Reset Admin
button, then use the super administrator account to update user accounts in the PDXpert client's User Management
tool.
More log-in accounts have been assigned than are allowed by your PDXpert software license. Log into PDXpert using
the super administrator account, and then delete user accounts in the PDXpert client's User Management  tool. When
the total number of user accounts is within the limits shown in the Software License Key  tool, all remaining users will
again have normal access.

Active: users can select
Mark this checkbox for current PDXpert users, and clear it for previous users.

If you're removing a user's log-in account, you'll usually make the person record inactive to keep their activity
history, rather than rename or delete the record. See the Set a person's status to inactive  help topic.

Permanent member of collection
See the Managing collections: Common attributes  help topic.

Address
This contains the person's individual contact information.

When you click the Copy organization's address  button, then the person's Organization ⌵  values are copied to all empty address
and phone values. Existing values are not replaced. Delete any existing address and/or phone value if you want the organization's
value copied. The organization's email address and messaging user name(s) are never copied.

Setup
The Batch Importer tool can import and update Persons collection members and create user accounts .

Any number of Persons collection members can be added without affecting the software license count. Persons can receive email
notices without having a PDXpert user account.

For complete information on adding, changing and removing user accounts in the User Management  tool, see the Manage user
accounts  help topic.

It may not be possible to delete a person. PDXpert uses the person record to track user activity history. Even after you
remove the person from collections (Groups, Product families, all change forms' analyst and participants, custom
attribute defaults), the record may remain tied to items (trustee, auxiliary persons, custom attributes), file attachments (added
by, checked-out by), change reviews, tasks (assigned by/assigned to), and queued email notices.

If the person was given a user account, it's more practical to keep the user's history by deleting the user account and making
the Persons member not active.
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Collection Explorer  ◢  Places/Organization/Persons group ◢  Groups collection

Purpose
Identifies a specific responsibility in the change review procedure, and the persons who are assigned that responsibility.

Where used
Change form and related workflow

Data fields

General

Name
This is the complete name for the group.

Description
This describes the group and its function.

Persons
Add a person record by dragging it from the Persons collection  and dropping it onto the list.

If the group is used for change reviews, then the person must have a full-function user account.

Setup
The Batch Importer tool can import and update Groups collection members and persons .

How to use groups
A group is a responsibility or authority. Name the group to show What is the responsibility or authority of the group's persons?

A responsibility may be given to one person now, and to another person later. Several persons may have the same responsibility, and
any one of them can do the work. Some persons may be qualified for more than one responsibility, and can be added to several
groups.

Change form review groups
To provide a response to the change form, the reviewing person must have a full-function user account.

A group can be added to a change form's workflow only when there's a person in the group. However, after the group is on a
change workflow it's possible to change the persons list. Be sure that each reviewing group always has at least one
responsible person.

Every person in a reviewing group receives that group's change workflow notices. The first person to respond completes the
group's review.

A group is most often used to identify the responsibility (knowledge and skills) needed to review a change form.

In smaller organizations, this responsibility may be rather broad: Engineering, Quality, Production. Larger organizations have more
limited or special review responsibilities, like Component Engineer or Metal Fabrications Purchaser. Create each responsible group
and add the responsible person to the group. When that person is no longer responsible, update the group with the person's
replacement. The change workflow remains the same, and years from now the change forms will show they've all been reviewed by
the correct authority.



The group's responsibility is not the same as a person's name, job or department. Don't create one group for each user. For example,
assigning the person Pat Lee to a person-based group Pat Lee Review has disadvantages.

Responsibilities change less frequently than users. You may need more person-based groups than responsibility-based groups,
and may update change form templates more often.
Change form originators (especially new employees) may not always know which person has a specific responsibility, but
usually know when a responsibility like Quality is needed.
When one person has several responsibilities — say, Quality and Production Engineering —, the group name shows the
authority that the change needed, and the reviewer used.
The group name confirms that your review workflow is correct before routing the change. Change participants can immediately
see that Program XYZ Engineer doesn't belong on a change for the ABC program, but Pat Lee Review needs more
information. Similarly, a change that has little impact on marketing may suggest removing the Marketing responsibility or setting
the group's participation from Must Act ⌵  to Can Act ⌵ . This can improve the approval list quality, and shorten the review
process.
If a reviewing person must be changed after the change form is routed, the reviewer is easily replaced in a responsibility-based
group. When using a person-based group, the workflow must be restarted because the group must be replaced.
Adding new persons to share responsibilities, or using an out-of-office agent , can cause confusion if the reviewer doesn't
match the group name.
Responsibility-based groups show a consistent, useful history. On released change forms, the group shows why a person was
on the reviewing list; on new change forms, the group shows who has that same responsibility today. Person-based groups
can't show this history.

Responsibilities may change as the organization and products evolve. As a product moves from development to maturity, the
sustaining engineer replaces the design engineer; possibly several groups are assigned to one person. When a responsibility is no
longer needed, the Groups member is set as inactive to keep the review history. The group can be set to active if it's needed again.

Group reviewer permission
A person who is added to a change form's reviewing group has permission to view the change and its affected items. This expands the
viewing permissions of the person's role.

Group reviewer permission is equivalent to applying these Roles collection permissions to the change form's affected items:

Document ☑ View pending , ☑ View released , ☑ View canceled  checkboxes
Part ☑ View pending , ☑ View released , ☑ View canceled  checkboxes
Change form ☑ View unreleased  and ☑ View released  checkboxes

It doesn't affect the user's ☑ Create new , ☑ Is an analyst  or ☑ Collections/Rules administrator  permissions.

For example, if the user's assigned role has only ☑ View released  permission, then the reviewing group lets the user see a routed
(unreleased) change form and each affected item's pending and canceled iterations. This expanded permission lets users with a full-
function user account give the group's response.

The group reviewer permission expands users' roles only while they're added to the group. Users added to the group can view items
previously reviewed by the group. Users removed from the group's Persons  list will return to their role's normal permissions. This may
prevent users from viewing items they've previously viewed and approved. A user with a role that has no permissions can only view
items related to the group's change review responsibilities.

Group reviewer permission enables access to items listed on the change form, but doesn't apply to related items. For example, an
assembly listed on a change may be viewed, but if none of its BOM items are on the change, then these cannot be viewed unless
other permissions allow viewing.

Change form observing groups
A group can also be a set of observers organized by product, functional team or partner. They don't have reviewing responsibilities, but
perhaps responsibility to rework parts or update computer records when the change form is released. When set in the workflow,
observing groups receive email notices.



Other groups
Groups can identify a team in custom attributes on parts, documents and change forms. It's possible to use this team to link, for
example, email addresses or phone lists in custom exports, reports or automation.
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Collection Explorer  ◢  Places/Organization/Persons group ◢  Organizations collection

Purpose
Identifies your organization as well as the suppliers, customers, regulatory agencies and other entities that interact with it or that affect
your products.

By design, the home organization  is permanent, default and active, and is the licensee of this PDXpert instance. You cannot
delete the home organization.

Where used
Documents, parts, persons (employees)

Data fields

General

Name
This is the name of the company, agency or other organization. It should be different from all other organization names.

This value is locked for the home organization. You can only change its value in the Software License Key  tool, which
can be opened by double-clicking on the Name  field or by selecting Software License Key  from the Tools  menu. If
you're using a ◉ Registered license  with a Registration key , you must request a new license key file with the correct
Organization name .

You may need to close the PDXpert client and start it again to see license changes in the Organizations  member.

Display name
Use the organization's abbreviation for this value. It should be different from all other organization abbreviations, and no more
than about 10 characters. It's used extensively throughout PDXpert to identify the organizations responsible for writing and
managing documents as well as designing and manufacturing parts. For other uses, see Color-coded environments , below.

D-U-N-S number
The D&B D-U-N-S Number is a unique nine-digit identification sequence, which provides unique identifiers of single business
entities, while linking corporate family structures together. It is recognized and/or required by many government, industry
standards bodies and trade associations, including ANSI, the United Nations, the U.S. Federal Government and the European
Commission.

D-U-N-S+4
This 13-digit (9+4) value specifies the organization and its geographic location. In non-IPC environments, you may prefer to
use this for the EAN.UCC 13-digit Global Location Number.

Language
This is the organization's preferred language for communications. Most documents, part descriptions and changes are written
in this language. You can select from active members of the languages collection.

Partner classification
You can classify the organization and its relationship to your own organization, which may be important to other parties who
exchange product design data with you. (See the Partner classifications topic for more information.)

Currency
This is the organization's preferred currency. For instance, when a part is given a cost, this currency is used unless
overridden.

URL/website
Enter the organization's home page or intranet page. Clicking on this link launches your computer's default browser and
attempts to open the web page.



Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Address
These fields are used to specify the organization's location and contact information. A PDX package  includes this information, which
is helpful to supply chain partners.

The Country  and Postal code  values are locked for the home organization. You can only change their values in the
Software License Key  tool. You may need to close the PDXpert client and start it again to see license changes.

Files
The Files  list lets you attach files to the organization. These can be changed or removed at any time by users with administrative
permissions for the Organizations collection.

To add, edit or remove a file:

Right-click within the Files  area or directly on an existing file. This shows a context menu with the available commands.

Library files are saved within PDXpert's own data library. Appropriate uses may be to save, for example, non-disclosure agreements
and contracts.

URLs can point to files stored anywhere such as a file server or website. An unmanaged file is not controlled by PDXpert, and may be
modified, moved or deleted without PDXpert's knowledge. Use a URL when you want to always point to the latest version of an often-
updated "background information" file, such as the organization's web site or supplier-maintained price list.

Notes
The Notes  textbox may be used for any purpose that you choose. Up to 20,000 characters (about 10 printed pages of text) can be
added.

Setup
The Batch Importer tool can import new Organizations collection members .

The organization that has the PDXpert software license is always the default ("home") collection member. Add the default
organization's address.

Add an organization record for any entity that:

Issues document numbers or part numbers that are used in your PLM system
Supplies you with parts
Has regulatory control over the technical contents of your documents
Has adopted any of your documentation for its own use, and is affected by changes to that documentation

Providing a unique Display name  for every entity you add to the database helps you distinguish between various organizations' parts
and documents. Make the abbreviation suggestive of the organization you're working with: "Motorola", "CSA", "VDE", "FDA" and
"Boeing" are good examples.

In U.S. Government contracting environments, the CAGE code can be appended to the Name  or used as the Display name
value. The CAGE then becomes a searchable value for items in the database.

Color-coded environments
You must request a separate software license key for each non-production server.



The Display name  is shown in the application and on reports. You can confirm to users that they're using a non-production system for
test or training.

If you include an exclamation character !  anywhere in the Display name , the background color on the main window's status bar is
changed.

!  (without a number following) shows the status bar with a dark gray background. For example, Test!  shows status text as
Status text .
!1  shows the status bar with a dark red background. For example, Home!1  shows as Status text
!2  shows the status bar with a dark yellow (brown) background. For example, Use!2Train  shows as Status text
!3  shows the status bar with a dark green background. For example, ALT!3rd  shows as Status text
!4  shows the status bar with a dark blue background. For example, !4Blue  shows as Status text
!5  shows the status bar with a dark orange background. For example, !5Orange  shows as Status text
!6  shows the status bar with a dark teal background. For example, !6Teal  shows as Status text
!7  shows the status bar with a dark violet background. For example, !7Violet  shows as Status text

To see the effect, lock the form F2  to save your changes.
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Collection Explorer  ◢  General group ◢  Item Lifecycle Phases collection

Purpose
Classifies item lifecycle phases, which distinguishes the lifecycle phases — that is, the design maturity — of documents, internally
developed parts, and partner parts.

Where used
Documents, parts

Data fields

Name
This is the complete name for the lifecycle phase.

Display name
The abbreviation is used where the full lifecycle Name  may be too long. These include the Item Explorer's search results
Release  column and on an item's References  lists.

Description
This gives the lifecycle phase and its function.

Relative maturity
The lifecycle phase specifies a numeric maturity of items, compared to other items' lifecycle phases. PDXpert uses a zero
value as unlimited production. Negative values are pre-production, and positive values are post-production.

PDXpert uses relative maturity to select the initial revision sequence or subsequent revision sequence to a part or
document. See help topics Items: Common elements  and Document and part iterations .

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Setup
The number of lifecycle phases is primarily determined by your business rules for constraining an item when its technical content is not
ready for Production (relative maturity 0).

Some people distinguish document lifecycle phases from part phases. For instance, a document may have Preliminary (design,
review, validate) and Production status. A part may go through a more detailed cycle of Preliminary (internal review, vendor quote,
customer discussion), Prototype (design validation), Field test (production validation / customer acceptance) and Production
(unconstrained).

There's rarely a need for lifecycles after Production. This is because the technical content normally doesn't change in post-production,
just its usage or availability. A Design End of Life (with relative maturity of 0) signals the part should not be used in new designs but
lets it remain on existing production BOMs. If the item is not serviceable for any use, then remove it from any BOM, Sources or
References list and cancel its released iteration.

By convention, parts produced by partner organizations and adopted without change by the home organization are maintained at
Production only. Since your organization has no direct control over their technical content, the parts are simply qualified and
Released , or disqualified and Canceled , for production use.

As is often the case, defining fewer members makes the collection easier to understand and manage.
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Collection Explorer  ◢  General group ◢  Product Families collection

Purpose
Specifies the users who can or cannot view selected product data.

Product families are used for access permissions, not for simply categorizing items. If you want a searchable tag for item
categories, use the item description text or a custom attribute.

Where used
Parts, documents, changes

Data fields

General

Name
This is the complete name for the product family.

Description
This gives the product family.

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Denied Access list
You may deny users, groups and organizations access to items in the product family. When the product family is added to an item,
persons on this list cannot open the item.

The denied list is ignored for these cases:

The product family's product team list overrides its denied access list. Users listed on the Product Team  always have access to
items in the product family.
Analysts always have access to the items specified by their role.
Trustees always have access to their items.

Product Team
When the product family is assigned to a part or document, team members can modify selected attributes. Marking the ☑ Product
team  on a Change Types member workflow includes team members on workflow emails.

To set up the Product Team members and permissions:

1. Unlock the Product Family record.
2. From the Persons collection, drag and drop persons onto the team members list.
3. In the Manage...  groups, set the access these persons have on items (parts and documents) and change forms.

An item's product team settings are summed to get the complete set of user permissions. For example, if an item has PF1
with ☑ Attributes  and ☑ Custom  marked, while PF2 has ☑ Custom  and ☑ Tasks  marked, then a person assigned to both
product teams will have permissions to Attributes , Custom  and Tasks  on that item.

The product team settings allow more users to modify the item. This may increase editing conflicts with the item trustee and
other team members. Always add the fewest possible Product Team persons, and enable the minimum set of permissions, to



accomplish your goals.

Product families can be added or removed throughout an item's life, whether pending, released, or canceled. This may affect
access to attributes on the item, as well as on related change forms.

A document's or part's Trustee, a change form's Originator and change form's Analyst are always treated as members of the
product team, regardless of whether they've been explicitly listed on the Product Team  list.

Product team members must have a Role that allows normal editing permissions on items. Adding a person with a read-only
user account or role will not provide full-function permissions.

In some cases, the product team member has more permissions than the item Trustee or change Originator. For example, a
trustee may be assigned a Role that does not allow editing custom attributes after the item's first release; however, a product
team member may have a Role with this permission.

Manage as item Trustee
When a checkbox is marked, the product team persons have permissions equal to the item trustee. For example, when the ☑ Custom
checkbox is marked, a product team member can edit the item's attributes on the Custom  page.

Product team members do not have permission to delete a pending iteration. This must be done by the trustee or an analyst.

General
Allows edits to item-level fields on the item's General  page: Owner , Number , Trustee , Product families  list, part Name  or
document Title , and Name{x}  button (when shown). On a part's Attributes  page, the Default unit of measure  can also be
modified until the part is released.
This permission is affected by the user role Edit after first release:  ☑ Item description  setting.

Be cautious allowing product team members ☑ General  permissions. This allows users to re-assign the Trustee ,
and to add or remove Product families . This can affect permissions to all other item attributes.

This setting does not allow edits to iteration-level attributes on the General  page; see the Attributes  setting below.

Iteration
Allows edits on all editable attributes within the — Iteration —  section on the item's General  page.

Attributes - Notes
Allows edits to all attributes on a document Attributes  page; on a part, all Attributes  values except a part's Default unit of
measure  (this is managed by the ☑ General  setting); and on a document or part, the Notes  page.

Custom
Allows edits to the part or document Custom  page attributes.
This permission is affected by the user role Edit after first release:  ☑ Custom attributes  setting.

Part: Materials
Allows edits to the part Materials  page attributes: the Part mass  setting and the Materials  list.
This permission is affected by the user role Edit after first release:  ☑ Mass and materials  setting.

Part: BOM
Allows edits to the part BOM  page Markup  list.

Part: Sources
Allows edits to the part Sources  page Markup  list.

References
Allows edits to the document or part References  page Markup  list.

Revision Files
Allows edits to the document or part Files  page Revision Files  list.

Item Files
Allows edits to the document or part Files  page Item Files  list.

Tasks



Allows edits to the document or part Tasks  page list.

Manage as change Originator
When a checkbox is marked, the product team persons have permissions equal to the change form's originator. For example, when
the ☑ Related  checkbox is marked, a product team member can add and remove change forms on the Related  page list.

Without originator or analyst permissions, product team members can't delete the change form. Product team members with ☑
General  permissions can submit and route the change form.

General
Allows edits to the change form's General  page, and permits processing the change to Submitted  or Routed  workflow
states.

Be cautious allowing product team members ☑ General  permissions. This allows the product team to modify the
Originator  and Analyst , which can affect permissions to all other item attributes.

Attributes - Notes
Allows edits to the Attributes  page, and to the Notes  page.

Custom
Allows edits to all Custom  page attributes.

Affected
Allows edits to the change form's Affected  page list, including disposition rows.

Be cautious allowing product team members ☑ Affected  permissions. This allows users to add new items and new
Product Families that may substantially expand the available permissions to all persons on the added product
teams.

Related
Allows edits to the change form's Related  page list.

Reviewers
Allows edits to the change form's Reviewers  page list.

Observers
Allows edits to the change form's Observers  page list.

Files
Allows edits to the change form's Files  page list.
This permission is affected by the system rule Unlock change form Files  setting.

Tasks
Allows edits to the change form's Tasks  page list.
This permission is affected by the system rule Unlock change form Tasks  setting.

Setup
The Batch Importer tool can import and update Product Families collection members and persons .

Setting exclusions on the Denied Access  list can be valuable if you have users that can see most things, but you want to prevent them
from seeing a few selected items. If all of your users are trusted, then not excluding anyone is the easiest option to manage.

PDXpert's underlying security model is "permissive" rather than "restrictive", and all users are assumed to enjoy at least viewing
access to the vast majority of items. This makes typical permissions very simple to administer, but it gets complicated when restricted
access becomes a major goal across the database. Thus, the Product Families are only useful to deny access to a limited set of items;
the vast majority of items won't be denied by a Product Family.

Product Families are separately assigned (and perhaps later removed) on whichever items need the restricted or extra permissions.
There's no inherited behavior from related parent items; for example, an assembly's Product Families won't affect the components on
its BOM.



Search results always include both normal and denied-access items so users know about, and can request access to, restricted items.
Thus, protected items should not contain any secrets within the search results fields (Owner / Type / Number / Lifecycle / Description).
Similarly, all item fields are indexed, so a user can search for a secret to test if the system has a match, even if the secret record can't
be opened.

When a person needs access to a small number of items, exporting a PDX package is often simpler and more secure than a user
account with denied access.
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Collection Explorer  ◢  General group ◢  Sequences: Identifier collection

Purpose
Defines the format and next number for new documents, parts and changes.

Where used
Documents, parts, changes

Data fields

General

Name
This is the complete name for the identifier sequence.

Description
This gives the identifier sequence and how it should be used.

Prefix
This is an unchanging set of characters that is copied to the beginning of every Next assignment  value.

Example: If you've specified DWG-  as the sequence's prefix characters and the Next assignment  value contains
100123 , then the value given to a new item is DWG-100123 . The item following is assigned DWG-100124 .

Next assignment
The Next assignment  value is given to a new item's number attribute, and the value is then incremented. You specify both the
sequence's format and the actual next-assigned value. The format is determined by the location and type of character (letter,
number or symbol) that you enter. If you enter a numeric digit at a specified location, then all subsequent values will only use
a numeric digit at that location. Likewise, a letter at a particular location ensures that only letters are used when the identifier
is incremented. Non-alphanumeric characters (symbols like / or -) are skipped when the value is incremented.

Example: If you've specified 123AZ-99  as the Next assignment  value, then the value is incremented to 123BA-00 .

Use only numeric characters (0…9) in your sequences. Avoid using a sequence longer than 8 characters.

Suffix
This is an unchanging set of characters that is added to the end of every Next assignment  value.

Example: If you've specified -000  as the sequence's suffix characters and the Next assignment  value contains
100123 , then the value assigned to a new item is 100123-000 . The item following is assigned 100124-000 .

Skip characters
You can also specify which characters are not considered when a Next assignment  value is incremented. Since these
characters are only examined when the sequence increments, you can (for instance) use a skip character as the initial value
for an identifier and it will never be used in a subsequent assignment.
Enter the exact characters to be skipped, without a space, quote or other delimiter: IOSQXZ .

Example: If the letters IOSZ  are invalid, then the Next assignment  value of CH9Y9  is incremented to CJ0A0 .

If your company mixes letters and numbers in the same sequence (not a best practice), then the letters BIOQSZ are
good candidates to be skipped since, in some typefaces or handwritten notes, they are difficult to distinguish from
numbers.

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.



Where Used list
This list enumerates all of the item types that are using the identifier sequence.

Setup
Designing a part or document number scheme can be simple or highly complex. For our recommendations, search the web
for PDXpert item number best practice .

Item identification is not just giving a number to a part or document, but typically includes defining the owning organization and
possibly the item class and type.

To avoid duplicate identifiers, your System Rules  tool specifies which data elements are tested for uniqueness. As you configure your
identification system, see the Item uniqueness definition system rule  help topic for more information.

The sequence generator doesn't try to enforce the rule. You can edit the value using, for example, a different prefix, suffix, or
skip character.

If you need to reserve a block of numbers (such as for a contract design service), edit the Next number  value. For example, if
the current value is 100489  and you need to reserve a block of 100 numbers, modify the Next number  to 100589 .

Although you can modify a sequence after it's been in use, you should consider possible conflicts with existing items. Edit the
value only when no other users are adding new item records.
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Collection Explorer  ◢  General group ◢  Sequences: Revision collection

Purpose
Defines the technical revision format for documents and parts.

Where used
Documents, parts

Data fields

General

Name
This is the complete name for the revision sequence.

Description
This gives the revision sequence and its use.

Starting revision
This is given to a new item's revision. The Starting revision  value never changes; instead, subsequent revisions of the item are
incremented based on the previous revision's value and the sequence rules, such as invalid characters.
You specify both the revision sequence's format and the value. The format is determined by the location and type of character
(letter, number or symbol) that you enter. If you enter a numeric digit at a specified location, then all subsequent values use
only a numeric digit at that location. Likewise, a letter at a particular location ensures that only letters are used when the
identifier is incremented. Non-alphanumeric characters (e.g., "/" or "-") are ignored when the value is incremented.

Example: If you've specified A.01  as the Starting revision  value, then the next item iteration is given as A.02 . The
revision immediately following A.99 is B.00.

If no alphanumeric characters are specified, then the item's initial iteration is given the starting revision value. Any subsequent
revisions are alphabetic.

Example: If the Starting revision  value is specified as a hyphen - , then the next item iteration would be A .

Skip characters
You can also specify which characters are not considered when a Starting revision  value is incremented. Since these
characters are only examined when the sequence increments, you can (for instance) use a skip character as the initial value
for a revision and it will never be used in a subsequent revision.
Enter the exact characters to be skipped, without a space, quote or other delimiter: IOSQXZ .

Example: If the letters IOSZ  are invalid, then an item with revision H is incremented to new revision J.

Skip characters are applied to single-character revisions only.

If your company mixes letters and numbers in the same sequence (not a best practice), then the letters BIOQSZ are
good candidates to be skipped since, in some typefaces or handwritten notes, they are difficult to distinguish from
numbers.

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Where Used list
This list enumerates all of the document and part types that are using the revision sequence.



Setup
Alphabetic characters have traditionally been used for revisions. Although most items won't require more than 20 revisions, you may
want to specify a double-letter revision sequence starting at "AA". This offers almost 700 revisions for those particularly long-lived
items, and specifying the number of revision characters up front means your users will never have to worry whether the item is truly at
Revision B, instead of an accidentally truncated Revision BC.

Numeric revisions are a more recent, and often superior, practice. They do not require skip characters, and are far more accessible on
computer keyboards for all languages. It's better to not use 0 as the first character in the Starting revision : Microsoft Excel often silently
deletes leading zeroes, for example, revision 02 becomes 2.

The sequence generator doesn't try to enforce the rule. You can edit the suggested revision using a skip character or
different number of characters.

Although you can modify a sequence after it's been in use, you should exercise caution as it will affect all new items, as well
as all existing items, that rely on that sequence.
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Collection Explorer  ◢  General group ◢  Units of Measure collection

Purpose
Classifies units of measure ( UoM ) into related categories. A unit of measure that belongs to a specified UoM category can be
converted to a different member of the same category.

Where used
Unit of Measure

Data fields

Name
This is the complete name for the UoM category.

Description
This gives the UoM category and its function.

Use on part
When this checkbox is marked, any unit within the category may be selected for a part's default unit of measure. For example,
the Proportion category is too indefinite to be used on a BOM, while the Count (e.g., each) category is commonly used on
BOMs.

Permanent member of collection
For information, see the Managing collections: Common attributes  help topic.

Setup
Numeric custom properties will often require units of measure. Broad types of property units would include electrical (voltage,
resistance, capacitance, inductance, power dissipation), and mechanical or physical (load, tensile strength, rotational velocity),
chemical (pH, molecular weight).
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Collection Explorer  ◢  General group ◢  Units of Measure group ◢  Units collection

Purpose
Defines measurement units for counting parts, time durations, physical properties, and other purposes.

Where used
System-wide

Data fields
Name

This is the complete name for the unit of measure. Unlike most other Name  attributes, this value is limited to 4 characters,
such as each, mm, kg and ohms.

While units of measure with Unicode characters (like cm² and kΩ) might look better, they're often hard to use. For
example, searches are more difficult if some keyboards don't show the character, and older manufacturing
applications may not know how to import or display these characters.

Description
This gives the unit of measure more fully.

UoM category
Use this dropdown list to select the appropriate category for the unit of measure. See the Units of Measure (category)
collection help topic.

Ensure that the correct category is selected. You cannot change this value after the new member is saved.

Measurement locale
You can specify whether a unit of measure is related to one of the principal regional measurement systems, or is globally
applied.

Default units per this unit
This conversion constant is the number of default member units required to make this unit. That is, there are [conversion
constant] x [default members] in [this member]. The default member conversion constant is, by definition, equal to 1.0.
Enter how many units of the default member you need to equal this member.

There are 100 centimeters in one meter. In the UoM Category Length collection, if the default category member is
set as:

centimeter (conversion constant = 1), then the meter member's conversion constant is 100.
meter (conversion constant = 1), then the centimeter member's conversion constant is 0.01.

Active: users can select
Default member of collection
Permanent member of collection

For information, see the Managing collections: Common attributes  help topic.

Setup
Keep poorly characterized unit types ("carton", "as needed", etc.) to a minimum, since they are not convertible to other compatible
units on part lists.
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Collection Explorer  ◢  General group ◢  Transforms collection

Purpose
Defines a template for reporting, exporting and displaying data using custom data queries.

Where used
Report/Export Wizard or, if defined within the transform, on menus.

Data fields

General

Name
The name of the transform template.

Description
A summary of how the data contained in the transform is used.

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

XML
A transform consists of the following sections (element and attribute names are case-sensitive unless noted otherwise):

<Provider>provider name</Provider>  The transform creates a DataGrid window; structured export file; or formatted report.

Provider name
(note 1)

Provider ID (note 2) Description

DataGrid Tabular data window displays, filters and exports results within the PDXpert client

PDXExport   PDX package export content definition

Report1
f61035e0-a334-4978-

909b-b4d4733c7654
SQL Server RDLC report with PDXpert's standard header and footer format (Obsolete)

Report2
7505f796-a1b5-43cc-

8ee3-218f7bf6ffdc
Unmodified, fully custom SQL Server RDLC report (note 3)

Table1
8fb9e24b-bbfb-44a0-

903e-d526db8e3fd0

Export tabular data file with CSV, TAB, XLS or XLSX extension. Obsolete: Use the
Table2  provider. This provider uses Microsoft OLEDB, which is replaced by OpenXML.
Use only when Excel 97-2003 files are required.

Table2   Export tabular data file as CSV, TAB or XLSX (using OpenXML)

XML
e2c4e89a-db62-43ad-

a718-ec08726d42b3
Export tabular data as a simple XML file

Notes:
1. The Provider name is case-sensitive. Use the value exactly as shown.
2. Do not use the Provider ID for new transforms. Edit older transforms to use the Provider name.
3. This provider uses the complete <Report>...</Report>  contents of a standard RDLC design file, excluding the <?xml ...>  encoding

declaration in the first line.



<context />  This optional element specifies added areas where the transform is shown. The transform context is specified by
a location, and one or more objects that contain the location and are compatible with the transform. See <context /> element
setting  below.

location="name"  identifies where the transform can be shown.
part="true" , change="false" , etc. identifies the objects that are compatible with the export file or report. This also
defines the parameter that's passed to the transform's query: item revision GUID or change item GUID.

<dataquery xmlns="http://www.plmx.org/DataQuery.xsd"></dataquery>  This contains an optional database SQL query that
makes a data source. If the attribute parameterized="true"  is included, then the SQL statement can include parameters in the
WHERE  clause to select a document or part revision GUID, or a change form GUID. See syntax and examples in Parameterized
SQL queries  below.
<Report>RDLC code</Report>  The optional Report Definition Language (Client-side) code is an XML-based report definition
specified by Microsoft for SQL Server reporting services.
<settings />  This element configures options.

isImport="true/false"  identifies whether the transform represents, respectively, an assembly (e.g., CAD BOM) import
or a datagrid/export/report. If missing, the value is false .
fileSaveAs="preferred file name"  suggests a file name for saving the export file or report. See syntax and examples
in fileSaveAs setting  below.
PDX packages contain one or more <kvp key="..." value="..." />  elements that adjust the package content. See
PDX export transforms setting  below.

<xsl:stylesheet></xsl>  The optional XSL instructions transform the source data into the appropriate import/export file format.

Setup
Restrict roles that can add or change members of the Transforms collection. Transforms directly access your database,
and inexperienced or malicious users can damage or destroy your data.

A transform can be used to show product data in a DataGrid window or printable report, or export it to a file.

The flow for output data is

Database ⇒  SQL data query ⇒  transform XML ⇒  [datagrid window or export file or [RDLC ⇒  report]]

After upgrading to a new PDXpert release, always test your transforms for proper operation.

A transform contains custom code that's not visible to PDXpert's upgrade procedure. It's impossible to ensure that a
transform will remain forward-compatible with future PDXpert upgrades. An upgrade may contain new features that removes
the need for an existing custom report or export. In some cases, a transform may require changes to maintain compatibility.

Transforms included with your PDXpert system are provided to demonstrate initial capabilities, and may need updating for
compatibility with future PDXpert releases.

Import (input) transforms are supported for backward compatibility with older PDXpert releases. Use the Standard BOM
Import format  instead.

Adding a new transform
When you receive or make a new XML transform as a text file:

1. Add a new Transforms collection member.
2. Open the text file in a plain text editor like Notepad or Notepad++. Do not open or edit the file in a word processing application

like Wordpad or Word.
3. Select the entire contents ( Ctrl + A ), and copy ( Ctrl + C ) the text to the Windows Clipboard.
4. On the transform window, select the XML  page, and paste the text ( Ctrl + V ) into the XML  textbox.
5. Save the transform.

Using a transform



After you save the new transform, it's immediately available. For showing or exporting data, see the Use the Report/Export Wizard
help topic. Selected transforms can be on context menus, as specified in the transform's <context /> element .

Designing a transform

SQL transforms
Bulk SQL queries
Parameterized SQL queries
Housekeeping columns in DataGrid
<settings fileSaveAs=… /> setting
<context /> element

PDX export transforms
Key-value pairs
Key path Actions and Value options
Creating a PDX export transform

PLMX transforms

SQL transforms
You can export data from an SQL query into a comma-separated value ("CSV") file, or use a SQL query as the basis for a custom
report or datagrid view. The query can search all database objects (a bulk query ) or focus on objects selected by the user (a
parameterized query ).

The system always includes a SQL parameter, @P0_CurrentUser , for personalizing a bulk or parameterized SQL query. This is the
SQL uniqueidentifier of the person who executes the query. For example, a query to export all items can instead export the current
user's items with the proper code, for example, WHERE Trustee=@P0_CurrentUser .

Do not use transforms to update native PDXpertDB  tables. Updates to native tables may affect data synchronization or cache
coherence that result in client "can't save" transaction errors. However, a transform can create, update and delete temporary
tables to, for example, aggregate data for reporting.

A P0_  parameter is provided by the system, not the user. Using it in a SQL query doesn't require the parameterized="true"
attribute in the <dataquery>  element.

Do not declare a variable @PLIST  or variables beginning with the characters @P0…  to @P9…  in your transform. These
variables are declared automatically by PDXpert to identify reserved parameters and user-selected items.

PLM data is complex, and the PDXpert schema is highly-normalized. For example, multi-level BOM queries that include
sources, references, file metadata, materials, and custom attributes need many joins. Where performance is a problem, use
the de-normalized Matererialized…  and viewer.…  tables/views. If your query takes longer than a few minutes, consider
upgrading your SQL Server edition and server hardware; redesigning the query to limit data, subqueries, joins and
calculations; and/or copying the database to a separate instance dedicated to reporting. For serious data analytics, consider
data extraction to a de-normalized data warehouse architecture.

The DataGrid window has a text filter that looks at all values within each row. If row filtering doesn't work as expected, try
formatting each column's data as text in the final SQL SELECT  statement. Apply CAST()  or CONVERT()  functions to numeric,
date, or other non-text values; convert NULL  values to an empty string.

Bulk SQL queries
A SQL statement can be used to export bulk information in specified columns, with criteria and sorting as specified within the
statement.

For example: SELECT * FROM PDXpertDB.viewer.ItemView

After writing your SQL query, add a new transform collection member, and embed the query within this XML framework:

<Definition>



 <dataquery xmlns="http://www.plmx.org/DataQuery.xsd">
  <choice>
   <sqlquery>
    <sql>
     <![CDATA[
     replace this line with a SQL SELECT statement
     ]]>
    </sql>
   </sqlquery>
  </choice>
 </dataquery>
 <Provider>DataGrid</Provider>
 <settings />
 <context />
</Definition>

To show the results, select Tools ◢  Report/Export Wizard...  and select your transform.

The DataGrid  provider can display approximately 100,000 cells. When using the DataGrid  provider, limit the number of
rows that can be returned by using TOP (n)  in your SQL query. The value of n  is usually 10000  or less. If users need more
than 100,000 cells, use the Table2  provider to export the data.

Parameterized SQL queries
Parameterized queries using @Pn  or @PLIST  must always include <dataquery parameterized="true" …

Exact parameters
A parameterized SQL statement can output results from an item selected using the Report/Export Wizard. The syntax for a part or
document is RevID=@P1  or PendingRevID=@P1 . For a change form, use ItemID=@P1 .

Part or document released (or canceled) revision example:

<Definition>
 <Provider>DataGrid</Provider>
 <context location="TopLevel" part="true" document="true" />
 <dataquery parameterized="true" xmlns="http://www.plmx.org/DataQuery.xsd">
  <choice>
   <sqlquery>
    <sql>
     <![CDATA[
     SELECT Owner, Type, Number, Revision, Description
     FROM viewer.ItemView
     WHERE RevID=@P1
     ]]>
    </sql>
   </sqlquery>
  </choice>
 </dataquery>
 <settings fileSaveAs="Summary of Released {ItemTypeShort} {ItemNumber}" />
</Definition>

Change form example:

<Definition>
 <dataquery parameterized="true" xmlns="http://www.plmx.org/DataQuery.xsd">
  <choice>
   <sqlquery>
    <sql>
     <![CDATA[
     SELECT Type, Number, Summary
     FROM viewer.ChangeView WHERE ItemID=@P1
     ]]>
    </sql>
   </sqlquery>
  </choice>
 </dataquery>
 <Provider>DataGrid</Provider>
 <settings fileSaveAs="Change Summary {ItemNumber}" />
 <context location="TopLevel" change="true" />



</Definition>

You can specify more than one item parameter in your query. As each item is added to the Report/Export Wizard, the system
automatically declares a new T-SQL variable as DECLARE @Pn uniqueidentifier = {objId}; , where n  is 1 or higher. An
error occurs if the user selects fewer items that your query requires. For example, if your query refers to @P1 , @P2  and @P3
and the user drops only two items onto the Wizard, the query's reference to @P3  fails.

Table parameters
If you're not sure how many items a user will want to include, you can design a transform query that uses a SQL table variable. This
table, declared as @PLIST , contains a list of part revision, document revision and change item identifiers. The table has two columns,
and an unlimited number of rows:

The Ordinal  column (SQL numeric data type int, starting at 0) contains the sequence that a part, document or change form is
dropped onto the Report/Export Wizard. Use this value if it's important for the query to know the sequence that items are added
(for example, the primary assembly of a BOM comparison).
The Id  column (SQL data type uniqueidentifier) contains the revision identifier (if part or document) or change form's item
identifier. To select the data records related to the user's items, your query must JOIN  other tables or views to this column.

This transform accepts any number of released part and document iterations, and any number of change forms, and sorts them in the
sequence they're added to the Report/Export Wizard:

<Definition>
 <dataquery parameterized="true" xmlns="http://www.plmx.org/DataQuery.xsd">
  <choice>
   <sqlquery>
    <sql>
     <![CDATA[
     SELECT
      [Class]
      ,[Owner]
      ,[Type]
      ,[Number]
      ,[Iteration]
      ,[Description]
     FROM
     (
      SELECT
       CASE Class WHEN 1 THEN 'Part' ELSE 'Document' END AS [Class]
       ,Owner
       ,TypeShort AS [Type]
       ,Number
       ,Revision + ' @ ' + Lifecycle AS [Iteration]
       ,Description
       ,LIST.Ordinal
      FROM
       @PLIST AS LIST
       INNER JOIN viewer.ItemView IV ON IV.RevID = LIST.Id
 
      UNION ALL
 
      SELECT
       'Change'
       ,''
       ,TypeShort
       ,Number
       ,''
       ,Summary
       ,LIST.Ordinal
      FROM
       @PLIST AS [LIST]
       INNER JOIN viewer.ChangeView CHG ON CHG.ItemId = LIST.Id
     ) ItemList
     ORDER BY
      Ordinal
     ]]>
    </sql>



   </sqlquery>
  </choice>
 </dataquery>
 <Provider>DataGrid</Provider>
 <settings fileSaveAs="Selected Items {FileDatetime}" />
 <context location="None" />
</Definition>

To show the resulting data:

1. On the Tools  menu, select Report/Export Wizard...
2. Select the transform, and click the Next >  button.
3. Drag one or more items from the Item Explorer and drop onto the Report/Export Wizard. Click the Finish  button.

Housekeeping columns in DataGrid
PDXpert public views may include housekeeping columns. These are named as [HKnumber] ; for example, [HK1] . In most cases,
housekeeping columns are useful only to PDXpert; they aren't interesting to users, and their definition may change.

The DataGrid hides all housekeeping columns automatically. Housekeeping columns are not included when copying or exporting. If
you want a housekeeping column shown in the DataGrid, you must rename the column in your SQL query, like SELECT [HK1] AS
[ID1]

HK100 column
Include an ID column named [HK100]  in your SQL query to let users open a document, part, change form or collection member from
the DataGrid. The column shows an Open link in the DataGrid.

The SQL column named [HK100]  must contain the ItemID (not revision ID) of a document, part, or change form; or a collection
member ID. If the ID cannot be matched to an item or collection member record, then nothing is opened. If [HK100]  is a null value,
then the Open link is not shown in that row. Do not include more than one [HK100]  column in your SQL query. The link column header
is always blank.

If a row contains more than one item, consider putting the Open column immediately after the selected item's number, or
collection member name. This example opens the part's source:
   SELECT Number AS [Part], Number_Child AS [Source], ItemId_Child AS [HK100] FROM viewer.SourcePairView

<settings fileSaveAs=… /> setting
When exporting data or saving a report, the fileSaveAs="preferred file name"  setting suggests a file name to the user. The user
can edit or replace the file name before the file is saved.

The suggested file name value can be simple text like fileSaveAs="Released parts" , which is shown in the Save As  dialog as
Released parts .

You can mix text with current values; for example, "Saved on {FileDatetime@dddd} by {FileCreator}"  becomes
Saved on Friday by Pat Lee  in the Save As  dialog.

.

Value name (note 1)
Applies to

(note 2)
Value inserted into file name

{FileCreator} All Current user's name from the Persons collection.

{FileDatetime} All Current local date and time as year-month-day hour-minute, like 2022-06-21 15-22  (note 3).

{ItemClass} Selection First selected item's class: Change , Document  or Part

{ItemName} Selection First selected item's name / description of up to 100 characters (note 4).

{ItemNumber} Selection First selected item's number.



{ItemOwner} Selection First selected item's owner name from the Organizations collection.

{ItemOwnerShort} Selection First selected item's owner abbreviation (display name) from the Organizations collection.

{ItemType} Selection First selected item's part type, document type or change form.

{ItemTypeShort} Selection First selected item's part type, document type or change form as an abbreviation.

{ItemRevision} Selection First selected item's revision.

{ItemLifecycle} Selection First selected item: iteration's lifecycle, or change form's full lifecycle name.

{ItemReleaseDatetime} Selection
First selected item: iteration's (SQL BasicItemRevision.ReleaseDate ) or change form's (SQL
Change.ReleaseDate ) release date for correctly identifying the file import sequence after release
(note 3).

{ItemReleaseFrom} Selection
First selected item: iteration's release marker (SQL BasicItemRevision.FromNum ) or internal
change event number (SQL Change.ChangeNum ) for correctly identifying the file import sequence
after release (note 5).

{ItemReleaseState} Selection
First selected item: iteration's release state ( Pending , Released , Canceled ) or change form's
short lifecycle state enumeration ( ORG, SUB, ..., CMP ).

{MemberName} All Transform's member name.

Notes:
1. The {ValueName}  is case-sensitive, and must be used exactly as shown. Use only one instance of a value name in a template.
2. If the user selects items to include in the output, data from the first selected item is inserted. Otherwise, these value names are ignored.
3. You can use standard Windows .NET datetime formats as {FileDatetime@datetime format}  or, for UTC, {FileDatetime@datetime formatZ} .

See the Custom attributes: Date format commands  help topic. A date without format is UTC as @yyMMdd-HHmmss ; for example, 220523-140321
(UTC). An invalid date format causes an empty date. Invalid file system characters (like /  and : ) are converted after the .NET format is applied.

4. You can limit the text length as {ItemName@maximum} , where maximum value is 1-99. For example: {ItemName@20}  limits the name Power Chassis
Assembly to Power Chassis Assemb

5. Number of digits is specified using .NET Decimal ("D") formatter; for example, {ItemReleaseFrom@D6}  formats event 1484 as 001484 . Allowed
range is D1 to D9, default value without a formatter (or with invalid format specifier) is D6.

If there's no fileSaveAs=  setting, then the file name is the first selected item (formatted as fileSaveAs="{ItemOwnerShort}
{ItemNumber} ({ItemTypeShort})" ) or the transform's name (as fileSaveAs="{MemberName}" ). Use fileSaveAs=" "  (with space
character) to force an empty file name.

Invalid file system characters (such as /  and : ) are replaced by an underscore ( _ ) character, and leading/trailing space characters
are removed. The complete file name is limited to 200 characters, and the operating system may shorten the name further. Try to
design the file name for fewer than 80 characters.

<context /> element
The location="name"  setting defines where the export or report transform is shown. One or more objects ( change , document , part ,
system ) will show the transform at the named location. Any item that is not specified as true  is ignored. See examples in the Exact
parameters  section of this topic.

A transform can be added to any location; it's the transform query, not the location, that defines its output. A transform
designed to export released BOM data won't start exporting pending source data after it's added to the SourcesMarkupList .

A parameterized query needs an item as the named location (for example, part="true" ). Only add bulk queries to locations
where system="true" .

Location name (note 1) Description of named location
Shows transform at named

location
GUID as SQL

parameter @P1

AdministratorArea Tools  menu (only users with administrator role).
Transforms added to this location will not be shown

system="true" none



in the Report/Export Wizard.

AffectedItemsList Change form Affected  list change="true" Change item

AppearsOnBillOfMaterialsList Part Appears On: BOM  list part="true"
Item's selected

iteration

AppearsOnChangeFormsList Document or part Appears On: Changes  list
document="true" ,

part="true"

Item's selected
iteration

AppearsOnReferencesList Document or part Appears On: References  list
document="true" ,

part="true"

Item's selected
iteration

AppearsOnSourcesList Part Appears On: Sources  list part="true"
Item's selected

iteration

BillOfMaterialsCurrentList Part BOM: Current  list part="true"
Assembly's selected

iteration

BillOfMaterialsMarkupList Part BOM: Markup  list part="true"
Assembly's selected

iteration

MaterialsList Part Materials  list part="true"
Part's selected

iteration

None   Report/Export Wizard  tool (note 2) none none

ReferencesCurrentList Document or part References: Current  list
document="true" ,

part="true"

Item's selected
iteration

ReferencesMarkupList Document or part References: Markup  list
document="true" ,

part="true"

Item's selected
iteration

ResultsRow Item Explorer Recent  and Search  lists
change="true" ,
document="true" ,

part="true"  (note 3)

Change item;
document or part
iteration (note 4)

SourcesCurrentList Part Sources: Current  list part="true"
Part's selected

iteration

SourcesMarkupList Part Sources: Markup  list part="true"
Part's selected

iteration

TasksList Document, part, or change form Tasks  list
change="true" ,
document="true" ,

part="true"

Change item;
document or part
selected iteration

TopLevel
All supported locations on document, part, or

change form

change="true" ,
document="true" ,

part="true"

Change item;
document or part
selected iteration

UserArea Tools  menu system="true" none

Notes:
1. The location name is not case-sensitive; for example, you may use TopLevel , toplevel  or TOPLEVEL .
2. Optional. This is the same as not including a <context />  element in the transform.
3. If more than one item is selected in the Item Explorer results list, then only transforms supported by every selected item are shown.
4. If a part or document has several iterations, then the released iteration is selected. If there's no released iteration, the pending iteration is selected.

If there's no pending iteration, the most recent canceled iteration is selected. This sequence can be changed in the transform's SQL query by
deriving the item from its iteration, and then selecting the preferred iteration.

Bulk (non-parameterized) transforms can be added to any location; @P1  is declared and a value is assigned, but the query can ignore
it.



If the same transform must be shown at several locations, add a copy in the Transforms collection, give it a new name, and update
the copy's location  value.

If an <context />  element isn't specified or its attributes are empty, then active transforms are available in the Report/Export Wizard.
The user's role must Allow Transforms .

PDX export transforms
The PDX file format is defined by industry standard IPC-2570. A PDX export transform defines standard XML elements and attributes
that are included or excluded.

The general format contains the Provider , context , dataquery  and settings  elements (exactly as shown). Within the settings ,
there is a set of one or more key-value pair <kvp …>  elements:

<Definition>
 <Provider>PDXExport</Provider>
 <context location="PDXConfig" />
 <dataquery parameterized="true" />
 <settings>
  <kvp key="{key name}" value="{value}" >
 </settings>
</Definition>

Key-value pairs
A key-value pair consists of:

Key A unique path of IPC elements, followed by an action.
The path is a series of element names or abbreviations, separated by a period/full stop. For example, an IPC-defined
Document element has a standard attribute globalProductTypeCode, thus the path to the action is
Document.StdAttr.globalProductTypeCode

Base path values: Change , Document , ManufacturerPart , Part , PDXPackage
Intermediate path values: AddAttr , Attachment , BillOfMaterial , Custom , Material , StdAttr

Only paths exported by the Export PDX Package  dialog are supported.

The action defines a result. For example, the action at the end of path Document.StdAttr.globalProductTypeCode  can
be :Load  (include the path object), or :Apply  (replace the path object's standard value).

Keys are fixed; you can only create a new key as a path to your custom attribute, and that path's action is always :Load .
Value The desired result of the path's action. Values are usually one selection from a fixed set of choices, such as Yes  / No , or
Include  / Exclude . Some values may be a numeric range ( :Limit  1  to 20 ) or user-defined text ( :Apply
My text value ).

Key path Actions and Value options

Action Purpose Value options

:Apply Assign text to attribute Any text

:Enable Use feature option Yes  No

:Filter
Specify whether a loaded value includes all, a subset, or

none
Include  Exclude  NameOnly  (note 2)

:Limit Defines an integer value for BOM levels From 1  to 20

:Load Load path object(s) into package Yes  No

:Select
Specifies the set of objects that will be used by the

:Filter

Comma-delimited list, such as part type names (note 3) or file types
(note 4)

Notes:



1. This table describes PDX transform syntax, but is rarely needed. If you create the template using the instructions below , all values are
automatically correct.

2. The NameOnly  option is used only for file types. It specifies that only the file name and other metadata, not the actual file, is included in the
package (the IPC attribute isFileIn is No).

3. If the object name has an embedded comma (for example, a part type named "Product,Final"), then use one of these characters to separate all
items in the list: !?;|   If you use one of these characters, it must be the first character in the list, and cannot be used within any of the listed items:
;Assembly;Product,Final;Design   The Export PDX Package dialog automatically handles this for you.

4. Use file extensions without the "dot" separator: use pdf,txt,png  not .pdf,.txt,.png

Creating a PDX export transform
To create a new PDX export transform:

1. Open an item record, and select the Export PDX package  command from the context menu.
2. Select a useful starting transform in the Select PDX starting values  dropdown list at the bottom center of the dialog. Use the

settings in the Export PDX Package  dialog to add your changes.
3. Click the Save As…  button to export the settings.
4. Add the file's content as a new Transforms collection member (see Adding a new transform , above).

Do not change the file's <kvp key={path:action}  text. Assign value={option}  only according to the table above. If
the key or option value is unexpected, the export file will use the default value. Default values can be viewed by saving
the — PDX Standard Package — ⌵  transform.

PLMX transforms
To ensure compatibility with current and future PDXpert releases, convert PLMX-based transforms:

For exports and reports that use the <Provider>8fb9e24b-bbfb-44a0-903e-d526db8e3fd0</Provider> , use a SQL
dataset with a supported provider ( DataGrid , Table2 , Report2 , Report1 ).
For CAD BOM importing, use the standard Import file format .

The PLMX transform uses an XML/XSLT format for product data objects. Although PLMX is very flexible, XSLT code complexity and
slow performance made these less popular than standard SQL datasets.

PLMX transforms are not actively supported, although some functions remain available for backward compatibility. PLMX example
transforms that were included in early PDXpert releases have been replaced with improved SQL-based versions. These replacement
transforms are available for download in the PDXpert software release notes.
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Collection Explorer  ◢  General group ◢  Views collection

Purpose
Defines an administrator-specified SQL Server or SQLite database view for replicating CAD data to the client's local database.

Where used
ODBC database connections for CAD and other local applications.

Data fields
Name

This is the view name that's used by ODBC or SQL Server clients. PDXpert view names always begin with the letters My…  as
in, say, MyReleasedParts . The name must conform to the executing database engine's (Microsoft SQL Server or SQLite)
guidelines.

To prevent errors in SQL Server and SQLite views and in ODBC client queries, only Basic Latin alphanumeric and
underscore ( _ ) characters are allowed. Do not use space or symbol characters (for example, %~'/\*<>([{+–
=}])? ). An invalid name requires deleting (not renaming) the Views member, and may require manually dropping
the view in the database. Invalid characters are automatically replaced with an underscore.

The member Name  defines the order that each view is added to the PDXpertDB.viewer.  database schema:
Views members are added to the collection in Name  alphabetical order.
If a member of the Views collection refers to another Views member, that other member must be added first.
Each time you save a Views collection member, all Views members are dropped and created again in
alphabetical order.

Thus, a new Views collection member must be named to alphabetically follow all members that it uses in its FROM
clause.

It's helpful to apply a suffix to a view that's compatible with only one engine, such as MyItems_SQLite  or
MyItems_MSSQL . A view compatible with both databases wouldn't have a suffix: MyItems .

Description
This gives the view and its purpose.

SQL SELECT statement
The SQL SELECT  statement is a required value that makes the view.

For an ODBC client connecting to a SQL Server database, the SELECT  statement must conform to SQL Server syntax.
For an ODBC client connecting to the SQLite database, the SELECT  statement must (a) conform to SQLite syntax, and
(b) select data only from the set of SQLite-compatible public and user-specified views.

Each time the PDXpert client starts, the client-side views are updated from the server. Minimizing the number
of views, and custom attributes within each view, reduces the time required for the client to start.

A set of four part-related public views are copied into the client-side local database: FilePairMasterView , ItemMasterView
and ItemView , and SourceItemMasterView . Private views used for local CAD views are executed by the PDXpert client
against the local database, and can select data from only these four views. If your view refers to any other table or view, then
it will always return zero rows.
The SQL Server public views are copied from the server viewer  schema into the local views default schema. Do not include
the viewer  prefix in local queries: use SELECT ... FROM ItemView WHERE ...  and not SELECT ... FROM viewer.ItemView
WHERE ...   If you include the viewer  schema in your query, the local database will not show the query in the views list.
See also User Settings: Enable local views  help topic.

Active: users can select

Default member of collection



Permanent member of collection
See the Managing collections: Common attributes  help topic.

Setup
For information about connecting to views, refer to the Make an ODBC connection  help topic.

Any change to a view, or to custom attributes in a view, can affect the local views database. Before you change a view and
before you add, remove or rename custom attributes used within a view, all other users should exit PDXpert and all ODBC
applications that use local views. After making your changes, users should start the PDXpert client before resuming work
with the ODBC application.

After upgrading to a new PDXpert release, always test your views for proper operation.

A view's SQL is not visible to PDXpert's upgrade procedure. A view may require changes to maintain compatibility with
PDXpert upgrades.

Views included with your PDXpert system are provided for demonstration purposes, and may not be compatible with future
PDXpert releases.
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Collection Explorer  ◢  Documents group ◢  Media/Locations collection

Purpose
Specifies the medium on which a document has been rendered and/or the physical storage location of a document.

Where used
Document

Data fields
Name

This is the complete name for the medium or physical location.

Description
This gives the medium or physical location in more detail.

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Setup
Document media may be broadly specified to include, for example, photographic film, paint color chip, or other physical sample.

If your product management system is entirely electronic, this attribute may be irrelevant. However, if you still maintain some
documents or files in some physical form, you can use this to define where they're stored, say, with all large-format drawings or in a
specified room, cabinet or drawer.
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Collection Explorer  ◢  Documents group ◢  Document Types collection

Other users should not be using the system while you're working. Close all item records in your workspace before you begin.
close the PDXpert client and start it again when you've finished.

Purpose
Classifies documents according to their usage, and defines their rules and custom properties.

A document type defines unique business rules and behaviors. It's not useful as a document category or search tag because,
once assigned to a document, it can never be changed (the document must be canceled and replaced). If you want a simple
category or searchable tag, use the document title or a custom attribute.

Where used
Documents

Data fields
Some data fields show a character counter in the upper right of the box. This is helpful for editing a custom label, and for
data that may be exported to other systems that limit imported text length.

General

Name
This is the complete name for the document type.

Display name
The abbreviation used as the display name in lists and reports to save space. It should be as short as possible, preferably
fewer than 10 characters.

Description
This describes the document type and its function.

Show Files list
When this checkbox is marked, the Files  lists are visible. Revision files, item files and external links can be added to the
document.

If any files have been attached to documents, and then this checkbox is cleared, the Files  lists – and attached files
– are hidden. The files are not deleted. To ensure visibility and access, this checkbox must remain marked after it is
set.

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Attributes

Item number
Use these settings to assign the part's Number  value.

Identifier sequence
This dropdown list lets you select an identifier (number) sequence for the type. You can choose a single number
sequence for all document types, or you can specify a sequence just for specifications, a different sequence for
procedures, etc. The selections for this are managed in the Sequences: Identifier collection .

User cannot edit assigned number



When this checkbox is marked, a new part identifier cannot be modified after it's set. When this checkbox is cleared,
the creator/trustee can (a) manually enter an identifier and/or (b) request a new identifier string and edit it after the
system sets it.

See note at Administrator Override command .

Revision/version
These settings define rules for the part's Revision  and Version .

Initial revision sequence
This lets you specify the revision format for the document type. The selections for this are managed in the
Sequences: Revision collection .

Subsequent revision sequence
This lets you specify a production revision format that's different from the initial revision sequence.
When an item moves to a lifecycle with relative maturity value of 0 or greater (for instance, Production or Service),
the subsequent revision sequence format is assigned.
If one revision format is used for the entire document lifecycle, leave this field empty so that the initial revision
continues into production.

Using a subsequent revision sequence may confuse vendors and employees with unnecessary data
changes. Instead of changing the revision when the document's maturity has changed, rely on the lifecycle
phase to specify when it's ready for production.

Warn on duplicate revision
When this is marked, a warning is shown if the pending iteration's revision identifier has been used for an earlier
revision. Setting this encourages users to assign a unique revision value for all item iterations, even when there's no
change to the technical content – for example, the lifecycle has changed.

User cannot edit assigned revision
This checkbox sets whether users can modify the revision given by the system, or whether the value is permanent.

Let users edit revisions to items owned by partner organizations, since the item revision is not controlled
within PDXpert.

Show Version field
When this checkbox is marked, the version attribute is shown on the document window and on reports. When this
checkbox is cleared, the version attribute is hidden.

The item's Revision area  expands when this field is not shown.

Documents have revisions, not versions. However, if the document type is closely related to an electronic
file type (such as a Software document type), then you may want to enable the version field for the
document type.

Default lifecycle phase
The selected Item Lifecycle Phase collection  member is assigned when a new document is made.

Show a Person #1 role
Marking the checkbox lets users identify a person with some responsibility for the document. Each new document iteration
can show a different person. For example, you may want users to identify the author of the document.
If this checkbox is cleared, then the person #1 dropdown list isn't shown on the part window.

These Person #1 / #2 controls are useful if your company has adopted the Institute for the Process Excellence
(ipxhq.com) change management process.
Each item is the exclusive responsibility of the item's (1) creator-designer, and (2) consumer-user-implementer (for
example, the design engineer and the production supervisor). The goal is that if these two people agree, no others
are needed to approve changes, eliminating non-essential change reviewers. These persons are identified for each
new iteration.
Maintaining this data can be somewhat burdensome in practice, so consider enabling these fields only for selected
types. Reviewing groups can also be limited using the change workflow.



Person #1 role label
This textbox shows the person's function. For example, you can use Authored by  as the label on the document
window.

Show a Person #2 role
Marking the checkbox lets users identify a person with some responsibility for the document. Each new document iteration
can show a different person. For example, you may want the editor or user of the document identified.
If this checkbox is cleared, then the person #2 dropdown list is not shown on the document window.

Person #2 role label
This textbox shows the person's function. For example, you can use Validated by  as the label on the document
window.

The item's Release description  area expands when both Person #1 and Person #2 fields are not shown.

Document title template
When a new document is first made, its Document name (title)  field is automatically loaded with this text value, which the user
can then edit. Defining a useful document name template enhances consistency, which makes items easier to locate.

Suggest information that the user should enter as [hint] , such as [model number] . Consistent document titles are
more predictable, and easier to search.

A text template can include custom attribute names as {custom attribute name} . After making a new document record,
clicking the Name{a}  button replaces the custom attribute's name with its actual value. For example, a custom attribute
named Customer , with an actual value of Acme Company , can be inserted using a text template like Requirements,
[product], {Customer}  to obtain a document title Requirements, [product], Acme Company . See the Custom
attributes: Inserting custom attribute values into an item name  help topic.

Custom list
You can define custom attributes (or "properties" or "extensions") to the system-supplied attributes for each document type. When a
new document is made, any custom attributes are shown on the document's Custom  page.

Before working with custom attributes, refer to the Custom attributes  help topic for important information.

Setup
Although there are many recognized methods for classifying documents, the values you enter are more a matter of preference than
requirement.

Users should have a clear idea of what each document type does, and how it's used. To this end, and to prevent unproductive hair-
splitting, it's probably best to keep the number of document types well under 30, and ideally fewer than 10.

Several references offer valuable guidance on defining appropriate document types. Information can be found in ASME Y14.24 "Types
and Applications of Engineering Drawings". The outdated MIL-STD-100A is a free and useful list of engineering document types and
uses (although far too detailed to adopt without careful pruning).

Be sure to make the abbreviations meaningful, since they are used extensively throughout the program. A good rule of thumb is to
remove all lowercase vowels (aeiou) from the name, and then condense further if necessary: e.g., "Assembly Drawing" becomes
"AssyDwg".
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Collection Explorer  ◢  Parts group ◢  BOM Type Codes collection

Purpose
Classifies an item's typical application when it's used on a bill of materials.

Where used
Parts

Data fields
Name

This is the complete name for the BOM type code.

Description
This gives the BOM type code and its function.

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Setup
This value tells how the part is aggregated or consumed in production. This collection is not likely to require changes.
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Collection Explorer  ◢  Parts group ◢  Handling/Storage Categories collection

Purpose
Classifies special handling or storage factors to protect the part, people, or surroundings.

Where used
Parts

Data fields
Name

This is the complete name for the part handling/storage category.

Description
This describes the health or safety hazard, or special handling or storage considerations. You may want to add
handling/storage procedures appropriate for your environment and procedures.

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Setup
To choose a list of possible handling hazards, contact your facilities manager, regulatory agency, safety engineer, fire inspector,
insurance representative and other professionals who are responsible for monitoring your workplace safety.

Special storage situations will require assistance from inventory managers and possibly the part manufacturers.

In some cases, parts may have multiple attributes. For instance, a chemical in your manufacturing may be both flammable and very
expensive; in this case, you'll want to add a new classification with both attributes, rather than forcing the user to choose only one.
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Collection Explorer  ◢  Parts group ◢  Make/buy Categories collection

Purpose
Classifies how your organization gets parts.

Where used
Parts

Data fields
Name

This is the complete name for the part make/buy code.

Description
This gives the part make/buy code and its function.

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Setup
This collection typically shows only a few categories: Make, Buy, Consigned, perhaps Subcontractor Managed, and Unspecified if
the decision is made downstream of your product definition.
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Collection Explorer  ◢  Parts group ◢  Material Categories collection

Purpose
Broadly classifies the materials that go into the parts that you buy and build.

Where used
Materials

Data fields
Name

This is the complete name for the material category.

Description
This gives the material category in more detail.

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Setup
If your organization deals with a wide variety of materials, then you can keep the classifications broad (e.g., "steel") or, at the expense
of manageability, more precise (e.g., "high carbon steel"). If your organization only deals with limited types of materials—for instance,
polymer resins—then you can have very detailed categories.

Materials declaration reports will use these categories to group materials in your products.
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Collection Explorer  ◢  Parts group ◢  Material Constraints collection

Purpose
Defines the handling, storage, recovery, or legally-imposed constraints on the materials and substances that are used in your parts.

Where used
Materials

Data fields
Name

This is the name for the material constraint.

Description
This gives the material constraint.

Application information required
When this checkbox is marked, a part with this material constraint must be provided with information about the location and/or
application of the material used within that part. If the checkbox is cleared, then the application or location information is not
required.

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Setup
Since the fundamental purpose of this collection is to segregate your materials for reporting purposes, you should define those
constraints that are most useful in handling, or which are legally required for reporting.

Each identified constraint probably requires related steps, such as employee training or special provisions for handling or
storage.
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Collection Explorer  ◢  Parts group ◢  Materials collection

Purpose
Defines the materials and chemical substances that are used in your parts.

Where used
Parts

Data fields

General

Name
This is the complete name for the unique material or substance. A material is made up of one or more substances (e.g.,
copper alloy is a material, which in turn is made up of a number of specified substances, copper, nickel, silver, etc.).
Substances are chemical elements and their compounds.

Description
This gives the material or substance. If applicable, this is where you enter information about radioactivity: radioactivity isotope
name and code, max activity level (MBq), typical activity level (MBq), etc.

CAS identifier
If available, enter the Chemicals Abstract Service (CAS) number, ISO International Standards number or other reference
identification of the material or substance.

Material category
This dropdown list identifies the Material Category collection member. Reports can group materials by category, so that
(for example) all ferrous metals are separated from non-ferrous metals.

Declaration category
This categorizes the material's disclosure requirement as Level A, Level B, or None.
"Level A" materials and substances are subject to laws that:

Prohibit their use and/or marketing;
Limit their use and/or marketing; or
Require reporting, or has other regulatory implications.

"Level B" materials and substances:
Provide economic value for end-of-life management purposes;
Are of environmental, health, or safety interest;
Would trigger hazardous waste management requirements; and/or
Could have a negative impact on end-of-life management.

Reporting threshold
This number represents the value that triggers reporting of the material. If the total material quantity exceeds this threshold for
a particular item, then the material is included on the item's Material Declaration form.
For regulated (Level A) materials that require reporting when intentionally added, regardless of quantity, use "0" as the
reporting threshold.
Select the appropriate ratiometric units, such as %  (percent), ppm  (parts per million), or ppb  (parts per billion).

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Material Constraints



You can construct a list of all constraints (such as safety provisions or special handling considerations) that must be imposed on the
material.

Setup
The Batch Importer tool can import new Materials collection members .

Recording every material in each part can be tedious and time-consuming, and in many cases may prove unnecessary. You'll generally
want to limit the list of materials to those that

Have legal rules or reporting requirements,
Affects health or safety, and/or
Impact end-of-life management.
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Collection Explorer  ◢  Parts group ◢  Recovery Methods collection

Purpose
Categorizes methods for end-of-life part (ELP) recovery, recycling and disposal.

Where used
Parts

Data fields
Name

This is the complete name for the part recovery method.

Description
This gives the part recovery method and its function.

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Setup
Classify the methods by which an end-of-life part can be handled. Many parts can be disassembled and reused, while others can be
broken down for their chemicals.
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Collection Explorer  ◢  Parts group ◢  Part Types collection

Other users should not be using the system while you're working. Close all item records in your workspace before you begin.
close the PDXpert client and start it again when you've finished.

Purpose
Classifies parts according to their application, and defines their rules and custom properties.

A part type defines unique business rules and behaviors. It's not useful as a part category or search tag because, once
assigned to a part, it can never be changed (the part must be canceled and replaced). If you want a simple category or
searchable tag, use the part name or a custom attribute.

Where used
Parts

Data fields
Some data fields show a character counter in the upper right of the box. This is helpful for editing a custom label, and for
data that may be exported to other systems that limit imported text length.

General

Name
This is the complete name for the part type.

Display name
This is the name that is shown in lists and reports to save space. It should be as short as possible, preferably fewer than 10
characters.

Description
This gives the part type and its function.

The following four checkboxes show or hide data lists on a part record. After making parts while a list is enabled, don't hide
the list. Hiding the list does not delete any data on the part. A part's Appears On  lists may identify parent items where the
part is used, but hidden.

Show Materials list
When this checkbox is marked, the Materials  information is visible. Materials (chemical substances) can be added to the
part.

The Part mass (weight)  is available only when the Materials  page is shown.

Show BOM list
When this checkbox is marked, the BOM  lists are visible. Component parts can be added to the part.

Show Sources list
When this checkbox is marked, the Sources  lists are visible. Approved manufacturer sources can be added to the part.

Show Files list
When this checkbox is marked, the Files  lists are visible. Revision files, item files and external links can be added to the
part.

If any files have been attached to parts, and then this checkbox is cleared, the Files  lists—and attached files—are
hidden. The files are not deleted. To ensure visibility and access, this checkbox must remain marked after it is set.



Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Attributes

Item number
Use these settings to assign the part's Number  value.

Identifier sequence
This dropdown list lets you select an identifier sequence (number generator) for the part type. You can choose a
single number sequence for all part types, or you can designate a separate sequence just for electrical components,
a different one for mechanical components, etc. The selections for this are managed in the Sequences: Identifier
collection .

User cannot edit assigned number
When this checkbox is marked, a new part identifier cannot be modified after it is set. When this checkbox is cleared,
the creator/trustee can (a) manually enter an identifier and/or (b) request a new identifier string and edit it after the
system sets it.

See note at Administrator Override command .

Revision/version
These settings define rules for the part's Revision  and Version .

Initial revision sequence
This lets you specify the revision format for the part type. The selections for this are managed in the Sequences:
Revision collection .

Subsequent revision sequence
This lets you specify a production revision format that's different from the initial revision sequence.
When an item moves to a lifecycle with relative maturity value of 0 or greater (for instance, Production or Service),
the subsequent revision sequence format is used.
If one revision format is used for the entire part lifecycle, leave this field empty so that the initial revision continues
into production.

Using a subsequent revision sequence may confuse vendors and employees with unnecessary data
changes. Instead of changing the revision when the part's maturity has changed, rely on the lifecycle
phase to specify when it's ready for production.

Warn on duplicate revision
When this is marked, a warning is shown if the pending iteration's revision identifier has been used for an earlier
revision. Setting this encourages users to assign a unique revision value for all item iterations, even when there's no
change to the technical content – for example, the lifecycle has changed.

User cannot edit assigned revision
This checkbox sets whether users can modify the revision given by the system, or whether the value is permanent.

Let users edit revisions to items owned by partner organizations, since the item revision is not controlled
within PDXpert.

Show Version field
When this checkbox is marked, the version attribute is shown on the part window, in lists and on reports. When this
checkbox is cleared, the version attribute is hidden.

The item's Revision area  expands when this field is not shown.

A part typically won't have versions. However, if the part type is closely related to an electronic file (for
instance, it is a masked ROM), and that file is identified by version, you may want to enable the version
field for the related part type.



Keep in mind that if a part number has multiple versions, all versions may be put into a single inventory bin
and freely mixed in production. If versions are not interchangeable, give each version its own unique part
number.

Default lifecycle phase
The selected Item Lifecycle Phase collection  member is used when a new part is made.

Purchased parts and their manufacturer sources are always set at Production lifecycle. You cannot alter a source
part's technical content, but must accept or disqualify the content offered by the manufacturer.

Show a Person #1 role
Marking the checkbox lets users identify a person with some responsibility for the part. Each new part iteration can show a
different person. For example, you may want trustees to identify the designer responsible for the part.
If this checkbox is cleared, then the person #1 dropdown list isn't shown on the part window.

These Person #1 / #2 controls are useful if your company has adopted the Institute for the Process Excellence
(ipxhq.com) change management process.
Each item is the exclusive responsibility of the item's (1) creator-designer, and (2) consumer-user-implementer (for
example, the design engineer and the production supervisor). The goal is that if these two people agree, no others
are needed to approve changes, eliminating non-essential change reviewers. These persons are identified for each
new iteration.
Maintaining this data can be somewhat burdensome in practice, so consider enabling these fields only for selected
types. Reviewing groups can also be limited using the change workflow.

Person #1 role label
This textbox shows the person's function. For example, you can use Designer  or Specified by  as the label on
the part window.

Show a Person #2 role
Marking the checkbox lets users identify a person with some responsibility for the part. Each new part iteration can show a
different person. For example, you may want trustees to identify the part's production user or field service engineer.
If this checkbox is cleared, then the person #2 dropdown list isn't shown on the part window.

Person #2 role label
This textbox shows the person's function. For example, you can use Prototyped by  or Validated by  as the label
on the part window.

The item's Release description  area expands when both Person #1 and Person #2 fields are not shown.

Default unit of measure
The selected Unit of Measure collection  member is used when a new part is made.

Default make/buy
The selected Make/Buy Category collection  member is used when a new part is made.

User cannot edit assigned make/buy value
When this checkbox is marked, the value given by the Default make/buy  (above) cannot be modified. For example, standard
purchased components will typically be marked (since it's very likely that, say, a standard machine screw will always be
bought), while custom fabrications and in-house assemblies will typically be cleared to enable outsourcing.

Show compliance checkbox
For parts that are subject to regulatory requirements, show a checkbox that tells whether the part is in compliance.

Compliance label
This textbox lets you label the compliance standard(s) that must be met by parts based on this type. You can leave it
rather generic, such as Meets regulatory requirements  or more specific to the part type, such as
Meets RoHS/WEEE regulations .

Part name template



When a new part is first made, the part's Name (description)  field will automatically be loaded with this text value, which the
user can then edit. Defining a useful part name template enhances consistency, which makes items easier to locate.

Suggest information that the user should enter as [hint] , such as [power rating] . Consistent part names are
more predictable, and easier to search.

A text template can include custom attribute names as {custom attribute name} . After making a new part record, clicking
the Name{a}  button replaces the custom attribute's name with its actual value. For example, a custom attribute named
Length , with an actual value of 50 mm , can be inserted using a text template like SCREW, {Length} {Length++@U}, PLATED
to obtain a part name SCREW, 50 MM, PLATED . See the Custom attributes: Inserting custom attribute values into an item
name  help topic.

Custom list
You can define custom attributes (or "properties" or "extensions") to the system-supplied attributes for each part type. When a new part
is made, any custom attributes are shown on the part's Custom  page.

Before working with custom attributes, refer to the Custom attributes  help topic for important information.

Setup
Limit the number of part types to broad easily-distinguished categories. Your users shouldn't have to puzzle over whether to categorize
a machine screw as hardware or a fastener, or an LED as a diode or a display device.

Part types should be used to make computer searches easier with distinct names and abbreviations. For example, let users search for
the Assembly part type using a simpler abbreviation like Assy .
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Collection Explorer  ◢  Changes group ◢  Change Classifications collection

Purpose
Classifies how a proposed change impacts the affected items' interchangeability or other business-related aspects.

Where used
Change form

Data fields
Name

This is the complete name for the change class.

Description
This gives the change class along with its application or business rule.

Class code
Provides the required database classification code for EIA-836/MIL-STD-2549 environments. In other environments, this field
may be ignored or used for another purpose.

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Setup
Change classifications are derived from business rules. For example, your company's sales team may need to notify a customer about
certain types of changes, or when the change's financial impact exceeds a specified limit.

Commercial organizations may want to show that a document change won't materially affect an existing part because the change (a)
releases a new part or (b) is purely clerical. In military environments, Class I and Class II changes may be used instead, and the
Clerical member can be deleted or made inactive.
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Collection Explorer  ◢  Changes group ◢  Change Priorities collection

Purpose
Classifies the urgency of a change.

Where used
Change form

Data fields
Name

This is the complete name for the change priority.

Description
This gives the change priority and its function.

Task priority
Select how a change form will be ranked in the Item Explorer's Tasks  list when the named change priority is selected.

Requires effectivity date
When marked, this checkbox shows that a user should enter the starting date when the change becomes effective.

Requires effectivity serial number
When marked, this checkbox shows that a user should enter a starting serial number when the change becomes effective.

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Setup
To ensure crisp execution, this collection should be kept relatively small, typically no more than six members.
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Collection Explorer  ◢  Changes group ◢  Change Reasons collection

Purpose
Classifies the rationale for making a change, so that managers can assess design and development procedures.

A Change Reason tells why you need to make a change. A Problem Source tells how an issue was discovered.

Where used
Change form

Data fields

Name
This is the complete name for the change reason.

Description
This gives the change reason in more detail.

Reason code
Specifies the required change reason database code for EIA-649 environments. In other environments, this field may be
ignored or used for another purpose.

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Setup
This collection may need to reflect aerospace/military contractor or regulatory requirements.

Without crisp definitions and clear categories, this collection can become confusingly similar to the Problem Sources collection.
Ensure that your users can easily distinguish between a problem source and its change reason, or simply use only one of these
collections.

This collection can grow large and unwieldy. Try to limit the number of members to get "big picture" trends that can help your product
management procedure. It's easier to spot trends using several broad categories, rather than offering users many detailed reasons
with only a few instances of each.
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Collection Explorer  ◢  Changes group ◢  Disposition Actions collection

Purpose
Classifies an item dispositioning activity, which briefly states what needs to be done to support the release or cancellation of an item.

Where used
Change form

Data fields
Name

This is the complete name for the disposition action.

Display name
This is the disposition action abbreviation.

Description
This gives the disposition action and its function.

Is for document release

Is for document cancellation

Is for part release

Is for part cancellation
These checkboxes identify the disposition action as being appropriate for releasing or canceling various items. In practice, as
the user adds an item to a change's Affected  list, that item's release status determines which disposition action members
are shown.

Recurring activity
When marked, this checkbox identifies actions that are repeated as necessary after the change is released. Clearing the
checkbox shows that the action happens only once, at the time that the change is implemented.

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Setup
Disposition actions are those activities that release a new item into production or phase an old item out. When first released, a
document needs to be distributed to various users, and a part may require special tooling, expedited shipping, or new equipment for
your assembly or test procedures. Similarly, canceled documents need to be recalled or destroyed, and old parts can be scrapped,
reworked, or used "as is." Each of these choices has cost implications that are determined by the number of units that must be
handled (or "dispositioned") and the cost of dispositioning each one.
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Collection Explorer  ◢  Changes group ◢  Disposition Locations collection

Purpose
Classifies an item disposition location (or expense incurred) during the release or cancellation of an item.

Where used
Change form

Data fields
Name

This is the complete name for the disposition location.

Display name
This is the disposition location abbreviation.

Description
This gives the disposition location and its application.

Is for document release

Is for document cancellation

Is for part release

Is for part cancellation
These checkboxes identify the disposition location as being appropriate for releasing or canceling various items. In practice,
as the user adds an item to a change's Affected  list, that item's release status determines which disposition location
members are shown.

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Setup
Disposition locations determine where disposition actions can occur. When first released, a document needs to be distributed to
internal and supply chain locations, and a part may require tooling at a supplier location, or must be reworked at a production location.
Similarly, canceled documents need to be recalled from where they're used, and obsolete parts can be at your suppliers' warehouse, in
transit, in your inventory, on your shop floor or in your product distribution channel.

Identifying your items' locations will help in assessing the cost impact of changing them.
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Collection Explorer  ◢  Changes group ◢  Problem Sources collection

Purpose
Classifies how the problem that caused a change was discovered, so that managers can assess design, production, quality and
service procedures.

A Problem Source tells how an issue was found. A Change Reason tells why you need to make a change.

Where used
Change form

Data fields
Name

This is the complete name for the problem source.

Description
This gives the problem source and its function.

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Setup
This collection may need to reflect aerospace/military contractor or regulatory requirements.

Without crisp definitions and clear categories, this collection can become confusingly similar to the Change Reasons collection.
Ensure that your users can easily distinguish between a problem source and its change reason, or simply use only one of these
collections.

This collection can grow large and unwieldy. Try to limit the number of members to get "big picture" trends that can help your product
management procedure. It's easier to spot trends using several broad categories, rather than offering users many detailed reasons
with only a few instances of each.
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Collection Explorer  ◢  Changes group ◢  Change Forms collection

Change forms should be Completed , Canceled  or Rejected  before editing their related Change Forms member. A new
change form's workflow, participants and some collection member attributes are copied from this template to the change
form. New settings may not affect previously-created change forms, or may have unexpected results.

Other users should not be using the system while you're working. Close all item records in your workspace before you begin.
Close the PDXpert client and start it again when you've finished.

Purpose
Classifies changes according to their usage; sets or enables options; manages standard approval and email notice lists; defines
workflow and custom properties.

Where used
Change form

Data fields
Some data fields show a character counter in the upper right of the box. This is helpful for editing a custom label, and for
data that may be exported to other systems that limit imported text length.

General

Name
This is the complete name for the change form, such as Change Notice  or Production Deviation .

Display name
The abbreviation is used extensively in identifying the change form. This is typically CN , Dev  and similar industry terms (up
to 10 characters in length).

Description
This gives the change form and its purpose.

Show Files list
When this checkbox is marked, the Files  list is visible. Files and external links can be added to the change form.

If any files have been attached to change forms, and then this checkbox is cleared, the Files  list – and attached
files – is hidden. The files are not deleted. To ensure visibility and access, this checkbox must remain marked after it
is set.

Active: users can select
Default member of collection
Permanent member of collection

See the Managing collections: Common attributes  help topic.

Attributes

Item number
These settings define how the change form's Number  is assigned.

User assigns number
When this checkbox is marked, the use must enter the change form's Number  at the time the change is created.
The selected Identifier sequence  is ignored. In most cases, this checkbox is marked only when a different computer
system gives the change number, and you must coordinate releases with the other system.

Identifier sequence



Specify the change number generator for the change form. This selection is disabled if the ☑ User assigns number  is
marked.
You can choose a single identifier sequence for all ECRs, ECNs, RFDs, etc., or you can designate a separate
sequence just for ECRs, a different one for ECNs, etc. For more information, refer to the Sequences: Identifier
collection .

Use a single identifier sequence for all change forms. You'll avoid confusion between overlapping change
numbers, such as ECR 1234 and ECN 1234.

Analyst label
This textbox lets you match an analyst's role to the change form. For example, the analyst for a design change may be
labeled as Design Analyst  while the analyst for a purchased part release is Component Engineer .

Default analyst
This dropdown list box lets you select an analyst for the change form. The default analyst can be overridden when the
originator makes a new change form. If the selection is empty, then the change form's analyst is (a) the originator if that
person has an analyst role; or (b) any other person who has an analyst role; otherwise (c) the super administrator. Changing
this value will not affect change forms that have been created.

The persons in the list have a Roles collection member  that includes ☑ Is an analyst . If you later remove the
analyst role from this person, update this value with a new analyst.

Affected list accepts documents

Affected list accepts parts
When these checkboxes are marked, items of the specified class may be added to the change's Affected  list.

Pause at Released state
When this checkbox is marked, the accepted change is stopped at the Released  state before it can be moved to Completed .
The Product Team attributes  can be edited and items on the Affected  list can be dispositioned. After the released data is
updated, the analyst can move the change to the Completed  state, where it's locked.
If this checkbox is not marked, then the system immediately moves an accepted change to Completed  without pausing at
Released . Workflow notices are sent only to the email recipients specified in paths 14  and 24  (all email checkboxes for path
25  are cleared).

Release/Cancel iterations on Affected list

Unless this setting was not set correctly during setup, do not change it after you begin using this collection member.
This setting is copied to each change form instance when the change was originated; an existing change form won't
use the current value. Before modifying this setting, finish processing all change forms based on this collection
member.

When this checkbox is marked, the change form is an executing change form. When (1) all reviewing groups have approved
the change and (2) the system or an analyst moves the change to the Released  state, then each iteration on the Affected
list is released (if previously pending) or canceled (if previously released).
When not marked, the change form shows a future intent (like a Change Request) or temporary status (Deviation, Waiver,
Stop Ship) to change an item. It doesn't have any effect on an Affected item.

A new Change Forms collection member does not show the following two settings. An existing (upgraded)
collection member shows these only when they don't match the ☑ Release/Cancel iterations on Affected list  value.
These two settings will be removed in a future PDXpert release. Set them to match the ☑ Release/Cancel
iterations on Affected list  value.

The following two settings are no longer supported. When the ☑ Release/Cancel iterations on Affected list  value is
changed, or if all three values match, then the following two settings are immediately and permanently hidden.

Show iterations on Affected tab
Mark this checkbox when you want item iterations to be shown on, and affected by, the change form (notably,
releasing and/or canceling iterations using a change notice). Clear the checkbox to provide a general notice about
the item, regardless of the iteration (for instance, a Change Proposal or Stop Shipment).

Show releasing/canceling icon



When this checkbox is marked, the Affected  list shows each iteration as getting Released or Canceled. When
cleared, the released change won't affect the affected item's release status.
This checkbox is automatically marked for executing changes. It's always cleared for information change forms (e.g.,
change request/proposal, waiver, deviation, stop ship).

Show a Person #1 role
This checkbox shows a principal person for the change form. For example, you may want users to identify the responsible
creator, such as design engineer, on the change.
If this checkbox is cleared, then the person #1 dropdown list isn't shown on the change.

Person #1 role label
The textbox lets you label the person's responsibility. For example, you can use Design Engineer  as the label on
the change.

Show a Person #2 role
This checkbox shows another principal person for the change form. For example, you may want to identify the responsible
user, such as project manager, on the change.
If this checkbox is cleared, then the person #2 dropdown list isn't shown on the change.

Person #2 role label
The textbox lets you label the additional person's responsibility. For example, you can use Project Manager  as the
label on the change.

Show Problem source selection
When this checkbox is marked, a problem source dropdown list box is shown to the change creator. Manage this list using the
Problem sources collection.

Display Change reason selection
When this checkbox is marked, a change reason dropdown list box is shown to the change creator. Manage this list using the
Change reasons collection.

Show a starting boundary
When this checkbox is marked, user can view and modify the change's starting date and/or serial number fields.

Starting boundary label
This value is shown to identify the starting date as, for example, Begins on .

Show an ending boundary
When this checkbox is marked, user can view and modify date, total quantity and serial number fields that show the change's
duration or limit. Specifying a completion or expiration point (date, serial number or quantity) is often required for advisory
changes, such as deviations and stop-ship orders.

Ending boundary label
This value is shown to identify the ending point as, for example, Ends after  or Resume shipments .

Clearly indicate whether the change period ends before, or after, the date entered by the change author.

Participants list

Reviewing groups
The Reviewing groups  list shows who is responsible for reviewing a routed change form. The list is copied to each new
change form, where the groups and email order can be edited further.

If there's no one listed on a group's Persons  list, then the group can't be added to a change form's Reviewing
groups  list. Read more about reviewing groups in the Groups: Change form reviewers  help topic.

Add to the Reviewing groups  list by dragging a group from the Groups collection on the Collection Explorer.
The Order  specifies when email notices are sent for a routed change: lower-valued groups (for example,
1:Engineering ) receive an email notice before higher-valued groups (say, 2:Production ) get their email notice.

More than one group can have the same Order  number, and there can be gaps between the values.



The Order  is a convenience for later reviewers, but it doesn't restrict when reviewers can respond. When the change
form is routed, all groups' reviewers immediately see the change in their Item Explorer Tasks  list. Trailing reviewers
can jump ahead and respond before receiving their email notice: for example, to clear review tasks before vacation, or
to promptly disapprove the change so earlier reviewers don't waste their time.

The most efficient review scheme is in parallel; that is, set every group's Order  to 1 .

You can specify whether Participation  is required or optional. The change workflow waits for reviewers who
Must act ⌵ . A reviewer who Can act ⌵  is free to approve, disapprove or ignore the change. After all required

reviewers have responded, the workflow proceeds without waiting for the optional reviewers' responses (unless the
Can act ⌵  reviewer has Held  the change).

Groups that are set as Can act ⌵  should be notified early in the workflow order. If they're notified after all
Must act ⌵  groups, the change is released before they're notified.

Set the reviewing group to Locked  so that its participation can't be deleted from the change form.
To delete a reviewing group: select the row ► , and press your keyboard's Delete  key.

Observing groups and persons
Persons with valid email addresses, even those without a user log-in account, can receive email notices during the change
workflow. You can designate when these observers are informed of a change's progress using the lifecycle states map in the

Workflow  page. This list is copied to a new change form, and can be further modified on each change form.
To add a group observer, drag the group's name from the Groups collection of the Collection Explorer onto this list.
To add a person observer, drag the person's name from the Persons collection of the Collection Explorer onto this list.

Delete an observer by clicking on it, and then pressing your keyboard's Delete  key.

Workflow
The workflow map enables workflow paths between a change's current state and the next enabled state. The map also specifies which
groups of users are notified as the change moves through the approval workflow.

The workflow diagram shows all possible lifecycle states. For each lifecycle state, you can (a) enable or disable the workflow paths to
other states; and (b) identify the user groups that should receive an email notice when the change moves to that state.

Workflow diagram paths
Workflow paths are buttons 01  to 25 . To enable a path between two workflow states, click on the path button, and set the
☑ Enable workflow path  checkbox. If you disable a particular path, then the change can't move to that lifecycle state. The
originator and the analyst are shown on the change form's General  page.
Path definitions:

01  [ORG→ORG] : The originator or the analyst selects a user as new change originator.
02  [ORG→SUB] : The originator or the analyst submits the change form to the analyst who, after a quality check,

routes it for approval on path 05.
03  [ORG→RTD] : The originator or the analyst routes the change form to reviewers for approval. If the change has

been previously routed, all reviewer responses are reset (comments are retained).
04  [SUB→ORG] : The analyst returns a submitted change form to the originator for further work.
05  [SUB→RTD] : The analyst routes the submitted change form to reviewers for approval. If the change has been

previously routed, all reviewer responses are reset (comments are retained).
06  [SUB→CAN] : The analyst cancels the change form, which the analyst can then delete.
07  [RTD→ORG/SUB] : The analyst removes the routed change from review, and returns it for further work. All

reviewer responses are reset to pending. (Note 1)
08  [RTD.disapprove→ORG/SUB] : After any reviewer has disapproved the routed change, the system returns it to

the originator or analyst. (Notes 1 & 2)
09  [RTD.disapprove→REJ] : After any reviewer has disapproved the routed change, the system rejects it and

retains it as a permanent record. (Note 2)
10  [RTD.disapprove→STP] : After any reviewer has disapproved the routed change, the system stops it and waits

for the analyst. (Note 2)
11  [RTD.disapprove→CAN] : After any reviewer has disapproved the routed change, the system cancels it, which

the analyst can then delete. (Note 2)



12  [RTD.approve→RTD.approve]  (always enabled): After all reviewers in the review order (for example, 1) have
approved the routed change, the system routes the change form to the reviewers in the next review order (say,
2). Path 12 defines who gets an email notice when the change moves from the previous set of groups to the
next set.

13  [RTD.approve→ACC] : After all reviewers have approved the routed change, the system accepts it and waits for
the analyst. (Note 3)

14  [RTD.approve→REL] : After all reviewers have approved the routed change, the system immediately releases it.
(Note 3)

Path 14 is a fast-track replacement of paths 13 and 24. The change form is released only if the affected
items' relationships remain valid.

However, if the change has an error—for example, an affected item now relies on a canceled reference item
—, then the system sets the change form's lifecycle to Accepted , and email notices are sent as specified by
path 13. The analyst resolves the error by (a) correcting the problem (say, by releasing a new iteration) and
then releasing the change via path 24; or (b) correcting the change form via path 23. Therefore, when using
path 14, set emails for path 13 and 24 to respond to errors.

15  [RTD→CAN] : The analyst cancels the routed change form, which the analyst can then delete.
16  [RTD.pending→HLD] : A "can act" reviewer blocks the release of the routed change form.

The analyst (not the reviewer) must move a change form out of the Held  state. If the analyst moves the
change directly to Routed  (path 18), then all previous approvals are retained. The reviewer who held the
change remains selected. If the analyst moves the change to Submitted  (path 17) and then to Routed , all
previous responses are reset.

Do not enable this path if all of your reviewing groups' participation is set as Must act ⌵ . For Must act ⌵
reviewing groups, the change is always blocked from release until a response is provided. The

Hold change ⌵  response is intended for Can act ⌵  reviewing groups, to prevent the Must act ⌵
reviewing groups from releasing the change.

17  [HLD→ORG/SUB] : The analyst takes the held change form from the reviewers. All existing reviewer responses
are reset. (Note 1)

18  [HLD→RTD.pending]  (always enabled): The analyst returns the held change form to the routed state.
19  [HLD→CAN] : The analyst cancels the held change form, which the analyst can then delete.
20  [STP→ORG/SUB] : The analyst withdraws the stopped change form. All existing reviewer responses are reset.

(Note 1)
21  [STP→REJ] : The analyst rejects the stopped change form and retains it as a permanent record.
22  [STP→CAN] : The analyst cancels the stopped change form, which the analyst can then delete.
23  [ACC→ORG/SUB] : The analyst withdraws the accepted change form. All existing reviewer responses are reset.

(Note 1)
24  [ACC→REL]  (always enabled): The analyst releases the accepted change form, which may update the release

status of affected items.
25  [REL→CMP]  (always enabled): The analyst completes the released change form after all dispositioning tasks are

closed. When the change is completed, all data fields, except the Notes  page, are locked.

Approved changes can be set to automatically move from Released  to Completed . In this case, emails are
not sent using path 25 . See the Pause at Released state  checkbox setting.

Notes
1. When the path ends at […→ORG/SUB] , the change returns for rework to the selected state:

When the ◉ Return to Originated  path is selected, then the change form always returns to the Originated  state.
When ◉ Return to Submitted  path is selected, then the change form always returns to the Submitted  state.

2. Paths 08/09/10/11  are mutually exclusive; for example, setting path 10  automatically disables the other paths.
3. Paths 13/14  are mutually exclusive; for example, setting path 13  automatically disables path 14 .
4. Some paths are always enabled, and the ☑ Enable workflow path  is locked. For example, moving a change into

Accepted  always requires an exit (path 23  or 24 ).



Send emails to:
Mark the corresponding checkbox to identify the parties who are notified when the change moves to a different lifecycle state.

☑ Originator  This is the person who made the change, and has principal authority for modifying (or deleting) it. This
role is similar to a document or part trustee.

☑ Reviewers in all groups  All authorized approvers of every listed group. The person must be listed in the Persons  list
on the Groups member form, and the group must be on the change form's Reviewers  list. The email notice is
sent without regard to the groups' responses ( Pending , Approve , Hold , Disapprove ).

☑ Reviewers in pending group(s)  All persons who are authorized to review on behalf of a listed group where the group's
current response is Pending .

☑ Holding reviewer  The person who sets a group's response to Hold .
☑ Reviewers in active group  All users who are also reviewers for the current reviewer's group.
☑ Observing persons  Persons identified on the change form's Observers  list.
☑ Analyst  The analyst who is named on the change form. This analyst can edit the change, add/remove file

attachments, and change the workflow lifecycle states.
☑ Analysts  The group of all persons who have been given an analyst role. Analysts may change the change's

workflow, and select a different named analyst. Analyst roles are specified within a Roles collection member
when ☑ Is an analyst  is marked, and that role is then selected for a Persons collection record.

☑ Reviewers in next group(s)  All authorized approvers for the next group(s) as specified by the Reviewing groups ' review
Order . Email notices are only sent where the next group's response is Pending .

☑ Disapproving reviewer  The person(s) who have set the group response to Disapprove .
☑ Product team  All members of Product Teams with affected items on the change.

Custom list
You can define custom attributes (or "properties" or "extensions") to the system-supplied attributes for each change form. A change
form's custom attributes are on the change's Custom  page.

Before working with custom attributes, refer to the Custom attributes  help topic for important information.

Text Templates

Primary discussion label
Label the primary discussion field based on how it's used. For example, you may want to label the field as
Problem description  or Solution summary  depending on the change form you're defining.

Primary discussion text template
When a new change form is made, the change form's primary discussion field is automatically loaded with this text value,
which the user can then edit. Providing your users with a good change discussion template ensures that your change forms
are clear, concise and valid. A good template enhances completeness and consistency, which makes finding, reviewing, and
releasing a change form easier.

Show secondary discussion
When this checkbox is marked, the change form shows a field (with your label) on the change's Attributes  page; this is used
for auxiliary change information.

Secondary discussion label
This value is shown to label the secondary discussion field based on how it's used. Depending on the change, you may want
to label the field as Rework instructions  or Production impact .

Secondary discussion text template
When the change form is made, the change form's secondary discussion field is automatically loaded with this text value,
which the user can then edit.

Setup

Executing and advisory change forms



PDXpert distinguishes between two categories of changes. Executing changes (like change notices) will affect the status of documents
and parts listed on them. Executing changes cannot be routed if the system finds a problem with an affected item, such as canceling
an iteration that's still on a released parent item. Advisory changes (such as change requests) propose changes, yet even upon
release won't update the items on the Affected  list. See the Processing a change  help topic.

You specify an executing change by marking ☑ Release/cancel iterations when change is released . If you make a change based on an
executing change form and put a document or part to the change's Affected  list, then that item's status is updated when the change
form is released.

Workflow states & paths
The diagram shows all change lifecycle states. Each change form moves from one state (say, Originated ) to a different state
( Routed ) along an enabled workflow path (path 03 ). When the change moves, it can notify persons affected by the new state.

Notes regarding workflow states:

The Submitted  and Accepted  states let the analyst confirm that the change form has been reviewed correctly. Submitted
provides the opportunity to make sure that the change form meets internal standards for completeness and accuracy, while the
Accepted  state lets the analyst make sure that reviewers' comments don't conflict with the change form's release. If the

organization doesn't require such intermediate reviews, then disabling path 02  and enabling path 14  provides the shortest
workflow.



In smaller organizations, a disapproved change invariably is reworked and then re-routed for approval; it's therefore common to
enable path 08 . In more complex reviews, the change form can be disapproved for a variety of reasons, and therefore enabling
path 10  offers the most flexible recovery.
Reviewers with participation set as Must act ⌵  should keep the Response  in Pending  state until they're ready to approve or
disapprove. Reviewers with participation set as Can act ⌵  may use the Held  state to block the change from leaving the
Routed  state while they investigate the change. If your Reviewing groups  list doesn't include reviewers set as Can act ⌵ ,

disable path 16  and rely on the Disapprove  paths 08  to 11 . When enabling path 16 , keep in mind that the reviewer requires
the analyst's assistance in moving the change back to Routed .
Moving a change into the Canceled  state lets it be permanently deleted from the system. The other terminating states,
Completed  and Rejected , retain a permanent record of the change.

In the Released  state, the dispositioning attributes can be modified and closed; in the Completed  state, these attributes are
locked.
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Collection Explorer  ◢  Custom group ◢  Administrator-assigned collection

Before making any changes to custom collections:
1. All users other than the administrator should exit the PDXpert application.
2. The administrator should close all open records ( Item ➔ Close All ).

Restart the PDXpert application when you've finished your changes.

Purpose
Defines a list of choices that are shown within a custom attribute.

Where used
Custom attributes in documents, parts, change forms

Data fields

Collection

Name
This is the custom collection's name within the Custom  group.

Do not use the name of a standard collection, such as Persons, for a new custom collection. Although the system
lets you use the same name, it's potentially confusing to users. Future PDXpert capabilities may require unique
collection names, and custom collections with the same name may need to be renamed later.

The collection name is typically plural (Colors, Sizes, Categories, etc.).

Description
This describes the function or purpose of the collection.

Collection member

Name
This is the complete name for the collection member.

Abbreviation
Specifies a short version of the member name. Although not used within the application, that database value may be available
for export via a Transforms object.

Description
This describes the function or purpose of the member.

Custom collection
Identifies the collection that contains the member. When first adding the member, you can move it to a different collection;
however, after saving, the member can't be moved.

Active: users can select
Default member of collection

See the Managing collections: Common attributes  help topic.

The first member of the collection is set as the default. If the collection has more than one member, the default can be
changed to a different member.

Making a custom collection member inactive makes it unavailable for new uses, but doesn't remove it from any items
where it's used.

Setup



The Batch Importer tool can import new Custom collections and their members .

A custom collection defines a fixed set of choices that can be selected in your items' custom attributes .

Custom collections can be made to meet a detailed need, or to be broadly reusable. For example, if you want a list of possible paint
colors for a part, the custom collection might be called either Colors or, more narrowly, Paint colors. The choice affects the
number of collections, and how you'll manage each one over time.

Consider whether:
the collection can be used for different purposes — that is, the collection members are generic (Red) or narrow (Copper
Sunset) —, and
changes to the custom collection's members — say, new colors — will be appropriate in all the places that the collection is
used.

Consider adding a standard record, such as Not specified, as the default collection member. When adding a custom
attribute in a part type, document type or change form template, use this standard member as the default. The value is
shown until the user gives a useful collection member to the item.
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Although PDXpert offers a sophisticated graphical user interface, you can still execute many commands with your keyboard.

In general, the keyboard Enter  key performs the same function as clicking an on-screen OK  button.

When pressing more than one key, you should hold down the keyboard keys in the sequence shown, and then release them in reverse
sequence. For example, to use the Ctrl + C  shortcut, you'd press the Ctrl  key, then the C , then release the C , and finally release
the Ctrl  key. When using the Alt  and Ctrl  keys, you do not use the Shift  key unless noted; there may be a difference between
Ctrl + C  and Ctrl + Shift + C .

Control shortcut keys
Ctrl + A select All

Ctrl + C Copy selected text to clipboard

Ctrl + D snapshot Duplicate

Ctrl + F view File

Ctrl + I check In file

Ctrl + K checK out file

Ctrl + R open Report/Export Wizard

Ctrl + S Save edits

Ctrl + V paste text from clipboard

Ctrl + X cut highlighted text to clipboard

Ctrl + Y redo last edit

Ctrl + Z undo last edit

Function keys
F1 open the related help topic

F2 unlock current item for editing, or lock and save changes

Ctrl + F4 close the selected form

Alt + F4 exit PDXpert application

F5 refresh data in the selected form

F8 make new collection member

F9 make new document

F10 make new part

F11 make new change
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* operator
Search wildcard that can be replaced by zero or more characters.

? operator
Search wildcard that can be replaced by exactly one character.

+ operator
Term is required as part of search results.

- operator
Term is excluded from search results.

&& operator
Logical AND search operator that requires both terms in the results.

|| operator
Logical OR search operator that requires at least one of the terms in the results.

[   TO   ]
A range from one item numbers to another, including the range end points.

~ operator
Requires two terms to be within a specified distance: ~3 allows gap of up to 3 words.

(  ) group
Makes a logical group of terms for Boolean (AND / && or OR / ||) functions.

"  " group
Groups one or more valid characters and spaces to make a search term.

administrator
Role with permissions to manage collections and system rules, and use system tools.

advisory change form
A change form that approves limited or future action without changing any listed items.

affected item
A part or document that is shown on a change form's Affected list.

alphanumeric
Letters A-Z, a-z and their Unicode equivalents, and the digits 0-9.

alternate parts
A set of parts that are interchangeable for a specific use, and not for all uses.

analyst
Role with 'super trustee' permissions and can manage change workflow.

ANSI Basic alphanumeric
ANSI Basic Latin letters A-Z, a-z and the digits 0-9 (ANSI x30-39; x41-5A; x61-7A).

ANSI Basic hexadecimal
ANSI Basic Latin letters A-F, a-f and the digits 0-9 (ANSI x30-39; x41-46; x61-66).

ANSI Basic uppercase alphanumeric
ANSI Basic Latin letters A-Z and the digits 0-9 (ANSI x30-39; x41-5A).

ANSI Extended alphanumeric
Letters A-Z, a-z and the digits 0-9, with extended characters like à.

ANSI Extended uppercase alphanumeric
Letters A-Z and the digits 0-9, with extended characters like À.



assembly
A combination of two or more parts; or, a single part that's modified to create a different part.

attachment
Electronic file saved in PDXpert library.

Basic Latin alphanumeric
Letters A-Z, a-z and the digits 0-9 (ANSI x30-39; x41-5A; x61-7A).

Basic Latin uppercase alphanumeric
Letters A-Z and the digits 0-9 (ANSI x30-39; x41-5A).

bill of materials
The list of all physical items needed for an assembly.

bulk query
A SQL database query that doesn't need the user to select an item.

canceled
Iteration that has been replaced or is obsolete, and cannot be used for any purpose.

canceling
Item revision in process to be canceled.

change form
Approved action that affects part and document records, with supporting details.

change notice
Releases a set of item iterations that are released or canceled.

change request
A proposal to make a future change to an item, without affecting its current release status.

child item
A BOM, source or reference item that is listed on a higher-level parent item.

child part
A part that is on a higher-level parent item's BOM, Sources or References list.

class
The basic Document, Part and Change Form objects managed by PDXpert.

client UDV
A user-designed view that uses SQLite SELECT statements for a client-side ODBC database.

context menu
A set of commands shown by clicking the secondary (usually right) mouse button.

conversion constant
Quantity of UOM Category's default member needed to equal the converted unit of measure.

criteria
The set of all terms and operators used to define the search.

current list
The last set of child iterations approved for use on the selected parent iteration.

custom attribute
An extension to the standard item attributes that is specified by the administrator.

data list
The list of all reference documents for producing an item or other outcome.

date
Number characters and delimiters as YYYY-MM-DD [ISO8601] or MM/DD/YYYY [US].

design part



A part with unique specification that may be made internally or by a contract manufacturer.

deviation
A temporary change to an approved part as the result of a production problem.

document
An item record describing a part or procedure, or related supporting information.

executing change form
A change form that releases and cancels affected iterations.

external link
An item resource on the network or internet that PDXpert doesn't copy or control.

find number
A part's row number on a BOM to track the row's revision history, and to compare similar BOMs.

fit
Can physically mate with, interconnect to, or assembled into another part.

form
Useful physical properties that make a part correct for a specified use.

forward secrecy
Encryption to ensure that session data is secure against future certificate compromise.

full-function user account
Lets users manage items, approve change forms, or edit system settings.

function
Action that a part performs in meeting its designed purpose.

group
Identifies a change review responsibility, and persons who are assigned that responsibility.

home organization
Organization that licenses PDXpert and whose users manage its designs.

identifier set
Class, Owner, Type, and/or Number attributes selected for identifying parts and documents.

interchangeable
Form, fit and function that is equal to another item.

item
A distinct part, document or change form.

item attachment
An electronic file copied and attached to an item as background or history.

item file
File copy or external link attached to an item as background or history.

item number
Given by an organization to uniquely identify its document, part or change form.

iteration
Approved technical content (revision) used for a specified business purpose (lifecycle).

level
Steps between the starting point of a multi-level BOM report and the current BOM part list.

letter character
Any valid character in ranges A to Z, a to z or its local language Unicode equivalent.

library
A PDXpert Application Server file system folder that contains all file attachments.



lifecycle phase
Item's ability to be used for a specified business use.

local views database
A subset of public views and user-defined views used by CAD and other ODBC clients.

localhost client
A PDXpert client automatically installed with the PDXpert Server application on a single computer.

manufacturer source
A part designed and supplied by a partner and approved for use by the home organization.

markup list
First child iterations added to a specified parent iteration, before any interchangeable changes.

material
A chemical substance or compound typically identified for regulatory compliance reporting.

MSU subscription
Perpetual license's maintenance, support and upgrades subscription.

named user account
A log-in name and password assigned to one person that lets that person use PDXpert.

network client
A PDXpert client that is installed on a network computer separate from the PDXpert Server.

number
One or more characters in the range 0 to 9.

operator
A symbol that signals special treatment for the immediately-following term.

OCR
Optical Character Recognition extracts text from an image.

parameterized query
A SQL database query that returns results based on a user selection.

parent item
Item that has items on its BOM, Sources, References, or other lists.

part
Physical item that is made, bought, or assembled as a product for sale or other use.

part unit of measure
UOM category member that is useful for specifying a BOM quantity.

partner organization
Organization providing documents or parts used by the Home organization.

password salt
Unrelated data added to a password to force a unique hash to protect common passwords.

PDX package
File to move product data from PDXpert to partners using the IPC-2570 standards.

pending
Iteration that is being prepared for release.

perpetual license
Software use on one server by the licensed named user accounts without upgrade or renewal.

private view
Private database tables that provide semi-standardized data to internal processes.

public view



Virtual database tables that provide stable, standardized product data to external applications.

purchased part
Home part that uses qualified interchangeable manufacturer source parts without alteration.

queue
A list of items that are waiting to be processed.

read-only user account
Lets users view, report and export data, but not to add, edit or approve data.

reference
A supporting document or process-related part used to make or validate the current item.

reference designator
Links a specific part on a diagram to its unique physical location in an assembly.

relative maturity
Intended use where pre-production < 0, production (fully usable) is 0, post-production > 0.

release state
One of pending (before approval), released (approved for use), or canceled (approval ended).

released
Iteration with technical content that is approved for its selected business purpose.

releasing
Item iteration in process to be released.

reviewer
The user who reviews a change form on behalf of a group.

revision
An identified level of technical content of an item.

revision file
Electronic file attached to a specific revision with controlled technical content.

search term
Valid characters in quotes, or a token, but not including any operator that acts on the term.

search token
A sequence of one or more valid characters.

server UDV
A user-specified view that uses standard Microsoft SQL Server SELECT statements.

snapshot
An existing item copied to a new record that has similar requirements.

source part
A part designed and supplied by a partner and approved for use by the home organization.

source rank
Preferred use of equivalent sources based on technical attributes or performance.

stop word
A common word that won't add value to searches, and is not indexed.

structure
An indented list of parts and supporting references needed to produce an assembly.

subscription license
Software use on one server by the licensed named user accounts that requires periodic payment.

substitute part
A part that's interchangeable as a Source (all uses) or an Alternate (limited use).



super administrator
Default member of the Persons collection with special permissions.

symbol
A character that is not an alphanumeric (A-Z,0-9) character.

title case
Format where the first character of a word is uppercase and all others are lowercase.

type
The attributes and rules for different objects within a class.

user-specified view
A Views member that filters and sorts data from public views and other user-specified views.

valid character
Any user-entered alphanumeric or symbol character, except non-display control characters.

variation
A "family" of parts that share many properties, with each having a unique part number.

version
A label given by another configuration management system to identify an iteration.
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Multi-user database software such as PDXpert has demanding communications and infrastructure requirements. They're often more
sensitive to software changes.

PDXpert software uses Microsoft Windows and .NET application services. PDXpert also needs a stable installation of the Microsoft
SQL Server database engine.

Start the computer again after an update to Microsoft Windows, .NET or SQL Server.

On the computer where your PDXpert Application Server is installed, start the computer after every Windows or SQL Server
update. If Microsoft Visual Studio development tool is installed on the server computer (this is not recommended), start the
computer after every VS update.
On the workstation computer where your PDXpert client is installed, start the computer after every Windows update.
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A. This is a license agreement ("Agreement") for the PDXpert computer programs (which may include the PDXpert Application Server
and PDXpert Client Application software), associated data and configuration files, and other software (the "Program"). The Program
contains proprietary information of HX3 Solutions, Inc.; it is provided under this Agreement that contains restrictions on use and
disclosure and is also protected by copyright law and international treaties. Unauthorized reproduction or distribution of this Program,
or any portion thereof, may result in severe civil or criminal penalties. Violators will be prosecuted to the maximum extent permitted by
law.

B. In this Agreement, "You" refers to the licensee (an organization or person) or any agent or consultant acting on its or their behalf,
and all users authorized by the licensee to use the Program, all of whom shall also be bound by the terms of this Agreement. "HX3
Solutions, Inc.", "HX3", and "We" all refer to HX3 Solutions, Inc., a Massachusetts corporation.

C. CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THIS PROGRAM. BY USING THIS
PROGRAM, YOU INDICATE YOUR ACCEPTANCE OF SUCH TERMS AND CONDITIONS. IN THE EVENT THAT YOU DO NOT
AGREE TO THIS AGREEMENT, THEN YOU MUST IMMEDIATELY AND COMPLETELY REMOVE THE PROGRAM FROM ANY
STORAGE MEDIA AND/OR COMPUTER(S) ON WHICH IT WAS COPIED AND/OR INSTALLED.

D. You agree that all licenses granted hereunder and all transactions with HX3 are governed by the policies and procedures that are
described on the HX3 website (the "HX3 Policies", located at www.buyplm.com/policies ), which are incorporated herein by reference,
and which are subject to change by HX3 from time to time in its discretion.

1. License

1.1. During the Term of this Agreement (as defined below), HX3 Solutions, Inc. will provide to You the Program with software license
key (the "Key") and user installation and operation instructions ("Documentation"). The Program and upgrades/updates thereto, the
Key, the Documentation, and the MSU Services as defined below (if the MSU Services have been purchased by You) are collectively
referred to as the "Product." A person obtains access to the Product using a log-in username and optional password (a licensed
"Named User Account"). Depending on the license type purchased, the Key specifies and authorizes one or more licensed Named
User Accounts for a designated term (the "Term"), which shall be either a recurring subscription period with a duration based on the
license You have purchased (a "Subscription" license type) or an unlimited period (a "Perpetual" license type), unless and until Your
applicable license is terminated as set forth in this Agreement. You may only use the Product subject to the terms and conditions of this
Agreement.

1.2. Subject to Your payment of applicable license fees for the Product as indicated in HX3's invoices ("Fees") when due, HX3 grants
You a non-transferable (except in accordance with this Agreement) license for the designated number of Named User Accounts to
access and use the Product for Your internal business purposes in accordance with the terms of this Agreement.

2. Maintenance, Support and Upgrades

2.1. All maintenance, support and upgrade services ("MSU Services") for the Product, which shall include without limitation all new
versions of the Program and the Documentation, will be provided with all Subscription licenses, but are not provided with Perpetual
licenses unless MSU Services are separately purchased. All MSU Services shall be subject to the terms and conditions set forth in the
HX3 Policies. MSU services are limited in duration and must be renewed periodically to maintain coverage.

3. License Restrictions

3.1. You may not, and will not permit any other party to: (a) modify, adapt, alter, translate, or create derivative works from the Product;
(b) merge the Product with other software except as needed to use the Product for its intended purposes or to use it with other
enterprise programs developed or licensed by You; (c) sublicense, distribute, sell, use for service bureau use, lease, rent, loan, or
otherwise transfer the Product to any third party other than as expressly provided herein; (d) reverse engineer, decompile,
disassemble, or otherwise attempt to derive the source code for the Product, except and only to the extent that such activity is
expressly permitted by applicable law notwithstanding this limitation (provided, however, that to the extent You intend to engage in any
of the foregoing, You will notify HX3 in advance of such activity and will treat the results of such activity as Confidential Information



(defined below) of HX3); (e) remove, alter, or obscure any proprietary notices of HX3, its licensors or suppliers included in the Product;
or (f) otherwise use or copy the Product except as expressly permitted under this Agreement.

3.2. In addition, You agree to comply with the following requirements:

3.2.1. You may assign a Named User Account to exactly one person, for that person's exclusive use on no more than three (3)
computers/devices during any 12-month period. A Named User Account may not be shared between persons.

3.2.2. You may use the Key issued to You by HX3 for the Subscription or Perpetual Term specified by the Key. You may not use any
other Key no matter how acquired. You may not use the Key issued to you by HX3 if You have not fully and completely complied with
the terms of this Agreement, or with the payment terms specified by HX3 at the time of purchase.

3.2.3. You may use the Program only on one server.

3.2.4. You must apply Product upgrades issued during the Term promptly following their release, in order to maintain the validity of the
warranty set forth below.

3.2.5. You may not separate the Product's component parts for independent use. You may not use a version or an upgrade of this
Product independently from the original version supplied to You. All versions and upgrades acquired by You become an integral part of
the original Product, and are subject to the terms of this Agreement as it may be updated with future versions of the Product.

3.2.6. You agree that to facilitate technical support services and to improve the Product, the Product may transmit technical and
diagnostic information to HX3, and We may transmit technical support notifications, data and code to the Product.

3.2.7. You may transfer the Product to another legal entity, only if (a) You assign all of your rights under this Agreement, cease all use
of the Program and Key, erase or destroy any copy (including the hard disk copy) made in support of Your use of this Product, and (b)
the other legal entity agrees to the terms of this Agreement. If You transfer an original version of the Program, or any upgrade of the
Program, You must transfer all versions and upgrades of the Program as a single Product.

4. Intellectual Property Rights

4.1. For purposes of this Agreement, the term "Intellectual Property Rights" means any and all known or hereafter existing worldwide
copyrights, trademarks, service marks, trade secrets, patents, patent products, know-how, moral rights, contract rights, and other
proprietary rights, and all registrations, products, renewals, extensions, and combinations of the foregoing. All Intellectual Property
Rights, as well as all other rights in the Product, shall remain with HX3 or its licensors, and You hereby waive all claims thereto and will
not assert any rights therein. You must reproduce any copyright, patent, or other notice marked on the Product on all copies that You
make.

4.2. Any rights not expressly granted to You hereunder are reserved by HX3 or its licensors. If any open source code or third party
code or other third party elements are included within the Product, they remain owned by the owners thereof and no rights are
transferred to either party herein.

5. Warranty

5.1. During the following specified warranty period, HX3 warrants that the Program will substantially conform to the Documentation
accompanying the Program:

5.1.1. If You have paid for a Perpetual license, the warranty period shall be the greater of (a) thirty days from the date of Your
company's first installation of the Program, or (b) for the period of time for which You have purchased MSU Services; or

5.1.2. If You have paid for a Subscription license, the warranty period shall be the period of time for which You have purchased a
Subscription.

5.2. If HX3 is notified of a warranty failure within the warranty period of such defect as described above, and provided You have paid
for a license, at its sole option HX3 will either (a) modify or replace the defective portion of the Product, or (b) refund all license fees
You have paid HX3 for the Product in the most recent period. Any action undertaken by HX3 does not extend the warranty period or
expand HX3's obligations under this warranty. If a refund is provided, the license is thereby terminated and You shall immediately
cease use of the Product.



6. Disclaimer of Warranties and Limitation of Liability

6.1. OTHER THAN THE LIMITED WARRANTY SET FORTH ABOVE, TO THE EXTENT PERMITTED BY APPLICABLE LAWS, THE
PRODUCT IS PROVIDED "AS-IS" AND HX3 HEREBY DISCLAIMS ALL OTHER WARRANTIES EXPRESS, IMPLIED, STATUTORY
OR OTHERWISE, INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT, AND ANY WARRANTIES ARISING OUT OF COURSE OF DEALING
OR COURSE OF PERFORMANCE. HX3 DOES NOT WARRANT THAT THE PRODUCT WILL OPERATE WITHOUT INTERRUPTION
OR WILL BE ERROR FREE. YOU ACKNOWLEDGE THAT NO WARRANTIES ARE MADE BY ANY OF HX3'S LICENSORS OR
SUPPLIERS WITH REGARD TO THE PRODUCT, USE THEREOF, OR RESULTS YOU MAY OBTAIN FROM USE OF THE
PRODUCT.

6.2. TO THE GREATEST EXTENT PERMISSIBLE UNDER APPLICABLE LAW, EVEN IF HX3 HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES: (1) IN NO EVENT WILL HX3 BE LIABLE FOR ANY CONSEQUENTIAL, INDIRECT,
EXEMPLARY, SPECIAL, OR INCIDENTAL DAMAGES, OR FOR ANY LOST DATA, LOST PROFITS OR COSTS OF PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES, ARISING FROM OR RELATING TO THIS AGREEMENT, HOWEVER CAUSED AND
UNDER ANY THEORY OF LIABILITY (INCLUDING NEGLIGENCE), AND (2) THE TOTAL CUMULATIVE LIABILITY OF HX3, ITS
LICENSORS OR SUPPLIERS, AND ANY OF EITHER OF THEIR OFFICERS OR DIRECTORS (COLLECTIVELY THE "HX3
PARTIES") IN CONNECTION WITH THIS AGREEMENT AND THE PRODUCT, WHETHER IN CONTRACT OR TORT OR
OTHERWISE, WILL NOT EXCEED THE LICENSE FEES YOU HAVE PAID HX3 FOR THE PRODUCT IN THE MOST RECENT 12
MONTH PERIOD. THIS LIMITATION OF LIABILITY CLAUSE SHALL BE APPLICABLE IN ADDITION TO ANY OTHER LIMITATION
ON THE LIABILITY OF HX3 SET FORTH ELSEWHERE IN THIS AGREEMENT. You acknowledge that this clause reflects the
allocation of risk set forth in this Agreement and that HX3 would not enter into this Agreement without these limitations on its liability,
and You agree that these limitations will apply notwithstanding any failure of essential purpose of any limited remedy. In addition, HX3
disclaims all liability of any kind of HX3's licensors and suppliers.

6.3. This limitation applies, without limitation, to (a) any claims, demands or liabilities related to the Product, software, services, content
(including code) on third party Internet sites, or third party programs; and (b) claims for breach of contract, breach of warranty,
guarantee or condition, strict liability, negligence, or other tort to the extent permitted by applicable law. The above limitation or
exclusion may not apply to You because Your legal jurisdiction may not allow the exclusion or limitation of incidental, consequential or
other damages. In those jurisdictions that do not allow the exclusion or limitation of damages, HX3's liability shall be limited or
excluded to the maximum extent allowed within those jurisdictions.

7. Fees and Payment

7.1. You will pay HX3 the Fees, which shall be based on (a) the license type You have selected, (b) whether or not you have
purchased separate MSU Services, and (c) the number of Named User Accounts You have licensed. Each invoice from HX3 will state
the basis for any Fees included therein. You will pay all amounts set forth on each such invoice in immediately available U.S. funds
according to the terms set forth in the invoice and in accordance with the HX3 Policies (including late fees as set forth therein). In
addition, You must immediately reimburse HX3 for all costs and expenses (including any attorney fees) it incurs collecting any past due
amounts owed by You. Except as otherwise expressly set forth in this Agreement, the Fees are non-refundable.

7.2. In the event You fail to pay HX3 any sum when due, HX3 may, without prior notice and without waiving or limiting any other
remedies to which it may be entitled to hereunder, in law or in equity, terminate the license granted herein and discontinue all further
MSU Services if applicable, until such time as all amounts due have been paid in full.

7.3. The Fees exclude all applicable sales, use, transfer, import, customs, and other taxes, fees, duties and similar charges imposed
by any governmental entity ("Taxes"), and You will be responsible for payment of all such Taxes to the extent applicable and any
penalties or charges that accrue with respect to the non-payment of any Taxes.

8. Compliance Audits

8.1. We have the right to verify Your compliance with the terms of this Agreement (including the HX3 Policies) by requesting a
compliance audit at any time during, and up to one year after, Your ownership of any Program license granted hereunder. You agree to
provide reasonable cooperation in the event of a compliance audit.

8.2. Within 30 days of our written request for an audit, You will perform an audit ("Customer Audit") as follows:



8.2.1. You will conduct an internal audit of your usage of the Program, comparing the number of persons using the Program at the time
of our request to the number of Named User Accounts specified by Your license.

8.2.2. You agree to provide us with access to usage information captured by our Program as a tool in conducting the Customer Audit. If
we provide any auditing software to You, You agree to use such software, and to return the true and unmodified results to us.

8.2.3. You will provide a written statement by an officer of Your company certifying that each person using the Program at the time of
our request has been assigned an individual Named User Account for his/her exclusive use, or that sufficient new Named User
Accounts have been ordered for each person using the Program.

8.3. If within such 30 day period You fail to perform all elements of a Customer Audit as described above, then we reserve the right to
either (a) perform our own audit by any means we desire, including without limitation the installation of auditing software or the
appointment of a third party auditor ("HX3 Audit") in which case the results of the HX3 Audit shall be deemed binding on You, or (b)
terminate this Agreement and invalidate all of your Named User Accounts immediately upon written notice to You.

8.4. If the results of a Customer Audit or HX3 Audit, as applicable, do not find a Named User Account shortage of at least 5% ("Material
Unlicensed Use"), we will not request or undertake another compliance audit for at least one year.

8.5. If the results of a Customer Audit or HX3 Audit, as applicable, reveal any Material Unlicensed Use, then You agree to purchase
sufficient Named User Accounts to restore compliance during each license period during which non-compliance occurred. We will
invoice You for such additional Named User Accounts following our determination of the applicable number thereof. If we have not
received Your payment of such invoice by the due date set forth therein, we reserve the right to immediately and without further notice,
terminate all of your Named User Accounts, this Agreement, and all of Your rights and licenses hereunder.

8.6. By requesting an audit, we do not waive our rights to enforce this Agreement, or to protect our intellectual property by any other
means permitted by law.

9. Restricted Rights

9.1. If the Product is acquired by or for the U.S. Government, then it is provided with restricted rights. Use, duplication or disclosure by
the United States Government (or any unit, agency or department thereof), is subject to the following provisions (or any applicable
successor provisions) which, to the extent applicable, are incorporated by reference herein as if set forth in their entirety: (i) FAR
52.227.19(a) through (c); (ii) in the case of the Department of Defense, DFAR 227.7202-1 through 227.7202-4; (iii) in the case of
NASA, the NASA Supplement to the FAR at 18-52.227-86(d); and (iv) all other Federal laws and regulations that protect Licensor's
rights in privately developed software. Contractor / Manufacturer is HX3 Solutions, Inc., PO Box 4040, Westford, MA 01886 USA.

10. Term and Termination

10.1. The Term of this Agreement will commence on the date you acquire the Program from HX3, and unless earlier terminated as set
forth herein, will continue (a) if a Perpetual license, for so long as HX3 offers the Product for license to the public, or (b) if a
Subscription license, for so long as you have paid the applicable Subscription Fees. Notwithstanding the foregoing, if You are subject
to a Subscription license and/or You have purchased MSU Services, if and when a new version of this Agreement is released as part
of a new version of the Program, You will be required to agree to the new version of this Agreement in order for Your license of the new
version of the Program to become effective, at which time the new version of this Agreement will supersede all prior versions of this
Agreement You may have previously entered.

10.2. HX3 may terminate the licenses granted herein immediately upon written notice if: (a) You breach any provision of this
Agreement, and such breach is not cured within fifteen (15) days following HX3's written notice thereof; (b) You have failed to pay
amounts due to HX3 pursuant to the applicable invoice, as described in Section 7.2; or (c) pursuant to the Compliance Audits as
described in Section 8.

10.3. Upon expiration or termination of this Agreement for any reason: (a) any amounts owed to HX3 under this Agreement prior to
such termination or expiration will be immediately due and payable; (b) all licensed rights granted to You in this Agreement will
immediately cease to exist; and (c) You will promptly discontinue all use of the Product and delete any copies of the Product in Your
possession or control. Sections 3.1, 4, 6, 8, 10.3, 11, 12, and 13 as well as any payment obligations outstanding as of termination, will
survive termination of this Agreement for any reason.



11. Indemnification

11.1. You will defend, indemnify, and hold the HX3 Parties harmless from and against any claim, action, proceeding, liability, loss,
damage, cost, or expense (including, without limitation, legal fees and expenses) (collectively a "Claim"), arising out of or in connection
with any of the following caused in whole or part by You or someone acting on Your behalf: (a) use of any portion of the Product in
violation of the terms of this Agreement, the Documentation, or as otherwise instructed by HX3; (b) breach of any of the provisions of
this Agreement, howsoever caused; or (c) any acts, omissions or negligence of You or someone acting on Your behalf.

12. Confidentiality

12.1. The Product, including without limitation, the structure, organization and code of the Program, contains information and valuable
trade secrets that are not generally known to the public, and shall be deemed "Confidential Information" of HX3. You will treat as
confidential and preserve the confidentiality of the Product and will not disclose any portion of the Product to any third party.

12.2. The foregoing obligation does not apply to any information that: (a) is already in Your possession without obligations of
confidentiality, as shown by documentation; (b) is or becomes publicly available through no fault of You; or (c) is obtained by You from
a third person without breach by such third person of an obligation of confidence. Information will not be deemed to be within the
foregoing exceptions merely because it is: (i) embraced by more general information in the public domain or in the possession of the
party receiving such information, or (ii) a combination of individual items of information that could be pieced together to reconstruct
such combination from non-confidential information.

13. General Provisions

13.1. This Agreement (including the HX3 Policies) sets forth the entire understanding and agreement for the Product, including the
MSU Services, between You and HX3, and supersedes all other prior and contemporary agreements, understandings, and
commitments between the parties regarding the subject matter of this Agreement. You may not amend this Agreement unless such
amendments are agreed to in writing by both You and HX3. In particular, any provisions, terms, or conditions contained in customer
provided documents that are in any way inconsistent with or in addition to the terms and conditions of this Agreement shall not be
binding upon HX3.

13.2. This Agreement describes certain legal rights. You may have other rights under the laws of your country. You may also have
rights with respect to the party from whom you acquired the Product, if applicable. This Agreement does not change your rights under
the laws of your country if the laws of your country do not permit it to do so.

13.3. No waiver of any right under this Agreement will be effective unless in writing, signed by a duly authorized representative of the
party to be bound. No waiver of any past or present right arising from any breach, failure or delay to perform, or failure or delay to
exercise any right will be deemed to be a waiver of any future right of either party arising under this Agreement.

13.4. If any provision in this Agreement is deemed by a court of law to be invalid or unenforceable, that provision will be construed,
limited, modified or, if necessary, severed, to the extent necessary, to eliminate its invalidity or unenforceability, and the other
provisions of this Agreement will remain unaffected.

13.5. The laws of the State of Massachusetts, United States of America, govern the interpretation of this Agreement and apply to
claims for breach of it, regardless of conflict of laws principles. Any action at law relating to this Agreement may only be brought before
the courts of competent jurisdiction of the State of Massachusetts, United States of America, and You hereby agree to the exclusive
jurisdiction and venue of such courts.

13.6. The Product is subject to export laws and regulations of the United States of America. You must comply with all domestic and
international export laws and regulations that apply to the Product. These laws include restrictions on destinations, end users and end
use.

13.7. The Product may incorporate or use other vendors' products to implement its functions. You agree to read and comply with these
other vendors' licenses which are either (a) installed as part of the Product's installation process, or (b) identified in the Documentation.

13.8. You will not bring any action against any HX3 Party arising out of or related to this Agreement or the subject matter hereof more
than one (1) year after the occurrence of the event which gave rise to such action.



13.9. You acknowledge and agree that HX3 will be irreparably injured if the provisions of Sections 4 or 12 hereof are not capable of
being specifically enforced, and agree that HX3 shall be entitled to equitable remedies for any breach of such Sections, in addition to,
and cumulative with, any legal rights or remedies, including the right to damages.

13.10. HX3 will not be responsible for any failure in the performance of its obligations under this Agreement to the extent that such
failure is due to causes beyond HX3's control including, but not limited to, acts of God, war, acts of any government or agency thereof,
fire, explosions, epidemics, quarantine restrictions, delivery services, telecommunication providers, strikes, labor difficulties, lockouts,
embargoes, severe weather conditions, delay in transportation, or delay of suppliers or subcontractors.
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Your use of this PDXpert Client Application program, associated data and configuration files, and other software, as well as user
documentation and the product key (collectively the "Product") is subject to a license agreement ("Agreement", located at
www.buyplm.com/license ) between your company and HX3 Solutions, Inc. ("HX3"). "You" refers to any authorized user of the
Product. These end user terms ("Terms") are incorporated into the Agreement, and You are bound by these Terms and the Agreement,
which includes HX3's policies ("HX3 Policies", located at www.buyplm.com/policies ).

You may use the Product only for the Term of the Agreement entered by your company, and only if Your company has provided you
with an authorized account ("Named User Account"). BY USING THE PRODUCT, YOU INDICATE YOUR ACCEPTANCE OF THESE
TERMS.

You may not allow anyone else to use your Named User Account. You may use your Named User Account on up to three (3)
computers/devices during any 12-month period. You agree that the Product may transmit technical and diagnostic information to HX3,
and HX3 may transmit technical support notifications, data and code to the Product. You must reproduce any copyright, patent, or
other notice marked on the Product on all copies that You make.

You may not: (a) modify, adapt, alter, translate, or create derivative works from the Product; (b) merge the Product with other software
except as needed to use the Product for its intended purposes or to use it with other enterprise programs licensed by You;
(c) sublicense, distribute, sell, use for service bureau use, lease, rent, loan, or otherwise transfer the Product to any third party other
than as expressly provided herein; (d) reverse engineer, decompile, disassemble, or otherwise attempt to derive the source code for
the Product, except and only to the extent that such activity is expressly permitted by applicable law notwithstanding this limitation
(provided, however, that to the extent You intend to engage in any of the foregoing, You will notify HX3 in advance of such activity and
will treat the results of such activity as Confidential Information (defined below) of HX3); (e) remove, alter, or obscure any proprietary
notices of HX3, its licensors or suppliers included in the Product; or (f) otherwise use or copy the Product except as expressly
permitted under the Agreement. Unauthorized reproduction or distribution of the Product may result in civil or criminal penalties.
Violators will be prosecuted to the maximum extent permitted by law.

The Product, including without limitation, the structure, organization and code of the Product, contains information and valuable trade
secrets that are not generally known to the public, and shall be deemed "Confidential Information" of HX3. You will treat as confidential
and preserve the confidentiality of the Product and will not disclose any portion of the Product to any third party.

THE PRODUCT IS PROVIDED WITHOUT ANY WARRANTIES OTHER THAN AS SET FORTH IN THE AGREEMENT. TO THE
GREATEST EXTENT PERMISSIBLE UNDER APPLICABLE LAW, EVEN IF HX3 HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES: (1) IN NO EVENT WILL HX3 BE LIABLE FOR ANY CONSEQUENTIAL, INDIRECT, EXEMPLARY, SPECIAL, OR
INCIDENTAL DAMAGES, OR FOR ANY LOST DATA, LOST PROFITS OR COSTS OF PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES, HOWEVER CAUSED AND UNDER ANY THEORY OF LIABILITY, AND (2) THE TOTAL CUMULATIVE LIABILITY OF
HX3, ITS LICENSORS OR SUPPLIERS, AND ANY OF EITHER OF THEIR OFFICERS OR DIRECTORS IN CONNECTION WITH
THESE TERMS OR THE AGREEMENT AND THE PRODUCT, WILL NOT EXCEED THE LICENSE FEES YOUR COMPANY HAS
PAID HX3 FOR THE PRODUCT IN THE MOST RECENT 12 MONTH PERIOD.

To the extent these Terms are inconsistent with the Agreement or the HX3 Policies, the terms of the Agreement will control.
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Any licenses for third-party software that are applicable to the installation and operation of PDXpert may be obtained as described
below, or by contacting HX3 Solutions, Inc.

Microsoft SSEE software license
The license(s) for Microsoft SQL Server and its related software are saved during the SSEE installation procedure. The End-User
License Agreement (EULA) files are in the Microsoft SQL Server \EULA  folder, typically located within
C:\Program Files\Microsoft SQL Server\

Other third-party licenses
Third-party software may be used in the software product. For your convenience, related licenses are included in the application server
installation \website\bin\  path. For example:

DockPanelSuite (MIT license)
DotNetZip (BSD, Apache, MIT, zlib licenses)
Lucene.NET (Apache software license 2.0)
Microsoft Report Viewer Runtime for SQL Server
Microsoft System CLR Types for SQL Server
NLog (BSD license)

The product may also incorporate third-party software that is in the public domain or does not require distribution of a license. Such
software may include, for example:

OpenXML (Microsoft Open Specification Promise)
SQLite (Public Domain statement)

1044



Legal notices Home 235

Disclaimer
The configuration management, product data management, information technology and security practices discussed in this Help Guide
may offer helpful insight into your own organization's practices and decisions. For brevity, many other practices are not discussed. You
are solely responsible for deciding whether the concepts presented in this Help Guide can be applied to your situation. If expert
assistance is required, the services of qualified professionals should be used.

Trademarks
PDXpert® and Acseni® are registered trademarks, and PDXplorer™ is a trademark, of HX3 Solutions, Inc.

Microsoft®, SQL Server®, Vista® and Windows® are registered trademarks of Microsoft Corporation.

All other trademarks are the property of their respective owners.

This Help Guide
Copyright © by HX3 Solutions, Inc. All rights reserved.

Information in this Help Guide is subject to change without notice and does not represent a commitment on the part of HX3 Solutions,
Inc. Companies, names, and data used in examples are fictitious unless otherwise noted.

This Help Guide may only be reproduced by, and for the exclusive use of, organizations licensed for this software application. All other
reproduction, transmission, translation, storage, or retrieval is expressly prohibited.
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